GnuCash Tutorial and Concepts Guide: The Didactical Documentation
by The GnuCash Documentation Team

This Guide contains a tutorial for using 5.8 and describes the concepts behind GnuCash.

Copyright © 2009-2024 GnuCash Documentation Team
Copyright © 2010-2011 Yawar Amin
Copyright © 2010 Tom Bullock
Copyright © 2010-2011 Cristian Marchi
Copyright © 2006 Chris Lyttle
Copyright © 2003-2004 Jon Lapham
Copyright © 2002 Chris Lyttle
Copyright © 2001 Carol Champagne and Chris Lyttle

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License (GFDL), Version 1.1 or any later version published by the Free Software Foundation with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts. You can find a copy of the GFDL at this link [help:fdl] or in the file COPYING-DOCS distributed with this manual.

This manual is part of a collection of GNOME manuals distributed under the GFDL. If you want to distribute this manual separately from the collection, you can do so by adding a copy of the license to the manual, as described in section 6 of the license.

Many of the names used by companies to distinguish their products and services are claimed as trademarks. Where those names appear in any GNOME documentation, and the members of the GNOME Documentation Project are made aware of those trademarks, then the names are in capital letters or initial capital letters.

DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT ARE PROVIDED UNDER THE TERMS OF THE GNU FREE DOCUMENTATION LICENSE WITH THE FURTHER UNDERSTANDING THAT:

1. DOCUMENT IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS FREE OF DEFECTS MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. THE ENTIRE RISK AS TO THE QUALITY, ACCURACY, AND PERFORMANCE OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS WITH YOU. SHOULD ANY DOCUMENT OR MODIFIED VERSION PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL WRITER, AUTHOR OR ANY CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER; AND

2. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER IN TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL THE AUTHOR, INITIAL WRITER, ANY CONTRIBUTOR, OR ANY DISTRIBUTOR OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER DAMAGES OR LOSSES ARISING OUT OF OR RELATING TO USE OF THE DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.

Feedback

To report a bug or make a suggestion regarding the program or this documentation, follow the instructions at the Bugzilla page of the GnuCash wiki [https://wiki.gnucash.org/wiki/Bugzilla] and use the GnuCash Bug Tracking System [https://bugs.gnucash.org/]. At first you want to browse [https://bugs.gnucash.org/describecomponents.cgi] or search [https://bugs.gnucash.org/query.cgi] it for already existing bugs. Select the product GnuCash for the program or Documentation for any parts of this documentation.
# Table of Contents

About the Authors .............................................................................................................. xvi
I. Overview .......................................................................................................................... 1
   Introduction ......................................................................................................................... 1
   Features ............................................................................................................................... 2
      Easy to Use ....................................................................................................................... 2
      Tracks Your Investments ................................................................................................. 3
      International Support ..................................................................................................... 3
      Business Support .......................................................................................................... 3
      Accounting Features ...................................................................................................... 4
   About this Book ................................................................................................................ 4
   Getting More Help ........................................................................................................... 5
      Context Help .................................................................................................................. 5
      GnuCash Website .......................................................................................................... 6
      GnuCash Wiki ................................................................................................................ 6
      GnuCash Frequently Asked Questions ......................................................................... 6
      GnuCash On-line Assistance ......................................................................................... 6
      Topic Search .................................................................................................................. 6
   Installation ......................................................................................................................... 7
I. The Basic Knowledge ....................................................................................................... 8
   2. The Basics ..................................................................................................................... 11
      Accounting Concepts ...................................................................................................... 11
         The 5 Basic Accounts .................................................................................................. 11
         The Accounting Equation ......................................................................................... 11
         Debits and Credits ....................................................................................................... 12
         Double Entry ............................................................................................................. 13
      Data Entry Concepts ...................................................................................................... 13
         Files ............................................................................................................................... 13
         Accounts ...................................................................................................................... 14
         Transactions ................................................................................................................ 14
   Running GnuCash ............................................................................................................ 15
      Welcome to GnuCash dialog ......................................................................................... 15
      New Account Hierarchy Setup ..................................................................................... 15
      Tip of the Day ............................................................................................................... 17
      Account Tree Window ................................................................................................... 17
      Account Register Window ............................................................................................ 18
      Toolbar Buttons ........................................................................................................... 19
      Tab Bar ........................................................................................................................... 20
      Menu Items .................................................................................................................... 20
      Menu Shortcuts ............................................................................................................. 20
   Storing your financial data .............................................................................................. 21
      Overview ......................................................................................................................... 21
      Storage Comparison and Recommendations ................................................................ 21
      Storage Comparison Table ........................................................................................... 21
      Creating a file ................................................................................................................ 22
      Saving data ..................................................................................................................... 22
      Opening data .................................................................................................................. 24
      Duplicating an Account Hierarchy ................................................................................ 25
   Backing Up and Recovering Data .................................................................................... 25
      Backup file (.gnucash) ................................................................................................. 25
      Log file (.log) ............................................................................................................... 26
      Lock files (.LNK and .LCK) .......................................................................................... 26
GnuCash Guide 5.8

File Management .......................................................... 26
Migrating GnuCash data ................................................. 27
  Migrating financial data ............................................ 27
  Migrating preferences data ........................................ 27
Putting It All Together ................................................ 28
Accounts ................................................................. 34
  Basic Accounting Concepts ....................................... 34
  GnuCash Accounts .................................................. 35
  Putting It All Together ............................................ 39
Transactions ............................................................. 43
  Basic Concepts ..................................................... 44
  The Account Register ............................................ 44
  Simple vs. Split Transactions ................................... 48
  Reconciliation ...................................................... 51
  Scheduled Transactions ......................................... 55
  Putting It All Together ............................................ 63
3. Importing Data into GnuCash ...................................... 70
  Importing Transactions from Files ............................ 70
    File Import Formats .......................................... 70
    Import Matcher ................................................ 70
    Import QIF ................................................... 71
    Import OFX/QFX ............................................ 72
    Import CSV .................................................. 73
    Import MT940 ............................................... 74
    Import MT942 ............................................... 74
    Import DTAUS ............................................... 74
4. Configuring GnuCash ................................................ 75
  Overview .......................................................... 75
  Main Configuration Screens .................................... 75
    Preferences: Accounting Period Tab ......................... 75
    Preferences: Accounts Tab .................................. 75
    Preferences: Online Banking ................................. 75
II. The Common Usage .................................................. 76
5. Checkbook .......................................................... 80
  Setting up Accounts ............................................. 80
  Entering Deposits ............................................... 80
  Entering Withdrawals .......................................... 81
    ATM/Cash Withdrawals ....................................... 81
  Reconciling Your Accounts .................................... 82
  Putting It All Together ......................................... 82
    Opening Balances ........................................... 82
    Add some transactions ...................................... 83
    Opening Balances ............................................ 84
    Save file ....................................................... 86
    Reports ........................................................ 87
6. Expense Accounts .................................................. 91
  Concepts .......................................................... 91
  Setting Up Accounts ............................................. 91
    Simple Expense Account Setup ............................... 91
    Complex Expense Account Setup ............................ 91
  Entering Expense Transactions ................................ 91
    Other Considerations for Expense Accounts ................ 92
7. Credit Cards ........................................................ 93
  Concepts .......................................................... 93
<table>
<thead>
<tr>
<th>Setting Up Accounts</th>
<th>Basic Concepts</th>
<th>Terminology</th>
<th>Setting Up Accounts</th>
<th>Calculations</th>
<th>House Mortgage (How-To)</th>
<th>Automobile Loan (How-To)</th>
<th>A Personal Loan to a friend (How-To)</th>
<th>Reconciling with the Loan Statements (How-To)</th>
<th>Selling a house or a car (How-To)</th>
<th>Simple Transaction</th>
<th>A More Complex Transaction</th>
<th>8. Loans</th>
<th>Terminology</th>
<th>105</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Payments</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Automatic Entry</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Manual Entry</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Initial Price Database Setup</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Open GnuCash file</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Purchases</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Refund</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Interest Charge</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Reconciliation</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Payment</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Save file</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
<tr>
<td>Reports</td>
<td>Basic Concepts</td>
<td>Terminology</td>
<td>Setting Up Accounts</td>
<td>Calculations</td>
<td>House Mortgage (How-To)</td>
<td>Automobile Loan (How-To)</td>
<td>A Personal Loan to a friend (How-To)</td>
<td>Reconciling with the Loan Statements (How-To)</td>
<td>Selling a house or a car (How-To)</td>
<td>Simple Transaction</td>
<td>A More Complex Transaction</td>
<td>9. Investments</td>
<td>Terminology</td>
<td>122</td>
</tr>
</tbody>
</table>

GnuCash Guide 5.8
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring for Automatic Retrieval of Quotes</td>
<td>140</td>
</tr>
<tr>
<td>Displaying Share Value</td>
<td>141</td>
</tr>
<tr>
<td>The “Price Source” in Reports</td>
<td>141</td>
</tr>
<tr>
<td>Selling Shares</td>
<td>143</td>
</tr>
<tr>
<td>Selling Shares with Manual Calculation of Capital Gain or Loss</td>
<td>144</td>
</tr>
<tr>
<td>Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots</td>
<td>151</td>
</tr>
<tr>
<td>Dividends</td>
<td>163</td>
</tr>
<tr>
<td>Dividends in Cash</td>
<td>163</td>
</tr>
<tr>
<td>Dividends Re-Invested</td>
<td>164</td>
</tr>
<tr>
<td>Return of Capital</td>
<td>165</td>
</tr>
<tr>
<td>Splits and Mergers</td>
<td>165</td>
</tr>
<tr>
<td>Simple Stock Split</td>
<td>166</td>
</tr>
<tr>
<td>Moderately Complex Stock Merger</td>
<td>168</td>
</tr>
<tr>
<td>10. Reports</td>
<td>171</td>
</tr>
<tr>
<td>Overview</td>
<td>171</td>
</tr>
<tr>
<td>Saved Reports Configurations Concepts</td>
<td>171</td>
</tr>
<tr>
<td>Standard Reports Overview</td>
<td>172</td>
</tr>
<tr>
<td>Transaction Report</td>
<td>172</td>
</tr>
<tr>
<td>Assets &amp; Liabilities Group</td>
<td>172</td>
</tr>
<tr>
<td>Budget Group</td>
<td>177</td>
</tr>
<tr>
<td>Business Group</td>
<td>177</td>
</tr>
<tr>
<td>Income and Expense Group</td>
<td>179</td>
</tr>
<tr>
<td>Sample &amp; Custom Group</td>
<td>182</td>
</tr>
<tr>
<td>Other Reports</td>
<td>183</td>
</tr>
<tr>
<td>Using the Transaction Report</td>
<td>184</td>
</tr>
<tr>
<td>11. Capital Gains</td>
<td>187</td>
</tr>
<tr>
<td>Basic Concepts</td>
<td>187</td>
</tr>
<tr>
<td>Estimating Valuation</td>
<td>187</td>
</tr>
<tr>
<td>Account Setup</td>
<td>188</td>
</tr>
<tr>
<td>Example</td>
<td>189</td>
</tr>
<tr>
<td>Unrealized Gains</td>
<td>190</td>
</tr>
<tr>
<td>Selling</td>
<td>190</td>
</tr>
<tr>
<td>Taxation</td>
<td>193</td>
</tr>
<tr>
<td>12. Multiple Currencies</td>
<td>194</td>
</tr>
<tr>
<td>Basic Concepts</td>
<td>194</td>
</tr>
<tr>
<td>Manually Recording Currency Transaction</td>
<td>194</td>
</tr>
<tr>
<td>Account Setup</td>
<td>194</td>
</tr>
<tr>
<td>Recording and Updating Currency Exchange Rates</td>
<td>197</td>
</tr>
<tr>
<td>Recording Purchases in a Foreign Currency</td>
<td>206</td>
</tr>
<tr>
<td>Tracking Currency Investments</td>
<td>211</td>
</tr>
<tr>
<td>Reconciling Statements in a Foreign Currency</td>
<td>213</td>
</tr>
<tr>
<td>Automatically Recording Currency Transactions</td>
<td>213</td>
</tr>
<tr>
<td>Trading Account Concepts</td>
<td>213</td>
</tr>
<tr>
<td>Recording Foreign Currency Transactions with Trading Accounts</td>
<td>214</td>
</tr>
<tr>
<td>III. The Advanced Features</td>
<td>222</td>
</tr>
<tr>
<td>13. Business Features</td>
<td>225</td>
</tr>
<tr>
<td>Introduction to Business Features</td>
<td>225</td>
</tr>
<tr>
<td>Business Setup</td>
<td>225</td>
</tr>
<tr>
<td>Account Setup</td>
<td>225</td>
</tr>
<tr>
<td>Setting up Sales Tax Tables</td>
<td>226</td>
</tr>
<tr>
<td>Enter Company Information</td>
<td>228</td>
</tr>
<tr>
<td>Setting Business Preferences</td>
<td>230</td>
</tr>
<tr>
<td>Setting Billing Terms</td>
<td>230</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>231</td>
</tr>
</tbody>
</table>
14. Budgets ........................................................................................................................................... 254
   Basic Concepts ................................................................................................................................. 254
   Terminology ....................................................................................................................................... 254
   Creating a Budget .............................................................................................................................. 254
      Choose Which Accounts To Budget For ......................................................................................... 254
      Choosing a Budget Period ............................................................................................................... 255
      Getting Started .............................................................................................................................. 255
      Entering Budget Values .................................................................................................................. 255
   Budget Reporting ............................................................................................................................... 255
      Budgeted Income Statement ........................................................................................................... 256
      Budgeted Balance Sheet ................................................................................................................ 256
15. Other Assets ....................................................................................................................................... 257
   General Concepts .............................................................................................................................. 257
   Other Assets Described ..................................................................................................................... 257
      Current Assets ............................................................................................................................... 257
      Long-term (Fixed) Assets ................................................................................................................ 257
   Current Assets ................................................................................................................................... 257
      Short-term Receivables .................................................................................................................... 258
      Reimbursable Expenses .................................................................................................................. 258
      Travel Advances ............................................................................................................................ 259
      Prepaid Premiums or Prepaid Rent ............................................................................................... 259
      Suspense or Wash Accounts .......................................................................................................... 260
   Short or Long-term Assets ................................................................................................................ 261
   Long-term (Fixed) Assets ................................................................................................................... 261
      Land ................................................................................................................................................ 261
      Buildings ....................................................................................................................................... 261
      Leasehold Improvements ................................................................................................................ 262
      Vehicles or Equipment ..................................................................................................................... 262
      Intangibles ....................................................................................................................................... 262
16. Depreciation ...................................................................................................................................... 263
   Basic Concepts ................................................................................................................................. 263
   Personal Finances .............................................................................................................................. 263
   Business .............................................................................................................................................. 263
   Estimating Valuation .......................................................................................................................... 264
   Depreciation Schemes ....................................................................................................................... 264
   Account Setup .................................................................................................................................... 266
   Example .............................................................................................................................................. 267
17. Python Bindings ................................................................. 271
18. Importing Business Data ......................................................... 272
   Importing Bills and Invoices ............................................... 272
      General ................................................................. 272
      The format of the import file ....................................... 272
      Import your data .................................................... 274
      Feedback and statistics ............................................. 274
      What could go wrong? .............................................. 275
      Not supported invoice functionality ............................. 276
   Importing Customers and Vendors ....................................... 277
      General ................................................................. 277
      The format of the import file ....................................... 277
      Import your data .................................................... 278
      Feedback and statistics ............................................. 279
      What could go wrong? .............................................. 279
      Not supported customer/vendor functionality ................... 280
IV. Appendices ........................................................................ 281
   GnuCash Glossary ............................................................... 283
   A. Migration Guide ............................................................... 287
      Using Accounts vs. Categories ...................................... 287
      Importing Data ............................................................ 287
         Import of Financial Data by QIF Files .......................... 287
         Import of Business Data by CSV Files ......................... 287
      Converting XML GnuCash File ............................................ 287
   B. Auxiliary File Formats ....................................................... 290
      Check Format Files (*.chk) ............................................. 290
         Overview ............................................................... 290
         Example file .......................................................... 290
         Field Descriptions .................................................. 291
         Creating Check Format Files ...................................... 300
   C. GNU Free Documentation License ......................................... 301
      0. PREAMBLE ................................................................. 301
      1. APPLICABILITY AND DEFINITIONS ............................... 301
      2. VERBATIM COPYING .................................................. 302
      3. COPYING IN QUANTITY .............................................. 302
      4. MODIFICATIONS ...................................................... 303
      5. COMBINING DOCUMENTS ............................................. 304
      6. COLLECTIONS OF DOCUMENTS .................................... 304
      7. AGGREGATION WITH INDEPENDENT WORKS ...................... 304
      8. TRANSLATION ............................................................ 305
      9. TERMINATION ........................................................... 305
     10. FUTURE REVISIONS OF THIS LICENSE .............................. 305
     Addendum ....................................................................... 305
## List of Figures

1.1. A Chart Of Accounts With Multiple Currencies And Investments .................................................. 1
2.1. The basic accounts relationships .................................................................................................. 12
2.2. The Tip of the Day ...................................................................................................................... 17
2.3. The basic accounts relationships .................................................................................................. 18
2.4. The Checking Account Register .................................................................................................. 19
2.5. Save screen when xml or sqlite3 is selected. .............................................................................. 23
2.6. Save screen when mysql or postgres is selected. ....................................................................... 24
2.7. New Account Hierarchy Setup: Introduction ........................................................................... 29
2.8. New Account Hierarchy Setup: Book Options ........................................................................... 30
2.9. New Account Hierarchy Setup: Currency Selection .................................................................. 31
2.10. New Account Hierarchy Setup: Account Selection .................................................................. 32
2.11. New Account Hierarchy Setup: Account Setup ...................................................................... 33
2.13. Tutorial: Starting Account View of the Test File ..................................................................... 34
2.14. The basic accounts relationships ............................................................................................... 35
2.15. Default Income Accounts ........................................................................................................ 38
2.16. Default Expense Accounts ....................................................................................................... 39
2.17. Creating an Assets account ....................................................................................................... 41
2.18. The Basic Top-level Accounts ................................................................................................... 42
2.19. The Basic Chart of Accounts ..................................................................................................... 43
2.20. Purchase Of 3 Jeans In Assets:Checking ................................................................................... 45
2.21. Purchase Of 3 Jeans In Expenses:Clothes Account In Basic Ledger Mode ............................. 45
2.22. Purchase Of 3 Jeans In Expenses:Clothes Account In Transaction Journal Mode ................ 45
2.23. Salary In The Assets:Checking Account ................................................................................... 49
2.24. Salary In The Income:Salary Account ..................................................................................... 49
2.25. The Checking Account After Inserting The Opening Balance Transaction ......................... 50
2.26. The Checking Account Adding A Transaction For Groceries .................................................. 50
2.27. Entering a split transaction ....................................................................................................... 51
2.28. The Initial Reconcile Window .................................................................................................. 52
2.29. Reconcile Window ..................................................................................................................... 54
2.30. The Checking account after postponing the reconciliation ...................................................... 55
2.31. Step 1 Of Creating Scheduled Transaction From The Ledger ............................................... 56
2.32. Step 2 Of Creating Scheduled Transaction From The Ledger ............................................... 56
2.33. Step 3 Of Creating Scheduled Transaction From The Ledger ............................................... 57
2.34. Filling In Data To A Scheduled Transaction ............................................................................ 57
2.35. Empty Scheduled Transactions Tab ......................................................................................... 58
2.36. Overview Tab Of The Edit Scheduled Transaction Window .................................................. 59
2.37. Frequency Tab Of The Edit Scheduled Transaction Window .................................................. 60
2.38. Template Tab Of The Edit Scheduled Transaction Window .................................................... 61
2.39. The Finally Entered Scheduled Transaction ......................................................................... 62
2.40. Scheduled Transaction Popup Reminder .................................................................................. 63
2.41. Starting Point For Putting It All Together ............................................................................... 64
2.42. Chart Of Accounts After Setting The Opening Balance .......................................................... 65
2.43. Chart Of Accounts After Setting All The Various Transactions ............................................. 67
2.44. Cash Flow Report For The Month Of March .......................................................................... 68
2.45. Transaction Report For The Checking Account During March ............................................. 69
2.46. Transaction Report For The Expenses Accounts During March .......................................... 69
5.1. The Chart Of Accounts .............................................................................................................. 83
5.2. The Checking Account Register ............................................................................................... 83
5.3. The Checking Account Register After Registering Some More Checks ................................. 84
5.4. The Checking Account Register With An ATM Withdrawal .................................................... 84
9.23. Selling Shares - Capital Gains - Lots in Account window .................................................. 152
9.25. Selling Shares - Capital Gains - Lots before scrubbing a single lot .................................. 156
9.26. Selling Shares - Capital Gains - Lots before scrubbing a single lot, after manual linking .... 156
9.27. Selling Shares - Capital Gains - Register after manual linking and scrubbing a single lot ..... 157
9.28. Selling Shares - Capital Gains - Register before Scrub Account ...................................... 158
9.29. Selling Shares - Capital Gains - Lots before Scrub Account .............................................. 159
9.30. Selling Shares - Capital Gains - Lots after Scrub Account ................................................ 159
9.31. Selling Shares - Capital Gains - Register after Scrub Account ......................................... 160
9.32. Selling Shares - Capital Gains - Register after Scrub Account ......................................... 161
9.33. Selling Shares - Capital Gains - Lot 0 after Scrub Account .............................................. 161
9.34. Selling Shares - Capital Gains - Lot 1 after Scrub Account ............................................... 162
9.35. Selling Shares - Capital Gains - Register after scrubbing a single lot ................................ 163
9.36. Example Of Cash Dividend Transactions .............................................................................. 164
9.37. Example Of Dividend Reinvestment Transactions ................................................................. 164
9.38. Example Of Return Of Capital Transactions ....................................................................... 165
9.39. Activation Of The “Stock Split” Assistant ............................................................................ 166
9.40. Selection Of A Stock Account In The “Stock Split” Assistant ............................................. 166
9.41. Split Details In The “Stock Split” Assistant ......................................................................... 167
9.42. “Cash In Lieu” In The “Stock Split” Assistant ..................................................................... 168
9.43. The NST Account After A Simple Stock Split ....................................................................... 168
9.44. Selection Of A Stock Account In The “Stock Split” Assistant—Moderate ........................... 169
9.45. Split Details In The “Stock Split” Assistant—Moderate ......................................................... 170
9.46. The T Account After A Moderate Stock Split ...................................................................... 170
10.1. The Investment Lots Report ............................................................................................... 175
11.1. Asset Appreciation Main Window ...................................................................................... 189
11.2. Asset Appreciation Main Window ...................................................................................... 190
11.3. Asset Appreciation Main Window ...................................................................................... 192
12.1. Initial multi currency Account Bank Setup ......................................................................... 196
12.2. Initial multi currency Account Bank Setup .......................................................................... 198
12.3. The Price Database Window—Still Empty .......................................................................... 199
12.4. Setup Of Euro Exchange Rate ........................................................................................... 200
12.5. The Price Database window after setting the exchange rate between Euros and US Dollars 201
12.6. Chart of Accounts After Setting The Exchange Rate Between Euro And US Dollar .......... 202
12.7. Price Database Before Obtaining Online Quotes ................................................................. 203
12.8. The Price Database After Obtaining Online Quotes .......................................................... 204
12.9. The Chart of Accounts After Obtaining Online Quotes ..................................................... 205
12.10. Transaction “Currency Transfer To Jamaica” .................................................................... 206
12.11. Edit Exchange Rate ........................................................................................................... 207
12.12. Chart of Accounts before purchasing the boat ................................................................. 207
12.13. The Chart Of Accounts After Purchasing The Boat .......................................................... 208
12.15. International Securities ...................................................................................................... 209
12.16. Transfer Funds .................................................................................................................. 210
12.17. The Purchased international stocks ................................................................................... 211
12.18. The Initial Multicurrency Bank Accounts Setup ............................................................... 214
12.19. The Initial Price Database Entries ...................................................................................... 214
12.20. The Initial Multicurrency Setup After Entering Exchange Rates Between USD, HKD and EUR ................................................................................................................................. 215
12.21. The Transfer Dialog To Create Transaction For Transfer From USD To HKD .................. 216
12.23. The Transaction After Adding The Splits For The Transfer Fee ........................................ 217
12.24. The Account Tab Balances After Completion Of USD To HKD Transfer ........................ 218
12.25. The Transaction To Transfer Funds From Hong Kong To US Bank Account .................... 219
12.26. The Price database after transfer of funds back to US account .................................................. 219
12.27. The Accounts tab after transfer back ................................................................. 220
12.28. The Balance Sheet After Above Transactions ................................................................. 221
13.1. Sales Tax Tables Editor .................................................................................. 227
13.2. New Sales Tax Table Entry ........................................................................... 227
13.3. Entering Company Information ........................................................................ 229
13.4. Billing Terms Editor ...................................................................................... 230
13.5. New Billing Term .......................................................................................... 231
13.6. New Customer Registration Window ................................................................. 233
13.7. Find Customer Window .................................................................................. 234
13.8. Creating a New Invoice .................................................................................. 235
13.9. Edit Invoice Window ...................................................................................... 235
13.10. Post Invoice Window ...................................................................................... 236
13.11. Invoice Print Output ...................................................................................... 237
13.13. Process Payment From Customer .................................................................. 239
13.15. HTML Style Sheet Example Window ................................................................. 240
13.16. HTML Style Sheets Example Output ................................................................. 241
13.17. New Vendor Registration Window .................................................................. 242
13.18. Find Vendor Window ...................................................................................... 243
13.19. New Bill Registration Window .......................................................................... 244
13.20. Edit Bill Window .......................................................................................... 245
13.21. Post Bill Window .......................................................................................... 245
13.22. New Vendor Job .......................................................................................... 246
13.23. Process Payment To Vendor .......................................................................... 247
13.24. Payroll Example: Initial Setup .......................................................................... 250
13.25. Payroll Example: Employee Split Transaction .................................................. 251
13.27. Payroll Example: Accounts After Paying Government ........................................ 253
16.1. Asset Accounts Before Depreciation ................................................................. 268
16.2. Asset Depreciation In The Register ................................................................. 269
16.3. Accounts Tab After Asset Depreciation ............................................................. 269
# List of Tables

2.1. Summary of effect of debits (Dr) and credits (Cr) on the balance of accounts of the 5 account types ................................................................. 12
2.2. Storage Comparison ................................................................ 21
2.3. Application Settings Locations .................................................. 27
2.4. Saved Reports Locations ............................................................ 27
2.5. Online Banking Settings Locations ............................................ 28
8.1. Buying a House Split Transaction ............................................. 111
8.2. Personal loan to Peter ............................................................... 115
8.3. Selling an asset (house) with a profit ........................................ 119
8.4. Selling an asset (house) with a loss .......................................... 120
8.5. Selling an asset (house) with a profit ........................................ 120
8.6. Selling an asset (house) with a profit 2 ..................................... 121
9.1. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Combined, Gross Pricing ................. 145
9.2. Selling Shares Split Scheme, Sale & Gain Combined, Gross Pricing ..................................................... 146
9.3. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Combined, Net Pricing ...................... 147
9.4. Selling Shares Split Scheme, Sale & Gain Combined, Net Pricing ..................................................... 148
9.5. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate Transactions, Sale Transaction .......... 148
9.6. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate Transactions, Capital Gain/Loss Transaction .................................................................. 149
9.7. Selling Shares Split Scheme, Sale Transaction, Gross Pricing ............................................................ 149
9.8. Selling Shares Split Scheme, Gain Transaction, Gross Pricing ............................................................ 149
9.9. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate Transactions, Sale Transaction .................................................................. 150
9.10. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate Transactions, Capital Gain/Loss Transaction .................................................................. 150
9.11. Selling Shares Split Scheme, Sale Transaction, Net Pricing .................................................................. 151
9.12. Selling Shares Split Scheme, Gain Transaction, Net Pricing .................................................................. 151
9.13. Transaction 1 dealing with value received and the reduction of the number of shares .................. 154
9.14. Transaction 2 capital gain/loss (loss in this example) .................................................................. 155
10.1. Sample Chart of Accounts for Income and GST Statement .................................................................. 182
10.2. Income and GST Statement ....................................................... 182
10.3. Sample Chart of Accounts for the Transaction Report ............................................................ 184
11.1. Turning an Unrealized Gain into a Realized Gain - Accurate Estimation ........................................ 191
11.2. Turning an Unrealized Gain into a Realized Gain - Over estimation ........................................ 192
11.3. Turning an Unrealized Gain into a Realized Gain - Under estimation ........................................ 193
12.1. Selling a currency with a Split Transaction Scheme .................................................................. 212
13.1. Sample Tax Table Entries for EU country (e.g. 21% / 6% / 0% Belgium, 20% / 5% / 0% UK etc.) (2017) .................................................................. 228
13.2. Sample Tax Table Entries for Australia (2017) .................................................................. 228
13.3. Sample Tax Table Entries for Cook County, Illinois (2017) .................................................................. 228
13.4. Payroll Transaction Map ........................................................... 249
13.5. Payroll Transaction Map for Employee 1 ........................................................................ 251
16.1. Linear Depreciation Scheme Example .................................................................................. 265
16.2. Geometric Depreciation Scheme Example .................................................................................. 265
16.3. Sum of Digits Depreciation Scheme Example .................................................................................. 266
B.1. Overall Page Description Fields .................................................................................. 291
B.2. Multiple Checks Per Page Fields .................................................................................. 293
B.3. Individual Check Item Fields .................................................................................. 295
B.4. Individual Check Item Types .................................................................................. 297
List of Examples

8.1. Accounts for the loan to Peter ................................................................. 115
9.2. Sale of Shares with Profit, Manual Profit/Loss Calculation, Sale & Profit Combined, Net Pricing ................................................................. 147
9.3. Sale of Shares with Profit, Manual Profit/Loss Calculation, Sale & Profit Separated, Gross Pricing ................................................................. 149
9.4. Sale of Shares with Profit, Manual Profit/Loss Calculation, Sale & Profit Separated, Net Pricing ................................................................. 150
9.5. Manual Lot Creation and Linking .............................................................. 155
9.6. Automatic Creation of Capital Gain Or Loss Transactions ....................... 157
9.7. Automatic Creation of Capital Gain Or Loss Transactions, 2 Sales at Once .......... 158
9.9. Changing the Orphaned Gains-CCC to Gain/Loss Account ..................... 162
List of Equations

2.1. The static accounting equation .......................................................... 11
2.2. The (dynamic) accounting equation .................................................... 12
2.3. The rearranged accounting equation .................................................... 12
About the Authors

The GnuCash Documentation Team is a self-designated group of GnuCash users and developers who have volunteered to write this documentation for the benefit of the broader user base. People who are interested in joining this group are encouraged to express their interest on the GnuCash lists (<gnucash-users> and <gnucash-devel>) for further direction.

Contributors on the team so far have been: Yawar Amin, J. Alex Aycinena, Tom Bullock, Carol Champagne, Frank H. Ellenberger, Mike Evans, Chris Good, Dave Herman, Geert Janssens, Jon Lapham, Chris Lyttle, Cristian Marchi, Brent McBride, John Ralls, Robert Ratliff, Christian Stimming, David T., and Bengt Thuree.
Chapter 1. Overview

Introduction

GnuCash is the personal finance software package made for you. It is versatile enough to keep track of all your financial information, from the simple to the very complex. It is one of the few financial software packages that supports global currencies, and it is the only open-source program of its kind. Best of all, GnuCash is easy to learn and use!

So, what can GnuCash do for you? It can keep track of your personal finances in as much detail as you prefer. If you are just starting out, use GnuCash to keep track of your checkbook. You may then decide to track cash as well as credit card purchases to better determine where your money is being spent. When you start investing, you can use GnuCash to help monitor your portfolio. Buying a vehicle or a home? GnuCash will help you plan the investment and track loan payments. If your financial records span the globe, GnuCash provides all the multiple-currency support you need.

Figure 1.1. A Chart Of Accounts With Multiple Currencies And Investments

This image shows a Chart of Accounts with multiple currencies and investments.

While GnuCash is well suited for personal finances, it is also powerful enough for business use. There are many business features, from integrated accounts receivable and payable systems, to tax table construction. You will find these and the many other business features surprisingly powerful and easy to use.
Features

Easy to Use

Within a matter of minutes you will be able to enter your personal finance information and generate color graphs that represent your financial status. If you can use the register in the back of your checkbook - you can use GnuCash! Type directly into the register, tab between fields, and use quick-fill to automatically complete transactions. The interface is customizable from within the application itself.

- *Easy to Use Menus*: GnuCash menus conform to the GNOME Human Interface Guidelines. This means that they are simple and similar in appearance to many other GNOME applications.


- *Import Methods*: GnuCash supports many ways to input transactions besides manual entry. If you can access your bank accounts on-line, this is especially useful, as most banks and credit card companies support one of the following import methods. You will spend less time entering data and more time analyzing results.
  
  - *Quicken Import File (QIF)*: Import Quicken QIF style files, a popular file format with many commercial personal finance software packages.
  
  - *Open Financial Exchange (OFX)*: GnuCash has been the first free software application to support the Open Financial Exchange protocol. Many financial institutions are moving towards this format.
  
  - *Home Banking Computer Interface (HBCI)*: GnuCash has been the first free software application to support the German Home Banking Computer Interface protocol. This protocol includes statement download, initiates bank transfers, and makes direct debits possible.

- *Reports*: GnuCash comes with over 30 prebuilt reports, including Account Summary, Income, Expenses, Transaction Report, Balance Sheet, Profit&Loss, Portfolio Valuation, and many others. Reports support graphical views of the data, including pie charts, bar charts, and scatter plots. The reports can be exported to HTML files, and are easily customized.

- *Scheduled Transactions*: GnuCash now has the ability to automatically create and enter transactions, or remind you when these transactions are due, giving you the choice of entering, postponing or removing the automated transaction.

- *Mortgage and Loan Repayment Assistant*: Used to set up a variable payment loan scheduled transaction.

- *Easy Account Reconciliation*: Integrated reconciliation makes reconciling your GnuCash accounts with statements simple and effective.

- *Multi-platform Compatibility*: GnuCash is supported on a variety of platforms and operating systems. The list of fully supported operating systems (and platforms) is for

  GnuCash $\geq 3.0$

  *Linux* (x86, x86_64), *FreeBSD* (x86, x86_64), *OpenBSD* (x86, x86_64), *macOS* (64-bit Intel), and *Windows* (Windows 7 and later).

  GnuCash $\leq 2.6.21$

  *macOS* (32-bit Intel, PPC) and *Windows* (XP and Vista).
GnuCash \leq 2.2.9


Previous versions of GnuCash

have been known to work with SGI IRIX (MIPS), IBM AIX 4.1.5 (RS/6000), Unixware 7 (Intel), SCO OpenServer 5.0.4 (Intel), and Solaris (SPARC) but their current status is unknown.

Tracks Your Investments

GnuCash includes a number of investment features that allow you to track all your investments. With GnuCash you can track stocks individually (one per account) or in a portfolio of accounts (a group of accounts that can be displayed together).

GnuCash supports online stock and mutual fund quotes. This means you no longer need to look up stock prices one at a time. The process can be automated, and you can see the latest value of your stocks.

International Support

GnuCash is truly an application that works with and understands users from all around the world. There are many built-in features to facilitate interaction with the international world we live in today.

- **Native Languages**: GnuCash has been translated into over 55 languages. Full translated are Chinese (traditional), Croatian, Dutch, Hebrew, Italian, Portuguese, and Ukrainian. Almost as good, with over 90% translated, are Catalan, Chinese (simplified), German, Indonesian, Japanese, Portuguese (Brazil), and Spanish.  

- **International Format Handling**: GnuCash understands that different countries display the date and numbers differently. You are able to work with the date and number formats you are accustomed to.

- **Multiple Currencies and Currency Trading**: All in ISO 4217 [https://en.wikipedia.org/wiki/ISO_4217] defined currencies are supported and can be bought and sold (traded). Currency movements between accounts remain fully balanced if "Trading Accounts" is enabled.

- **On-line exchange rates**: With GnuCash, you no longer need look up your exchange rates one at a time. The process can be automated, to always present you with the account values converted to your preferred currency using the latest exchange rates.

Business Support

GnuCash has many features to support the needs of the business accounting community.

- **Accounts Receivable/Payable**: GnuCash has an integrated Accounts Receivable and Accounts Payable system. You can track Customers, Vendors, Invoicing and Bill Payment, and use different Tax and Billing Terms in a small business.

- **Depreciation**: GnuCash can track depreciation of capital assets.

- **Reports**: GnuCash offers a wide variety of ready-to-use business reports.

1If you want to create or improve the translation of your language see https://wiki.gnucash.org/wiki/Translation.
Accounting Features

For those knowledgeable in accounting, here is a list of GnuCash’s accounting features.

- **Double Entry**: Every transaction must debit one account and credit others by an equal amount. This ensures the “books balance” - that the difference between income and expense exactly equals the sum of all bank, cash, stock and other assets.

- **Split Transactions**: A single transaction can be split into several pieces to record taxes, fees, and other compound entries.

- **Chart of Accounts**: A master account can have a hierarchy of detail accounts underneath it. This allows similar account types such as Cash, Bank, or Stock to be grouped into a master account such as “Assets”.

- **General Journal**: One register window can display multiple accounts at the same time. This eases the trouble of tracking down typing/entry errors. It also provides a convenient way of viewing a portfolio of many stocks, by showing all transactions in that portfolio.

- **Income/Expense Account Types (Categories)**: These categorize your cash flow and, when used properly with the double-entry feature, will provide an accurate Profit&Loss statement.

About this Book

This manual’s goal is to save you time. It will get you started using GnuCash as quickly as possible.

Each chapter follows a simple format. A chapter begins with a “Concepts” discussion which introduces general themes and terminology, addressed and used within that chapter. “How-To” sections, which address specific procedures follow. Finally, a “Putting It All Together” section ends the chapter by giving detailed, concrete examples.

Beginning users will find the “Concepts” sections very helpful. They provide a reference for good ways to track your finances, and serve as a general introduction to financial background and terminology. Experienced users can flip to the “How-To” sections to quickly scan procedures. These sections provide to-the-point steps for accomplishing specific tasks. The “Putting It All Together” sections present real-world examples in the form of a tutorial. Beginning with creation of a file in Chapter 2, *The Basics*, each successive chapter builds on the previous chapter’s tutorial.

This manual is organized into 3 main parts:

- Part I, “The Basic Knowledge”
- Part II, “The Common Usage”
- Part III, “The Advanced Features”

Part I, “The Basic Knowledge” provides you with the most basic information needed to begin using GnuCash. The chapters in this part explain concepts that are fundamental to using GnuCash. New users of GnuCash should familiarize themselves with the information in these chapters to get you up and running:

- Chapter 1, *Overview* - (this chapter) gives a general overview of GnuCash

- Chapter 2, *The Basics* - gives users a very brief introduction to accounting principles, and then provides information about how GnuCash structures its data. There is also information on basic interface elements in GnuCash. Finally, this chapter explains how GnuCash stores and manages your data.
• the section called “Accounts” - gives further information about accounts and how to organize them.

• the section called “Transactions” - gives basic information about transactions and how to enter them.

Part II, “The Common Usage” addresses common applications and features of GnuCash in greater detail. You will see more specific cases, based on frequently asked questions about applying GnuCash to everyday situations. Here are the applications and features covered in this part:

• Chapter 5, Checkbook

• Chapter 7, Credit Cards

• Chapter 8, Loans

• Chapter 9, Investments

• Chapter 11, Capital Gains

• Chapter 12, Multiple Currencies

Part III, “The Advanced Features” discusses the use of GnuCash in business accounting:

• Chapter 13, Business Features

• Chapter 14, Budgets

• Chapter 15, Other Assets

• Chapter 16, Depreciation

• Chapter 17, Python Bindings

• Chapter 18, Importing Business Data

This manual also includes several appendices, which contains extra information you might want to know:

• GnuCash Glossary - Glossary of terms used in GnuCash

• Appendix A, Migration Guide - Guide for former Quicken®, MS Money or other QIF users

• Appendix B, Auxiliary File Formats

• Appendix C, GNU Free Documentation License

Last, but not least, a glossary and index help you quickly locate topics.

Getting More Help

GnuCash offers help in many ways, including the Tip of the Day, context help, a website, a wiki, the mailing lists, and IRC chat.

Context Help

The context help provides detailed instructions for using GnuCash's menus, windows, and controls. To open online help, select Help→Contents.
The GnuCash Help window also acts as a simple web browser, so you can pull up a website for additional information. You can open any website under this window by clicking the Open Toolbar button and then typing in the URL. Use the Back, Forward, Reload, Stop, and Print buttons as you would in a standard browser.

**GnuCash Website**

The [GnuCash website](https://www.gnucash.org/) contains helpful information about the program and about any updates to it. It also contains links to other online resources.

**GnuCash Wiki**

An immense amount of less-formal documentation, both of GnuCash itself and its maintenance and development may be found in the GnuCash Wiki [https://wiki.gnucash.org/wiki/].

**GnuCash Frequently Asked Questions**

GnuCash Frequently Asked Questions [https://wiki.gnucash.org/wiki/FAQ] (FAQ) page is also on the GnuCash Wiki. It should be a first stop whenever you encounter difficulty using GnuCash. It is now translated into German and Simplified Chinese. If you'd like to access to the translated page, see tabs on the top of the GnuCash Frequently Asked Questions [https://wiki.gnucash.org/wiki/FAQ] page.

**GnuCash On-line Assistance**

**Mailing List**

The primary source of user support is the user mailing list [mailto:gnucash-user@gnucash.org]. If you prefer a web forum-like presentation, you can use it via Nabble [http://gnucash.1415818.n4.nabble.com/GnuCash-f1415818.subapps.html]. One must subscribe [%url-mail-li;gnucash-user] before posting, even if using Nabble.

**IRC**

Several of the developers monitor the #gnucash channel at irc.gimp.net [irc://irc.gimp.net/gnucash]. They are usually busy with other tasks and of course are not always at their computers. Log in, ask your question, and stay logged in; it may take several hours before your question is noticed and responded.

- If you got disconnected check the IRC logs [https://lists.gnucash.org/logs/] to verify that you missed nothing related.

- Requirements, netiquette, and other details are explained in the IRC wiki page [https://wiki.gnucash.org/wiki/IRC].

The GnuCash website [https://www.gnucash.org/] has more details on these channels. You will also find pointers there to additional useful resources such as the GnuCash wiki and bug tracking system.

**Topic Search**

The online manual also provides a search function. To search for a particular topic, click the Search tab at the bottom of the help window and type in your topic in the field provided. Click the Search button to complete your search. A list of choices should appear in the box below, clicking a choice will bring up its text on the right.
Installation

Installation of GnuCash is usually simple.

The GnuCash download page [https://www.gnucash.org/download.phtml] contains detailed instructions on how to install GnuCash for each operating system supported.
Part I. The Basic Knowledge
# Table of Contents

2. The Basics .............................................................................................................. 11
   Accounting Concepts ............................................................................................... 11
      The 5 Basic Accounts ......................................................................................... 11
      The Accounting Equation .................................................................................... 11
      Debits and Credits ............................................................................................... 12
      Double Entry ......................................................................................................... 13
   Data Entry Concepts ................................................................................................. 13
      Files ......................................................................................................................... 13
      Accounts ................................................................................................................ 14
      Transactions .......................................................................................................... 14
   Running GnuCash ...................................................................................................... 15
      Welcome to GnuCash dialog ............................................................................... 15
      New Account Hierarchy Setup ............................................................................. 15
      Tip of the Day ....................................................................................................... 17
      Account Tree Window ........................................................................................... 17
      Account Register Window ..................................................................................... 18
      Toolbar Buttons .................................................................................................... 19
      Tab Bar .................................................................................................................. 20
      Menu Items ............................................................................................................ 20
      Menu Shortcuts ...................................................................................................... 20
   Storing your financial data ....................................................................................... 21
      Overview ................................................................................................................. 21
      Storage Comparison and Recommendations ....................................................... 21
      Storage Comparison Table ................................................................................... 21
      Creating a file ......................................................................................................... 22
      Saving data ............................................................................................................. 22
      Opening data .......................................................................................................... 22
      Duplicating an Account Hierarchy ......................................................................... 24
   Backing Up and Recovering Data ............................................................................ 25
      Backup file (.gnucash) ........................................................................................ 25
      Log file (.log) ......................................................................................................... 26
      Lock files (.LNK and .LCK) ................................................................................ 26
      File Management ................................................................................................... 26
   Migrating GnuCash data .......................................................................................... 27
      Migrating financial data ....................................................................................... 27
      Migrating preferences data ................................................................................... 27
   Putting It All Together ............................................................................................. 28
   Accounts .................................................................................................................... 34
      Basic Accounting Concepts ................................................................................ 34
      GnuCash Accounts ............................................................................................... 35
      Putting It All Together .......................................................................................... 39
   Transactions .............................................................................................................. 43
      Basic Concepts ..................................................................................................... 44
      The Account Register ........................................................................................... 44
      Simple vs. Split Transactions .............................................................................. 48
      Reconciliation ....................................................................................................... 51
      Scheduled Transactions ...................................................................................... 55
      Putting It All Together .......................................................................................... 63
3. Importing Data into GnuCash ............................................................................... 70
   Importing Transactions from Files ........................................................................... 70
   File Import Formats ................................................................................................. 70
The Basic Knowledge

Import Matcher .............................................................................................................. 70
Import QIF ...................................................................................................................... 71
Import OFX/QFX .......................................................................................................... 72
Import CSV ................................................................................................................... 73
Import MT940 ............................................................................................................... 74
Import MT942 ............................................................................................................... 74
Import DTAUS .............................................................................................................. 74

4. Configuring GnuCash ............................................................................................... 75
   Overview ..................................................................................................................... 75
   Main Configuration Screens ....................................................................................... 75
   Preferences: Accounting Period Tab .......................................................................... 75
   Preferences: Accounts Tab ......................................................................................... 75
   Preferences: Online Banking ..................................................................................... 75
Chapter 2. The Basics

This chapter will introduce some of the basics of using GnuCash. It is recommended that you read through this chapter, before starting to do any real work with GnuCash. Next chapters will begin to show you hands on examples.

Accounting Concepts

GnuCash is easy enough to use that you do not need to have a complete understanding of accounting principles to find it useful. However, you will find that some basic accounting knowledge will prove to be invaluable as GnuCash was designed using these principles as a template. It is highly recommended that you understand this section of the guide before proceeding.

The 5 Basic Accounts

Basic accounting rules group all finance related things into 5 fundamental types of “accounts”. That is, everything that accounting deals with can be placed into one of these 5 accounts:

Account types

Assets

Things you own

Liabilities

Things you owe

Equity

Overall net worth

Income

Increases the value of your accounts

Expenses

Decreases the value of your accounts

It is clear that it is possible to categorize your financial world into these 5 groups. For example, the cash in your bank account is an asset, your mortgage is a liability, your paycheck is income, and the cost of dinner last night is an expense.

The Accounting Equation

With the 5 basic accounts defined, what is the relationship between them? How does one type of account affect the others? Firstly, equity is defined by assets and liability. That is, your net worth is calculated by subtracting your liabilities from your assets:

Equation 2.1. The static accounting equation

Assets - Liabilities = Equity
Furthermore, you can increase your equity through income, and decrease equity through expenses. This makes sense of course, when you receive a paycheck you become “richer” and when you pay for dinner you become “poorer”. This is expressed mathematically in what is known as the Accounting Equation:

**Equation 2.2. The (dynamic) accounting equation**

Assets - Liabilities = Equity + (Income - Expenses)

This equation must always be balanced, a condition that can only be satisfied if you enter values to multiple accounts. For example: if you receive money in the form of income you must see an equal increase in your assets. As another example, you could have an increase in assets if you have a parallel increase in liabilities.

**Figure 2.1. The basic accounts relationships**

A graphical view of the relationship between the 5 basic accounts. Net worth (equity) increases through income and decreases through expenses. The arrows represent the movement of value.

**Debits and Credits**

The use of debits and credits in accounting and their effect on accounts of different types is often confusing when first encountered in accounting. The accounting equation introduced above is the key to understanding which accounts types are debited or credited and when. First of all we need to rearrange the expanded form a little bit with Assets on the left hand side of the equal sign and transposing any account type with a negative sign to the other side to obtain:

**Equation 2.3. The rearranged accounting equation**

Assets + Expenses = Liabilities + Equity + Income

With the accounting equation in this form, the accounts on the left hand side of the equal sign are known as debit balance accounts in accounting practice, that is the normal positive balance for these accounts is increased by debit entries to accounts of these types. Conversely credit entries to accounts of these types will decrease the balance of accounts of these types.

Similarly, the account types on the right hand side of the equal sign are known as credit balance accounts, that is the normal positive balance for these account types is increased by credit entries to the accounts of these types. Again debit entries to accounts of these types will reduce the balance in the account.

**Table 2.1. Summary of effect of debits (Dr) and credits (Cr) on the balance of accounts of the 5 account types**

<table>
<thead>
<tr>
<th>Account Type</th>
<th>Effect on Account Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets</td>
<td>Increase</td>
</tr>
<tr>
<td>Expenses</td>
<td>Decrease</td>
</tr>
</tbody>
</table>
### Account Type | Effect on Account Balance
---|---
Debit (Dr) | Credit (Cr)
Liabilities |  
Equity | Decrease | Increase
Income |  

**Double Entry**

The accounting equation is the very heart of a double entry accounting system. For every change in value of one account in the Accounting Equation, there must be a balancing change in another. This concept is known as the Principle of Balance, and is of fundamental importance for understanding GnuCash and other double entry accounting systems. When you work with GnuCash, you will always be concerned with at least 2 accounts, to keep the accounting equation balanced.

Balancing changes (or transfers of money) among accounts are done by debiting one account and simultaneously crediting another. Accounting debits and credits do not mean “decrease” and “increase”. Debits and credits each increase certain types of accounts and decrease others as described in the previous section. In asset and expense accounts, debits increase the balance and credits decrease the balance. In liability, equity and income accounts, credits increase the balance and debits decrease the balance.

In traditional double-entry accounting, the left column in the register is used for debits, while the right column is used for credits. Accountants record increases in asset and expense accounts on the debit (left) side, and they record increases in liability, income, and equity accounts on the credit (right) side. GnuCash follows this convention in the register.

**Note**

This accounting terminology can be confusing to new users, which is why GnuCash allows you to use the common terms Deposit and Withdrawal. If you prefer the formal accounting terms, you can change the account register column headings to use them in the Accounts tab under Preferences (see the GnuCash Manual for more information on setting preferences).

**Warning**

Common use of the words debit and credit does not match how accountants use these words. In common use, credit generally has positive associations; in accounting, credit means affecting the right column of the ledger sheet of an account. This is associated with a decrease in asset and expense, but an increase of income, liability and equity accounts.


**Data Entry Concepts**

When entering data in GnuCash, you should be aware of the 3 levels of organization in which GnuCash divides your data: files, accounts and transactions. These levels are presented in their order of complexity, one file contains many accounts and one account contains many transactions. This division is fundamental to understanding how to use GnuCash.

**Files**

GnuCash stores information at the highest level in files. A file can be stored on your computer either as a single XML file (in all versions of GnuCash), or in a SQL database (in GnuCash version 2.4 and higher).
The Basics

Note

SQL is pronounced “sequel”, so in spoken and written language we would say “a SQL database”.

With the XML file format, GnuCash stores your data in an XML data file, usually in compressed format (although this can be changed in the General tab of the GnuCash Preferences).

With SQL storage, GnuCash stores your data in a SQL database under the database application you select (SQLite3, MySQL or PostgreSQL).

You will need one main file or database for each set of accounts you are maintaining. To learn how to create and manage GnuCash files, see the section called “Storing your financial data”.

Note

If you think you might need more than one set of accounts, you might want to consult a professional accountant or bookkeeper before proceeding. Most users will probably have only one data file.

Backup files and log files are automatically generated by GnuCash when appropriate. Backup and log files are described in the section called “Backing Up and Recovering Data”.

Accounts

An account keeps track of what you own, owe, spend or receive. Each GnuCash file can contain any number of accounts, and each account can contain many sub-accounts up to an arbitrary number of levels. This simple feature gives GnuCash much of its power in managing your finances, as you will see in later chapters.

Examples of accounts include: checking accounts, savings accounts, credit card accounts, mortgages, and loans. Each GnuCash account tracks the activity for that “real” account, and can inform you of its status.

In addition, accounts are also used to categorize the money you receive or spend. For example, you can create expense accounts to track the money you pay on utilities or groceries. Even though these are not accounts that receive statements, they allow you to determine how much money is being spent in each of these areas.

Accounts will be covered in more detail in the section called “Accounts”.

Transactions

A transaction represents the movement of money among accounts. Whenever you spend or receive money, or transfer money between accounts, that is a transaction.

Examples of transactions are: paying a phone bill, transferring money from savings to checking, buying a pizza, withdrawing money, and depositing a paycheck. the section called “Transactions” goes more in depth on how to enter transactions.

In double entry accounting, transactions always involve at least two accounts--a source account and a destination account. GnuCash manages this by inserting a line into the transaction for every account that is affected, and recording the amounts involved in each line. A line within a transaction that records the account and amount of money involved is called a split. A transaction can contain an arbitrary number of splits.
Note

Splits in transactions will be covered in the section called “Split Transaction Example”

Running GnuCash

GnuCash can be run from your desktop main menu by selecting the associated menu entry.

Alternatively it can be run from a command line prompt with the command gnucash.

During start up, GnuCash will display the Splash Screen, where some information about the program (version number, build, etc.) and the loading process are displayed.

Welcome to GnuCash dialog

The very first time you open GnuCash, you will see the Welcome to GnuCash! screen. This dialog includes three choices:

• Create a new set of accounts - Runs the New Account Hierarchy Setup assistant (see the section called “New Account Hierarchy Setup”). Select this option if you want to be assisted in creating a set of accounts.

• Import my QIF files - Runs the Import QIF Files assistant (see the section called “Import QIF”). Select this option if you already have Quicken files (.qif files) and wish to import them into GnuCash.

• Open the new user tutorial - Opens the GnuCash Tutorial and Concepts Guide. Select this option if you are completely new to GnuCash and accounting concepts.

Note

It is possible to access each of these items after you have left this screen, but the Welcome to GnuCash! screen will not reappear. To create a new set of accounts, see the section called “New Account Hierarchy Setup”. To import QIF files, see the section called “Import QIF”.

New Account Hierarchy Setup

The New Account Hierarchy Setup assistant helps you to create a set of GnuCash accounts. It will appear if you choose Create a new set of accounts in the Welcome to GnuCash! menu, or when you select File → New File (Ctrl+N). You may also use it to add a section of accounts to an existing book from the Accounts page by selecting Action → New Account Hierarchy… .

This assistant will guide you through the creation of a Chart of Accounts. There are several steps in the assistant, which are outlined below.

1. The first screen briefly describes what this assistant does.

2. New Book Options appears only when creating a new book. Here you set various book attributes. This page has four tabs: Accounts, Budgeting, Business, and Counters. These items are explained elsewhere in the Guide, and can be changed at any time from File → Properties (Ctrl+Enter).

3. Choose Currency sets the hidden root account currency and the default currency for new accounts. The offered default is based on the computer locale settings. Choose this carefully: Not only does it set the...
The Basics

default currency for creating new accounts, it is the "Home" currency for the book and becomes the default currency for all stock pricing and foreign currency exchange rates. While it can be changed by rerunning the New Account Hierarchy Setup Assistant from the Action menu, doing so after you've created transactions is risky.

4. Choose accounts to create provides a variety of accounting categories that may be added to the book. There are two main panels: On the left the list of categories with a selection check box next to each one and on the right the accounts that will be added by the highlighted category.

Above the Categories list you'll find two list-buttons, one for language code and the other for country code. The initial selection is again based on your computer's locale settings. You may select any language and country combination that suits your needs.

Note

The New Account Hierarchy Setup Assistant can't process selections from more than one locale at a time, so if you need to select segments from multiple locales—perhaps because the categories for your primary locale are intended to extend those of another country—you'll need to run the assistant more than once from the Action menu.

5. Setup selected accounts presents the accounts from the categories you selected on Choose accounts to create in a non-collapsible tree view with four or five columns depending on whether or not you're creating a new book:

• Account Name. This is editable, just click in it or select the row and press Enter.

• Type Not editable. This is the type of the account.

• Placeholder accounts (accounts that are intended only to collect sub-accounts and not to have transactions themselves). You may change this by checking to make an account a placeholder or unchecking to make it a regular account.

• Opening Balances can accept a value for new non-placeholder accounts that are not of type Equity, as existing accounts already have balances, placeholder accounts can't have transactions, and Equity can't have an opening balance.

Note

Opening Balance entry isn't obvious until you click in it. You must move out of the entry by clicking somewhere or by pressing Tab or Enter before clicking Next or your entry will be discarded.

• Use Existing appears only when you've started the New Account Hierarchy Setup Assistant from the Action menu. It indicates whether an account already exists. It's not editable.

6. Finish account setup is the last screen and gives you a final option to cancel the process, back up to change something, or apply to confirm your choices. If you're creating a new book, GnuCash will present a dialog to select a backend and either a file to save it or database server, database name, and credentials to create a MySQL or PostgreSQL database if GnuCash was built with those features and you have the necessary dependencies installed.

Warning

If you choose to cancel, any selections you have made up to this point will be lost.
Tip of the Day

GnuCash provides a Tip of the Day screen to give helpful hints for using the program:

Figure 2.2. The Tip of the Day

![Tip of the Day Image]

This image shows the Tip of the Day.

These tips provide useful information for beginning users. To view more of the tips, click Forward to continue. If you do not wish to see this screen box on start-up, deselect the box next to Show tips at startup. When you have finished viewing the helpful tips, click Close to close the Tip of the Day screen.

Account Tree Window

You should now see the Accounts window, which appears as shown below. The exact layout of the account tree will depend on which default accounts you selected during the New Account Hierarchy Setup. In this example, the Common Accounts are shown.
The Basics

Figure 2.3. The basic accounts relationships

This image shows the Accounts window.

The Account Tree window (also known as a Chart of Accounts, or CoA) provides an overview of the data contained in the current file. It contains a list of account names and their current balances.

From this window, you can open the register of any account either by double-clicking the account name, right clicking the account name and selecting Open Account from the menu, or by using the Open button on the toolbar. GnuCash allows you to have as many account registers open as you wish. For more information on using account registers, see the section called “Account Register Window”.

Tip

Clicking the small triangle to the left of an account that has children will expand the tree view showing child accounts.

At the top of this window is the Titlebar, which displays the file name for this set of accounts (once you have saved the file.) Below that is the Menubar. You can access the menu options by either clicking on these menu headings or by using shortcuts and access keys (see the section called “Menu Shortcuts”). Next is the Toolbar, which contains buttons for the most common functions.

The account tree appears below the Toolbar. Once you have started creating accounts, the account names will appear in the account tree. You can customize which headings show up by using the small down-arrow at the far right just above the account tree.

At the bottom is the Statusbar, which tells you information about what you own (Net Assets) and how much money you have made (Profits).

Account Register Window

Account Register windows are used to enter and edit your account data. As the name suggests, they look similar to a checkbook register.
Figure 2.4. The Checking Account Register

This image shows the Checking Account - Register with several transactions.

the section called “Transactions” explains more about account register windows and how to enter data into them. For now, note that the parts of an account register window are similar to the parts of the account tree window described earlier. The Titlebar at the top contains the account name. Below that, the Menubar contains menu options related to the account register. Toolbar buttons simplify common data entry functions. The Statusbar at the bottom of the window displays some account balances covered in the section called “Transactions”. At the bottom of the account register window, information appears about the current location of the cursor.

Note

In the register windows, you can resize the various columns that GnuCash displays, but keep in mind that the Description and Balance columns behave differently from other columns.

The Description column is designed to expand automatically to fill all unused horizontal screen space. Therefore you should set the widths of all your other columns before setting the Description column width.

The Balance column must be resized by double-clicking on the column heading.

Toolbar Buttons

Both the account tree window and the account register window contain Toolbar buttons. These buttons provide quick access to common functions such as Save and Open in the account tree window and Record and Delete in the account register window. If you are not sure what a button does, move the mouse pointer over that button, and you should see a description of the function appear.

Here is a summary of the account tree window buttons:

Account tree window buttons

Save

Save the current file to disk

Close

Close the current notebook page
Open, Edit, New and Delete

These are functions related to accounts. They are discussed in the section called “Accounts”.

Register-specific buttons are discussed in the section called “Transactions”.

Tab Bar

GnuCash uses a tabbed model that allows you to open multiple account registers and reports simultaneously. Each open window (which can include account registers, reports, or Scheduled Transactions windows) is given a tab on this bar that you can click to view that window. Tabs can be configured in Preferences to appear along any side of the GnuCash window.

To see the full name for a tab, hover the mouse pointer over an account window tab. If more tabs are open than can be displayed across the window, some tabs will not display.

Tip

1. You can move through all tabs by clicking the arrows on either end of the tab bar.

2. You can also change the alignment of the tab bar by changing the Tab Position in The Preferences window, Windows tab [https://www.gnucash.org/docs/v5/C/gnucash-manual/set-prefs.html#prefs-window].

3. A complete list of tabs can be viewed by right-clicking the Tab Bar and any tab can be selected by clicking it.

Menu Items

The account tree window and the account register window both contain menu headings in a Menu bar. Clicking on a menu heading brings up the menu items for that heading.

You can click on the account tree menu headings and then move the mouse pointer over the menu items to see what they do. As the pointer moves over a menu item, a description of the item appears in the lower left-hand corner of the window (inside the Status bar). To select a menu item, click on it.

You can also access the most common menu items in a window by right-clicking the mouse anywhere in that window. In the account tree window, this will bring up a list of account items. In the account register window, this will bring up a list of transaction items.

Other ways of accessing menu items are through keyboard shortcuts and access keys, described next.

Menu Shortcuts

All of the menu items have access keys which are marked by underlined characters in the menu names. Pressing the Alt key with the underlined character in the menu heading will bring up the menu items for that heading. Once the menu items are displayed, type the underlined character in the menu item to activate it. For example, typing Alt+F in the main window brings up the File menu, then typing S will save the file. Access keys are fixed and cannot be changed by users.

Some of the more commonly used menu items also have shortcut keys that directly activate the command without having to traverse the menu structure. These shortcuts typically use the Ctrl key, although they can use any key combination. Menu shortcuts are displayed at the end of each menu item.
The Basics

Storing your financial data

Overview

GnuCash offers several formats for storing your financial data. The default file storage format is XML, while SQL storage is available in SQLite, MySQL, and PostgreSQL formats. Users can choose a file format for new files from File → Save and for existing files from File → Save As... dialogs.

The XML storage format is a text file that by default is compressed, which is a preference that is set at Edit → Preferences General Compress files. SQLite storage is also available, and stores your data in a single file on your system, like the XML format. However, internally, an SQLite file is managed as a database. The MySQL and PostgreSQL storage options require access to a MySQL or PostgreSQL database server and the installation of additional database drivers on your machine.

Tip

Users can change the format at any time by using File → Save As... . This will create a copy of the data file in the selected format.

Storage Comparison and Recommendations

Each storage format has benefits and shortcomings that users should consider for their needs and abilities. See the Storage Comparison below for further details.

The XML format is the most stable and established, and for this reason, it is recommended for most users. SQL storage was added for the 2.4 release and has become an increasingly popular choice for users. The SQLite format allows users to realize the benefits of SQL storage without the overhead of installing or managing a full DBMS. MySQL and PostgreSQL require the installation of MySQL and PostgreSQL DBMS, respectively, and are best maintained only by experienced database administrators.

Note

Use of a SQL back end for storage implies to many that GnuCash has fully implemented DBMS features, including multi-user and incremental data manipulation. However, GnuCash does not currently implement these features, although it is a long term goal of the development team.

Storage Comparison Table

Table 2.2. Storage Comparison

<table>
<thead>
<tr>
<th></th>
<th>XML</th>
<th>SQLite</th>
<th>MySQL</th>
<th>PostgreSQL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability</td>
<td>Built-in</td>
<td>Depends on packaging a</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File extension</td>
<td>gnu cash</td>
<td>N/A b</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional software</td>
<td>None</td>
<td>MySQL</td>
<td>PostgreSQL</td>
<td></td>
</tr>
<tr>
<td>Additional expertise</td>
<td>None</td>
<td>Database Administrator</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compression</td>
<td>gzip</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Save</td>
<td>On command</td>
<td>On commit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Basics

<table>
<thead>
<tr>
<th>Multi-user</th>
<th>XML</th>
<th>SQLite</th>
<th>MySQL</th>
<th>PostgreSQL</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

The SQL backends rely on additional packages. These are included in the macOS and Microsoft Windows application bundles and installed automatically by GnuCash's flatpak installer. Linux distribution users may need to explicitly install the one they want with their package manager. Look for a package named something like libdbd-sqlite3, libdbd-mysql, or libdbd-pgsql for SQLite3, MySql, and Postgresql respectively.

MySQL and PostgreSQL place data within their own storage system.

Creating a file

To create a new GnuCash file do the following:

1. From the GnuCash Menubar, choose File → New File. The New Account Hierarchy setup assistant will start.

   **Note**

   If you are running GnuCash for the first time, you will be presented with the Welcome to GnuCash! screen. This screen is described in detail in the GnuCash manual.

2. Set your preferences in the assistant and move through the screens with the Forward, Cancel and Previous buttons.

Saving data

Follow these steps to save the file under your preferred name:

1. Choose File → Save As... from the Menubar or select the Save Toolbar button. GnuCash will bring up the save window.

2. Select the Data Format of the file you are saving from the drop down list. The default selection is xml but if you have set up a database back end you can change to that format.

   Depending on the selected Data Format the window can change as described in the following.

3. • If you selected xml or sqlite3 you will see a screen like this:
This image shows the Save screen when the selected Data Format is xml or sqlite3.

Type your chosen filename in the Name field. It is not necessary to specify an extension when you write the file name. GnuCash will automatically add the extension `.gnucash` to the file.

**Note**

The `.gnucash` extension was introduced in the 2.3 series of GnuCash. For already existing files, the extension will never be changed. So if you open an existing file named `Myold-file`, that name won’t be changed if the file is saved. You might use the Save As... command and give the file a new name in order to have it saved with the extension `.gnucash`.

Select the path where the file will be saved by browsing the tree in the lower panes.

**Tip**

Click on the Create Folder button to create a new folder with a custom name in the selected path.

- If you selected mysql or postgres Data Format, you will see a screen like this:
The Basics

**Figure 2.6. Save screen when mysql or postgres is selected.**

This image shows the Save screen when the selected Data Format is mysql or postgres.

Enter in this window the Database Connection information: Host, Database, Username and Password.

**Warning**

Saving to mysql or postgres requires the proper permissions in that database, that is you need to have the permissions to create a new database with the given database name, or you need to have write access to an existing database with the given database name.

4. Click the Save As button to save the file.

If you are keeping track of finances for a single household, you need only one file. But if you are also tracking business finances or want to keep data separate for some reason, then you will need more than one file.

Before ending each GnuCash session, be sure to save your data changes using File → Save or the Save Toolbar button.

**Note**

As it is very important to save your data frequently to avoid losing them for whatever reason, GnuCash is able to automatically save the opened file every a certain amount of time. This interval can be set in the General tab under Edit → Preferences (GnuCash → Preferences on macOS). Keep in mind that this option is relevant only if you are saving in XML format. If you are working with a database, the Save button and the Save menu entry will be grayed out because changes are stored right away.

**Opening data**

To open an existing file or database, select File → Open from the menu. In the window that will open, select the Data Format. If you selected File choose the file you want to open by browsing the folders in the lower panes. Else, enter the required Database Connection information.

**Tip**

GnuCash keeps a list of the recently opened files. Open the File menu and you will see listed the names of recently opened files. Click on the one you want to load to open it.
Duplicating an Account Hierarchy

In some cases, it might be useful to duplicate the structure of an existing data file in a new file. For example, you might want to try out new accounting techniques without corrupting your actual accounting data, or you might need to follow accounting guidelines that require you to close your books at the end of the year and begin each year with a fresh set of books.

GnuCash allows you to create an empty copy of your Chart of Accounts simply by selecting File → Export → Export Accounts. When you select this command, you are asked to provide the name for the new empty file, and GnuCash creates a new data file that contains only your account hierarchy (that is, there is no transaction data). Once saved, the new file can be opened like any other GnuCash data file as described above.

Backing Up and Recovering Data

GnuCash creates several types of files to help ensure that your data is not lost. If you look in the folder where your saved file resides, you may see other files generated by GnuCash with the following extensions: .gnucash, .log, .LCK, .LNK in the same directory as your primary data file. What each of these files does is presented below.

Note

The following sections are relevant only if you are saving your financial data in the XML format

```
$ ls
myfile.gnucash
myfile.gnucash.20100414185747.gnucash
myfile.gnucash.20100414223248.log
myfile.gnucash.20100415114340.gnucash
myfile.gnucash.20100415154508.log
myfile.gnucash.20100415173322.gnucash
myfile.gnucash.20100415194251.log
myfile.gnucash.7f0982.12093.LNK
myfile.gnucash.LCK
```

Backup file (.gnucash)

Each time you save your data file, a backup copy will also be saved with the extension .YYYYMMDHH-MMSS.gnucash. This backup file is a complete copy of your previous data file, and the filename format refers to the data file, year, month, day and time of the backup. For example, the filename myfile.gnucash.20100414185747.gnucash indicates this is a backup copy of the file myfile saved in the year 2010, April 14, at 6:57:47 p.m.

To restore an old backup file, simply open the .YYYYMMDHH-MMSS.gnucash file with the date to which you wish to return. Be sure to save this file under a different name.

Note

.YYYYMMDDHMMSS.xac instead of the actual extension .YYYYMMDHH-MMSS.gnucash. So if you upgrade from the 2.2 series to the 2.4 series, you may end up with both .YYYYMMD-DHH-MMSS.xac and .YYYYMMDHH-MMSS.gnucash backup files in your directory.
Log file (.log)

Each time you open and edit a file in GnuCash, GnuCash creates a log file of changes you have made to your data file. The log file uses a similar naming format as the backup files: .YYYYMMDDHHMMSS.log. Log files are not a full backup of your data file - they simply record changes you have made to the data file in the current GnuCash session.

In case you exit GnuCash inadvertently, possibly due to a power outage or a system wide crash, it is possible to recover most of your work since the last time you saved your GnuCash file using this log file. This is the procedure:

1. Open the last saved GnuCash file.
2. Go to File → Import → Replay GnuCash .log file and select the one .log file with the same date as the saved file you just opened. Make sure that you picked the right .log file, or you will possibly wreak havoc in your accounts.

Log replaying will recover any transaction affecting the balance entered since the last save, including those created from scheduled transactions and business features (invoices, bills, etc.).

Warning

Changes to the scheduled transactions, invoices or bills themselves are NOT recovered, and their transactions that were recovered may not be properly associated with them, and should thus be double-checked. Especially for business transactions, you may have to delete and re-create some of them. If you do not, although the balance will be correct, some reports may not.

Lock files (.LNK and .LCK)

You may occasionally see .LNK and .LCK files appear. These do not store any data, but they are created to prevent more than one user from opening the same file at the same time. These files are automatically created when you open the file, to lock it so no one else can access it. When you close your GnuCash session or open another file, GnuCash unlocks the first data file by deleting the .LCK and .LNK files.

If GnuCash crashes while you have a data file open, the .LCK and .LNK files are not deleted. The next time you try to open GnuCash, you will get a warning message that the file is locked. The warning message appears because the .LNK and .LCK files are still in your directory. It is safe to choose Yes to open the file, but you should delete the .LNK and .LCK files (using a terminal window or your file manager). Once those files are deleted, you will not get the warning message again unless GnuCash crashes.

File Management

So which files should you keep around? Keep your main data file, of course. It’s a good idea to keep some of the more recent .YYYYMMDDHHMMSS.gnucash backup files, but you can safely delete the .log files since they are not complete copies of your data.

Note

If you upgraded from a GnuCash version prior to 2.4, you may also have backup files in the old .xac format. For these files you can apply the same principle described above for .YYYYMMDDHHMMSS.gnucash backup files.

You should also delete any .LCK and .LNK files that you see after closing GnuCash. If you decide to back up your data file to another disk manually, it’s enough to back up the main data file - not the .YYYYMMDDHHMMSS.gnucash backup files.
By default GnuCash will automatically delete any .log and .YYYYMMDDHHMMSS.gnucash backup files that are older than 30 days. You can change this behavior in the GnuCash preferences in the General tab under Edit → Preferences (GnuCash → Preferences on macOS).

Migrating GnuCash data

Sometimes you may need to move your financial data and GnuCash settings to another machine. Typical use cases are when you buy a new computer or if you want to use the same settings over two different operating systems in a dual boot configuration.

Migrating financial data

Migrating GnuCash financial data is as simple as copying .gnucash files with a file manager if you know where they are saved. If you can’t remember where a file is stored but you can open it directly within GnuCash, save it in the desired path from within GnuCash.

All other files in the folder are either backups or log files. It won’t do any harm to copy them too, but it’s not likely to do any good, either.

Migrating preferences data

Preferences are stored in three different locations: one for GnuCash preferences, one for reports, and one for online banking settings. Preferences are managed by gsettings, reports are managed by GnuCash itself, and online banking is managed by aqbanking. If you do not use online banking, then you will not have this folder on your machine.

Where the GnuCash preferences are stored varies depending on your operating system (see Table 2.3, “Application Settings Locations”, Table 2.4, “Saved Reports Locations”, and Table 2.5, “Online Banking Settings Locations”). To back up and transfer your entire installation, you must copy these preferences as well.

Table 2.3. Application Settings Locations

<table>
<thead>
<tr>
<th>Operating system</th>
<th>folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unix</td>
<td>GnuCash preferences are stored in dconf. You can use the commands <code>dconf dump /org/gnucash/</code> on the old machine and <code>dconf load /org/gnucash/</code> on the new machine to migrate your preferences.</td>
</tr>
<tr>
<td>macOS</td>
<td>~/Library/Preferences/gnucash.plist</td>
</tr>
<tr>
<td>Windows</td>
<td>The preferences are stored in the Windows registry HKEY_CURRENT_USER/software/GSettings</td>
</tr>
</tbody>
</table>

Table 2.4. Saved Reports Locations

<table>
<thead>
<tr>
<th>Operating system</th>
<th>folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unix</td>
<td>~/.local/share/gnucash/</td>
</tr>
</tbody>
</table>
### The Basics

**Operating system** | **folder**  
---|---  
macOS | ~/Library/Application Support/gnucash  
Windows | Documents and Settings/User-name/.gnucash or Users/User-name/.gnucash

*Up to GnuCash 2.6.21 it was ~/.gnucash/*

<table>
<thead>
<tr>
<th>Operating system</th>
<th>folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unix</td>
<td>~/.aqbanking</td>
</tr>
<tr>
<td>macOS</td>
<td>~/.aqbanking</td>
</tr>
<tr>
<td>Windows</td>
<td>Documents and Settings/User-name/.aqbanking</td>
</tr>
</tbody>
</table>

### Table 2.5. Online Banking Settings Locations

---

**Note**

On Unix and macOS, these folders will generally not display in the file manager. You must set the file manager to show hidden files and folders to see them.

**Tip**

On Unix and macOS, the ~ symbol means the home folder.

### Putting It All Together

**Note**

This section begins a tutorial that will continue throughout this book. At the end of each chapter, you will see a Putting It All Together section that walks you through examples to illustrate concepts discussed in that section. Each Putting It All Together section builds on the previous one, so be sure to save your file for easy access.

Let’s get started!

1. First, let’s create a file to store your real data. Open GnuCash and select File → New File from the Menubar. This will start the New Account Hierarchy Setup assistant that allows you to create several accounts at once.

**Note**

If you are running GnuCash for the first time, you will be presented with the Cannot find default values screen which is described in details in the GnuCash manual.
The Basics

Figure 2.7. New Account Hierarchy Setup: Introduction

This image shows the first screen of the New Account Hierarchy Setup assistant.

The first screen of the assistant gives you a description of what the assistant does. Click the Forward button to proceed to the next screen.

2. In the second screen, set the New Book Options on the different tabs, then press the Forward button. You can also update these options later using File → Properties. For details of these options, see the GnuCash Manual, chapter Customizing GnuCash, Book Options.
Figure 2.8. New Account Hierarchy Setup: Book Options

This image shows the second screen of the New Account Hierarchy Setup assistant where you select the Book Options.

3. In the third screen, select the currency to use for the new accounts from the dropdown list. Then press the Forward button.

**Note**

The currency you select here, will be assigned to all the accounts created in this assistant.
Figure 2.9. New Account Hierarchy Setup: Currency Selection

This image shows the third screen of the New Account Hierarchy Setup assistant where you select the Currency.

4. In the fourth screen select the Common Accounts group in the Categories pane. Then press the Forward button to proceed.

**Note**

If you want, you can select one or more of the predefined account-groups here. For more information on account types, see the section called “GnuCash Accounts”.
5. In the fifth screen you will be able to set an Opening Balance on each of the accounts, as well as indicate if the account should be a Placeholder. As these features will be described in next chapters, leave all as configured by GnuCash and click Forward to open the last screen of the assistant.
The Basics

Figure 2.11. New Account Hierarchy Setup: Account Setup

This image shows the fifth screen of the New Account Hierarchy Setup assistant where you can set Opening Balance.

6. In the last screen of the assistant, click Apply to create all the accounts and leave the assistant.

Figure 2.12. New Account Hierarchy Setup: Finish

This image shows the last screen of the New Account Hierarchy Setup assistant.
7. After pressing Apply in the previous window, you will be presented with the save dialog. Select the XML Data Format, Name the file as \texttt{gcashdata_1}, select the folder where to save the file (remember it as the data file will be used in the tutorials throughout this manual), and finally press the Save as button.

Your main window should now look something like this:

\textbf{Figure 2.13. Tutorial: Starting Account View of the Test File}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{tutorial.png}
\end{figure}

\section*{Accounts}

This section discusses some useful concepts for organizing your accounts. Since GnuCash does not impose any specific account tree layout, you are free to design your account structure in any manner you wish. However, there are a few basic accounting concepts which you will probably want to follow when designing your accounts to maximize their utility.

\section*{Basic Accounting Concepts}

As we saw in the previous chapter, accounting is based on 5 basic account types: Assets, Liabilities, Equity, Income and Expenses. We will now expand on our understanding of these account types, and show how they are represented in GnuCash. But first, let’s divide them into 2 groups, the balance sheet accounts and the income and expense accounts. As the name says the balance sheet accounts can be summarized in the balance of what you own and owe \textit{at a point in the time}, while the income and expense accounts can be summarized in the Profit & Loss report, which shows the \textit{change of values in a period of time} like the economic year.

Let’s have a quick look at the Accounting Equation ($\text{Assets} - \text{Liabilities} = \text{Equity} + (\text{Income} - \text{Expenses})$) again as a reminder, before we go deeper into each account type.
The Basics

Figure 2.14. The basic accounts relationships

A graphical view of the relationship between the 5 basic accounts. Net worth (equity) increases through income and decreases through expenses. The arrows represent the movement of value.

Balance Sheet Accounts

The three so-called Balance Sheet Accounts are Assets, Liabilities, and Equity. Balance Sheet Accounts are used to track the things you own or owe.

Assets is the group of things that you own. Your assets could include a car, cash, a house, stocks, or anything else that has convertible value. Convertible value means that theoretically you could sell the item for cash.

Liabilities is the group of things on which you owe money. Your liabilities could include a car loan, a student loan, a mortgage, your investment margin account, or anything else which you must pay back at some time.

Equity is the same as "net worth." It represents what is left over after you subtract your liabilities from your assets. It can be thought of as the portion of your assets that you own outright, without any debt.

Income and Expense Accounts

The two Income and Expense Accounts are used to increase or decrease the value of your accounts. Thus, while the balance sheet accounts simply track the value of the things you own or owe, income and expense accounts allow you to change the value of these accounts.

Income is the payment you receive for your time, services you provide, or the use of your money. When you receive a paycheck, for example, that check is a payment for labor you provided to an employer. Other examples of income include commissions, tips, dividend income from stocks, and interest income from bank accounts. Income will always increase the value of your Assets and thus your Equity.

Expense refers to money you spend to purchase goods or services provided by someone else for early consumption. Examples of expenses are a meal at a restaurant, rent, groceries, gas for your car, or tickets to see a play. Expenses will always decrease your Equity. If you pay for the expense immediately, you will decrease your Assets, whereas if you pay for the expense on credit you increase your Liabilities.

GnuCash Accounts

This section will show how the GnuCash definition of an account fits into the view of the 5 basic accounting types.

But first, let’s begin with a definition of an account in GnuCash. A GnuCash account is an entity which contains other sub-accounts, or that contains transactions. Since an account can contain other accounts,
you often see account trees in GnuCash, in which logically associated accounts are grouped together within a common parent account.

A GnuCash account must have a unique name (that you assign) and one of the predefined GnuCash “account types”. There are a total of 12 account types in GnuCash. These 12 account types are based on the 5 basic accounting types; the reason there are more GnuCash account types than basic accounting types is that this allows GnuCash to perform specialized tracking and handling of certain accounts. There are 6 asset accounts (Cash, Bank, Stock, Mutual Fund, Accounts Receivable, and Other Assets), 3 liability accounts (Credit Card, Accounts Payable, and Liability), 1 equity account (Equity), 1 income account (Income), and 1 expense account (Expenses).

These GnuCash account types are presented in more detail below.

**Balance Sheet Accounts**

The first balance sheet account we will examine is Assets, which, as you remember from the previous section, refers to things you own.

To help you organize your asset accounts and to simplify transaction entry, GnuCash supports several types of asset accounts:

1. **Cash** Use this account to track the money you have on hand, in your wallet, in your piggy bank, under your mattress, or wherever you choose to keep it handy. This is the most *liquid*, or easily traded, type of asset.

2. **Bank** This account is used to track your cash balance that you keep in institutions such as banks, credit unions, savings and loan, or brokerage firms - wherever someone else safeguards your money. This is the second most *liquid* type of account, because you can easily convert it to cash on hand.

3. **Stock** Track your individual stocks and bonds using this type of account. The stock account’s register provides extra columns for entering number of shares and price of your investment. With these types of assets, you may not be able to easily convert them to cash unless you can find a buyer, and you are not guaranteed to get the same amount of cash you paid for them.

4. **Mutual Fund** This is similar to the stock account, except that it is used to track funds. Its account register provides the same extra columns for entering share and price information. Funds represent ownership shares of a variety of investments, and like stocks they do not offer any guaranteed cash value.

GnuCash treats account types Stock and Mutual Fund the same.

5. **Accounts Receivable (A/Receivable)** This is typically a business use only account in which you place outstanding debts owed to you. It is considered an asset because you should be able to count on these funds arriving.

Transactions involving an Accounts Receivable account should not be added, changed or deleted in any way other than by using

- post/unpost bill/invoice/voucher or

- process payment

6. **Asset** No matter how diverse they are, GnuCash handles many other situations easily. The account type “Asset”, covers all assets not listed above.

GnuCash treats account types Cash, Bank and Asset the same.
Accounts are repositories of information used to track or record the kinds of actions that occur related to the purpose for which the account is established.

For businesses, activities being tracked and reported are frequently subdivided more finely than what has been considered thus far. For a more developed treatment of the possibilities, please read the descriptions presented in Chapter 15, Other Assets of this Guide.

For personal finances a person can follow the business groupings or not, as they seem useful to the activities the person is tracking and to the kind of reporting that person needs to have to manage their financial assets. For additional information, consult Chapter 15, Other Assets of this Guide.

The second balance sheet account is Liabilities, which as you recall, refers to what you owe, money you have borrowed and are obligated to pay back some day. These represent the rights of your lenders to obtain repayment from you. Tracking the liability balances lets you know how much debt you have at a given point in time.

GnuCash offers three liability account types:

1. Credit Card Use this to track your credit card receipts and reconcile your credit card statements. Credit cards represent a short-term loan that you are obligated to repay to the credit card company. This type of account can also be used for other short-term loans such as a line of credit from your bank.

2. Accounts Payable (A/Payable) This is typically a business use only account in which you place bills you have yet to pay.

   Transactions involving an Accounts Payable account should not be added, changed or deleted in any way other than by using
   • post/unpost bill/invoice/voucher or
   • process payment

3. Liability Use this type of account for all other loans, generally larger long-term loans such as a mortgage or vehicle loan. This account can help you keep track of how much you owe and how much you have already repaid.

GnuCash treats account types Credit Card and Liability the same.

Tip

Liabilities in accounting act in an opposite manner from assets: credits (right-column value entries) increase liability account balances and debits (left-column value entries) decrease them. (See note later in this chapter)

The final balance sheet account is Equity, which is synonymous with “net worth”. It represents what is left over after you subtract your liabilities from your assets, so it is the portion of your assets that you own outright, without any debt. In GnuCash, use this type of account as the source of your opening bank balances, because these balances represent your beginning net worth.

There is usually only a single GnuCash equity account, called naturally enough, Equity. For companies, cooperatives etc. you can create a subaccount for each partner.

Tip

In equity accounts, credits increase account balances and debits decrease them. (See note later in this chapter)
The Basics

Note

The accounting equation that links balance-sheet accounts is Assets = Liabilities + Equity or rearranged Assets - Liabilities = Equity. So, in common terms, the things you own minus the things you owe equals your net worth.

Income and Expense Accounts

Income is the payment you receive for your time, services you provide, or the use of your money. In GnuCash, use an Income type account to track these.

Tip

Credits increase income account balances and debits decrease them. As described in the section called “Accounting Concepts”, credits represent money transferred from an account. So in these special income accounts, when you transfer money from (credit) the income account to another account, the balance of the income account increases. For example, when you deposit a paycheck and record the transaction as a transfer from an income account to a bank account, the balances of both accounts increase.

Expenses refer to money you spend to purchase goods or services provided by someone else. In GnuCash, use an Expense type account to track your expenses.

Tip

Debits increase expense account balances and credits decrease them. (See note later in this chapter.)

Note

When you subtract total expenses from total income for a time period, you get net income. This net income is then added to the balance sheet as retained earnings, which is a type of Equity account.

Below are the standard Income and Expense accounts after selecting Common Accounts in the assistant for creating a new Account Hierarchy (Actions → New Account Hierarchy...).

Figure 2.15. Default Income Accounts

This image shows the standard Income accounts.
The Basics

Figure 2.16. Default Expense Accounts

This image shows some standard Expense accounts.

Other Account Types

There are some special other account types.

Trading Multiple currency transactions have splits in “Trading” accounts to make the transaction balance in each currency as well as in total value. See Chapter 12, Multiple Currencies for more information.

Money Market and Credit Line are used only in the OFX importer, apparently for completeness with the specification.

Putting It All Together

Let’s go through the process of building a common personal finance chart of accounts using the information we have learned from this chapter. A chart of accounts is simply a new GnuCash file in which you group your accounts to track your finances. In building this chart of accounts, the first task is to divide the items you want to track into the basic account types of accounting. This is fairly simple, let’s go through an example.

Simple Example

Let us assume you have a checking and a savings account at a bank, and are employed and thus receive a paycheck. You have a credit card (Visa), and you pay monthly utilities in the form of rent, phone, and electricity. Naturally, you also need to buy groceries. For now, we will not worry about how much money you have in the bank, how much you owe on the credit card, etc. We want to simply build the framework for this chart of accounts.

Your assets would be the bank savings and checking account. Your liabilities are the credit card. Your Equity would be the starting values of your bank accounts and credit card (we do not have those amounts
yet, but we know they exist). You have income in the form of a salary, and expenses in the form of
groceries, rent, electricity, phone, and taxes (Federal, Social Security, Medicare) on your salary.

The Basic Top Level Accounts

Now, you must decide how you want to group these accounts. Most likely, you want your Assets grouped
together, your Liabilities grouped together, your Equity grouped together, your Income grouped together,
and your Expenses grouped together. This is the most common way of building a GnuCash chart of ac-
counts, and it is highly recommended that you always begin this way.

Start with a clean GnuCash file by selecting File → New File from the menu. The New Account Hierarchy
Setup assistant will start. Press Cancel to close the assistant as we don’t want to use one of the predefined
accounts structure; instead we will build a basic starting account structure from scratch. In the empty
GnuCash window select View → New Accounts Page from the menu: the Accounts tab will open. Finally
select Actions → New Account... .

Now you are ready to build this basic starting account structure

1. Account name Assets (account type Asset, parent account New top level account)
Figure 2.17. Creating an Assets account

This image shows the dialog to create an asset account.

2. Account name Liabilities (account type Liability, parent account New top level account)

3. Account name Equity (account type Equity, parent account New top level account)

4. Account name Income (account type Income, parent account New top level account)
5. Account name Expenses (account type Expenses, parent account New top level account)

When you have created the top-level accounts, the main Account page in GnuCash should look like below.

**Figure 2.18. The Basic Top-level Accounts**

This image shows the basic top-level accounts.

### Making Sub-Accounts

You can now add to this basic top-level tree structure by inserting some real transaction-holding sub-accounts. Notice that the tax accounts are placed within a sub-account named *Taxes*. You can make sub-accounts within sub-accounts. This is typically done with a group of related accounts (such as tax accounts in this example).

**Tip**

Instead of selecting Actions → New Account... from the menu, you can alternatively create a new sub-account of an account by right clicking on the main account’s name and selecting the New Account... entry. This will open a dialog similar to the one depicted in the section called “The Basic Top Level Accounts” where the new sub-account will be already set as a child of the main account.

1. Account name Cash (account type Cash, parent account *Assets*)
2. Account name Checking (account type Bank, parent account *Assets*)
3. Account name Savings (account type Bank, parent account *Assets*)
4. Account name Visa (account type Credit Card, parent account *Liabilities*)
5. Account name Salary (account type Income, parent account *Income*)
6. Account name Phone (account type Expense, parent account *Expenses*)
7. Account name Electricity (account type Expense, parent account *Expenses*)
8. Account name Rent (account type Expense, parent account *Expenses*)
9. Account name Groceries (account type Expense, parent account *Expenses*)
10. Account name Taxes (account type Expense, parent account *Expenses*)
11. Account name Federal (account type Expense, parent account *Expenses:Taxes*)

12. Account name Social Security (account type Expense, parent account *Expenses:Taxes*)

13. Account name Medicare (account type Expense, parent account *Expenses:Taxes*)

14. Account name Opening Balance (account type Equity, parent account *Equity*)

After you have created these additional sub-accounts, the end result should look like below

**Figure 2.19. The Basic Chart of Accounts**

This image shows a simple chart of accounts.

Save this chart of accounts with the name `gcashdata_3`, as well as `gcashdata_3emptyAccts`, as we will continue to use them in the later chapters.

You have now created a chart of accounts to track a simple household budget. With this basic framework in place, we can now begin to populate the accounts with transactions. The next chapter will cover this subject in greater detail.

**Transactions**

This chapter will give you the basic information you need to understand and use transactions in GnuCash. Whereas accounts are the framework and structure of a chart of accounts, transactions are the data which fills each account.
Basic Concepts

A transaction in a double entry accounting system such as GnuCash is an exchange between at least 2 accounts. Thus, a single transaction must always consist of at least two parts, a from and a to account. The from account is transferring value to the to account. Accountants call these parts of a transaction Ledger Entries. In GnuCash, they are called Splits.

A split identifies the account to which it refers, the amount of money specifically moved to or from that account, and can contain a few other specific pieces of information if needed. GnuCash supports multiple splits in a single transaction, and the splits can move money into or out of the involved accounts arbitrarily.

For example, you receive a paycheck and deposit it into your savings account at the bank. The transaction that occurs is that your bank savings account (an asset) received money from your income account. Two accounts are affected, and in this case there is a net increase in your equity.

Working with transactions in GnuCash is performed using what is known as the account register. Every account you create has an account register. It will appear familiar to you as it looks very similar to the log used to track checkbooks.

The account register is explained in the upcoming section, the section called “The Account Register”.

The Account Register

The account register is the window that allows you to view or edit preexisting transactions, or add new transactions for a particular account. To open an account register from the Account Tree, double-click the account name, right click the account name and select Open Account from the menu, or use the Open button on the toolbar. GnuCash will display the account register window.

Features of the Account Register

The Titlebar of the account register displays the account name. Below the Titlebar, the Menubar displays the menu items available within the account register, and the Toolbar contains handy buttons that help you work with the account register.

At the bottom left of the register window, GnuCash displays helpful messages as you move about the register. To the right, you can see the current account balance and the total of cleared splits.

Choosing a Register Style

GnuCash offers several options for viewing your registers. The default style is Basic Ledger mode, which displays only the summary of splits affecting the current account. This is the style that most closely resembles other popular personal financial packages. You can choose a different register style from the View menu. There are two other view modes:

- View → Auto-Split Ledger style expands the current transaction automatically. As you highlight a new transaction in the register, the transaction automatically expands to show all splits.

- View → Transaction Journal style shows all splits for all transactions in the register, which is more like an accounting journal.

All styles permit you to view your data in either single-line or double-line format. Select View → Double Line, and you will see your transaction line expand to two register lines. Double-line mode will also display the transaction-level Notes field.

Below are screenshots that demonstrate how the Basic Ledger and Transaction Journal views differ.
The Basics

For this example, let’s assume that you have purchased 3 pair of Jeans for $1,000, and have recorded the purchase as a split transaction with each pair entered on a separate split.

The below screenshots illustrate the different view modes.

First let’s view the Jeans transaction from your checking account:

**Figure 2.20. Purchase Of 3 Jeans In Assets:Checking**

This image shows one split transaction with 3 Jeans purchases.

Now, let’s open the *Expenses:Clothes* account, and look at it in Basic view.

**Figure 2.21. Purchase Of 3 Jeans In Expenses:Clothes Account In Basic Ledger Mode**

This image shows them in the *Expenses:Clothes* account in Basic Ledger mode.

Three entries appear here, but there was only the single split entry in the checking account. Further examination shows that each row has a different amount, $200, $300, and $500. This demonstrates that each row in this view reflects a single split from the original transaction.

Changing to Transaction Journal mode will display only the original split transaction.

**Figure 2.22. Purchase Of 3 Jeans In Expenses:Clothes Account In Transaction Journal Mode**

This image shows the Expenses:Clothes account in *Transaction Journal* mode.
The Basics

Setting Column Widths

As with most spreadsheet-like displays the columns in the register can be resized by left-clicking and dragging the dividers in the header. The divider to the right of the column header controls the width of that column. In GnuCash the Description and Memo columns autosize to fit the register into the window so dragging those columns' dividers to the left will shrink the column but it will snap back when you release it. Dragging them to the right will widen the display and put a scrollbar at the bottom of the window, but that will persist only while the register is open. If you close it and reopen it or quit GnuCash the register will again fill the space exactly.

**Note**

Many new users have trouble resizing the Balance column, in particular making it larger. Just drag its right-hand border out of the window to grow it. Be careful, though, as there's another column called rate whose width is set to 1 pixel to hide it (it's for internal use). Approach the divider from the left side and click as soon as the cursor changes to a double-headed arrow (<-|->).

**Important**

When in split mode there are different column markers in the header for split rows and transaction rows depending on which type of row is active. In order to adjust split column widths one must first make a split row active; to adjust transaction line column widths a transaction row must be active.

Column width settings except for the Description column are saved in the user's book state file and will be restored when the register is closed and reopened.

Using Entry Shortcuts

GnuCash provides several shortcuts to speed data entry:

- The date field will interpret short date entries (e.g. 2/15 or 15/2 depending on locale) to mean the month and day in either the current year or within a sliding window encompassing a 12-month period selected in Preferences on the Date/Time tab, and the following keys will adjust the currently set date as follows:
  - + or = to increment the date and - or _ to decrement the date
  - ] or } to increment the month and [ or { to decrement the month
  - M or m to enter the first date of the month
  - H or h to enter the last date of the month
  - Y or y to enter the first date of the year
  - R or r to enter the last date of the year
  - T or t to enter today’s date

**Tip**

These date shortcuts not only work in the account register but everywhere you can enter a date.
Tip

Specifically for dates there's another way you can save time: you can enter partial dates. For example if you only enter one number, GnuCash will interpret it as the day in the current month of the current year. If you only enter a day and month, GnuCash will automatically append the year. The default this to take such a date in a sliding window starting 11 months before the current month. This means that if you enter 1/5 (January 5th) as date while the current date is in December 2015, the date will be completed as 1/5/16. This default can be changed via Edit → Preferences → Date/Time+Date Completion. You can change it to either always evaluate a date in the current calendar year or change the start of the sliding window.

- In the Num field of the transaction line, you can type + to increment the transaction number from the last one you typed in. Typing - will decrement the number. This will also work in the Action field of the split line, if you choose to enter split numbers there. The Action field also supports QuickFill - if you type the first characters of a common action (such as Deposit), GnuCash will fill in the rest.

- Perhaps most powerful of all, as you type in the Description field GnuCash will find previous transactions that begin the same as your typing and offer them as completions. When you Tab with the offered completion text shown GnuCash will copy that previous transaction and focus the Debit or Credit value used, selected and ready for you to overwrite it with a new value.

Note

This copies the whole transaction including parts that may not be visible like Notes and Price. Unless you intend to exactly duplicate the transaction be sure to edit all fields that should differ.

Tip

You can use this feature to fill in the transaction then go back to the Description field and change the description.

- The Transfer field supports QuickFill of account names. You can start typing an account name and GnuCash will fill in the remaining part of the name. Typing the separator character at any time will complete the current level of the account name, leaving the cursor positioned to start the next level of account name. For example, typing A : C might complete to the Assets:Checking account. Entering the name in sequence this way will pop up the whole account list with the predicted item selected. Alternatively you can type any character sequence in the account name and the popup will display an account list filtered to those accounts containing the characters typed so far. In either case you may use the Up Arrow or Down Arrow to select an account from the popup.

- In any of the amount fields, you can use a built-in calculator. Simply type in the first value, followed by +, -, *, or /, then type in the second value. GnuCash will perform the calculation and return the resulting value to the amount field when you press the Tab key.

- All of the menu items have access keys defined, and these are marked by underlined characters in the menu names while Alt is hold. Press Alt+underlined character to bring up the menu, then select an item by typing its underlined character. For example, typing Alt+A brings up the Actions menu, then typing P will split the transaction. A few of the menu items also have shortcut keys that immediately invoke the command (typically using the Ctrl key). These shortcuts are listed next to the item.

- To move around the register, use these keys to save time:

  • Tab to move to the next field, Shift+Tab to move to the previous field
The Basics

- **Home** to move to the beginning of the field, **End** to move to the end of the field
- **Enter** or ↓ to move to the next transaction, ↑ to move to the previous transaction
- **Page Up** to move up one screen, **Page Down** to move down one screen
- **Shift+Page Up** to go to the first transaction, **Shift+Page Down** to go to the last transaction

In the Reconcile window you can use these keyboard shortcuts:
- **Tab** moves to the next box and **Shift+Tab** moves to the previous box
- Space bar toggles the status between reconciled and not reconciled
- ↑ and ↓ navigate through the entries within the current box

**Simple vs. Split Transactions**

Every transaction in GnuCash has at least two splits, but a transaction can have more than two splits. A transaction with only two splits is called a **simple transaction**, since it only involves the current account and a single remote account. A transaction with three or more accounts is called a **split transaction**.

When the register is in Basic view, you will see a summary of the splits affecting the current account. For a simple transaction, the Transfer column will display the other account from which money is **transferred**. For a split transaction, the Transfer column will display -- Split Transaction --. You can see the individual splits of each transaction by clicking the Split button in the **Toolbar** while selecting the appropriate transaction.

For split transactions, the first line of the transaction is the **transaction line**. It contains a Date, optional Num (such as a check number), transaction Description, total amount affecting the current account (Tot Deposit here), and updated account Balance after the current transaction. Note that in the expanded view, the Transfer column heading disappears, and there is no account name listed in that field. This line shows you only a summary of the transaction’s effect on the current account. For more detailed information, you need to look at the individual splits that make up the transaction.

**Note**

An account register displays a transaction when that transaction has a split assigned to the account. If a given transaction has more than one split assigned to the account, then in Basic and Auto-Split views, that transaction will appear in the register one time for each split assigned to that account. In Transaction Journal view, such a transaction will only appear once in the register.

The partial lines below the transaction line are the **split lines**, and they are separated by gray lines. As you highlight one of the split lines, the column headings change to show the split-related fields:
Figure 2.23. Salary In The Assets:Checking Account

This image shows how split headings change.

Each split contains an optional Action, or type of split, which you can either type in or choose from a pull-down list. The split also contains an optional Memo which describes the split. Each split affects an Account, which can be selected from a pull-down list of your accounts. The R field indicates whether the split has been reconciled. The last two columns show the amount of the split and whether money is coming into or going out of the account.

As we discussed in the section called “Accounting Concepts”, total debits (left-column entries) must equal total credits (right-column entries) for each transaction. In the example shown above, the total debits equal the total credits, so this transaction is balanced. If you notice, the transaction line contains the same debit amount as the Checking split line. Why is this shown twice? Because the transaction line is merely a summary of the transaction’s effect on the current account. The same transaction in a different account will have a different transaction line, one that shows the effect on that particular account. You can see this by highlighting another split line and clicking the Jump button on the Toolbar.

In this example, if you jump to the Income:Salary account, GnuCash brings up the same transaction in the Income:Salary - Register:

Figure 2.24. Salary In The Income:Salary Account

This image shows a jump to the Income:Salary account.

Note that the transaction line total now summarizes the effect on the Income:Salary account instead of the Checking Account, because you are looking at the Income:Salary account register. The splits are exactly the same, but the transaction line now reflects the credit to the Income:Salary account.

Simple Transaction Example

Starting with the chart of accounts we created in the previous chapter gcashdata_3, double click on the Checking asset account. Let’s add a simple transaction to the checking account. When you first create your accounts in GnuCash, it is common to start them off with an initial balance.
In the first transaction row, enter a date (e.g.: March, 1, 2006), a description (e.g.: “Opening Balance”), click on the Transfer pop-up menu and select Equity:Opening Balances, add a deposit value of $1,000, and press the Enter key. The account register should now appear similar to this figure:

**Figure 2.25. The Checking Account After Inserting The Opening Balance Transaction**

![Image of the Checking Account After Inserting The Opening Balance Transaction](image)

This image shows the Assets:Checking register after inserting the opening balance transaction.

Setting the opening balances of an account is an example of a simple two account transaction. In this case, affecting the Assets:Checking and the Equity:Opening Balances accounts.

As another example of a simple 2 account transaction, add another transaction to describe the purchase of $45.21 worth of groceries. From within the Assets:Checking account, you would set Transfer to Expenses:Groceries. The account register should now appear:

**Figure 2.26. The Checking Account Adding A Transaction For Groceries**

![Image of the Checking Account Adding A Transaction For Groceries](image)

This image shows Assets:Checking - Register after adding a transaction for groceries.

**Split Transaction Example**

The need for 3 or more splits in a transaction occurs when you need to split either the “from” or the “to” account in a transaction into multiple accounts. The classic example of this is when you receive a paycheck. Your take home pay from a paycheck will typically be less than your net pay, with the difference being due to taxes, retirement account payments, and/or other items. Thus, the single transaction of you receiving a paycheck involves other accounts besides simply Assets:Checking and Income:Salary.

To add the paycheck split transaction from the Assets:Checking account register window, click on a new transaction line and click Split. Note that if you have set your register view to Auto-Split or Transaction Journal, the splits will be opened for you. Enter the description of this transaction on the first line (e.g. “Employers R Us”). In the split lines below this, enter the various splits that make up this transaction, one by one. To enter the splits, first choose the account, then enter the amount by which to change the account. Keep in mind that when in an asset account register, amounts entered in the left column increase the account balance, while amounts entered in the right column decrease the balance (for more about this, see the section called “Transactions”). Tab or click the next split line and repeat the process. Note that if you are using the keyboard to navigate the transaction, use Tab to move from field to field, as using Enter will commit the transaction and create splits to an Imbalance account.

---

50
The Basics

**Note**

When creating a transaction in GnuCash, splits can be entered in any order. However, when the transaction is closed (either when leaving the transaction, or when pressing the **Enter** key), all debit splits will jump ahead of all credit splits.

In this example, choose the deposit account (**Assets:Checking**) and then enter the amount that is being deposited into it (e.g. $670). Follow this by entering the amounts for the various taxes: **Expenses:Taxes:Federal** account, $180; **Expenses:Taxes:Medicare** account, $90; and **Expenses:Taxes:Social Security** account, $60. Finally, enter the gross total of your paycheck ($1,000 in this example) as a withdrawal transfer from **Income:Salary**.

The final split should look like **Figure 2.27, “Entering a split transaction”**. Remember to press **Enter** after finishing the entry. But you should also know that when you press **Enter**, the split view will be “folded” back into a simplified transaction view. The splits are still there; you just have to click **Split** to view them. See the section called “Features of the Account Register” for details.

**Figure 2.27. Entering a split transaction**

---

**Reconciliation**

Once transactions have been entered into GnuCash, it is important to verify that they agree with the records of your financial institution. This verification process is known as **reconciliation**, and it is key to determine whether your records are accurate. Most commonly, you will check transactions against bank statements, although you can use this process to verify any transaction.

GnuCash keeps track of the reconciliation status of each transaction. The reconciliation status of a transaction is shown by the reconciliation R field in a register: *y* indicates that a transaction has been reconciled, *n* indicates that it has not, and *c* indicates that it has been cleared, but not reconciled. A split marked cleared signifies that you got some kind of confirmation that the institution accepted the order (e.g. you have the restaurant's receipt for your credit card purchase). You can toggle the reconciliation status between *n* and *c* by clicking in the R field; you can set it to *y* by using the section called “Reconcile windows”.

At the bottom of the account window, there are (among others) two running balances (the cleared and reconciled balance), and the total balance. The former balances should correspond to how much money the bank thinks you have in your account, while the latter includes outstanding transactions.

For example, when you write a check for something, you should enter the transaction into GnuCash. The reconciliation R field of the transaction will initially contain *n* (new). Your new entry will contribute to the total balance, but not to the cleared and reconciled balance. Later, if you got some confirmation that the check has been cashed, you might click on the transaction’s R field to change it to *c* (cleared). When you do this, the cleared balance will change to include this amount. When the bank statement arrives, you can then compare it to what you’ve recorded in GnuCash by opening the reconciliation window. There, you will be able to change the R field to *y* (reconciled).
Note

You cannot reconcile directly in a register window by clicking in the $R$ field. You must use the reconciliation window. Once a transaction has been marked *reconciled*, it can no longer be easily changed without breaking the Starting Balance of the next reconciliation.

Warning

It is important to understand that reconciliation is done for a given date, and when you reconcile an account based on a statement from a given date, you are reconciling **all transactions prior to that date**. Therefore, if you add or modify transactions that predate your last reconciliation, your reconciled balances will be thrown off.

Reconcile windows

The reconciliation windows are used to reconcile a GnuCash account with a statement that a bank or other institution has sent you. Reconciliation is useful not only to double-check your records against those of your bank, but also to get a better idea of outstanding transactions, e.g. uncashed checks.

To use the reconciliation windows, select an account from the account tree and click on Actions → Reconcile. A window like the one below will appear in which you can enter the reconcile information.

Figure 2.28. The Initial Reconcile Window

In the initial reconcile window, some Reconcile Information need to be entered.

**Statement Date**

The date of the statement you will be reconciling against.

**Tip**

Click on the down arrow in the right of this field to open a calendar.
The Basics

Starting Balance

This is a non-editable item which displays the balance from the previous reconciliation. It should match the starting balance in your statement.

**Warning**

Sometimes, the starting balance in GnuCash does not match that found on your statement. This can happen the first time you reconcile your account or when a previously-reconciled transaction is de-reconciled or deleted.

**Note**

The first time you reconcile your account, the starting balance will be 0.00, thus probably not the *opening balance* of your account. When you reconcile the account, the *opening balance* for the account will be included in the reconciliation, and the result should balance.

**Tip**

In the case when a previously-reconciled transaction is accidentally de-reconciled, you can simply re-reconcile the transaction along with the transactions on the current statement, and the result should balance.

The case of accidentally deleting a previously-reconciled transaction presents more of a challenge; if you cannot determine what was deleted and restore it to the register, you will have to create a dummy transaction to get the reconciliation to finish.

**Caution**

While the latter case does not matter for your private accounting, you should have a really good explanation for your auditors, if you are the accountant of a club or a company.

Ending Balance

This field should be filled with the ending balance as it appears in the statement.

**Note**

GnuCash automatically fills this field with the Present balance as shown in the lower part of the account’s register.

Include Sub-accounts

Check this option if you want to include in the reconciliation the transactions that belongs to the sub-accounts of the currently selected account. Note that all sub-accounts must be in the same commodity as the parent for the option to be enabled.

Enter Interest Payment

Clicking this button opens a new window that allow you to enter an interest transaction to the account to be reconciled.

**Tip**

The Interest Payment window might be opened automatically when you start a reconciliation for an account of the type *Bank, Credit, Mutual, Asset, Receivable, Payable, and Liability*. If you want to disable this behavior for any of the previous accounts, go to the Register tab of...
the GnuCash Preferences and uncheck the Automatic interest transfer option. Alternatively, to disable this behavior only for the selected account, press the No Auto Interest Payments for this Account button in the Interest Payment window.

Then, click on the Ok button, and you will see the transactions listing reconcile window:

**Figure 2.29. Reconcile Window**

![Reconcile Window](image)

The transactions listing in the reconcile window.

The two panes called Funds In and Funds Out, lists all the unreconciled transactions that belongs to the account that is going to be reconciled. The R columns show whether the transactions have been reconciled.

Now, examine each item on the bank statement, and look for the matching item in the Reconcile window.

If you cannot find a transaction, then perhaps you forgot to enter it, or did not know that the transaction had happened. You can use the New button on the Toolbar, or the Transaction → New menu item in the menu, to open a register window and enter the missing transaction. The new item will appear in the Reconcile window when you press the Enter button in the register after entering the transaction.

When you find the item in the Reconcile window, compare the amount in the item to the amount on the statement. If they disagree, you may have made an error when you entered the transaction in GnuCash. You can use the Edit button on the Toolbar, or the Transaction → Edit item, to open a register window and correct the transaction.

If the amounts agree, click on the item in the Reconcile window. A check mark will appear in the R column aside the selected transaction. GnuCash will automatically update the amounts in the lower right summary pane.

**Tip**

You can use the up/down arrow keys to scroll to the item, the space key to mark the item as reconciled and the Tab key to switch panes.

You then repeat this for each item that appears on the bank statement, verifying that the amounts match with the amounts in GnuCash, and marking off transactions in GnuCash as they are reconciled.
Tip

You can check or uncheck the reconcile status of all transactions in either pane by clicking on a transaction in the required pane then clicking **Ctrl-A** followed by **space**. This will toggle the reconcile status of all transactions in the pane to either checked or unchecked state. This procedure can be repeated to achieve the desired status for the transactions in the pane.

At the bottom of the Reconcile window there is a Difference field, which should show 0.00 when you are done reconciling. If it shows some other value, then either you have missed transactions, or some amounts may be incorrect in GnuCash. (Or, less likely, the bank may have made an error.)

Note

Under some circumstances, it may be difficult or impossible to determine why an account will not reconcile. If you are unable to correct the discrepancy between your books and a statement, GnuCash includes a Balance button on the **Toolbar** that will automatically create a balancing entry for you in the amount that cannot be reconciled.

To use this, carry out the full reconciliation (marking all transactions that you can identify) and then click this button. GnuCash will create a balancing entry for the remaining discrepancy that uses the **Special Accounts:Orphan-XXX** account (where "XXX" represents your currency). The Reconcile window will close; re-opening it will allow you to check the newly-created balancing entry and finish the process.

When you have marked off all the items on the bank statement and the difference is 0.00, press the Finish button on the **Toolbar** or select Reconcile → Finish from the menu. The Reconcile window will close. In the register window, the R field of the reconciled transactions will change to **y**.

In this case, we have not received all the information yet, so we simply press the Postpone button, so we can continue at a later stage. Observe that the R column indicates we cleared (**c**) two transactions. They have not been reconciled yet, but we have verified these two transactions so they have been marked as cleared. If you look at the **Statusbar** at the bottom of the account register, you will see a summary of what has been reconciled and what has been cleared (Cleared:USD 954.79 Reconciled:USD 0.00)

Figure 2.30. The Checking account after postponing the reconciliation

Scheduled Transactions

Scheduled transactions are made to help entering repetitive money operations, like subscriptions, insurances or taxes. By using scheduled transactions, you only have to enter the concerned transaction once, set a few parameters like start date, frequency and a little description, and then GnuCash will tell you whenever a scheduled transaction is ready to be created, and create it for you.

In this how-to, we’ll take a monthly Internet subscription of 20 USD as example, which is taken on the 28th of each month.
In GnuCash, there are two ways of creating scheduled transactions, from the ledger or from the Scheduled Transactions Editor.

Creating from the Ledger

Enter the first occurrence of your to-schedule transaction in the ledger. In the Transfer field for this transaction, type *Expenses:Internet* as shown in the next screenshot.

**Figure 2.31. Step 1 Of Creating Scheduled Transaction From The Ledger**

![Figure 2.31. Step 1 Of Creating Scheduled Transaction From The Ledger](image)

**Note**

Since we did not create the *Expenses:Internet* account, GnuCash will prompt us to create it.

Then you right click on your transaction and select Schedule...

**Figure 2.32. Step 2 Of Creating Scheduled Transaction From The Ledger**

![Figure 2.32. Step 2 Of Creating Scheduled Transaction From The Ledger](image)
A window like this will appear:

**Figure 2.33. Step 3 Of Creating Scheduled Transaction From The Ledger**

Let’s fill the values, we know that the subscription is taken on the 28th each month, and the next one is for next month (since we entered the one for this month manually):

**Figure 2.34. Filling In Data To A Scheduled Transaction**

Click the OK button, and the transaction will be scheduled. GnuCash now has memorized this scheduled transaction and on the 28th of next month, it will pop up a window asking if it should create it (see far below for a screenshot of this window).

**Creating from the Editor**

Another way of entering a scheduled transaction is from the Scheduled Transaction Editor, it may be faster if we have several scheduled transactions to create at once.

From the main accounts windows, select Actions → Scheduled Transactions → Scheduled Transaction Editor from the Menubar. A new Scheduled Transactions tab will be opened in the current GnuCash window as shown below:
Empty Scheduled Transactions tab

This tab contains a list, now empty, of all the scheduled transactions. Let’s create a new one by clicking on the New button in the Toolbar. A window like the one below will pop up:
First, let’s enter a name for this new scheduled transaction in the top of the window.

**Note**

This name will only identify the transaction in the Edit Scheduled Transaction window, it will never appear in the ledger.

In the Options pane of the Overview tab you have four options:

**Enable**

Sets the status of the scheduled transaction.

**Create automatically**

If enabled, will insert this transaction in the ledger without asking you before (see below). If needed, you can be advised when the transaction is entered by checking the Notify me when created option.

**Create in advance**

Sets how many days in advance the transaction will be created.

**Remind in advance**

Sets how many days in advance a reminder is presented. This can be used, for example, when you have to pay something by check, and a reminder one week before allows you to send your check before the deadline.
The Occurrences pane allows you to tell GnuCash that this scheduled transaction won’t last for ever. For example if you are repaying a loan, you can enter the loan end date or the number of occurrences left.

Select now the Frequency tab in the Edit Scheduled Transaction window. Here you can set the time-related options of the transaction.

**Figure 2.37. Frequency Tab Of The Edit Scheduled Transaction Window**

![Edit Scheduled Transaction window, Frequency tab](image)

**Frequency**

Sets the basic frequency of the transaction, with options for once, daily, weekly, semi-monthly and monthly. In this example, this is set to monthly.

**Note**

It is possible to set a transaction to occur at intervals other than those listed in the Frequency list, by changing the setting in the Every control (see below).

**Start Date**

Sets when the transaction will begin. In the example, this would be set to the start of the next month.

**Every**

This option allows you to schedule transactions by multiplies of the value in Frequency. For example, to create a transaction that runs every 3 weeks, set Frequency to Weeks and Every to 3.

**On the and Except on weekends**

Sets the day of the month that the transaction is scheduled, and controls what GnuCash will do when the day occurs on a weekend day.
Note

We know that the subscription is taken on the 28th each month, so the Start date will be November 1, 2003 (assuming November is the next month), the Frequency will be Monthly, it will be taken every month on the 28th. Since in our example the internet subscription is automatically taken from the account, we have no need to create it in advance, nor give an end date.

When the elements on this tab are filled in, GnuCash will highlights the calendar below to indicate when future transactions will be run.

Finally select the Template Transaction tab and enter your transaction in the lower part as you would do in the ledger, with the only difference of having no date.

Now, you should have a window like this:

**Figure 2.38. Template Tab Of The Edit Scheduled Transaction Window**

![Edit Scheduled Transaction window, Template Transaction tab](image)

Remember to click on the Enter icon, to validate and enter the transaction.

Now click OK, it takes you to the Scheduled Transactions tab, now showing one item in the Transactions list:
Figure 2.39. The Finally Entered Scheduled Transaction

Tip

If you click in the calendar part on the first day of one month, a small window, following your mouse, will show you what is planned for this day. To make the small window disappear again, just click in it one more time.

You can now close the Scheduled Transaction tab, and save your work.

Note

What comes below is just an illustration, and is not meant to be entered into the GnuCash database at this stage. As per this example, the below dialogs will appear when the scheduled transaction is supposed to run.

From now on, when GnuCash is launched and a scheduled transaction is scheduled or need to be entered, you may see a Since Last Run... window summarizing the scheduled transactions operations (Reminder, To-Create etc... a better description of each option can be found in the GnuCash manual):
You can click on the Status column to change the scheduled transaction status if needed. Then just click on Ok to close the Since Last Run... window and to apply the pending operations. Select Cancel to skip entering in the ledger the pending operations.

If the Status field was set to To-Create, then if you take a look in your bank account register, you’ll see the transaction has been created:

**Tip**

If you enable the Review created transactions option in the lower right of the Since Last Run... window, GnuCash will open, after pressing Ok, the register tab of each account where the scheduled transactions were entered automatically.

**Note**

If you entered the transaction for 28 of April at this stage, then please revert back to the last saved GnuCash file by selecting File → Open and choosing the previously saved gcashdata_3 GnuCash file.

**Putting It All Together**

In the previous sections of this chapter the concepts and mechanics of working with transactions in GnuCash have been discussed. This section will expand upon the chart of accounts initially built in the previous chapter, by setting some opening balances, adding transactions and a scheduled transaction.

**Open GnuCash file**

Start with opening the previous datafile we stored, gcashdata_3emptyAccts, and store it as gcashdata_4 directly. The main window should look something like this:
The Basics

Figure 2.41. Starting Point For Putting It All Together

This image shows the starting point for this section.

Opening Balances

As shown earlier in the section called “Simple Transaction Example” with the Assets:Checking account, the starting balances in an account are typically assigned to a special account called Equity:Opening Balance. To start filling in this chart of accounts, begin by setting the opening balances for the accounts. Assume that there is $1,000 in the savings account and $500 charged on the credit card.

1. Open the Assets:Savings account register. Select View from the menu and check to make sure you are in Basic Ledger style. You will view your transactions in the other modes later, but for now let’s enter a basic transaction using the basic default style.

2. From the Assets:Savings account register window, enter a basic 2 account transaction to set your opening balance to $1,000, transferred from Equity:Opening Balance. Remember, basic transactions transfer money from a source account to a destination account. Record the transaction (press the Enter key, or click on the Enter icon).

3. From the Assets:Checking account register window, enter a basic 2 account transaction to set your opening balance to $1,000, transferred from Equity:Opening Balance.

4. From the Liabilities:Visa account register window, enter a basic 2 account transaction to set your opening balance to $500, transferred from Equity:Opening Balance. This is done by entering the $500 as a charge in the Visa account (or decrease in the Opening Balance account), since it is money you borrowed. Record the transaction (press the Enter key, or click on the Enter icon).

You should now have 3 accounts with opening balances set. Assets:Checking, Assets:Savings, and Liabilities:Visa.
Additional Transaction Examples

Now add some more transactions to simulate a month’s expenses. During the month, $78 is spent on electricity, $45 on phone, and $350 on rent. All paid by check. We also spent $45.21 on groceries, received $670 as salary, and paid our Internet bill this month. Finally, let’s move $100 from the savings account to the checking account.

1. Open the Expenses:Electricity account register and enter a simple 2 account transaction to pay the $78 electrical bill at the end of the current month (e.g.: March 28, 2006). Enter a description (e.g.: Light Company) and the check number (e.g.: 102). The Transfer account should be Assets:Checking.

2. Open the Assets:Checking account register and enter a simple 2 account transaction to pay the $45 phone bill at the end of the current month (e.g.: March 28, 2006). Enter a description (e.g.: Phone Company Name) and the check number (e.g.: 103). The Transfer account should be Expenses:Phone. Notice that you can enter expense transactions from either the credit side (the expense accounts) or the debit side (the asset account).

3. Open the Expenses:Rent account register and enter a simple 2 account transaction to pay the $350 in rent at the end of the current month (e.g.: March 28, 2006). Enter a description (e.g.: April Rent) and the check number (e.g.: 104). The Transfer account should be Assets:Checking.
4. Duplicate this transaction using the Duplicate button in the Toolbar. Start by clicking on the current rent transaction, and click on the Duplicate icon. Enter the transaction date a month out in the future (e.g.: April 28, 2006), and notice the blue line separator that GnuCash uses to separate future transactions from current ones. In this way, you can enter transactions before they occur.

You could also set up a scheduled transaction to pay your rent, since the value of the rent is likely to be constant for the foreseeable future.

• Start by clicking on the current (April 28) rent transaction, and click on the Schedule icon

• Change to Monthly, change description if needed and press OK

5. To transfer money from your savings account to your checking account, open the Assets:Savings account register, add a new transaction setting the Transfer to Assets:Checking in the amount of $100 (date 6 March, 2006).

6. As another example of a simple 2 account transaction, add another transaction to describe the purchase of $45.21 worth of groceries on 5 of March. From within the Assets:Checking account, you would set Transfer to Expenses:Groceries. The account register should now appear:

7. To add a paycheck transaction from the Assets:Checking account register window, click on a new transaction line, and click on Split. First enter the description of this transaction on the first line (e.g.: “Employers R Us”), as well as the date (14 March). In the “split” line below this, enter the deposit into Assets:Checking (e.g.:$670). Follow this with the various tax deposits (Expenses:Taxes:Federal account (e.g.: $180), Expenses:Taxes:Medicare account (e.g.: $90), and Expenses:Taxes:Social Security account (e.g.: $60)) and lastly the gross total of your paycheck (e.g.: $1,000) as a withdrawal transfer from Income:Salary.

8. You also need to pay for your Internet subscription of 20 USD on the 28th.
Figure 2.43. Chart Of Accounts After Setting All The Various Transactions

This image shows the ending balances after the section called “Transactions”.

Save file

Before we go to the report section, let’s save the GnuCash data file (gcashdata_4).

Reports

But only having data available on the computer screen will not make your accountant happy, therefore GnuCash comes with a large number of highly customizable reports.
Let’s have a look at a Cash Flow, and a Transaction Report.

1. First let’s have a look at the Cash Flow report for the month of March.

Select the cash flow report from Reports → Income & Expense → Cash Flow.

**Figure 2.44. Cash Flow Report For The Month Of March**

<table>
<thead>
<tr>
<th>Cash Flow - 01/03/06 to 31/03/06 for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Accounts</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>• Assets</td>
</tr>
<tr>
<td>• Assets:Checking</td>
</tr>
<tr>
<td>• Assets:Savings</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Money into selected accounts comes from</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Income:Salary</td>
<td>USD 1,000.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Money In</th>
<th>USD 1,000.00</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Money out of selected accounts goes to</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenses:Electricity</td>
<td>USD 78.00</td>
</tr>
<tr>
<td>Expenses:Groceries</td>
<td>USD 45.21</td>
</tr>
<tr>
<td>Expenses:Internet</td>
<td>USD 20.00</td>
</tr>
<tr>
<td>Expenses:Phone</td>
<td>USD 45.00</td>
</tr>
<tr>
<td>Expenses:Rent</td>
<td>USD 350.00</td>
</tr>
<tr>
<td>Expenses:Taxes:Federal</td>
<td>USD 180.00</td>
</tr>
<tr>
<td>Expenses:Taxes:Medicare</td>
<td>USD 90.00</td>
</tr>
<tr>
<td>Expenses:Taxes:Social Security</td>
<td>USD 60.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Money Out</th>
<th>USD 868.21</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Difference</th>
<th>USD 131.79</th>
</tr>
</thead>
</table>

This image shows the Cash Flow report after the section called “Transactions”.

To get this customized report, right click in the report and choose Report Options. Then set the time period, and specify which accounts you want in the report.

2. Now let’s have a look at corresponding transaction report for the Checking account.

Select the transaction report from Reports → Transaction Report.
**Figure 2.45. Transaction Report For The Checking Account During March**

**Transaction Report**

**From 01/03/06 To 31/03/06**

<table>
<thead>
<tr>
<th>Date</th>
<th>Num</th>
<th>Description</th>
<th>Transfer from/to</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Checking</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>05/03/06</td>
<td></td>
<td>Groceries</td>
<td>Groceries</td>
<td>-USD 45.21</td>
</tr>
<tr>
<td>06/03/06</td>
<td></td>
<td>Transfer</td>
<td>Savings</td>
<td>USD 100.00</td>
</tr>
<tr>
<td>14/03/06</td>
<td></td>
<td>Employers R Us</td>
<td>Split</td>
<td>USD 670.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td></td>
<td>Internet subscription</td>
<td>Internet</td>
<td>-USD 20.00</td>
</tr>
<tr>
<td>28/03/06 102</td>
<td></td>
<td>Light Company</td>
<td>Electricity</td>
<td>-USD 78.00</td>
</tr>
<tr>
<td>28/03/06 103</td>
<td></td>
<td>Phone Company</td>
<td>Phone</td>
<td>-USD 45.00</td>
</tr>
<tr>
<td>28/03/06 104</td>
<td></td>
<td>April Rent</td>
<td>Rent</td>
<td>-USD 350.00</td>
</tr>
<tr>
<td><strong>Total For Checking</strong></td>
<td></td>
<td></td>
<td></td>
<td>USD 231.79</td>
</tr>
<tr>
<td><strong>Grand Total</strong></td>
<td></td>
<td></td>
<td></td>
<td>USD 231.79</td>
</tr>
</tbody>
</table>

This image shows the Transaction Report for the Checking account during March.

3. Now let’s change the transaction report to only show the various Expenses accounts.

**Figure 2.46. Transaction Report For The Expenses Accounts During March**

**Transaction Report**

**From 01/03/06 To 31/03/06**

<table>
<thead>
<tr>
<th>Date</th>
<th>Num</th>
<th>Description</th>
<th>Transfer from/to</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>March 2006</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>05/03/06</td>
<td></td>
<td>Groceries</td>
<td>Checking</td>
<td>USD 45.21</td>
</tr>
<tr>
<td>14/03/06</td>
<td></td>
<td>Employers R Us</td>
<td>Split</td>
<td>USD 180.00</td>
</tr>
<tr>
<td>14/03/06</td>
<td></td>
<td>Employers R Us</td>
<td>Split</td>
<td>USD 90.00</td>
</tr>
<tr>
<td>14/03/06</td>
<td></td>
<td>Employers R Us</td>
<td>Split</td>
<td>USD 60.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td></td>
<td>Internet subscription</td>
<td>Checking</td>
<td>USD 20.00</td>
</tr>
<tr>
<td>28/03/06 102</td>
<td></td>
<td>Light Company</td>
<td>Checking</td>
<td>USD 78.00</td>
</tr>
<tr>
<td>28/03/06 103</td>
<td></td>
<td>Phone Company</td>
<td>Checking</td>
<td>USD 45.00</td>
</tr>
<tr>
<td>28/03/06 104</td>
<td></td>
<td>April Rent</td>
<td>Checking</td>
<td>USD 350.00</td>
</tr>
<tr>
<td><strong>Total For March 2006</strong></td>
<td></td>
<td></td>
<td></td>
<td>USD 868.21</td>
</tr>
<tr>
<td><strong>Grand Total</strong></td>
<td></td>
<td></td>
<td></td>
<td>USD 868.21</td>
</tr>
</tbody>
</table>

This image shows the Transaction Report for the various Expense accounts during March.
Chapter 3. Importing Data into GnuCash

This chapter will detail procedures for importing data into GnuCash.

Importing Transactions from Files

Outdated

This is an older version of “Common Transaction Operations” in the manual [https://www.gnucash.org/docs/v5/C/gnucash-manual/trans-import.html]. Better continue there until this update anomaly is resolved.

Imported transactions will generally be to a specific account in your account tree. In the following this will be referred to as the import or base account. It may or may not be specified in the data being imported, depending on the import format. It is usually the first split of a transaction being imported.

All transactions will also must have a destination account for at least matching splits. This may or may not be supplied in the imported data. If it is not, an account can be assigned on the basis of the previous import history by matching to information in the imported data. The user may always over-ride this assignment.

Multi-split data previously exported from GnuCash may have both the import and destination accounts for transaction splits specified in the data file.

File Import Formats

Gnucash allows transactions to be imported in the following formats:

- **QIF (.qif)** Quicken Interchange format - import data from Quicken financial software;
- **OFX/QFX (.ofx,.qfx)** Open Financial eXchange format (QXF is an Intuit/Quicken proprietary version of OFX);
- **CSV (.csv)** Comma Separated Values;
- **MT940**
- **MT942**
- **DTAUS**

These import methods can be accessed from File → Import ... .

Import Matcher

Several of the Import Assistants use an Import Matcher to implement a Bayesian approach to assign destination accounts, if such accounts are not specified in the imported data, to each imported transaction based on the previous import history of the import account. It also attempts to match the transactions being imported to any existing transactions based on the date and the description fields.

Transaction rows which match existing transactions already in the import account are flagged not to be imported. They will have a light green background and the A and U+R checkboxes will be unchecked and the R checkbox will be checked. To override and import the transaction, check the A checkbox. The U and
R boxes will be unchecked automatically. The reliability of the match is indicated by a bar display in the Info column. If a destination account for the second split is assigned by the matcher if will be appended to the info column.

Transaction rows which do not match existing transactions in the import account, for which an assignment of a destination account cannot be made on the basis of the previous import history to the account, will be displayed with an orange-yellow background and the A box will be checked and U+R and R unchecked. A destination account must be specified for these transactions.

**Assign a Destination Account to a Single Transaction**

The currently selected row is selected by Left-clicking it. It is displayed with a mid dark green background.

Double click on a row. This will select it and open an Account Selection dialog. Select the desired destination account in the dialog and click OK. The row background will change to a light green and the assigned destination account will be displayed in the Info column.

or alternatively, Left-click on a row to select it followed by a Right-click to bring up a popup menu then select "Assign a transfer account" to display the Account Selection dialog, select the destination account and click the OK button.

**Assign a Destination Account to Multiple Transactions**

Sometimes you will have several transactions which will have the same destination account. Gnucash allows you to select multiple transactions and apply the same destination account to all transactions in the selection.

Rows in a selection are displayed with a mid dark green background.

Multiple rows may be selected to have the same destination account assigned to them.

To select rows either:

- **Left click** on first row and then **Ctrl-Left click** on other rows to add to the selection or
- **Left-click** on a first row and then **Shift-Left-click** on another row to select all rows between them.

then **Right-click** to display a popup menu and then select "Assign a transfer account" to open the Account Selection dialog. Select the desired destination account and click the OK button in the Account Selection dialog.

**Completing the Import**

Once you have assigned destination accounts for all the imported transactions using the above methods (all row backgrounds will be a light green colour), check that the assigned destination accounts are correct and then press the OK button at the bottom of the Generic Import Matcher window. The transactions selected for import will have their splits added to the selected source and destination accounts.

The choices made for the destination accounts and description/memo fields are remembered and stored and used for future imports to the same account to automatically assign a destination account for transaction records not containing destination account information.

**Import QIF**

To import data from Quicken®, MS Money, or other programs that use QIF(Quicken® Interchange Format), you must first export your data to a QIF file. One way to do this is to export each account as a separate
Importing Data into GnuCash

QIF file. An easier way, available in Quicken® 98 and beyond, is to export all accounts at once into a single QIF file. Check your program's manual to determine if this option is available.

**To import QIF files:**

**Load all of the QIF files containing data you wish to import**

To do this, select **File -> Import -> Import QIF...** from the menu. When the QIF Import dialog box appears, click **Next** and follow the instructions to guide you through the process of loading your files.

This image shows the start of the QIF Import assistant.

You will be prompted for a filename to load. Use the Select button to select your QIF file and click **Next** to load it. Once the file is loaded, select Load another file if you have more files to load. When you have loaded all your QIF files, click **Next** to continue with the import process.

**Review the GnuCash accounts to be created.**

The importer then matches up your QIF accounts and categories with GnuCash accounts and gives you a brief description of the matching process. Clicking Next will bring you to a view comparing your QIF accounts with the corresponding GnuCash accounts created. To change an account name, select the row containing that account name and edit the name in the dialog box provided. Click Next when you have finished making changes, and proceed through a similar category matching process. QIF income and expense categories import as GnuCash income and expense accounts. Make changes to these account names if necessary, and click Next to continue.

**Note:** If you are not sure what changes are needed, it is safe to accept the GnuCash account names. It is easy to edit the accounts later if you find you need to make a change.

From the drop-down list, select a standard currency to be used for the imported accounts and click **Next** to continue. If you have stocks, mutual funds, or other securities, you will be prompted for additional information. The importer dialog will ask for the exchange or listing (i.e. Nasdaq), the security's full name, and the ticker symbol. If you do not have this information handy, you can edit the account information later, once the import is complete. Click **Next** to continue.

**Tell GnuCash to import the data.**

The last step is the import. Once you have verified your account names and investment information, click **Finish** in the Update your GnuCash accounts page to complete the import process. Depending upon the size of your file, the import might take a few minutes to complete, so a progress bar displays the percentage finished. When the import process is complete, GnuCash will return you to the main window, which should now display the names of the accounts you imported.

**Import OFX/QFX**

This opens a file selection dialog. Navigate to the file you wish to import, select a file with the appropriate extension (.ofx or .qfx), then press the **Import** button.

Gnucash opens an Account Selection dialog to select an account in your CoA corresponding to data source. Select the appropriate account from the account tree and press the **OK** button. On subsequent import of files from the same source (identified by tags in the file), the source is remembered and the account selection dialog is not displayed.
The generic import transaction matcher dialog is opened next. See the Import Matcher section (common to both OFX/QFX and CSV import formats) following the Import CSV section to continue the import process.

**Import CSV**

Clicking on Import CSV in the Import menu will bring up the Import Assistant dialog. The first step brings up a file selection dialog. Navigate to the location where the file you wish to import is located and select the file to import then click the OK button.

The next window will allow you to set parameters for the importing of the file. All widgets have tooltips which explain what the setting affects and the options for the setting.

**Load and Save Settings**

If this import is a regular occurrence, once you have set the other import parameters, you can save these settings by typing in a setting name in the Load and Save Settings Entry combo box and pressing the Save button just to the right of the box. Previously defined settings can be retrieved by selecting the appropriate setting name from the dropdown list activated by the down arrow at the right end of the text box. The trash can button to the right of the Save button can be used to remove the settings selected from the drop down list for the box. The settings group "GnuCash Export Settings" define a setting group for the export and reimport of GnuCash transaction data - use this if importing data previously exported from GnuCash.

**Account**

This combo box allows you to select the base or import account into which the transactions will be imported. It may be left unset if the imported data contains a column listing the accounts associated with each split or the import data specifies the account for first split of the transaction.

**File Format**

This section allows you to define whether the file has:

- **Fixed width columns** Selecting this radio button will allow you to define column boundaries by double clicking at the appropriate positions in the sample records displayed in the panel below. Single clicking in a column will narrow, widen or merge the column.

- **Separators** Selecting this radio button will allow you to define characters which will be used to distinguish columns in the input file. The default is comma separated however spaces, tabs, colons or semicolons or any combination of them may be used to separate columns in the input file by selecting the appropriate check boxes. You may also define custom separators by typing the required characters into the text box and selecting the Custom checkbox. This may be used in combination with any of the predefined separators.

- **Multi-split** Selecting this check box allows the splits for a single transaction to be defined on consecutive lines within the file with each line defining a single split. If not selected each line is assumed to contain the information for a single transaction including one or two splits.

**Miscellaneous**

The miscellaneous settings allow you to set:

- **Encoding** This is usually the UTF-8 variant for your locale;

- **Date Format** This does not default to the Locale setting so check it matches the data you are importing;
Importing Data into GnuCash

- **Currency Format:**

- **Leading Lines to Skip** Can be set to skip a number of non-transaction lines preceding the actual data. This can include a field name header or an introduction section in the import file;

- **Trailing Lines to Skip** Can be set to skip a number of non-transaction lines following the actual data. This can include a summary section;

- **Skip alternate lines** When set only every other line will be imported, starting from the first line not skipped with the "Leading Lines to Skip" option;

to match the settings for the file you are importing. Tooltips may also contain information on the setting and options.

**Import Panel**

The import panel shows the data being imported as it is interpreted using the settings chosen to define columns and formats. The dropdown lists in the headers for each column of the import allow you to associate a specific column in the imported data with a specific field in the display of a transaction in an account register. At a minimum to import data, columns in the imported data containing the following information **must** be specified:

- **Date** of transaction;

- **Account** into which transaction is to be imported (or alternatively set the base account as above);

- **Description** of the transaction;

- **Deposit or Withdrawal** column.

The **Skip Errors** check box will skip trying to import any rows with errors in matching the columns.

When you are happy with all the import settings, save them if you will use the same settings again, then press the **Next** button. This will bring up a window which allows you to map the accounts identified in the account column (Account Id) with accounts in the GnuCash account tree (Account name). Double click on a row to bring up a dialog to select the matching GnuCash account. When you have selected a match for all accounts, click on the **Next** button.

The Transaction Information panel allows review of data entry settings so far.

Clicking on Match Transactions will then bring up the main Import Matcher window described in the next section.

**Import MT940**

Use this option to import MT940 data.

**Import MT942**

Use this option to import MT942 data.

**Import DTAUS**

Use this option to import DTAUS data.
Chapter 4. Configuring GnuCash

This chapter will detail preference settings for GnuCash.

Overview

Configuring is fun.

Main Configuration Screens

GnuCash stores settings in two main locations.

Preferences: Accounting Period Tab

Stuff about the Accounting Period tab

Preferences: Accounts Tab

Stuff about the Accounts tab. Need this stub for the link in The Basics. More later.

Preferences: Online Banking

Stuff about the Accounts tab. Need this stub for the link in The Basics. More later.
Part II. The Common Usage
# Table of Contents

5. Checkbook ............................................................................................................. 80  
   Setting up Accounts ............................................................................................ 80  
   Entering Deposits ............................................................................................... 80  
   Entering Withdrawals ......................................................................................... 81  
   ATM/Cash Withdrawals ...................................................................................... 81  
   Reconciling Your Accounts ............................................................................... 82  
   Putting It All Together ....................................................................................... 82  
      Opening Balances ............................................................................................. 82  
      Add some transactions ..................................................................................... 83  
      Opening Balances ............................................................................................ 84  
      Save file ........................................................................................................... 86  
      Reports ............................................................................................................ 87  
6. Expense Accounts ............................................................................................... 91  
   Concepts ............................................................................................................. 91  
   Setting Up Accounts .......................................................................................... 91  
      Simple Expense Account Setup ..................................................................... 91  
      Complex Expense Account Setup .................................................................. 91  
   Entering Expense Transactions ..................................................................... 91  
   Other Considerations for Expense Accounts ................................................. 92  
7. Credit Cards ....................................................................................................... 93  
   Concepts ............................................................................................................. 93  
   Setting Up Accounts .......................................................................................... 93  
      Simple Setup .................................................................................................. 93  
      Complete Setup ............................................................................................... 94  
   Entering Charges ............................................................................................... 94  
   Entering Payments ............................................................................................. 95  
   Putting It All Together .................................................................................... 96  
      Open GnuCash file .......................................................................................... 96  
      Purchases ......................................................................................................... 98  
      Refund ............................................................................................................ 98  
      Interest Charge ............................................................................................... 99  
      Reconciliation ................................................................................................. 99  
      Payment .......................................................................................................... 100  
      Save file ........................................................................................................... 102  
      Reports ............................................................................................................ 102  
8. Loans .................................................................................................................. 105  
   Basic Concepts .................................................................................................. 105  
   Terminology ...................................................................................................... 105  
   Setting Up Accounts .......................................................................................... 106  
   Calculations ....................................................................................................... 106  
      Example: Monthly Payments ........................................................................ 108  
      Example: Length of Loan ............................................................................... 108  
      Advanced: Calculation Details ...................................................................... 108  
   House Mortgage (How-To) ............................................................................. 110  
   Automobile Loan (How-To) ........................................................................... 113  
   A Personal Loan to a friend (How-To) ............................................................. 114  
      Loan Specifications ......................................................................................... 114  
      Accounts for the loan ..................................................................................... 115  
      Lending the money ......................................................................................... 115  
      Receiving first payment ................................................................................... 116  
      Receiving second payment ............................................................................ 117
## 9. Investments

- **Basic Concepts** .................................................. 122
- **Terminology** ....................................................... 122
- **Types of Investments** ............................................. 123
- **Setting Up Accounts** ............................................. 124
  - Using Predefined Investment Accounts ......................... 125
  - Creating Investment Accounts Manually ......................... 125
  - Custom Accounts Example ........................................ 126
- **Interest Bearing Accounts** ..................................... 127
  - Account Setup ...................................................... 127
  - Example ............................................................. 128
- **Setup Investment Portfolio** ..................................... 130
  - Setup Accounts for Stocks and Mutual Funds ................. 131
  - Example Stock Account ........................................... 131
- **Buying Shares** .................................................... 135
  - Entering Preexisting Shares ..................................... 135
  - Buying New Shares ............................................... 136
- **Setting Share Price** ............................................. 138
  - Initial Price Database Setup .................................... 138
  - Setting Stock Price Manually ................................... 140
  - Configuring for Automatic Retrieval of Quotes ............. 140
  - Displaying Share Value .......................................... 141
  - The “Price Source” in Reports .................................. 141
- **Selling Shares** .................................................... 143
  - Selling Shares with Manual Calculation of Capital Gain or Loss ........................................ 144
  - Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots ......................... 151
- **Dividends** .......................................................... 163
  - Dividends in Cash .................................................. 163
  - Dividends Re-Invested ............................................ 164
- **Return of Capital** ................................................ 165
- **Splits and Mergers** .............................................. 165
  - Simple Stock Split ................................................ 166
  - Moderately Complex Stock Merger ............................... 168

## 10. Reports

- **Overview** .......................................................... 171
- **Saved Reports Configurations Concepts** .......................... 171
- **Standard Reports Overview** ...................................... 172
  - Transaction Report ................................................ 172
  - Assets & Liabilities Group ........................................ 172
  - Budget Group ....................................................... 177
  - Business Group ..................................................... 177
  - Income and Expense Group ....................................... 179
  - Sample & Custom Group ........................................... 182
- **Other Reports** ..................................................... 183
- **Using the Transaction Report** .................................... 184

## 11. Capital Gains

- **Basic Concepts** .................................................... 187
- **Estimating Valuation** ............................................ 187
- **Account Setup** ..................................................... 188
- **Example** ............................................................ 189

---

The Common Usage
Unrealized Gains ................................................................. 190
Selling ............................................................................. 190
Taxation ........................................................................... 193
12. Multiple Currencies ..................................................... 194
Basic Concepts ................................................................. 194
Manually Recording Currency Transaction ............................. 194
   Account Setup ............................................................... 194
Recording and Updating Currency Exchange Rates ..................... 197
Recording Purchases in a Foreign Currency ............................... 206
Tracking Currency Investments ............................................ 211
Reconciling Statements in a Foreign Currency ......................... 213
Automatically Recording Currency Transactions using Trading Accounts ........................................ 213
   Trading Account Concepts .............................................. 213
Recording Foreign Currency Transactions with Trading Accounts ........................................... 214
Chapter 5. Checkbook

This chapter will give you all the specific information you need to manage your checkbook with GnuCash. Managing your checkbook register is the first step of tracking your finances, and GnuCash makes it much easier to manage than the traditional paper register does.

For one thing, as discussed in the section called “Transactions”, data entry of common transactions is practically done for you in GnuCash, because of its auto-completion feature. GnuCash keeps a running balance of each account, and it makes reconciling these accounts easy. And the double-entry method helps you account for your spending by requiring a transfer account for withdrawals, so you can easily find out how much money you spend in different areas.

Once you are comfortable with using GnuCash for your checking and other bank accounts, you may wish to continue on with tracking other financial accounts. Chapters 6 through 9 examine methods to manage your other accounts.

Setting up Accounts

The first step in managing your checkbook is to set up the necessary accounts. You can either use the default GnuCash accounts or set up your own. For more detail on how to set up a new account, refer to the section called “The Basic Top Level Accounts”. For instructions on importing your accounts from another program, refer to the GnuCash manual.

Let’s start with the bank accounts you’ll need. You need one GnuCash bank type account for each physical bank account you wish to track. If you are setting up your own accounts or using the default GnuCash accounts, make sure that you have an opening balance transaction for each bank account you own. The easiest way to get this number is to use the balance from your last bank statement as your opening balance. You can enter this in the account information window automatically as part of the New Account Hierarchy Setup assistant, or you can enter a manual transaction directly in the account. To enter the transaction manually, enter a transfer from an Opening Balances account (type equity) to the bank account.

The typical bank accounts you might track include:

- Checking - any institutional account that provides check-writing privileges.
- Savings - an interest-bearing institutional account usually used to hold money for a longer term than checking accounts.

Common transactions that affect these bank accounts are payments and deposits. Payments are transfers of money out of the bank account, usually to an expense account. Deposits are transfers of money into the bank account, usually from an income account. You will need to set up income and expense accounts to track where that money comes from and where it goes. Remember that a balanced transaction requires a transfer of an equal sum of money from at least one account to at least one other account. So if you deposit money in your checking account, you must also enter the account that money comes from. If you pay a bill from your checking account, you must also enter the account where that money goes.

Entering Deposits

Most deposit transactions are entered as a transfer from an income account to a bank account. Income may come from many sources, and it’s a good idea to set up a separate income type account for each different source. For example, your income may come mainly from your paychecks, but you may also
receive interest on your savings. In this case, you should have one income account for salary and another income account for interest income.

**Tip**

Be sure to check the Tax-Related box and assign an appropriate tax category in the Income Tax Information Dialog (Edit → Tax Report Options) when you set up taxable income accounts. Some types of income, such as gift income, may not be considered taxable, so check the appropriate tax rules to determine what is taxable. For ways to track capital gains income, refer to Chapter 11, *Capital Gains*.

Before you start entering paycheck deposits, decide how much detail you want to track. The basic level of detail is to enter your net pay, just like you would in your paper register. This is easiest, but you can get even more information out of GnuCash if you enter your gross pay with deductions. It takes a bit more effort to enter the deductions, but entering your tax withholding information throughout the year allows you to run useful tax status reports in GnuCash at any time. These reports can help you determine whether you are withholding enough tax, and they can help you estimate your tax bill ahead of time. If you are unsure about the level of detail, start by entering net pay. You can always go back and edit your transactions later if you decide you want more detail.

**Entering Withdrawals**

When you withdraw money from your bank account, for whatever reason, you are transferring money from your bank account to some other location. In GnuCash, this other location is tracked as an account. The more detailed accounts you create and use for your spending, the more information you will get about where your money goes.

Withdrawals take many forms. ATM withdrawals are one of the most common transactions. Writing checks is one way to withdraw money to pay bills, to buy purchases, or to give to charity. Depending on your bank, you might also have service charges, where the bank withdraws the money from your account. Transfers of money out to another account are also withdrawals. We will take a look at each of these types of withdrawals and how to record them in GnuCash.

**ATM/Cash Withdrawals**

Cash withdrawals are handled as a transfer from a bank account to a cash account. GnuCash provides special *Cash* type accounts for tracking your cash purchases, so you should set up a cash account to record your ATM and other cash withdrawals.

Cash accounts can be used for different levels of detail. On a basic level of detail, you simply transfer money to it from your checking account. That tells you how much money you took out of checking on a given day, but it doesn’t tell you where that cash was spent. With a little more effort, you can use the cash account to record your cash purchases as well, so that you can see where that cash went. You record these purchases as a transfer from the cash account to expense accounts.

Some people record every cash purchase, but this takes a lot of work. An easier way is to record the purchases for which you have receipts, but then adjust the balance of the account to match what is in your wallet.

It’s a good idea to at least set up a cash account for your withdrawals. Then if you decide to track where your cash goes, you can enter transactions for the money you spend. You determine what level of detail you want to use.
Reconciling Your Accounts

GnuCash makes reconciliation of your bank account with your monthly bank statement much easier. The section called “Reconciliation” gives instructions on how to reconcile your transactions with the monthly bank statement. This is the main reconciliation task that should be done every month.

But what about all those other accounts you created? Should those be reconciled too? If you receive a statement for the account, then you should consider reconciling that account. Examples include the checking account statement, the savings account statement, and the credit card statement. Credit card statements and credit card transactions are covered in the Chapter 7, Credit Cards, so if you are interested in tracking your credit cards in GnuCash, take a look at the instructions provided there.

Income and expense accounts are usually not reconciled, because there is no statement to check them against. You also don’t need to reconcile cash accounts, for the same reason. With a cash account, though, you might want to adjust the balance every once in a while, so that your actual cash on hand matches the balance in your cash account. Adjusting balances is covered in the next section.

Putting It All Together

In the section called “Transactions”, you entered some transactions in your checking account. In this chapter, we will add more transactions and then reconcile them.

Opening Balances

So, let’s get started by opening the gcashdata file you saved in the last chapter (gcashdata_4). Your chart of accounts should look like this:
Add some transactions

1. Now open the Checking account from the main window. In the last chapter, you entered some paycheck transactions as deposits into Checking. Now we will enter another kind of deposit - a transfer of money from Savings into Checking. On a blank line, enter a transaction to transfer $500 from Savings to Checking (In this case, the last transaction date was March 28, but this transfer transaction took place on the March 24). Your Transfer account will be Savings, since you are in the Checking account. Your Checking account should now look like this:
write a check to ABC Hardware for $100 (6 of March), and split this amount between two expenses: Household $50 and Tools $50. You will need to create an Expense type account for each of these, then enter splits for them. Your checking account should now look like this;

**Figure 5.3. The Checking Account Register After Registering Some More Checks**

This image shows the Checking Account Register after registering some more checks.

3. Suppose you now need to withdraw some money. You don’t have a cash account set up in your chart of accounts, so you will need to create one. Create the account as Cash as a top-level account of type Asset. From your Checking account register, enter an ATM type withdrawal to transfer $100 from Checking to Cash on the 25 of March.

**Figure 5.4. The Checking Account Register With An ATM Withdrawal**

This image shows the Checking Account Register with an ATM withdrawal.

**Opening Balances**

Now we are ready to reconcile this Checking account, using this sample bank statement:
This image shows a sample Bank Statement.

1. Select Actions → Reconcile from the menu, and fill in the Closing balance as $1451.79. Click OK to begin reconciling the account. Check off the entries as they appear on the sample statement. When you have checked off all your entries, the reconcile window should look like this:

2. So click on the Checking register and add the $5.00 service charge to your Checking account. On a blank line of the Checking register, enter a transaction to transfer $5.00 from Checking to a Service Charges account. (You will need to create the Service Charges account as type Expense.) Use the transaction date printed on the sample statement as the date you enter for this transaction. Your Checking account should now look like this:
This image shows the Checking Account Register with service charge added.

3. Click back on the Reconcile window, and you should see the service charge now under Funds Out. Click on it to mark it as reconciled, and note that the difference amount below now becomes 0.00. Click the Finish button on the Toolbar to complete the reconciliation. The Reconcile R column in your Checking register should now show y for each transaction you just reconciled. Also observe the bottom status row that now indicates Reconciled: USD 1451.79

This image shows the reconciled Checking Account Register.

Save file

Go back to the main window and save your file with the new gcashdata_5 name. Your chart of accounts is steadily growing, and it should now look like this:
Figure 5.9. The Chart of Accounts

This image shows the Chart of Accounts.

Reports

As we did in the previous chapter, let’s have a look at a Cash Flow, and a Transaction Report.

1. First let’s have a look at the Cash Flow report for the month of March.

   Select the cash flow report from Reports → Income & Expense → Cash Flow.
Figure 5.10. Cash Flow report for the month of March

**Cash Flow - 01/03/06 to 31/03/06 for**

Selected Accounts

- **Assets:Cash**
- **Assets:Checking**
- **Assets:Savings**

<table>
<thead>
<tr>
<th>Money into selected accounts comes from</th>
<th>USD 2,000.00</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Equity:Opening Balance</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Income:Salary</strong></td>
<td>USD 1,000.00</td>
</tr>
<tr>
<td><strong>Money In</strong></td>
<td><strong>USD 3,000.00</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Money out of selected accounts goes to</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Expenses:Electricity</strong></td>
<td>USD 78.00</td>
</tr>
<tr>
<td><strong>Expenses:Groceries</strong></td>
<td>USD 120.21</td>
</tr>
<tr>
<td><strong>Expenses:Household</strong></td>
<td>USD 50.00</td>
</tr>
<tr>
<td><strong>Expenses:Internet</strong></td>
<td>USD 20.00</td>
</tr>
<tr>
<td><strong>Expenses:Phone</strong></td>
<td>USD 45.00</td>
</tr>
<tr>
<td><strong>Expenses:Rent</strong></td>
<td>USD 350.00</td>
</tr>
<tr>
<td><strong>Expenses:Service Charge</strong></td>
<td>USD 5.00</td>
</tr>
<tr>
<td><strong>Expenses:Taxes:Federal</strong></td>
<td>USD 180.00</td>
</tr>
<tr>
<td><strong>Expenses:Taxes:Medicare</strong></td>
<td>USD 90.00</td>
</tr>
<tr>
<td><strong>Expenses:Taxes:Social Security</strong></td>
<td>USD 60.00</td>
</tr>
<tr>
<td><strong>Expenses:Tools</strong></td>
<td>USD 50.00</td>
</tr>
<tr>
<td><strong>Money Out</strong></td>
<td><strong>USD 1,048.21</strong></td>
</tr>
</tbody>
</table>

| **Difference**                        | **USD 1,951.79** |

This image shows the Cash Flow report after Chapter 5, *Checkbook*.

2. Now let's have a look at corresponding transaction report for the various Asset accounts.

Select the transaction report from Reports → Transaction Report.
### Figure 5.11. Transaction Report For The Assets During March

**Transaction Report**  
**From 01/03/06 To 31/03/06**

<table>
<thead>
<tr>
<th>Date</th>
<th>Num</th>
<th>Description</th>
<th>Transfer from/to</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cash</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25/03/06</td>
<td></td>
<td>ATM Withdrawal</td>
<td>Checking</td>
<td>USD 100.00</td>
</tr>
<tr>
<td><strong>Total For Cash</strong></td>
<td></td>
<td></td>
<td></td>
<td>USD 100.00</td>
</tr>
<tr>
<td><strong>Checking</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>01/03/06</td>
<td></td>
<td>Opening Balance</td>
<td>Opening Balance</td>
<td>USD 1,000.00</td>
</tr>
<tr>
<td>05/03/06</td>
<td>101</td>
<td>Grocery Store</td>
<td>Groceries</td>
<td>-USD 45.21</td>
</tr>
<tr>
<td>05/03/06</td>
<td>105</td>
<td>HomeTown Grocery</td>
<td>Groceries</td>
<td>-USD 75.00</td>
</tr>
<tr>
<td>06/03/06</td>
<td></td>
<td>Transfere Money</td>
<td>Savings</td>
<td>USD 100.00</td>
</tr>
<tr>
<td>06/03/06</td>
<td>106</td>
<td>ABC Hardware</td>
<td>Split</td>
<td>-USD 100.00</td>
</tr>
<tr>
<td>14/03/06</td>
<td></td>
<td>Employers R Us</td>
<td>Split</td>
<td>USD 670.00</td>
</tr>
<tr>
<td>24/03/06</td>
<td></td>
<td>Transfer Money</td>
<td>Savings</td>
<td>USD 500.00</td>
</tr>
<tr>
<td>25/03/06</td>
<td></td>
<td>ATM Withdrawal</td>
<td>Cash</td>
<td>-USD 100.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td>102</td>
<td>Light Company</td>
<td>Electricity</td>
<td>-USD 78.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td>104</td>
<td>April Rent</td>
<td>Rent</td>
<td>-USD 350.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td></td>
<td>Internet Subscription</td>
<td>Internet</td>
<td>-USD 20.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td>103</td>
<td>Phone Company</td>
<td>Phone</td>
<td>-USD 45.00</td>
</tr>
<tr>
<td>31/03/06</td>
<td></td>
<td>Service Charge</td>
<td>Service Charge</td>
<td>-USD 5.00</td>
</tr>
<tr>
<td><strong>Total For Checking</strong></td>
<td></td>
<td></td>
<td></td>
<td>USD 1,451.79</td>
</tr>
<tr>
<td><strong>Savings</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>01/03/06</td>
<td></td>
<td>Opening Balance</td>
<td>Opening Balance</td>
<td>USD 1,000.00</td>
</tr>
<tr>
<td>06/03/06</td>
<td></td>
<td>Transfere Money</td>
<td>Checking</td>
<td>-USD 100.00</td>
</tr>
<tr>
<td>24/03/06</td>
<td></td>
<td>Transfer Money</td>
<td>Checking</td>
<td>-USD 500.00</td>
</tr>
<tr>
<td><strong>Total For Savings</strong></td>
<td></td>
<td></td>
<td></td>
<td>USD 400.00</td>
</tr>
<tr>
<td><strong>Grand Total</strong></td>
<td></td>
<td></td>
<td></td>
<td>USD 1,951.79</td>
</tr>
</tbody>
</table>

This image shows the Transaction Report for the Assets accounts during March.

3. Now let’s change the transaction report to only show the various *Expenses* account.
Figure 5.12. Transaction Report For The Expenses During March

Transaction Report
From 01/03/06 To 31/03/06

<table>
<thead>
<tr>
<th>Date</th>
<th>Num</th>
<th>Description</th>
<th>Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/03/06</td>
<td>101</td>
<td>Grocery Store</td>
<td>Groceries</td>
<td>USD 45.21</td>
</tr>
<tr>
<td>05/03/06</td>
<td>105</td>
<td>HomeTown Grocery</td>
<td>Groceries</td>
<td>USD 75.00</td>
</tr>
<tr>
<td>06/03/06</td>
<td>106</td>
<td>ABC Hardware</td>
<td>Household</td>
<td>USD 50.00</td>
</tr>
<tr>
<td>06/03/06</td>
<td>106</td>
<td>ABC Hardware</td>
<td>Tools</td>
<td>USD 50.00</td>
</tr>
<tr>
<td>14/03/06</td>
<td></td>
<td>Employers R Us</td>
<td>Federal</td>
<td>USD 180.00</td>
</tr>
<tr>
<td>14/03/06</td>
<td></td>
<td>Employers R Us</td>
<td>Social Security</td>
<td>USD 60.00</td>
</tr>
<tr>
<td>14/03/06</td>
<td></td>
<td>Employers R Us</td>
<td>Medicare</td>
<td>USD 90.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td></td>
<td>Internet Subscription</td>
<td>Internet</td>
<td>USD 20.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td>104</td>
<td>April Rent</td>
<td>Rent</td>
<td>USD 350.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td>102</td>
<td>Light Company</td>
<td>Electricity</td>
<td>USD 78.00</td>
</tr>
<tr>
<td>28/03/06</td>
<td>103</td>
<td>Phone Company</td>
<td>Phone</td>
<td>USD 45.00</td>
</tr>
<tr>
<td>31/03/06</td>
<td></td>
<td>Service Charge</td>
<td>Service Charge</td>
<td>USD 5.00</td>
</tr>
</tbody>
</table>

Grand Total | USD 1,048.21

This image shows the Transaction Report for the various Expense accounts during March.

Notice that you have not yet used one of the accounts listed in your chart, the Credit Card account. Now that you know how to keep track of your bank and cash accounts in GnuCash, you may want to start tracking your credit cards as well. GnuCash provides a special type of account for credit cards, and this is discussed in the next chapter.
Chapter 6. Expense Accounts

If managing your checkbook is the first step in tracking your finances, then using expense accounts to see where you are expending money is a close second step. This chapter will give you an understanding of how GnuCash uses expense accounts to help you keep track of many different categories of transactions.

Concepts

An expense type account is used to allow you to track how much you spend on specific expenses. Many people's first experience with tracking expenses comes from Quicken(tm), where transactions can be assigned to one or more categories. In GnuCash, these categories are set up as separate accounts, which are designated as Expense type accounts. This allows GnuCash to apply the rules of double-entry accounting consistently. Expense accounts can be as detailed or as general as you need. Some users need only a few accounts for personal expense tracking. Others use GnuCash expense accounts to manage their expenses in great detail. The level of detail you choose is up to you. Keep in mind that with GnuCash, you can change accounts for transactions, so if your needs change later on, it is possible to move transactions around.

Setting Up Accounts

Simple Expense Account Setup

For many users, the easiest way to set up expense accounts is to check the "Common Accounts" when you create a new Account Hierarchy. This will establish many of the most common expense accounts that users need. See "New Account Hierarchy Setup" in Chapter 3 of the GnuCash Manual for more information.

Complex Expense Account Setup

If you have different expense accounting needs, you can refer to the section called “Transactions”, or Chapter 5.4 in the GnuCash Manual for instructions on how to create accounts.

Typical reasons for adding new or different expense accounts include: to track expenses for particular business purposes (e.g., specific types of supply expenses), to track expenses for particular tax purposes (e.g., tax expenses that must be reported to others), or simply to track expenses that are meaningful to you (e.g., payments made to a particular charity).

Entering Expense Transactions

While it is possible to enter transactions directly into expense accounts, it is not normally how these are entered. For most people, transactions for an expense account are added when the user is entering data into the other account in the transaction. In other words, if you have an expense account for Charitable Donations (e.g., Expenses:Charity), you will typically add a transaction to the expense account by assigning a check in your checking account register to the Charity account.

If you open an expense account, you will see a register similar to most others you find in GnuCash. The informal column headings for the transaction amounts are slightly different, however. The left (debit) column will read Tot Expense, while the right (credit) column will read Tot Rebate.
Other Considerations for Expense Accounts

Because expense accounts are generated entirely by you, there are no statements against which you would reconcile your data. Therefore, there is technically nothing to reconcile. You can, of course use the reconcile process for expense accounts, which will lock the transactions for future editing.

One point to consider is that as your use of GnuCash continues, the balances in these accounts will grow, since there are usually very few credit transactions that reduce the balances. There is nothing wrong with this situation, but some users may wish to clear the balances in their expense accounts periodically. Zeroing transactions can be entered that transfer the balance of the account to an Equity account. GnuCash includes a Closing Books procedure that includes zeroing out expense accounts. Keep in mind that this is not necessary, and that if you need to gather information on a given expense account, you can use various reports to extract that data without zeroing the account out.
Chapter 7. Credit Cards

This chapter will show you how to manage your credit cards using GnuCash.

Concepts

Since you probably write a check or make an electronic payment to the credit card company each month, you may think of your credit card bill as an expense - but it really is not an expense. Why? A credit card account is a short-term loan - you buy things on that loan account, and then you eventually have to pay back the money, often with interest (your finance charge). The purchases you make with that credit card are your expenses.

You have a couple of options when entering credit card transactions, so choose the one that fits your desired level of detail. The simplest method is to simply track monthly payments to the credit card company. From your bank account, you enter a transfer of money each month to the credit card expense account. This will show you the amount of money you are paying each month to the credit card company, but it won’t show you any information about your credit card balance or credit card purchases.

A more complete way to track your credit card in GnuCash is to enter each purchase and payment as a separate transaction. Using the credit card account register, you enter your receipts throughout the month. When your credit card statement arrives, you reconcile the credit card account to the statement, and you enter your payment as a transfer of money from your checking account to your credit card account. This method gives you more information about your balance during the month and points out any discrepancies during reconciliation, but you will have to do more data entry.

Setting Up Accounts

To begin managing your credit cards in GnuCash, you should set up a Liability top level account and under this parent account create credit card type accounts for each credit card you use. If you are tracking only the payments you make to the credit card company, then all you need is a bank account and a credit card account to enter your transactions.

The charges you make on your credit card are expenses, so you will have to set up these accounts under the top-level account called Expenses. If you decide to keep a more detailed records of your purchases, you will need to create expense accounts for each kind of purchase you make. Since you will also be reconciling the balance to your credit card statements, you should also enter an opening balance in each credit card account. The easiest way to do this is to use your last statement balance as the opening balance.

Simple Setup

If you do not want to track each expense made on the credit card, you can set up a simple account hierarchy like this:

- Assets
  - Bank
- Liabilities
  - Credit Card
- Expenses
  - Credit Card
In this example, if you enter your total amount charged per month as a transaction between Liabilities:Credit Card and Expenses:Credit Card. When you make a payment, you would enter a transaction between Assets:Bank and Liabilities:Credit Card.

The obvious limitation of this simple credit card setup is that you cannot see where your money is going. All your credit card expenses are being entered in the Credit Card expense account. This is, however, very simple to set up and maintain.

**Complete Setup**

If you want to track your expenses more completely, you should set up multiple expense accounts named for the various kinds of expenses you have. Each charge on your credit card is then entered as a separate transaction between your Credit Card liability account and a specific expense account. Below is an example of an account hierarchy for this:

- **Assets**
  - Bank
- **Liabilities**
  - Credit Card
- **Expenses**
  - Food
  - Car
  - Clothes
  - Entertainment
  - Interest
  - Service

Clearly, you should enter specific expense accounts which fit your spending habits. The only difference with this setup as compared to the simple setup is that the expenses have been subdivided by groups. Also notice that there is an “Interest” expense, this is used for when your credit card charges interest on your monthly unpaid balance. The “Service” expense account is used to track service expenses associated with the credit card, such as the yearly usage fee if it exists. With this setup, you will be able to see where your money goes every month, grouped according to the expense accounts.

The rest of this chapter will assume you are using the complete setup.

**Entering Charges**

Entering your charges provides you with a more complete picture of your spending habits. Charges on a credit card are tracked as a transaction between the credit card liability account and the appropriate expense account.

When you pay for goods or services with your credit card, you are telling the credit card company to pay the merchant for you. This transaction will increase the amount of money you owe the credit card company, and the credit card balance will increase. The other side of these transactions will in most cases be an expense account. For example, if you buy clothing from a store with your credit card for $50, you would be transferring that money from the credit account into Expenses:Clothing.

Entering these transactions into GnuCash allows you to track how much you owe the credit card company, as well as provides you a better picture of your overall accounts. It also allows you to monitor your account and ensure that fraud is avoided.

Adding transactions to a credit card account is similar to entering transactions in other accounts. You can enter them manually, or import them from your credit card company using a compatible import format.
For assistance with entering transactions, see Chapter 6 of the GnuCash Manual and the section called “Transactions”.

## Entering Payments

Most payments to your credit card bill are entered as transfers from a bank account (asset) to the credit card account (liability). When you pay the monthly bill, you are withdrawing money from a bank account to pay down the credit card balance. This transaction decreases both your bank account balance and the amount of credit card debt you owe.

When you return a purchase, you receive a refund on your credit card. This is another type of payment in that it decreases the amount of credit card debt you owe. If you recorded the original purchase transaction as a transfer from the credit card account to the expense, you now simply reverse that transaction: transfer the money back from the expense to the credit card account. This transaction decreases the expense account balance and the credit card account balance. For example, if you originally recorded a credit card purchase of clothing, the transaction is a transfer from the credit card account to the clothing expense account. If you then return that clothing for a refund, you simply transfer the money back from the clothing expense account to the credit card account.

**Note**

A common mistake is to enter a refund as income. It is not income, but rather a “negative expense”. That is why you must transfer money from the expense account to your credit card when you receive a refund.

To clarify this, let’s run through an example. You bought some jeans for $74.99 on your VISA card, but realized one day later that they are too big and want to return them. The shop gracefully agrees, and refunds your credit card.

1. Start with opening the previous datafile we stored (gcashdata_5), and store it as gcashdata_6.

2. Open the **Liabilities:Visa** account register and enter a simple 2 account transaction to pay the $74.99 jeans purchase. The Transfer account should be **Expenses:Clothes** and you Charge your **Visa** account with the $74.99.

   **Note**

   Since we had not created the **Expenses:Clothes** account previously, GnuCash will prompt us to create it. Just remember to create it as an Expense account

3. Enter the refund in one of the following way.

   - Enter the same transaction as the purchase transaction, but instead of a “Charge” amount, use a “Payment” amount in the Credit Card account register.
   - Select the purchase transaction you want to refund (that is the Jeans transaction in our case), and selecting Transaction → Add Reversing Transaction. Modify the date as needed.

After reversing the transaction, your credit card account should look something like this:
This image shows *Liability: Credit Card* - Register after reversing a purchase transaction.

And the *Expenses: Clothes* register should look something like this:

This image shows *Expenses: Clothes* register after reversing a purchase transaction.

4. Save the GnuCash data file.

**Putting It All Together**

Now that we have covered the basic ideas behind the various transactions you must make to successfully track your credit card in GnuCash, let’s go through an example. In this example, we will make credit card purchases, refund two of the purchases, get charged interest on the unpaid balance, reconcile the credit card account, and finally make a partial payoff of the credit card.

**Open GnuCash file**

Start with opening the previous datafile we stored, `gcashdata_5`, and store it as `gcashdata_6` directly. The main window should look something like this:
**Figure 7.3. Starting account structure for tracking a credit card**

![Credit Card Accounts](image)

<table>
<thead>
<tr>
<th>Account Name</th>
<th>Type</th>
<th>Commodity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash</td>
<td>Asset</td>
<td>US Dollar</td>
<td>USD 100.00</td>
</tr>
<tr>
<td>Checking</td>
<td>Bank</td>
<td>US Dollar</td>
<td>USD 1,101.79</td>
</tr>
<tr>
<td>Savings</td>
<td>Bank</td>
<td>US Dollar</td>
<td>USD 400.00</td>
</tr>
<tr>
<td>Equity</td>
<td>Equity</td>
<td>US Dollar</td>
<td>USD 1,500.00</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 1,398.21</td>
</tr>
<tr>
<td>Clothes</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 0.00</td>
</tr>
<tr>
<td>Electricity</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 78.00</td>
</tr>
<tr>
<td>Groceries</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 120.21</td>
</tr>
<tr>
<td>Household</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 50.00</td>
</tr>
<tr>
<td>Internet</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 20.00</td>
</tr>
<tr>
<td>Phone</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 45.00</td>
</tr>
<tr>
<td>Rent</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 700.00</td>
</tr>
<tr>
<td>Service Charge</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 5.00</td>
</tr>
<tr>
<td>Taxes</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 330.00</td>
</tr>
<tr>
<td>Tools</td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 50.00</td>
</tr>
<tr>
<td>Income</td>
<td>Income</td>
<td>US Dollar</td>
<td>USD 1,000.00</td>
</tr>
<tr>
<td>Liabilities</td>
<td>Liability</td>
<td>US Dollar</td>
<td>USD 500.00</td>
</tr>
<tr>
<td>Visa</td>
<td>Credit Card</td>
<td>US Dollar</td>
<td>USD 500.00</td>
</tr>
</tbody>
</table>

Starting account structure for tracking a credit card in the putting it all together example.
Purchases

Let’s make some purchases on our visa card. Start by buying $25 worth of food from the Greasy Spoon Cafe, $100 worth of clothing from Faux Pas Fashions, $25 worth of gasoline from Premium Gasoline, $125 worth of groceries and household items from Groceries R Us (split between $85 in groceries and $40 in household items) and finally, $60 worth of household items from CheapMart.

We also redo the exercise in previous chapter, with purchasing a pair of Jeans for $74.99 on April 3, and refund them two days later.

The register window for the credit card liability should look like this:

Figure 7.4. Initial credit card purchases

Refund

Now suppose that on April 15th you return the clothes you bought on April 11th from Faux Pas Fashions and they give you credit back on your credit card. Enter a transaction for the credit card refund for the full $100 amount. Remember to use the same transfer account you used for the original purchase, and enter the amount under the Payment column. GnuCash will automatically complete the name and transfer account for you, but it will also automatically enter the $100 in the Charge column. You will need to reenter the amount in the Payment column. The transaction looks like this:

Figure 7.5. Item return transaction refunded to credit card

Returning clothes to Faux Pas Fashions, refund to credit card.
Interest Charge

After the month of spending, unfortunately, the credit card bill arrives in the mail or you access it on-line through the internet. You have been charged $20 in interest on the last day of April because of the balance you carried from the previous month. This gets entered into the credit card account as an expense.

Figure 7.6. Interest charge on the Credit Card

Reconciliation

When your credit card bill arrives you should reconcile your credit card account to this document. This is done using GnuCash’s built-in reconciliation application. Highlight the credit card account and click on Actions → Reconcile... . This reconciliation procedure is described in detail in the the section called “Reconciliation”, but we will step through the process here as well. For this example, let’s assume that the credit card statement is dated May 1st, with a final balance of $455. Enter these values in to the initial Reconcile window as shown here.

Figure 7.7. The Initial Reconciliation Window For The Credit Card

During the reconciliation process, you check off each transaction in the account as you confirm that the transaction appears in both your GnuCash account and the credit card statement. For this example, as
shown in the figure below, there is a $300 difference between your GnuCash accounts and the credit card statement.

**Figure 7.8. The Main Reconciliation Window With A Discrepancy**

Main account reconciliation window, demonstrating a discrepancy of $300.

Some investigation uncovers that you forgot to record a payment you made on March 5th to the credit card company for $300, you must enter this payment transaction from your bank account to the credit card. Now the credit card statement and your GnuCash account can be reconciled, with a balance of $455.

**Payment**

Assuming you have completed reconciliation of your credit card account, you need to make a payment to the credit card company. In this example, we owe $455 but will make a partial payment of $300 again this month. To do so, enter a transaction from your bank account to the credit card account for $300, which should reduce your credit card balance to $155. Your credit card account register should now appear like this:

**Figure 7.9. The Credit Card Account After Reconciliation And Payment**

Account register after reconciliation and payment.

Go back to the main window and save your file (gcashdata_6). Your chart of accounts is steadily growing, and it should now look like this:
Figure 7.10. The Chart of Accounts After Account Reconciliation And Payment

<table>
<thead>
<tr>
<th>Account Name</th>
<th>Type</th>
<th>Commodity</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assets</strong></td>
<td>Asset</td>
<td>US Dollar</td>
<td>USD 1,001.79</td>
</tr>
<tr>
<td><strong>Cash</strong></td>
<td>Cash</td>
<td>US Dollar</td>
<td>USD 100.00</td>
</tr>
<tr>
<td><strong>Checking</strong></td>
<td>Bank</td>
<td>US Dollar</td>
<td>USD 501.79</td>
</tr>
<tr>
<td><strong>Savings</strong></td>
<td>Bank</td>
<td>US Dollar</td>
<td>USD 400.00</td>
</tr>
<tr>
<td><strong>Equity</strong></td>
<td>Equity</td>
<td>US Dollar</td>
<td>USD 1,500.00</td>
</tr>
<tr>
<td><strong>Expenses</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 1,653.21</td>
</tr>
<tr>
<td><strong>Car</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 25.00</td>
</tr>
<tr>
<td><strong>Clothes</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 0.00</td>
</tr>
<tr>
<td><strong>Electricity</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 78.00</td>
</tr>
<tr>
<td><strong>Food</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 25.00</td>
</tr>
<tr>
<td><strong>Groceries</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 205.21</td>
</tr>
<tr>
<td><strong>Household</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 150.00</td>
</tr>
<tr>
<td><strong>Interest</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 20.00</td>
</tr>
<tr>
<td><strong>Internet</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 20.00</td>
</tr>
<tr>
<td><strong>Phone</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 45.00</td>
</tr>
<tr>
<td><strong>Rent</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 700.00</td>
</tr>
<tr>
<td><strong>Service Charge</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 5.00</td>
</tr>
<tr>
<td><strong>Taxes</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 330.00</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td>Expense</td>
<td>US Dollar</td>
<td>USD 50.00</td>
</tr>
<tr>
<td><strong>Income</strong></td>
<td>Income</td>
<td>US Dollar</td>
<td>USD 1,000.00</td>
</tr>
<tr>
<td><strong>Liabilities</strong></td>
<td>Liability</td>
<td>US Dollar</td>
<td>USD 155.00</td>
</tr>
<tr>
<td><strong>Visa</strong></td>
<td>Credit Card</td>
<td>US Dollar</td>
<td>USD 155.00</td>
</tr>
</tbody>
</table>

USD: Assets: USD 846.79  Profits: -USD 653.21
Save file

Last, save the GnuCash data file (gcashdata_6).

Reports

As we did in the previous chapters, let’s have a look at a Cash Flow, and a Transaction Report.

1. First let’s have a look at the Cash Flow report for the liability account Visa during the month of March.

   Select the cash flow report from Reports → Income & Expense → Cash Flow.

**Figure 7.11. The Cash Flow report for the month of March**

<table>
<thead>
<tr>
<th>Money into selected accounts comes from</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Checking</td>
<td>USD 300.00</td>
</tr>
<tr>
<td>Expenses:Clothes</td>
<td>USD 174.99</td>
</tr>
<tr>
<td><strong>Money In</strong></td>
<td><strong>USD 474.99</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Money out of selected accounts goes to</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Equity:Opening Balance</td>
<td>USD 500.00</td>
</tr>
<tr>
<td>Expenses:Car</td>
<td>USD 25.00</td>
</tr>
<tr>
<td>Expenses:Clothes</td>
<td>USD 174.99</td>
</tr>
<tr>
<td>Expenses:Food</td>
<td>USD 25.00</td>
</tr>
<tr>
<td>Expenses:Groceries</td>
<td>USD 85.00</td>
</tr>
<tr>
<td>Expenses:Household</td>
<td>USD 100.00</td>
</tr>
<tr>
<td>Expenses:Interest</td>
<td>USD 20.00</td>
</tr>
<tr>
<td><strong>Money Out</strong></td>
<td><strong>USD 929.99</strong></td>
</tr>
<tr>
<td><strong>Difference</strong></td>
<td><strong>-USD 455.00</strong></td>
</tr>
</tbody>
</table>

This image shows the Cash Flow report after Chapter 7, *Credit Cards*.

2. Now let’s have a look at corresponding transaction report for the Visa account.

   Select the transaction report from Reports → Transaction Report.
Figure 7.12. The Transaction Report for the Visa account during March/April

**Transaction Report**

**From 01/03/06 To 30/04/06**

<table>
<thead>
<tr>
<th>Date</th>
<th>Num</th>
<th>Description</th>
<th>Transfer from/to</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visa</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>March 2006</td>
<td></td>
<td>Opening Balance</td>
<td>Opening Balance</td>
<td>USD 500.00</td>
</tr>
<tr>
<td>05/03/06</td>
<td></td>
<td>Partial Payment</td>
<td>Checking</td>
<td>-USD 300.00</td>
</tr>
<tr>
<td>Total For March 2006</td>
<td></td>
<td></td>
<td></td>
<td>USD 200.00</td>
</tr>
<tr>
<td>April 2006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03/04/06</td>
<td></td>
<td>Jeans R Us</td>
<td>Clothes</td>
<td>USD 74.99</td>
</tr>
<tr>
<td>05/04/06</td>
<td></td>
<td>Jeans R Us</td>
<td>Clothes</td>
<td>-USD 74.99</td>
</tr>
<tr>
<td>10/04/06</td>
<td></td>
<td>Greasy Spoon Cafe</td>
<td>Food</td>
<td>USD 25.00</td>
</tr>
<tr>
<td>11/04/06</td>
<td></td>
<td>Faux Pas Fashion</td>
<td>Clothes</td>
<td>USD 100.00</td>
</tr>
<tr>
<td>12/04/06</td>
<td></td>
<td>Premium Gasolin</td>
<td>Car</td>
<td>USD 25.00</td>
</tr>
<tr>
<td>13/04/06</td>
<td></td>
<td>Groceries R Us</td>
<td>Split</td>
<td>USD 125.00</td>
</tr>
<tr>
<td>13/04/06</td>
<td></td>
<td>CheapMart</td>
<td>Household</td>
<td>USD 60.00</td>
</tr>
<tr>
<td>15/04/06</td>
<td></td>
<td>Faux Pas Fashion - Refund</td>
<td>Clothes</td>
<td>-USD 100.00</td>
</tr>
<tr>
<td>30/04/06</td>
<td></td>
<td>Interest</td>
<td>Interest</td>
<td>USD 20.00</td>
</tr>
<tr>
<td>Total For April 2006</td>
<td></td>
<td></td>
<td></td>
<td>USD 255.00</td>
</tr>
<tr>
<td>Total For Visa</td>
<td></td>
<td></td>
<td></td>
<td>USD 455.00</td>
</tr>
</tbody>
</table>

This image shows the Transaction Report for the Visa account during March/April.

3. Now let’s change the transaction report to only show the various Expenses accounts.
Figure 7.13. The Transaction Report for the Expenses accounts during April

**Transaction Report**

**From 01/04/06 To 30/04/06**

<table>
<thead>
<tr>
<th>Date</th>
<th>Num</th>
<th>Description</th>
<th>Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/04/06</td>
<td>Premium Gasolin</td>
<td>Car</td>
<td></td>
<td>USD 25.00</td>
</tr>
<tr>
<td></td>
<td>Total For Car</td>
<td></td>
<td>USD 25.00</td>
<td></td>
</tr>
<tr>
<td>03/04/06</td>
<td>Jeans R Us</td>
<td>Clothes</td>
<td></td>
<td>USD 74.99</td>
</tr>
<tr>
<td>05/04/06</td>
<td>Jeans R Us</td>
<td>Clothes</td>
<td></td>
<td>-USD 74.99</td>
</tr>
<tr>
<td>11/04/06</td>
<td>Faux Pas Fashion</td>
<td>Clothes</td>
<td></td>
<td>USD 100.00</td>
</tr>
<tr>
<td>15/04/06</td>
<td>Faux Pas Fashion - Refund</td>
<td>Clothes</td>
<td></td>
<td>-USD 100.00</td>
</tr>
<tr>
<td></td>
<td>Total For Clothes</td>
<td></td>
<td>USD 0.00</td>
<td></td>
</tr>
<tr>
<td>10/04/06</td>
<td>Greasy Spoon Cafe</td>
<td>Food</td>
<td></td>
<td>USD 25.00</td>
</tr>
<tr>
<td></td>
<td>Total For Food</td>
<td></td>
<td>USD 25.00</td>
<td></td>
</tr>
<tr>
<td>13/04/06</td>
<td>Groceries R Us</td>
<td>Groceries</td>
<td></td>
<td>USD 85.00</td>
</tr>
<tr>
<td></td>
<td>Total For Groceries</td>
<td></td>
<td>USD 85.00</td>
<td></td>
</tr>
<tr>
<td>13/04/06</td>
<td>Groceries R Us</td>
<td>Household</td>
<td></td>
<td>USD 40.00</td>
</tr>
<tr>
<td>13/04/06</td>
<td>CheapMart</td>
<td>Household</td>
<td></td>
<td>USD 60.00</td>
</tr>
<tr>
<td></td>
<td>Total For Household</td>
<td></td>
<td>USD 100.00</td>
<td></td>
</tr>
<tr>
<td>30/04/06</td>
<td>Interest</td>
<td>Interest</td>
<td></td>
<td>USD 20.00</td>
</tr>
<tr>
<td></td>
<td>Total For Interest</td>
<td></td>
<td>USD 20.00</td>
<td></td>
</tr>
<tr>
<td>28/04/06</td>
<td>May Rent</td>
<td>Rent</td>
<td></td>
<td>USD 350.00</td>
</tr>
<tr>
<td></td>
<td>Total For Rent</td>
<td></td>
<td>USD 350.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Grand Total</strong></td>
<td></td>
<td>USD 605.00</td>
<td></td>
</tr>
</tbody>
</table>

This image shows the Transaction Report for the various Expense accounts during April.
Chapter 8. Loans

This chapter explains how to manage your loans with GnuCash.

Basic Concepts

A loan is defined as a financial transaction in which someone pays for the use of someone else’s money. There are many familiar examples of loans: credits cards, auto loans, house mortgages, or a business loan.

Terminology

Before discussing tracking loan in GnuCash specifically, it will be helpful to present a glossary of terminology. The terms presented below represent some of the basic concepts found concerning loans. It is a good idea to become familiar with these terms, or at least, refer back to this list if you encounter an unfamiliar word in the later sections.

Amortization

The repayment plan which will insure that a loan is eventually paid off, typically utilizing equal valued monthly payments. These payments are usually split into principal and interest, where the amount of principal per payment increases (and interest decreases) as the amortization period elapses.

Borrower

The person or company that receives the money from a loan.

Default

The time when a borrower fails to repay a loan according to the terms agreed upon with the lender.

Deferment

A temporary delay in the repayment of a loan.

Delinquency

It is the term that refers to late payments.

Disbursement

An amount of the loan paid to the borrower. Some loans have multiple disbursements, meaning the borrower does not receive the full amount of the loan at one time.

Interest

The expense charged by the lender to the borrower for the use of the money loaned. This is typically expressed in terms of a yearly percentage charged on the principal borrowed, known as the Annual Percentage Rate or APR.

Lender

The company or person who lends money to a borrower.
Loans

Loan Fee

A processing fee removed from the principal at the time the borrower receives a loan.

Principal

The original amount of the loan, or the amount of the original loan that is still owed. When you make a monthly payment on a loan, part of the money pays the interest, and part pays the principal.

Promissory Note

The legal agreement between the borrower and lender concerning the loan.

Setting Up Accounts

When a borrower obtains a loan, it is usually with the intention to make a purchase of something of value. In fact, most loans require the borrower to buy some predetermined asset, such as a house. This asset is insurance against the borrower defaulting on the loan. There are, of course, examples of loans which do not necessarily have an associated high value asset, such as educational loans.

For the account structure presented here, we will assume the loan was used to purchase a compensating asset.

A loan is a liability, the interest you accrue on the loan is an on-going expense, and any administrative fees you may have to pay would be another expense. The thing purchased with the money from a loan is an asset. With these parameters, we can now present a basic loan account structure:

Basic Loan Account Structure

-Asset
  -Current Assets
  -Saving
  -Fixed Assets
  -Asset Purchased
- Liability
  -Loans
    -Mortgage Loan
-Expenses
  -Interest
    -Mortgage Interest
  -Mortgage Adm Fees

GnuCash has a number of predefined loan account hierarchies available, including Car Loans and Home Mortgage Loans. To access these predefined account structures, click on Actions → New Account Hierarchy... and select the loan types in which you are interested.

Calculations

Determining loan amortization schedules, periodic payment amounts, total payment value, or interest rates can be somewhat complex. To help facilitate these kinds of calculations, GnuCash has a built-in Loan Repayment Calculator. To access the calculator, go to Tools → Loan Repayment Calculator.
Loans

Figure 8.1. Loan Repayment Calculator

The GnuCash Loan Repayment Calculator.

The Loan Repayment Calculator can be used to calculate any one of the parameters: Payment Periods, Interest Rate, Present Value, Periodic Payment, or Future Value given that the other 4 have been defined. You will also need to specify the compounding and payment methods.

Payment Periods

The number of payment periods.

Interest Rate

The nominal interest rate of the loan, i.e., the yearly interest rate.

Present Value

The present value of the loan, i.e., current amount owed on the loan.

Periodic Payment

The amount to pay per period.

Future Value

The future value of the loan, i.e., the amount owed after all payment periods are over.

Compounding

Two interest compounding methods exist, discrete or continuous. For discrete compounding select the compounding frequency from the popup menu with a range from yearly to daily.

Payments

The popup menu allows you to select the payment frequency with a range from yearly to daily. You can also select whether your payments occur at the beginning or end of the period. Payments made
at the beginning of the payment period have interest applied to the payment as well as any previous money paid or money still owed.

**Example: Monthly Payments**

What is your monthly payment on a $100,000 30 year loan at a fixed rate of 4% compounded monthly?

This scenario is shown in the example image above. To perform this calculation, set Payment Periods to 360 (12 months x 30 years), Interest Rate to 4, Present Value to 100000, leave Periodic Payment empty and set Future Value to 0 (you do not want to owe anything at the end of the loan). Compounding is Monthly, Payments are Monthly, assume End of Period Payments, and Discrete Compounding. Now, click on the Calculate button next to the Periodic Payment area. You should see $-477.42.

Answer: You must make monthly payments of 477.42.

**Example: Length of Loan**

How long will you be paying back a $20,000 loan at 10% fixed rate interest compounded monthly if you pay $500 per month?

To perform this calculation, leave Payment Periods empty, set Interest Rate to 10, Present Value to 20000, Periodic Payment is -500, and Future Value is 0 (you do not want to owe anything at the end of the loan). Compounding is Monthly, Payments are Monthly, assume End of Period payments, and Discrete Compounding. Now, click on the Calculate. You should see 49 in the Payment Periods field.

Answer: You will pay off the loan in 4 years and 1 month (49 months).

**Advanced: Calculation Details**

In order to discuss the mathematical formulas used by the Loan Repayment Calculator, we first must define some variables.

```
n   == number of payment periods
%i  == nominal interest rate, NAR, charged
PV  == Present Value
PMT == Periodic Payment
FV  == Future Value
CF  == Compounding Frequency per year
PF  == Payment Frequency per year
```

Normal values for CF and PF are:

```
1   == annual
2   == semi-annual
3   == tri-annual
4   == quarterly
6   == bi-monthly
12  == monthly
24  == semi-monthly
26  == bi-weekly
52  == weekly
360 == daily
365 == daily
```
Converting between nominal and effective interest rate

When a solution for n, PV, PMT or FV is required, the nominal interest rate (i) must first be converted to the effective interest rate per payment period (ieff). This rate, ieff, is then used to compute the selected variable. When a solution for i is required, the computation produces the effective interest rate (ieff). Thus, we need functions which convert from i to ieff, and from ieff to i.

To convert from i to ieff, the following expressions are used:
Discrete Interest:  \( \text{ieff} = (1 + i/\text{CF})^{\text{CF}/\text{PF}} - 1 \)
Continuous Interest:  \( \text{ieff} = e^{i/\text{PF}} - 1 = \exp(i/\text{PF}) - 1 \)

To convert from ieff to i, the following expressions are used:
Discrete Interest:  \( i = \text{CF} \times [(1+\text{ieff})^{\text{PF}/\text{CF}} - 1] \)
Continuous Interest:  \( i = \ln[(1+\text{ieff})^{\text{PF}}] \)

Note

In the equations below for the financial transaction, all interest rates are the effective interest rate, “ieff”. For the sake of brevity, the symbol will be shortened to just “i”.

The basic financial equation

One equation fundamentally links all the 5 variables. This is known as the fundamental financial equation:

\[ PV \times (1 + i)^n + PMT \times (1 + iX) \times [(1+i)^n - 1]/i + FV = 0 \]

Where:  \( X = 0 \) for end of period payments, and  
\( X = 1 \) for beginning of period payments

From this equation, functions which solve for the individual variables can be derived. For a detailed explanation of the derivation of this equation, see the comments in the file libgnucash/app-utils/calculation/fin.c from the GnuCash source code. The A, B, and C variables are defined first, to make the later equations simpler to read.

\[ A = (1 + i)^n - 1 \]
\[ B = (1 + iX)/i \]
\[ C = PMT \times B \]

\[ n = \ln[(C - FV)/(C + PV)]/\ln((1 + i)) \]
\[ PV = -[FV + A \times C]/(A + 1) \]
\[ PMT = -[FV + PV \times (A + 1)]/[A \times B] \]
\[ FV = -[PV + A \times (PV + C)] \]

The solution for interest is broken into two cases. The simple case for when \( PMT = 0 \) gives the solution:
\[ i = [(FV/PV)^{(1/n)} - 1] \]

The case where \( PMT \neq 0 \) is fairly complex and will not be presented here. Rather than involving an exactly solvable function, determining the interest rate when \( PMT \neq 0 \) involves an iterative process. Please see the libgnucash/app-utils/calculation/fin.c source file for a detailed explanation.
Example: Monthly Payments

Let’s recalculate the section called “Example: Monthly Payments”, this time using the mathematical formulas rather than the Loan Repayment Calculator. What is your monthly payment on a $100,000 30 year loan at a fixed rate of 4% compounded monthly?

First, let’s define the variables: \( n = (30*12) = 360 \), \( PV = 100000 \), \( PMT = \text{unknown} \), \( FV = 0 \), \( i = 4\% = 4/100 = 0.04 \), \( CF = PF = 12 \), \( X = 0 \) (end of payment periods).

The second step is to convert the nominal interest rate \( i \) to the effective interest rate \( i_{eff} \). Since the interest rate is compounded monthly, it is discrete, and we use: \( i_{eff} = (1 + i/CF)^{CF/PF} - 1 \), which gives \( i_{eff} = (1 + 0.04/12)^{12/12} - 1 \), thus \( i_{eff} = 1/300 = 0.0033333 \).

Now we can calculate \( A \) and \( B \). \( A = (1 + i)^n - 1 = (1 + 1/300)^{360} - 1 = 2.313498 \). \( B = (1 + iX)/i = (1 + (1/300)*0)/(1/300) = 300 \).

With \( A \) and \( B \), we can calculate \( PMT \). \( PMT = -[FV + PV*(A + 1)]/[A*B] = [-[0 + 100000*(2.313498 + 1)] / [2.313498 * 300] = -331349.8 / 694.0494 = -477.415296 = -477.42 \).

Answer: You must make monthly payments of 477.42.

House Mortgage (How-To)

A house mortgage can be setup using the account structure present in the section called “Setting Up Accounts”.

As an example, assume you have $60,000 in you Saving account, and you buy a $150,000 house. The mortgage is charging 6% APR, and has administrative fees (closing costs, etc) of 3%. You decide to put $50,000 down, and thus will need to borrow $103,000, which will give you $100 after the closing costs are paid (3% of $100,000).

Your accounts before borrowing the money:
The purchase of the house is recorded with a split transaction in the *Assets:Fixed Assets:House* account, with $50,000 coming from the bank (i.e., your down payment), and $100,000 coming from the Mortgage. You can place the $3,000 closing costs in the same split, and we increase the house loan to $103,000 to include the closing costs as well.

### Table 8.1. Buying a House Split Transaction

<table>
<thead>
<tr>
<th>Account</th>
<th>Increase</th>
<th>Decrease</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Fixed Assets:House</td>
<td>$150,000</td>
<td></td>
</tr>
<tr>
<td>Assets:Current Assets:Bank</td>
<td></td>
<td>$50,000</td>
</tr>
</tbody>
</table>
Loans

| Liabilities: Loans: Mortgage Loan | $103,000 |
| Expenses: Mortgage Adm Fees | $3,000 |

The split will look like this in the `Assets: Fixed Assets: House` Account:

**Figure 8.3. Mortgage Split Transaction**

Which will give a Chart of Accounts like this:
Automobile Loan (How-To)

The automobile Loan, or in common terms, car Loan, is treated more or less exactly as the house loan. The only difference is different accounts, and different interest rates. The basic car loan account structure is as follows:

-Asset
  -Current Assets
  -Saving
  -Fixed Assets
  -Car
A Personal Loan to a friend (How-To)

It is not always you are borrowing money from the bank, sometimes you borrow money from your family, or perhaps even lend money to a friend. This How-To chapter will describe one way to handle lending money to a friend.

We are basing this How-To on the following generic account structure.

-Asset
  -Bank
    -Bank Account
  -Money owed to you
    -Person
-Income
  -Interest Income
    -Person

This example will show how to track a personal loan of 2,000 USD (default currency) to your friend Peter.

Loan Specifications

Peter wants to borrow $2,000 dollars from you and plans to pay you back monthly for the next 18 months. Since he is your friend, (but not that close) you both agree on a yearly interest rate of 5%.

In summary we have the below details. Peter's loan details:

- Principal Amount - $2,000
- Term - 18 months with 12 payments per year
- Annual Percentage Rate: 5%
- Monthly Payment : ??

So how do you calculate the Monthly Payment?

You have a number of different options, like paper and pen, Linux Calculator, Apache OpenOffice/LibreOffice Calc module, but the easiest is to use GnuCash Loan Repayment Calculator. This tells you that the Monthly Payment should be $115.56.

But you need to know how much of this is Interest and how much is Principal to be able to do a proper bookkeeping. For this you need a more powerful tool, something like the Calc module in Apache OpenOffice/LibreOffice, and in particular the PMT function.
Figure 8.5. Calculation Of Private Loan Details

<table>
<thead>
<tr>
<th></th>
<th>Start Amount</th>
<th>Interest</th>
<th>Principal</th>
<th>End Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loan Amount</td>
<td>$2,000.00</td>
<td></td>
<td></td>
<td>$2,000.00</td>
</tr>
<tr>
<td>Number of months</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payments per year</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interest per year</td>
<td>5%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monthly payment</td>
<td>$115.56</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Bank:USD</td>
<td>1785.10</td>
<td>1806.67</td>
<td>1806.67</td>
<td>1785.10</td>
<td>1785.10</td>
<td>1785.10</td>
<td>1785.10</td>
<td>1785.10</td>
</tr>
<tr>
<td>Assets:Money owed to you:Peter</td>
<td>1072.33</td>
<td>1072.33</td>
<td>1072.33</td>
<td>1072.33</td>
<td>1072.33</td>
<td>1072.33</td>
<td>1072.33</td>
<td>1072.33</td>
</tr>
<tr>
<td>Income:Interest Income:Peter</td>
<td>1086.12</td>
<td>1086.12</td>
<td>1086.12</td>
<td>1086.12</td>
<td>1086.12</td>
<td>1086.12</td>
<td>1086.12</td>
<td>1086.12</td>
</tr>
</tbody>
</table>

Detailed view over the private loan to Peter

**Accounts for the loan**

Let’s start with the following accounts. They all have the same currency, in this case USD.

**Example 8.1. Accounts for the loan to Peter**

- Assets:Bank:USD
- Assets:Money owed to you:Peter
- Income:Interest Income:Peter
- Equity:Opening Balances:USD

**Lending the money**

When you have lent money to your friend, you have in fact moved money from an Asset account (like Bank, Checking or similar) to your Asset account _Money owed to you_. To record this you enter the following transaction into the _Assets:Money owed to you:Peter_ account.

**Table 8.2. Personal loan to Peter**

<table>
<thead>
<tr>
<th>Account</th>
<th>Increase</th>
<th>Decrease</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Money owed to you:Peter</td>
<td>$2,000</td>
<td></td>
</tr>
<tr>
<td>Assets:Bank:USD</td>
<td></td>
<td>$2,000</td>
</tr>
</tbody>
</table>
Receiving first payment

When the first payment ($115.56) is received, you will need to determine how much is for the principal loan, and how much is for the loan interest.

- Outstanding loan amount this period = $2,000
- Payment per month = $115.56
- Payment breakdown
  - 5%/12 * $2,000 = $8.33 Interest
  - $115.56 - $8.33 = $107.23 Principal

This can be translated to the following GnuCash entry
Loans

Figure 8.7. First Payment

Detailed view over first payment

The balance on Peter’s loan is now $2,000 - $107.23 = $1,892.77.

Receiving second payment

When the second payment ($115.56) is received, you will again need to determine how much is for the principal loan, and how much is for the loan interest.

• Outstanding loan amount this period = $1,892.77
• Payment per month = $115.56
• Payment breakdown
  • 5%/12 * $1,892.77 = $7.89 Interest
  • $115.56 - $7.89 = $107.67 Principal

This can be translated to the following GnuCash entry.

Figure 8.8. Second payment

Detailed view over the second payment

The balance on Peter’s loan is now $1,892.77 - $107.67 = $1,785.10.

The Chart of accounts looks now like this:
As you can see, the interest varies for every month, as well as the principal amount. So for every payment you receive you need to calculate the proper amounts for your various split entries.

The interest amount will be less and less for every payment (since it is calculated on a smaller loan amount all the time), until the last payment where it is more or less 0. Please review Detailed view over the private loan to Peter for more details.

Reconciling a loan statement is not different from reconciling a bank or credit card statement.

During the period you should have recorded all the various loan related transactions, and every one of them are touching the Liability:Loans:Loan account. For instance, paying off a bit of the loan decreases your Bank Account and Loan account, and increases the Loan Interest as well as perhaps Loan administration fee.

With the loan statement in your hands, open the Loan account, start the reconcile assistant, and tick of all the various transaction you have recorded. When you have finished, the reconciling difference should be
Loans

0, and if it is not, then you will have to go through the account and compare it with the loan statement to find the difference. When you have reached a 0 in difference, then your loan account is reconciled and you can finish the Reconcile assistant.

For more information on how to Reconcile, please check the section called “Reconciliation”.

**Selling a house or a car (How-To)**

When you will record the selling of your house in GnuCash you have some different options. Here we will go through two of them, one in which you only recorded the purchase amount, and now the selling amount. The other where you have followed the ups and downs on the property market and registered various Unrealized gains over the time.

**Simple Transaction**

In this way you only record the proper sale amount.

Let’s work through two samples of selling a house, one with a profit, and one with a loss. If you want to sell a car instead, just substitute the house account with a car account.

- **Assets**
  - Fixed Assets
    - House
  - Current Assets
  - Saving
  - Income
    - Capital Gains Long
    - House

- You bought a house for $300,000 once upon a time, and now managed to sell it for $600,000. How do you record this?

To record this you need to increase your Saving account with the $600,000, and decrease some other accounts with $600,000. The house account only contains $300,000 which is what you bought it for, so you move this amount to your Saving account. That means you are lacking $300,000. This amount you fetch from the *Income:Capital Gains Long:House* account. The split transaction you enter into your Saving account (*Assets:Current Assets:Saving*) should look like this.

**Table 8.3. Selling an asset (house) with a profit**

<table>
<thead>
<tr>
<th>Account</th>
<th>Increase</th>
<th>Decrease</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Current Assets:Saving</td>
<td>$600,000</td>
<td></td>
</tr>
<tr>
<td>Assets:Fixed Assets:House</td>
<td></td>
<td>$300,000</td>
</tr>
<tr>
<td>Income:Capital Gains Long:House</td>
<td></td>
<td>$300,000</td>
</tr>
</tbody>
</table>

- You bought a house for $300,000 once upon a time, but due to a newly created airport, could only sell it for $230,000. How do you record this?

To record this you need to increase your Saving account with the $230,000, and decrease some other accounts with $230,000. The house account contains $300,000 which is more than what you sold it for. So let’s move $230,000 of it to your Saving account. After this you have $70,000 remaining in
your house account which needs to be removed. You move it to our Income:Capital Gains Long:House account, which will indicate a loss. The split transaction you enter into your house account (Assets:Fixed Assets:House) should look like this.

Table 8.4. Selling an asset (house) with a loss

<table>
<thead>
<tr>
<th>Account</th>
<th>Increase</th>
<th>Decrease</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Fixed Assets:House</td>
<td></td>
<td>$300,000</td>
</tr>
<tr>
<td>Assets:Current Assets:Saving</td>
<td>$230,000</td>
<td></td>
</tr>
<tr>
<td>Income:Capital Gains Long:House</td>
<td>$70,000</td>
<td></td>
</tr>
</tbody>
</table>

A More Complex Transaction

In this example, we will touch a little on some more complicated accounting principles. For more details on this subject, please check Chapter 11, Capital Gains.

Here we will only touch on the case when you have accurately estimated the current value of your house. For the other cases (over-, and under-estimated), please check Chapter 11, Capital Gains.

-Assets
  -Fixed Assets
    -House
    -Cost
    -Unrealized Gain
  -Current Assets
    -Saving
-Income
  -Realized Gain
    -House
    -Unrealized Gain
    -House

You bought a house for $300,000 once upon a time, and over the years kept a close look on the market and updated your records with the estimated current value of your house. At the time you want to sell it, you have determined that the current market value is $600,000.

The difference between $600,000 (estimated market value) and $300,000 (purchase value) is the current Unrealized Gain value. Therefore you have a total of $300,000 in your Assets:Fixed Assets:House:Unrealized Gain account

How do you record this sell transaction?

To record this you need to increase your Saving account with the $600,000, and decrease some other accounts with $600,000. You must first change from unrealized gain to realized gain for your Income accounts. Lastly you need to transfer the full amounts from the Assets:Fixed Assets:House sub-accounts.

The transaction you enter into your Income:Realized Gain:House account should look like this.

Table 8.5. Selling an asset (house) with a profit

<table>
<thead>
<tr>
<th>Account</th>
<th>Increase</th>
<th>Decrease</th>
</tr>
</thead>
</table>

120
The transaction you enter into your Assets:Current Assets:Saving account should look like this.

### Table 8.6. Selling an asset (house) with a profit 2

<table>
<thead>
<tr>
<th>Account</th>
<th>Increase</th>
<th>Decrease</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Current Assets:Saving</td>
<td>$600,000</td>
<td></td>
</tr>
<tr>
<td>Assets:Fixed Assets:House:Cost</td>
<td></td>
<td>$300,000</td>
</tr>
<tr>
<td>Assets:Fixed Assets:House:Unrealized Gain</td>
<td></td>
<td>$300,000</td>
</tr>
</tbody>
</table>

After having recorded these transactions you see that your House Asset have a value of 0, your Saving account have increased with $600,000, and lastly, the Income:Realized Gain have increased to $300,000.
Chapter 9. Investments

This chapter explains how to manage your investments with GnuCash. Most people have an investment plan, whether it's just putting money into a certificate of deposit (CD for short) account, investing through a company sponsored plan at your workplace or buying and selling stocks and bonds through a brokerage. GnuCash gives you tools to help you manage these investments such as the Price Database which allows you to record changes in the prices of stocks you own.

Basic Concepts

An investment is something that you purchase in the hopes of generating income, or that you hope to sell in the future for more than you paid. Using this simple definition, many things could be considered investments: the house you live in, a valuable painting, stocks in publicly traded companies, your savings account at the bank, or a certificate of deposit. These many types of investments will be discussed in this chapter in terms of how to track them using GnuCash.

Terminology

Before discussing investments specifically, it will be helpful to present a glossary of investment terminology. The terms presented below represent some of the basic concepts of investing. It is a good idea to become familiar with these terms, or at least, refer back to this list if you encounter an unfamiliar word in the later sections.

Capital gains
The difference between the purchase and selling prices of an investment. If the selling price is lower than the purchase price, this is called a capital loss. Also known as realized gain/loss.

Commission
The fee you pay to a broker to buy or sell securities.

Common stock
A security that represents a certain fractional ownership of a company. This is what you buy when you “buy stock” in a company on the open market. This is also sometimes known as capital stock.

Compounding
The concept that the reinvested interest can later earn interest of its own (interest on interest). This is often referred to as compound interest.

Dividends
Dividends are cash payments a company makes to shareholders. The amount of this payment is usually determined as some amount of the profits of the company. Note that not all common stocks give dividends.

Equities
Equities are investments in which the investor becomes part (or whole) owner in something. This includes common stock in a company, or real estate.
Investments

Interest

What a borrower pays a lender for the use of their money. Normally, this is expressed in terms of a percentage of the principal per year. For example, a savings account with 1% interest (you are the lender, the bank is the borrower) will pay you $1 for every $100 you keep there per year.

Liquidity

A measure of how easily convertible an investment is to cash. Money in a savings account is very liquid, while money invested in a house has low liquidity because it takes time to sell a house.

Principal

The original amount of money invested or borrowed.

Realized vs Unrealized Gain/Loss

Unrealized gain or loss occurs when you’ve got a change in price of an asset. You realize the gain/loss when you actually sell the asset. See also Capital gains.

Return

The total income plus capital gains or losses of an investment. See also Yield.

Risk

The probability that the return on investment is different from what was expected. Investments are often grouped on a scale from low risk (savings account, government bonds) to high risk (common stock, junk bonds). As a general rule of thumb, the higher the risk the higher the possible return.

Shareholder

A shareholder is a person who holds common stock in a company.

Stock split

Occurs when a company offers to issue some additional multiple of shares for each existing stock. For example, a “2 for 1” stock split means that if you own 100 shares of a stock, you will receive an additional 100 at no cost to you. The unit price of the shares will be adjusted so there is no net change in the value, so in this example the price per share will be halved.

Valuation

The process of determining the market value or the price the investment would sell at in a “reasonable time frame”.

Yield

A measure of the amount of money you earn from an investment (That is how much income you receive from the investment). Typically this is reported as a percentage of the principal amount. Yield does not include capital gains or loses (see Return). For example, a stock sells for $100 and gives $2 in dividends per year has a yield of 2%.

Types of Investments

Below is presented some of the broad types of investments available, and examples of each type.
Investments

• **Interest-bearing account or instrument**

This type of investment usually allows you immediate access to your money, and will typically pay you interest every month based on the amount of money you have deposited. Examples are bank savings accounts (and some interest bearing checking accounts) and cash accounts at your brokerage. This is a very low risk investment, in the US these accounts are often insured against loss, to a specified limit.

Sometimes an interest bearing investment is *time-locked*. This type of investment requires you to commit your money to be invested for a given period of time for which you receive a set rate of return. Usually, the longer you commit the higher the interest rates. If you withdraw your money before the maturity date, you will usually have to pay an early withdrawal penalty. This is a relatively lower risk investment. Examples are certificates of deposit or some government bonds. Other types of Bonds may have higher yields based on the higher risks from the quality of the issuer’s “credit rating”.

• **Stocks and Mutual Funds**

This is an investment you make in a company, in which you effectively become a part owner. There is usually no time lock on publicly traded stock, however there may be changes in the tax rates you pay on capital gains depending on how long you hold the stock. Thus, stocks are typically quite liquid, you can access your money relatively quickly. This investment is a higher risk, as you have no guarantee on the future price of a stock.

A mutual fund is a group investment mechanism in which you can buy into many stocks simultaneously. For example, a “S&P 500 index fund” is a fund which purchases all 500 stocks listed in the Standard and Poor’s index. When you buy a share of this fund, you are really buying a small amount of each of the 500 stocks contained within the fund. Mutual funds are treated exactly like a single stock, both for tax purposes and in accounting.

• **Fixed Assets**

Assets that increase in value over time are another form of investment. Examples include a house, a plot of land, or a valuable painting. This type of investment is very difficult to determine the value of until you sell it. The tax implications of selling these items is varied, depending on the item. For example, you may have tax relief from selling a house if it is your primary residence, but may not receive this tax break on an expensive painting.

Fixed asset investments are discussed in Chapter 11, *Capital Gains* and Chapter 16, *Depreciation*. Typically, there is not much to do in terms of accounting for fixed asset investments except recording the buying and selling transactions.

### Setting Up Accounts

To setup investment accounts in GnuCash you can either use the predefined investment account hierarchy or create your own. The minimum you need to do to track investments is to setup an asset account for each type of investment you own. However, as we have seen in previous chapters, it is usually more logical to create a structured account hierarchy, grouping related investments together. For example, you may want to group all your publicly traded stocks under a parent account named after the brokerage firm you used to buy the stocks.

**Note**

Regardless of how you setup your account hierarchy, remember that you can always move accounts around later (without losing the work you’ve put into them), so your initial account hierarchy does not have to be perfect.
Using Predefined Investment Accounts

The Investment Accounts option of the New Account Hierarchy Setup assistant will automatically create a basic investment account hierarchy for you. To access the predefined investment accounts hierarchy, you must make sure your GnuCash file is open, switch to the Accounts tab, and choose Actions → New Account Hierarchy. This will run the New Account Hierarchy Setup assistant and allow you to select additional accounts to add to your account hierarchy. Choose the Investment Accounts option (along with any others you are interested in). Assuming only investment accounts were selected, this will create an account hierarchy as shown below.

Tip

You can also run the New Account Hierarchy Setup assistant by creating a new GnuCash file.

Figure 9.1. A New File Containing Only The Default Investment Accounts

This is a screen image of the Accounts tab after creating a new file and selecting only the default investment accounts.

You will probably at least want to add a Bank account to the Assets account and probably an Equity:Opening Balances account, as we have done in previous chapters. Don’t forget to save your new account file with a relevant name!

Creating Investment Accounts Manually

If you want to set up your own investment accounts hierarchy, you may of course do so. Investments usually have a number of associated accounts that need to be created: an asset account to track the investment itself; an income account to track dividend transactions; and expense accounts to track investment fees and commissions.
In a typical account structure, security accounts are sub accounts of an asset account representing an account at a brokerage firm. The brokerage account would be denominated in your local currency and it would include sub accounts for each security that you trade there.

Related purchases, sales, income and expense accounts should also be in the same currency as the brokerage account.

The security sub accounts would each be configured to contain units of a single security selected from the master (user defined) security list and they are expected to use the same currency as the brokerage account.

Security prices are kept in the Price Database of GnuCash (see the section called “Setting Share Price”). This contains prices for individual securities (not security accounts). All prices for an individual security are in a single currency. If a security is traded in multiple currencies, then a separate security and separate accounts should be set up for each currency.

**Custom Accounts Example**

The following is a somewhat more complicated example of setting up GnuCash to track your investments, which has the advantage that it groups each different investment under the brokerage that deals with the investments. This way it is easier to compare the statements you get from your brokerage with the accounts you have in GnuCash and spot where GnuCash differs from the statement.

```
Assets
Investments
  Brokerage Accounts
    I*Trade
      Stocks
        ACME Corp
      Money Market Funds
        I*Trade Municipal Fund
    Cash
  My Stockbroker
    Money Market Funds
      Active Assets Fund
    Government Securities
      Treas Bond xxx
      Treas Note yyy
    Mutual Funds
      Fund A
      Fund B
    Cash

Income
  Investments
    Brokerage Accounts
      Capital Gains
        I*Trade
        My Stockbroker
      Dividends
        I*Trade
        Taxable
        Non-taxable
        My Stockbroker
        Taxable
```
Investments

Non-taxable
Interest Income
I*Trade
Taxable
Non-taxable
My Stockbroker
Taxable
Non-taxable

Expenses
Investment Expenses
Commissions
I*Trade
My Stockbroker
Management Fees
I*Trade
My Stockbroker

Tip

There really is no standard way to set up your investment account hierarchy. Play around, try different layouts until you find something which divides your investment accounts into logical groups which make sense to you.

Interest Bearing Accounts

Investments which have a fixed or variable rate of interest are one of the simplest and most common form of investments available. Interest bearing investments include your bank account, a certificate of deposit, or any other kind of investment in which you receive interest from the principal. This section will describe how to handle these kinds of investments in GnuCash.

Account Setup

When you purchase the interest bearing investment, you must create an asset account to record the purchase of the investment, an income account to record earnings from interest, and an expense account to record bank charges. Below is an account layout example, in which you have an interest bearing savings account and a certificate of deposit at your bank.

Assets
Bank ABC
Certificate of Deposit
Savings
Expenses
Bank ABC
Charges
Income
Interest Income
Certificate of Deposit
Savings

As usual, this account hierarchy is simply presented as an example, you should create your accounts in a form which best matches your actual situation.
Example

Now let’s populate these accounts with real numbers. Let’s assume that you start with $10,000 in your bank account, which pays 1% interest and you buy a $5,000 certificate of deposit with a 6 month maturity date and a 2% yield. Clearly, it is much better to keep your money in the certificate of deposit than in the savings account. After the initial purchase, your accounts should look something like this:

Figure 9.2. The Chart Of Accounts After Investing In A Certificate Of Deposit

![Chart of Accounts]

This is an image of the account register after creating and investing in a certificate of deposit investment.

Now, during the course of the next 6 months, you receive monthly bank statements which describe the activity of your account. In our fictional example, we do nothing with the money at this bank, so the only activity is income from interest and bank charges. The monthly bank charges are $2. After 6 months, the register window for the certificate of deposit and for the savings account should look like these:
**Figure 9.3. The CD Account After 6 Months**

This is an image of the register of the certificate of deposit account after 6 months.

**Figure 9.4. The Savings Account After 6 Months**

This is an image of the register of the Savings account after 6 months.

And this is the main GnuCash account window:
Figure 9.5. The Chart Of Accounts After 6 months

This a screen capture of the accounts after 6 months.

From the above image of the main GnuCash account window you see a nice summary of what happened to these investments over the 6 months. While the yield on the certificate of deposit is double that of the savings account, the return on the certificate of deposit was $50.21 versus $13.03 for the savings account, or almost 4 times more. Why? Because of the pesky $2 bank charges that hit the savings account (which counted for $12 over 6 months).

After this 6 month period, the certificate of deposit has reached maturity which means you may sell it with no early withdrawal penalty. To do so, simply transfer the $5,050.21 from the certificate of deposit account into the savings account.

Setup Investment Portfolio

Now that you have built an account hierarchy in the previous section, this section will show you how to create and populate the accounts with your investment portfolio. After this initial setup of your portfolio, you may have shares of stock purchased from before you started using GnuCash. For these stocks, follow the instructions in the Entering Preexisting Shares section. If you have just purchased your stocks, then use the Buying New Shares section.
Setup Accounts for Stocks and Mutual Funds

This section will show you how to add stocks and mutual fund accounts to GnuCash. In this section, we will assume you are using the basic account setup introduced in the previous section, but the principles can be applied to any account hierarchy.

You should have within the top level Asset account, a few levels down, an account entitled Stock. Open the account tree to this level by clicking on the “right facing triangle marker” signs next to the account names until the tree is opened to the depth of the new account. You will need to create a sub-account (of type stock) under the Stock account for every stock you own. Every stock is a separate account. The naming of these stock accounts is usually done using the stock ticker abbreviation, though account names may be anything that is clear to you and other users. So, for example, you could name your accounts AMZN, IBM and NST for your Amazon, IBM and NSTAR stocks respectively. Below is a schematic model of the layout (only showing the Assets sub-accounts).

Assets
   Investments
      Brokerage Accounts
         Bond
         Mutual Funds
         Market Index
         Stock
            AMZN
            IBM
            NST

Note

If you want to track income (dividends/interest/capital gains) on a per-stock or fund basis, you will need to create an Income:Dividends:STOCKSYMBOL, Income:Cap Gain (Long):STOCKSYMBOL, Income:Cap Gain (Short):STOCKSYMBOL and Income:Interest:STOCKSYMBOL account for each stock you own that pays dividends or interest.

Example Stock Account

As an example, let’s assume that you currently own 100 shares of Amazon stock. First, create the stock account AMZN by selecting the Stock account and click on the menu Actions+New Account…. The New Account dialog will appear, follow the steps, in the sequence below to setup your new stock account.
1. **Account Name** - Usually, use the stock ticker abbreviation, like “**AMZN**”.

2. **Account Code** - Optional field, use CUSIP, the newspaper listing symbol, mutual fund family ID or code of your own choosing.

3. **Description** - Optional field for detailed description of the commodity/stock. Note this field by default is displayed in the Account tab tree.

4. **Account Type** - Select the type of account you are creating from the lower left-hand list.

5. **Parent Account** - Select the parent account for the new account from the right hand listing. Expand list of accounts if necessary.

6. **Create the New Security** - To use a new stock, you must create the stock as a new commodity.

**Note**

Be sure to first select Account Type **Stock** or **Mutual Fund** so that the Select... button brings up the list of securities rather than currencies.

- **Select Security/Currency** - Click on the Select... button next to the Security/currency line. We must change the security from the default (your default currency) to this specific stock. This will bring up the Select Security dialog.

- **Type** - Select the exchange where the security/commodity is traded (in this example NASDAQ).
Select the New button to open the New Security window.

**Figure 9.7. The “Select Security” Window**

- **Create the Security** - Click on the New... button and enter the appropriate information for this stock on the new form New Security.

  - The Full name: is Amazon.com.

  - The Symbol/abbreviation: is AMZN. The symbol is the stock ticker used in your quote source several lines down on the form.

**Note**

Different symbols will be used on different price sources for the same stock, an example is Ericsson on the Stockholm Exchange is ERIC-B while on Yahoo it is ERRICB.ST.

- The Type: should already be NASDAQ, because this is what was selected in the security selector, but you can change it here, including adding more categories. More information about this can be found in the GnuCash Manual in section 8.7, “Security Editor”.

- The ISIN, CUSIP or other code is where you can enter some other coding number or text (leave it blank in this example).

- The Fraction traded should be adjusted to the smallest fraction of this security which can be traded, usually 1/100 or 1/10000.

- The checkbox “Get Online Quotes”, the quote source and the timezone should be selected to define the sources for updating prices on-line. See also the section called “Configuring for Automatic Retrieval of Quotes”.

**Note**

If the Get Online Quotes button is not highlighted, and it is not tickable, then the Finance::Quote package is not installed. See the chapter Setting Up the Quote Retrieval [https://www.gnucash.org/docs/v5/C/gnucash-manual/finance-quote.html] in the manual.

Below is what this window should look like when finished:
Investments

Figure 9.8. The “New Security” Window

- **Save Security** - Click on the OK button to save this new security, this will close the New Security window and return to the New Account window.

7. **Select the Security** - you should now see the newly created security available in the pull down menu for Security/Currency. Select it (it is probably already selected) and click on OK.

8. **Smallest Fraction** - Specify the smallest fraction of the security/commodity that is traded.

9. **Notes** - Enter any notes or messages related to this security/commodity.

10. **Tax Related** - Go to Edit → Tax Report Options to check this box if this account’s transactions will relate to Income Taxes.

11. **Placeholder** - Check box if this account is a “Placeholder”, that is it will contain no transactions.

12. **Finished** - You should now have been automatically returned to the New Account dialog, with the symbol/abbreviation: line set to “AMZN (Amazon.com)”. Click on OK to save this new stock account.

You have now created the Amazon stock account, your main account should look something like this (notice that there are a few extra accounts here, a bank account, and an equity account):
Figure 9.9. The Chart of Accounts After The Creation Of The First Stock Account

This image is after the creation of the first stock account (AMZN).

Open the account register window for this AMZN stock account (double click on it). Here you see the Commodity view. This gives you an overview of the transactions in this commodity including the number of units (shares for a stock or mutual fund) bought or sold, the net price per unit, and the total amount. Obviously, we have not bought or sold any shares of AMZN yet, so the register should not contain any transactions.

Buying Shares

Entering Preexisting Shares

The examples in this section use Transaction Journal view.

To register the initial 100 shares of this stock that you purchased previously, on the first (transaction) line, enter the date of the purchase (for example, Jan. 1 2005) and Description (for example, Opening Balance). On the first split line, enter 100 in Shares, delete the (unit) Price (it will be calculated when you Tab out of the split) and enter 2000 in the Buy column.

Note

It is also possible to use GnuCash to calculate Shares or Buy from the other 2 columns. But to avoid rounding errors, it is better to automatically calculate Price.

Tab to the second split line, enter transfer from account Equity:Opening Balances. For simplicity, this example assumed there were no commissions on this transaction. Your AMZN Commodity view should now appear like this:
Figure 9.10. The Transaction Register Of The AMZN Account After The First Purchase

This image is the transaction register of the AMZN account after the first stock “purchase”.

Notice that the Balance (last column) is in the units of the commodity (AMZN shares) not in currency units. Thus, the balance is 100 (AMZN units) rather than $2,000. This is how it should be.

**Buying New Shares**

The main difference between setting up a new stock purchase versus the setup for preexisting stocks as described in the previous section is that instead of transferring the money used to purchase the stock from the *Equity:Opening Balances* account, you transfer from your *Assets:Bank ABC* or *Assets:Brokerage Account* account.

**Handling Commissions and Fees**

For conciseness, this document will refer to the money you pay to a broker for buying and selling securities as *Commissions*. Government fees may also be payable. Unless otherwise stated, fees are handled in a similar way.

In GnuCash 2 alternate ways can be used to handle commissions (for simplicity this document section will refer to these ways as net pricing and gross pricing).

**Gross Pricing**

You enter the price not adjusted by commissions and enter the commissions expense on a separate split in the transaction. This enables the tracking of commissions but is not compatible with using the section called “Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots”. Scrubbing doesn’t know to deduct commissions and fees from the gains, so capital gains or losses must be manually calculated (see the section called “Selling Shares with Manual Calculation of Capital Gain or Loss”).

**Net Pricing**

You enter a net price (adjusted by commissions) when buying and selling securities. You do not also record commissions in a specific commissions account in order to later claim it as an expense, as this
would be claiming commissions twice. This way is compatible with using the section called “Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots”. This results in a slightly misleading price being added to the price database (the effective price you paid) but is not usually of any concern.

Please get professional advice if you are unsure which of these ways are applicable to your jurisdiction.

**Example: Buying Shares with Gross Pricing**

In this example you will purchase 100 shares at $50 per share of IBM stock with a commission of $100. First step will be to create the stock account for IBM. The existing Expenses:Commission account will be used.

Now for the transaction, on the first (transaction) line, enter the Date of the purchase (for example, Jan. 3, 2005) and Description (for example, Initial IBM Purchase). On the first split line, enter 50 in Shares, delete Price (leave it empty so it will be calculated), and enter 5000 in Buy. You do not need to fill in the Price column, as it will be calculated for you when you Tab to the next split. The next line in the split transaction will be Expenses:Commissions and fill 100 in Buy. The third split line will be to transfer $5,100 from Assets:Bank ABC account to balance the transaction. Your IBM Commodity view should now appear like this:

**Figure 9.11. The Transaction Register Of The IBM Account After The First Stock Purchase**

This image is of the transaction register of the IBM account after the first stock “purchase” with a commission.

**Example: Buying Shares with Net Pricing**

Repeating the previous example using Net Pricing instead of Gross Pricing, in Transaction Journal view.

Purchase $5,000 of IBM stock being 50 Shares for $100.00 each, plus a commission of $100.

Now for the transaction, on the first (transaction) line, enter the Date of the purchase (for example, Jan. 3, 2005) and Description (for example, Initial IBM Purchase). On the first split line, optionally enter more details in Memo, then 50 in Shares, delete anything in Price (so it will be calculated by dividing Buy by Shares when you Tab out of the split), 800px0 in Buy (50 * $100.00 + $100). Alternatively use GnuCash to calculate Buy by entering the formula 5000 + 100 or (50 * 100) + 100 in Buy (Buy will
investments

be calculated when you Tab out of the column.) Use the Tab key as many times as needed to proceed to the next split.

Do not enter a separate split for Commission as it has already been included in the Buy value. The second split line will be to transfer $5,100 from Assets: Bank ABC account to balance the transaction. After the splits are all correct, use the Enter key to save the transaction. Your IBM Commodity view should now appear like this:

**Figure 9.12. The IBM Account After The First Stock Purchase With A Commission**

![IBM Account After The First Stock Purchase With A Commission](image)

This image is of the transaction register of the IBM account after the first stock "purchase" with a commission.

### Setting Share Price

The value of a commodity, such as a stock, must be explicitly set. The stock accounts track the quantity of stocks you own, but the value of the stock is stored in the Price Database. The values set in the Price Database can be updated manually or automatically.

### Initial Price Database Setup

To use the Price Database to track a stock value, you must initially insert the stock. To do so, open the Price Database (Tools → Price Database) and click on Add button. The first time a Commodity/Stock is entered this window will be blank except for the control buttons on the bottom. Select the appropriate Commodity you want to insert into the Price Database. At this point, you can input the price of the commodity manually. There are 6 fields in the New Commodity window:

**Namespace**

- The exchange market where the security/commodity is traded (in this example NASDAQ.)

**Security**

- The name of the commodity, must be chosen from the Select... list.

**Currency**

- The currency in which the Price is expressed.
Date

Date that the price is valid.

Type

One of: Bid (the market buying price), Ask (the market selling price), Last (the last transaction price), Net Asset Value (mutual fund price per share, NAV for short), or Unknown. Stocks and currencies will usually give their quotes as one of bid, ask or last. Mutual funds are often given as net asset value. For other commodities, simply choose Unknown. This option is for informational purposes only, it is not used by GnuCash.

Price

The price of one unit of this commodity.

As an example of adding the AMZN commodity to the price database, with an initial value of $40.50 per share.

**Figure 9.13. Entering A Price Into The Database**

![Price Editor](image)

Adding the AMZN commodity to the price database, with an initial value of $40.50 per share.

Click OK when finished. Once you have performed this initial placement of the commodity into the Price Database, you will not have to do it again, even if you use the same commodity in another account.

**Note**

If you have online retrieval of quotes activated (see the section called “Configuring for Automatic Retrieval of Quotes”), you can initialize a commodity without manually making an entry. When you initially add the security in the Security Editor, check Get Online Quotes and save the security. Then, in the Price Database, click Get Quotes, and the new security will be inserted into the price list with the retrieved price.
Setting Stock Price Manually

If the value of the commodity (stock) changes, you can adjust the value by entering the Price Database, selecting the commodity, clicking on Edit and entering the new price.

Figure 9.14. The Price Database With The List Of All Known Commodities

The main price database window, showing the list of all known commodities.

Configuring for Automatic Retrieval of Quotes

If you have more than a couple of commodities, you will tire of having to update their prices constantly. GnuCash has the ability to automatically download the most recent price for your commodities using the Internet. This is accomplished through the Perl module Finance::Quote, which must be installed in order to activate this feature.


Configuring Securities for Online Quotes

With Finance::Quote installed and functioning correctly, you must configure your GnuCash securities to use this feature to obtain updated price information automatically. Whether creating new securities or modifying securities that have already been setup, use the Tools → Security Editor, to edit the security and check the Get Online Quotes box. You will now be able to modify the radio buttons for Type of quote source, the pull-down menus to specify the specific source(s) and The timezone for these quotes. When finished editing, Close the Security Editor to return to the Price Database and click on the Get Quotes button to update your stock prices on the Internet.

Configuring for Getting Online Quotes Periodically

After you have verified the proper fetching of Online Quotes for your commodities, you can tell your operating system to fetch the quotes periodically. See the section Updating Prices Automatically with gnucash-cli [https://www.gnucash.org/docs/v5/C/gnucash-manual/fq-command-line.html] in the manual.
Displaying Share Value

The main account window, by default, only shows the quantity of each commodity that you own, under the column heading Total. In the case of stocks, this commodity is the number of shares. Often, however, you will want to see the value of your stocks expressed in terms of some monetary unit. This is easily accomplished by entering the main window, selecting the Accounts tab, by clicking on the Titlebar Options button (the small down pointing arrow on the right side of the main account window titles bar), and selecting the option to display the account total field “Total (USD)”. You will see a new column in the main window entitled Total (USD) that will express the value of all commodities in the report currency.

Figure 9.15. Displaying Stock Values in the Chart of Accounts

Viewing the value of a stock commodity in the main window using the Total in Report Currency option.

The “Price Source” in Reports

Most GnuCash reports have options to set/modify a number of parameters for the report. The Options dialog box is displayed by selecting the report tab, then either clicking on the Options icon in the MenuBar or selecting Edit → Report Options. Price Source determines how accounts denominated in commodities different from the report currency are converted to the report currency. Depending on the report the selector may appear in either the General, the Commodities, or the Display tab of the Report Options dialog box.

Note

In the example the report can be customized using the Reports → Assets & Liabilities → Average Balance menu.
Figure 9.16. Determining The Source Of The Stock Price/Currency Exchange Rate in Reports

Determining the value of a stock commodity or a currency other than the report currency in a report by setting the Price Source option.

Weighted Average

Calculates the price by summing the absolute value of the amount and the absolute value of every split in every account denominated in the commodity, excluding those splits with a zero amount, and dividing the sum of values by the sum of amounts to obtain a price. For example, if you had a buy transaction for 200 shares of XYZ for a total of 2000 and a sell of 100 for 1300 the weighted average would be 3300/300 or 11/share.

Note

Gain/Loss splits have an amount of 0 and are not included in this calculation.

Average Cost

Calculates the price by summing the amounts and values of every split in every account denominated in the commodity, including the zero amount splits. In the example above, with an additional split (either part of the sale transaction or in a separate transaction) booking the gain at 0 shares and a 300 gain, the average cost is 1000/100 (2000 original cost - 1300 proceeds from the sale + 300 gain)/(200 - 100) shares or 10/share.

Note

• Gain/Loss splits are included in this calculation.

• This is the only Price Source that will balance the Trial Balance Report and in order for it to balance you must correctly book your gains and losses.
Most Recent

Uses the latest price from the price database.

Nearest in time

Uses the price nearest in time to the report date—the datum date for time series reports like Assets Over Time—from the price database.

Note

The nearest date isn’t necessarily before the date in question.

Figure 9.17. An Asset Barchart Report Based On The “Nearest In Time” Price Source

Tracking what value your stocks would’ve had on the stock exchanges.

Selling Shares

Entering an investment sale transaction is done in a similar way to entering a buy transaction (see the section called “Buying New Shares”) except the amount entered in the Shares column is negative and the proceeds of the transaction is entered in the Sell column. The net proceeds from the sale should be transferred from the shares account to your bank or brokerage account.

For information on handling commissions and the use of Net Pricing or Gross Pricing, please see the section called “Handling Commissions and Fees”. If you will be recording a capital gain or loss on the sale, please see Chapter 11, Capital Gains and Chapter 16, Depreciation for more information on this topic. To use the GnuCash Automatic Calculation of Capital Gain or Loss Using Lots feature, please see the section called “Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots” otherwise continue to the next section.
Selling Shares with Manual Calculation of Capital Gain or Loss

Note

In order for GnuCash to commit the zero-share, zero-price split for account Assets:Stock:SYM-BOL to the transaction in the following schemes, you must Tab out of that split. If you use the Enter key, GnuCash will convert the split into shares of the commodity.

In the schemes of transaction splits presented below, the following symbols are used:

NUM_SHARES
the number of shares you are selling

COMMISSION
brokerage commissions or fees

GROSS_SELL_PRICE
unit price for which you sold the shares, not reduced by COMMISSION

NET_SELL_PRICE
unit price for which you sold the shares, reduced by COMMISSION

GROSS_BUY_PRICE
unit price for which you bought the shares, not increased by COMMISSION

NET_BUY_PRICE
unit price for which you bought the shares, increased by COMMISSION

GROSS_BUY
total price for which you bought shares, excluding COMMISSION, equal to NUM_SHARES * GROSS_BUY_PRICE

NET_BUY
amount of money for which you bought shares including COMMISSION, equal to GROSS_BUY + COMMISSION

GROSS_SALE
total price for which you sold shares, equal to NUM_SHARES * GROSS_SELL_PRICE

NET_SALE
amount of money received from the sale, equal to GROSS_SALE - COMMISSION

GROSS_PROFIT
amount of money you made on the sale, not reduced by COMMISSION
NET_PROFIT

amount of money you made on the sale, reduced by COMMISSION

There are 2 ways of manually recording the capital gain or loss. The capital gain/loss can be combined with the sale in one transaction or it can be entered in a separate transaction.

Combine the Sale and Capital Gain/Loss in One Transaction

This has the advantage that all parts of the sale event are kept together. This is not compatible with using scrubbing (see the section called “Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots”). If you may in future use scrubbing on a specific security, save some work later by entering the capital gain/loss splits in a separate transaction now.

When the capital gain/loss splits are combined with the sale splits in one transaction, there are 2 splits for the security account in the same transaction, so the transaction must be entered with the security register in Auto-Split Ledger or Transaction Journal view. One of the splits for the security account is for the sale and the other is for the capital gain or loss. The security account split for the capital gain or loss must be entered with 0 number of shares and 0 price per share to stop the automatic recalculation of these fields.

Account for the profit or loss as coming from an Income:Capital Gains or Expenses:Capital Loss account.

Combined, Gross Pricing

Table 9.1. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Combined, Gross Pricing

<table>
<thead>
<tr>
<th>Account</th>
<th>Number of Shares</th>
<th>Share Price</th>
<th>Total Buy</th>
<th>Total Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Bank ABC</td>
<td></td>
<td></td>
<td>NET_SALE</td>
<td></td>
</tr>
<tr>
<td>Assets:Stock:SYMBOL</td>
<td>0</td>
<td>0</td>
<td>GROSS_PROFIT(Loss)</td>
<td></td>
</tr>
<tr>
<td>Expenses:Commission</td>
<td></td>
<td></td>
<td>COMMISSION</td>
<td></td>
</tr>
<tr>
<td>Assets:Stock:SYMBOL</td>
<td>#NUM_SHARES</td>
<td>GROSS_SEL-L_PRICE</td>
<td>GROSS_SALE</td>
<td></td>
</tr>
<tr>
<td>Income:Capital Gains</td>
<td></td>
<td></td>
<td>(Loss)</td>
<td>GROSS_PROFIT</td>
</tr>
</tbody>
</table>


In this example, we will use the AMZN account created in the section called “Example Stock Account”.

You bought 100 shares of AMZN for $20 per share, then later sell them all for $36 per share with a commission of $75. The split transaction scheme is as follows:

- GROSS_BUY_PRICE is $20 (the original buying price),
- NUM_SHARES is 100,
- GROSS_BUY is $2,000 (the original buying cost),
- GROSS_SALE is $3,600,
Investments

- and finally GROSS_PROFIT is $1,600 (GROSS_SALE - GROSS_BUY).

Table 9.2. Selling Shares Split Scheme, Sale & Gain Combined, Gross Pricing

<table>
<thead>
<tr>
<th>Account</th>
<th>Shares</th>
<th>Price</th>
<th>Buy</th>
<th>Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets: Bank ABC</td>
<td></td>
<td></td>
<td>3525.00</td>
<td></td>
</tr>
<tr>
<td>Assets: Brokerage Account: Stock: AMZN</td>
<td>0</td>
<td>0</td>
<td>1600.00</td>
<td></td>
</tr>
<tr>
<td>Expenses: Commission</td>
<td></td>
<td></td>
<td>75.00</td>
<td></td>
</tr>
<tr>
<td>Assets: Brokerage Account: Stock: AMZN</td>
<td>-100</td>
<td>36.00</td>
<td>3600.00</td>
<td></td>
</tr>
<tr>
<td>Income: Capital Gain (Long Term): AMZN</td>
<td></td>
<td></td>
<td></td>
<td>1600.00</td>
</tr>
</tbody>
</table>

Figure 9.18. Selling Shares, Gain Combined, Gross Pricing

Note

In the above screenshot, it appears there are 2 transactions for Mar. 21, 2006. This is because the register is in Auto-Split Ledger view and there are 2 splits for the register account in the 1 transaction. Transaction Journal view may be clearer. Refer to the section called “Simple vs. Split Transactions”. As there are 2 splits for the register account in the sale transaction, this transaction must be entered in Auto-Split Ledger or Transaction Journal view. It cannot be entered in Basic Ledger view.
Figure 9.19. The Account Tree after the Example of Selling Shares for a Gain

Combined, Net Pricing

Table 9.3. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Combined, Net Pricing

<table>
<thead>
<tr>
<th>Account</th>
<th>Number Shares</th>
<th>Share Price</th>
<th>Total Buy</th>
<th>Total Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Bank ABC</td>
<td></td>
<td></td>
<td>NET_SALE</td>
<td></td>
</tr>
<tr>
<td>Assets:Stock:SYMBOL</td>
<td>0</td>
<td>0</td>
<td>NET_PROFIT (Loss)</td>
<td>NET_SALE</td>
</tr>
<tr>
<td>Income:Capital Gains</td>
<td></td>
<td></td>
<td>(Loss)</td>
<td>NET_PROFIT</td>
</tr>
</tbody>
</table>

Example 9.2. Sale of Shares with Profit, Manual Profit/Loss Calculation, Sale & Profit Combined, Net Pricing

In this example, we will use the AMZN account created in the section called “Example Stock Account”.

You bought 100 shares of AMZN for $20 per share (including commissions), then later sell them all for $36 per share with a commission of $75. The split transaction scheme is as follows:

- NUM_SHARES is 100,
- NET_BUY_PRICE is $20 (the original buying price).
• NET_BUY is $2,000 (the original buying cost),
• NET_SELL_PRICE is $35.25 (($3600 − $75) / 100)),
• GROSS_SALE is $3,600, NET_SALE is $3,525,
• and finally NET_PROFIT is $1,525 (NET_SALE − NET_BUY).

**Table 9.4. Selling Shares Split Scheme, Sale & Gain Combined, Net Pricing**

<table>
<thead>
<tr>
<th>Account</th>
<th>Shares</th>
<th>Price</th>
<th>Buy</th>
<th>Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Bank ABC</td>
<td></td>
<td>3525.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assets:Brokerage Account:Share:AMZN</td>
<td>0</td>
<td>0</td>
<td>1525.00</td>
<td></td>
</tr>
<tr>
<td>Assets:Brokerage Account:Share:AMZN</td>
<td>-100</td>
<td>35.25</td>
<td>3525.00</td>
<td></td>
</tr>
<tr>
<td>Income:Capital Gain (Long Term):AMZN</td>
<td></td>
<td></td>
<td></td>
<td>1525.00</td>
</tr>
</tbody>
</table>

**Figure 9.20. Selling Shares for Gain using Net Pricing in Transaction Journal View**

Separate the Capital Gain/Loss Transaction from the Sale Transaction

This is *required* if using *scrubbing* to calculate and create capital gain/loss transactions automatically. Otherwise scrubbing will not detect them and will create an incorrectly valued capital gain/loss transaction.

**Separated, Gross Pricing**

**Table 9.5. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate Transactions, Sale Transaction**

<table>
<thead>
<tr>
<th>Account</th>
<th>Number of Shares</th>
<th>of</th>
<th>Share Price</th>
<th>Total Buy</th>
<th>Total Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Bank ABC</td>
<td></td>
<td></td>
<td></td>
<td>NET_SALE</td>
<td></td>
</tr>
</tbody>
</table>
Table 9.6. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate Transactions, Capital Gain/Loss Transaction

<table>
<thead>
<tr>
<th>Account</th>
<th>Number of Shares</th>
<th>Share Price</th>
<th>Total Buy</th>
<th>Total Sell</th>
<th>GROSS_PROFIT (Loss)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Stock:SYMBOL</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Income:Capital Gains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>GROSS_PROFIT</td>
</tr>
</tbody>
</table>

Example 9.3. Sale of Shares with Profit, Manual Profit/Loss Calculation, Sale & Profit Separated, Gross Pricing

In this example, we will use the AMZN account created in the section called “Example Stock Account”.

You bought 100 shares of AMZN for $20 per share and commissions $20, then later sell them all for $36 per share with a commission of $75. The split transaction scheme is as follows:

- GROSS_BUY_PRICE is $20 (the original buying price),
- NUM_SHARES is 100,
- GROSS_BUY is $2,000 (the original buying cost),
- GROSS_SALE is $3,600,
- finally GROSS_PROFIT is $1,600 (GROSS_SALE − GROSS_BUY).

Table 9.7. Selling Shares Split Scheme, Sale Transaction, Gross Pricing

<table>
<thead>
<tr>
<th>Account</th>
<th>Shares</th>
<th>Price</th>
<th>Buy</th>
<th>Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Bank ABC</td>
<td></td>
<td>3525.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expenses:Commission</td>
<td></td>
<td>75.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assets:Brokerage</td>
<td>−100</td>
<td>36.00</td>
<td>3600.00</td>
<td></td>
</tr>
</tbody>
</table>

Table 9.8. Selling Shares Split Scheme, Gain Transaction, Gross Pricing

<table>
<thead>
<tr>
<th>Account</th>
<th>Shares</th>
<th>Price</th>
<th>Buy</th>
<th>Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Brokerage</td>
<td>0</td>
<td>0</td>
<td>1600.00</td>
<td></td>
</tr>
<tr>
<td>Income:Capital Gain</td>
<td></td>
<td></td>
<td></td>
<td>1600.00</td>
</tr>
</tbody>
</table>

Income:Capital Gain (Long Term):AMZN

Figure 9.21. Selling Shares for Gain Where the Sale and Gain are Recorded in Separate Transactions, in Transaction Journal View

Separated, Net Pricing

Table 9.9. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate Transactions, Sale Transaction

<table>
<thead>
<tr>
<th>Account</th>
<th>Number Shares</th>
<th>of</th>
<th>Share Price</th>
<th>Total Buy</th>
<th>Total Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Bank ABC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NET_SALE</td>
</tr>
<tr>
<td>Assets:Stock:SYMBOL</td>
<td>#NUM_SHARES</td>
<td></td>
<td>NET_SEL-L_Price</td>
<td></td>
<td>NET_SALE</td>
</tr>
</tbody>
</table>

Table 9.10. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate Transactions, Capital Gain/Loss Transaction

<table>
<thead>
<tr>
<th>Account</th>
<th>Number Shares</th>
<th>of</th>
<th>Share Price</th>
<th>Total Buy</th>
<th>Total Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Stock:SYMBOL</td>
<td>0</td>
<td></td>
<td></td>
<td>NET_PROFIT</td>
<td>(Loss)</td>
</tr>
<tr>
<td>Income:Capital Gains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NET_PROFIT</td>
</tr>
</tbody>
</table>

Example 9.4. Sale of Shares with Profit, Manual Profit/Loss Calculation, Sale & Profit Separated, Net Pricing

In this example, we will use the AMZN account created in the section called “Example Stock Account”.

You bought 100 shares of AMZN for $20 per share (including commissions), then later sell them all for $36 per share with a commission of $75. In the split transaction scheme is as follows:

- NUM_SHARES is 100,
- NET_BUY_PRICE is $20 (the original buying price),
• NET_BUY is $2,000 (the original buying cost),
• NET_SELL_PRICE is $35.25 (($3600 − $75) / 100)),
• GROSS_SALE is $3,600, NET_SALE is $3,525,
• and finally NET_PROFIT is $1,525 (NET_SALE − NET_BUY).

Table 9.11. Selling Shares Split Scheme, Sale Transaction, Net Pricing

<table>
<thead>
<tr>
<th>Account</th>
<th>Shares</th>
<th>Price</th>
<th>Buy</th>
<th>Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Bank ABC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assets:Brokerage Account:Stock:AMZN</td>
<td>−100</td>
<td>35.25</td>
<td>3525.00</td>
<td></td>
</tr>
</tbody>
</table>

Table 9.12. Selling Shares Split Scheme, Gain Transaction, Net Pricing

<table>
<thead>
<tr>
<th>Account</th>
<th>Shares</th>
<th>Price</th>
<th>Buy</th>
<th>Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Brokerage Account:Stock:AMZN</td>
<td>0</td>
<td>0</td>
<td>1525.00</td>
<td></td>
</tr>
<tr>
<td>Income:Capital Gain (Long Term):AMZN</td>
<td></td>
<td></td>
<td>1525.00</td>
<td></td>
</tr>
</tbody>
</table>

Figure 9.22. Selling Shares for Gain Where the Sale and Gain are Recorded in Separate Transactions, in Transaction Journal View

Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots

Introduction

Wikipedia [https://en.wikipedia.org/wiki/Lot] includes the following definition of a lot:

a set of goods for sale together in an auction; or a quantity of a financial instrument
GnuCash has a built-in lot management facility that can be used to keep track of capital gains or losses resulting from security sales. Buy and sell transactions are put into lots for the purpose of calculating the cost of the sale. More specifically, a lot is used to link particular buy and sell transaction splits. Lots can be automatically or manually created and linked. Capital gain or loss can be automatically calculated and transaction(s) created for the difference between the sale value and the cost of the securities sold. GnuCash refers to this process as *scrubbing*.

The term *scrub* is used because security accounts need to be cleaned after sales to ensure the difference between the cost paid for securities, and value received from selling them, is accounted for as capital gain or loss. If the capital gain/loss is not correct, the Trial Balance bottom line total debits will not balance to total credits. To see the Trial Balance, select Reports → Income & Expense → Trial Balance.

**Note**

If you make an error, you can delete the lot(s) and capital gain/loss transaction(s) and retry. Ensure you delete the lot, or at least unlink sale transactions from the lot, before you delete a capital gain/loss transaction. Otherwise, the Lots in Account screen will recreate the capital gain/loss transaction when you select the lot.

If you are not familiar with FIFO, LIFO or Average costing, please see Wikipedia FIFO and LIFO accounting [https://en.wikipedia.org/wiki/FIFO_and_LIFO_accounting] and Average cost method [https://en.wikipedia.org/wiki/Average_cost_method].

If you are not familiar with the difference between GnuCash transactions and splits, please see the section called “Simple vs. Split Transactions”.

The GnuCash lot management facility can be a useful feature, reducing manual calculation, especially if dividends have been reinvested over years and there are many different costs involved. It can automatically link buy transactions to sell transactions using FIFO cost method and one can manually link specific buy transactions to sell transactions in order to use LIFO. Advanced Portfolio Report basis costs and gains/losses will agree with the costs and gain/loss transactions created by scrubbing if either the FIFO or LIFO cost methods are used.

**Lots in Account Window**

The Lots in Account SSSS window, where SSSS is a security account, is used to manually or automatically link security transaction splits to lots and create capital gain/loss transactions to account for the difference between the costs of buying a security and the value received by selling it.

To open the Lots in Account window, open the security account register, then select Actions → View Lots.

**Figure 9.23. Selling Shares - Capital Gains - Lots in Account window**

![Lots in Account window](image)

An image of the *Lots in Account* window.

Procedure Summary

Using the lot management facility for the automatic calculation of capital gain or loss typically follows these steps:

1. Record the sale transaction using Net Pricing (but stop short of entering the Capital Gain transaction as it will be created by scrubbing). See Example 9.4, “Sale of Shares with Profit, Manual Profit/Loss Calculation, Sale & Profit Separated, Net Pricing”.

2. the section called “Manual Lot Creation and Linking” (Optional depending on cost method)

3. the section called “Automatic Creation of Capital Gain Or Loss Transactions”

4. the section called “Change Orphaned Gains-CCC to Gain/Loss Account”

5. the section called “Run a Trial Balance” report to ensure total debits balance to total credits.

Manual Lot Creation and Linking

Before using this feature, ensure you have read the section called “Considerations”.

This functionality allows the manual linking of specific buy and sell transactions. It may be used in the case where a user wishes to use a different cost method than the automatic linking method (FIFO). Effectively, if one wishes the cost basis and capital gains in the Advanced Portfolio Report to be consistent with the capital gains transactions created by scrubbing, manual lot creation only needs to be used when using LIFO or “sale of designated lots” (the same thing for securities as far as US personal tax law is concerned). This is because the scrub function can automatically do FIFO linking so there is no need to do it manually and scrubbing cannot be used for average costing. See Example 9.5, “Manual Lot Creation and Linking”.

Automatic Creation of Capital Gain Or Loss Transactions

Note

Do not do this unless you are using FIFO or LIFO to cost sales. See the section called “Considerations”.

GnuCash can automatically calculate and create security sale capital gain/loss transactions. Lots are used to link buy transaction splits with sell transaction splits so the correct cost of the securities sold can be determined. GnuCash will use any existing lots, and create new lots for any buy transaction splits not already linked to a lot. Buy and sell transaction splits are linked to lots using FIFO method.

See:

• Example 9.6, “Automatic Creation of Capital Gain Or Loss Transactions”,

• Example 9.7, “Automatic Creation of Capital Gain Or Loss Transactions, 2 Sales at Once”,

• Example 9.8, “Automatic Creation of Capital Gain Or Loss Transactions - After a Simple Stock Split”.

Change Orphaned Gains-CCC to Gain/Loss Account

The capital gain/loss transaction(s) created by scrubbing uses an automatically created generic Orphaned Gains-CCC account (where CCC is the security currency) because GnuCash doesn’t know which capital gain or loss account should be used. After scrubbing, the user should edit the Orphaned Gains-CCC transaction split to re-assign the income account to a more meaningful income (or expense) gain or loss account (for example, Income:Capital Gain (Long Term):IBM).
See Example 9.9, “Changing the Orphaned Gains-CCC to Gain/Loss Account”.

Run a Trial Balance

Running a Trial Balance report (Reports → Income & Expense → Trial Balance) after creating capital gain/loss transactions, is a basic check that capital gains/losses are correctly accounting for the difference between the cost paid for securities, and value received from selling them. At the end of the report, total debits should equal total credits.

Tip

A Trial Balance may not balance due to some other problem. To determine if the cause of an imbalance is from incorrectly accounting for capital gain/loss:

1. If necessary, temporarily change the date of the sell transaction and the capital gain/loss transaction, so they are the only transactions for a particular date, then run the Trial Balance as at the day before. If the Trial Balance is still out by the same amount, it is not the capital gain/loss that is causing the problem.

2. If you find a prior out of balance Trial Balance, keep running the Trial Balance report with different dates until you find the date it starts being out of balance. Temporarily change the transaction dates for each transaction on the problem date to the following day, then change the dates back to the correct date 1 at a time, running the Trial Balance each time, until you identify the problem transaction. When you change the date of a security sell transaction, you also need to change the date of the corresponding capital gain transaction as it is only the sum of these that will balance in the Trial Balance.

Considerations

There are some points that should be considered before using the lot management facility.

1. GnuCash implements only the First In/First Out (FIFO) cost method when automatically linking buy transactions to sell transactions. That means the oldest securities are always sold first. The Last In First Out (LIFO) cost method may be used by manually linking the most recent buy security splits to the sell split before scrubbing.

2. The Advanced Portfolio Report does not use lot information when calculating costs, just the security transaction splits. It calculates the cost basis and gains or losses using the selected Basis calculation method report option (Average, FIFO or LIFO). If one wishes the Advanced Portfolio Report costs and gains/losses to be consistent with the capital gain/loss transactions created by scrubbing, the same cost model must be used in both places.

3. Scrubbing does not recognize commissions or fees so makes no allowance for them in the calculation of gain or loss. Therefore you must use Net Pricing rather than Gross Pricing if you wish to use scrubbing. See the section called “Handling Commissions and Fees”.

4. Scrubbing does not recognize capital gain/loss transaction splits if they have been manually entered as part of the sale transaction. Therefore ensure previous sales are recorded as 2 transactions:

Table 9.13. Transaction 1 dealing with value received and the reduction of the number of shares

<table>
<thead>
<tr>
<th>Account</th>
<th>Tot Shares</th>
<th>(Unit) Price</th>
<th>Buy (Debit)</th>
<th>Sell (Credit)</th>
</tr>
</thead>
</table>
5. The automatic capital gains calculations can handle straightforward buy, sell, and return of capital transactions, but any transaction that affects the number of shares, even simple splits, will cause it to produce wrong answers so those cases must be handled manually.

Examples

Example 9.5. Manual Lot Creation and Linking

Here is an example of selling part of a security holding using the LIFO method. In this example, the most recent buy transaction (dated Jul. 1, 2016, a reinvested dividend), is linked to a lot, along with the sell transaction, and the GnuCash scrub function is used to calculate capital gain or loss and create the capital gain/loss transaction.

1. Open the security account's register.

Figure 9.24. Selling Shares - Capital Gains - Security register before scrubbing a single lot

An image of the Security Account register in transaction journal view, before lot scrubbing.

2. Ensure all previous capital gain/loss transactions are separate transactions to the sell transactions which record the reduction in the number of shares and the value received.

3. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security account.
Figure 9.25. Selling Shares - Capital Gains - Lots before scrubbing a single lot

An image of the Lots in Account window before lot scrubbing.

4. Create a new lot using the New Lot button. Initially this lot is not linked to any buy or sell split.

5. Highlight the new lot in the Lots in This Account panel.

6. Highlight the buy split (dated Jul. 1, 2016) of the security to be sold in the Splits free panel.

7. Click the >> button to link the buy split with the highlighted lot. The split moves from the Splits free panel to the Splits in Lot panel.

8. Repeat the previous 2 steps for any other buy splits that should be included in the lot (in this example, there is only 1 buy split in the sale).

9. Highlight the sell split in the Splits free panel.

10. Click the >> button to link the sell split with the highlighted lot.

11. Check the lot Balance is as expected. In this example the lot balance should be zero as the number of securities sold in the lot, is matched with the same number of security buys.

Figure 9.26. Selling Shares - Capital Gains - Lots before scrubbing a single lot, after manual linking

An image of the Lots in Account window before scrubbing a single lot.

12. Click the Scrub button (not the Scrub Account button.)

The Lots in Account window has not changed after using the Scrub button so no example screen image is supplied.

13. Close the Lots in Account SSSS window and return to the security account register.
**Figure 9.27. Selling Shares - Capital Gains - Register after manual linking and scrubbing a single lot**

An image of the Register after scrubbing a single lot.

14. Continue to the section called “Change Orphaned Gains-CCC to Gain/Loss Account”.

**Example 9.6. Automatic Creation of Capital Gain Or Loss Transactions**

Create the capital gains transaction by following these steps:

1. Open the security account's register.

2. Ensure any previous manually entered capital gain/loss transaction splits have been entered in separate transactions to the sell transactions.

3. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security account.

4. If using LIFO, use the above procedure the section called “Manual Lot Creation and Linking” to create a lot for each sell transaction, link the lot with the sell transaction and each of the buy transactions that make up the sale.

5. Click the Scrub Account button which:
   - Creates lots for any buy transactions that are not already linked to a lot and links them to sell transactions splits using the FIFO method. As a transaction split can only be linked to 1 lot, if a sell transaction needs to be linked to multiple lots, the sell transaction split is itself split into multiple subsplits. In the case of multiple subsplits, it is possible to have different splits from the same transaction in both the Splits free and Splits in lot panels.
   - Creates a separate transaction per lot for capital gain/loss.

6. Continue to the section called “Change Orphaned Gains-CCC to Gain/Loss Account”.

<table>
<thead>
<tr>
<th>Date</th>
<th>Num</th>
<th>Description</th>
<th>Tot Shares</th>
<th>Tot Bu</th>
<th>Tot Sel</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/01/2016</td>
<td></td>
<td>Bought STOCK1 10 @ 50.00 Brokerage 1.00</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Assets Investments Broker1 STOCK1</td>
<td>10.1</td>
<td>10.1</td>
<td>10.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Assets Investments Broker1</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td></td>
</tr>
<tr>
<td>03/02/2016</td>
<td></td>
<td>STOCK1 Div Reinvestment 1 @ 311.00</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>311.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Assets Investments Broker1 STOCK1</td>
<td>11.0</td>
<td>11.0</td>
<td>11.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Increase in Residual 320.00 - 311.00 = 9.00</td>
<td>9.0</td>
<td>9.0</td>
<td>9.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Income Dividend Transferred STOCK1</td>
<td>20.0</td>
<td>20.0</td>
<td>20.0</td>
<td></td>
</tr>
<tr>
<td>03/07/2016</td>
<td></td>
<td>STOCK1 Div Reinvestment 2 @ 322.00 + 324.00</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>322.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Assets Investments Broker1 STOCK1</td>
<td>24.0</td>
<td>24.0</td>
<td>24.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Decrease in Residual = [9.00 - 7.00] = 2.00</td>
<td>2.0</td>
<td>2.0</td>
<td>2.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Income Dividend Transferred STOCK1</td>
<td>22.0</td>
<td>22.0</td>
<td>22.0</td>
<td></td>
</tr>
<tr>
<td>02/03/2016</td>
<td></td>
<td>Sell STOCK1 Last lot Qty 3 @ 833.60+426.00 Brokerage 63</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Assets Investments Broker1 STOCK1</td>
<td>75.0</td>
<td>75.0</td>
<td>75.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sell Cost qty 2 @ 832.00 = 824.00</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>832.00</td>
</tr>
<tr>
<td>02/03/2016</td>
<td></td>
<td>Realized Gain/Loss 0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Realized Gain/Loss</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Realized Gain/Loss</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>23/02/2017</td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Shares: 11 STOCK1  Current Value: 3143.00
Enter a description of the transaction
Example 9.7. Automatic Creation of Capital Gain Or Loss Transactions, 2 Sales at Once

Here is an example of FIFO scrubbing without manual lot creation. In this example, the transactions for 2 sales are scrubbed at once but usually scrubbing would be performed after each sale. One reason for scrubbing 2 sales at once, could be because there were multiple sales on the same day.

Figure 9.28. Selling Shares - Capital Gains - Register before Scrub Account

An image of the Security Account register in transaction journal view, before Scrub Account is used.

1. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security account.
Figure 9.29. Selling Shares - Capital Gains - Lots before Scrub Account

An image of the Lots in Account window before Scrub Account is used.

2. Click the Scrub Account button.

Figure 9.30. Selling Shares - Capital Gains - Lots after Scrub Account

An image of the Lots in Account window after using Scrub Account.

**Note**

After using the Scrub Account button only the last lot is shown, so the above image is after the Lots in Account window has been closed and reopened so all the lots show.

3. Close the Lots in Account SSSS window and return to the security account register.
Investments

Figure 9.31. Selling Shares - Capital Gains - Register after Scrub Account

An image of the security register after using Scrub Account.

**Note**

The security splits in the sell transactions have been split into subsplits, one subsplit per lot, and a capital gain transaction has been created for each security subsplit of each sell transaction.

4. Continue to the section called “Change Orphaned Gains-CCC to Gain/Loss Account”.

**Example 9.8. Automatic Creation of Capital Gain Or Loss Transactions - After a Simple Stock Split**

Here is an example of FIFO scrubbing without manual lot creation/linking, where the Stock Split Assistant has been used for a simple stock split. In this example, 100 shares of security XYZ were bought for $10.00.
each, there was a simple 2 for 1 stock split for zero cost (so the holding was then 200 shares @ $5.00 each), then all 200 shares were sold for $6.00 each.

Figure 9.32. Selling Shares - Capital Gains - Register after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.

Figure 9.33. Selling Shares - Capital Gains - Lot 0 after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.
Figure 9.34. Selling Shares - Capital Gains - Lot 1 after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.

The above screenshots show that scrubbing created:

- 2 lots. A separate lot for each buy (it essentially treats the stock split as a buy of 100 for no cost.)

- 2 capital gain transactions (one for each lot) on the date of the sale:
  - Lot 0: Jul. 1, 2009 loss $400 (sale $600 - cost $1,000.)
  - Lot 1: Jul. 1, 2009 gain $600 (sale $600 - cost $0.)

Total gain $200 is correct. Whether the gain is a single long-term one or one each of long-term and short-term or whether there's even a distinction depends on the user's tax jurisdiction and the way the split is structured. If the user needs help figuring it out they should consult a professional.

Example 9.9. Changing the Orphaned Gains-CCC to Gain/Loss Account

1. Close the Lots in Account SSSS window if open and return to the security account register.
2. Find each new Realized Gain/Loss transaction in the security account register (they will have the same date as the sell transactions).

3. Edit the Orphaned Gains-CCC transaction split to re-assign the income account to a more meaningful income (or expense) gain or loss account (for example, Income:Capital Gain (Long Term):IBM).

Tip

You may like to split the capital gain/loss into taxable and non taxable parts if that is in accord with your tax laws.

Dividends

Some companies or mutual funds pay periodic dividends to shareholders. Dividends are typically given in one of two ways, either they are automatically reinvested into the commodity or they are given as cash. Mutual funds are often setup to automatically reinvest the dividend, while common stock dividends usually pay cash.

Dividends in Cash

If the dividend is presented as cash, you should record the transaction in the asset account that received the money, as income from Income:Dividends. Additionally if you want to tie the cash dividend to a particular stock holding then add a dummy transaction split to the stock account with quantity 0 price 1 value 0.

As an example consider the following; the dividends deposited as cash into the Broker Account with a tie to the stock account.
Figure 9.36. Example Of Cash Dividend Transactions

An image of the Brokerage Account register after a series of cash dividends.

Note

If you want to track dividends on a per-stock basis, you would need to create an Income:Dividends:STOCKSYMBOL account for each stock you own that pays dividends.

Dividends Re-Invested

If you receive the dividend in the form of an automatic reinvestment, the transaction for this should be handled within the stock or mutual fund account as income from Income:Dividends for the appropriate number of reinvested shares. This type of reinvest account is often referred to as a DRIP (Dividend Re-Investment Program).

As an example consider the following purchase of NSTAR (NST) stock with the dividends reinvested into a DRIP Account. Mutual fund re-investments would be the same.

Starting with the purchase of 100 shares on Jan. 3, 2005, all dividends will be reinvested and an account is created to track the dividend to the specific stock. GnuCash simplifies the entry by allowing calculations within the cells of the transaction. If the first dividend is $0.29/share, enter 53.28 (purchase price + dividend) in the share Price cell and 100*0.29 in the Buy cell. GnuCash will calculate for you the corresponding number of Shares.

Figure 9.37. Example Of Dividend Reinvestment Transactions

An image of the NST Stock Account register after a dividend reinvestment.
Return of Capital

This refers to a transaction where an investment returns capital to the investor and doesn't have any accounting implications other than reducing the cost basis. The number of shares held is not changed.

A Return of Capital transaction can be entered in the stock register by entering the stock split with:

<table>
<thead>
<tr>
<th>Shares</th>
<th>Price</th>
<th>Sell</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Return of Capital value</td>
</tr>
</tbody>
</table>

The other side of the double entry would usually be a debit to the brokerage bank account.

Figure 9.38. Example Of Return Of Capital Transactions

An image of the Stock Account register after a return of capital.

**Note**

It is not possible to use the Stock Split Assistant to do this type of transaction.

**Tip**

If you accidentally entered a non-zero price in the stock split, GnuCash may have created an unwanted price database entry which could cause reports to be wrong. Check for and remove such an unwanted entry from the price database using Tools → Price Database.

Splits and Mergers

Companies may split their stock for many reasons but the most common is that the price has risen higher than management thinks is a reasonable price for many investors. Some of these splits are simple exchanges (for example, 2 for 1 or 3 for 2) and some are complex exchanges with cash distributions. Splits may also result in fewer shares if the exchange rate is a reverse split (1 for 3 or 0.75 for 1).
Simple Stock Split

As an example, our holding of NST stock declared a 2 for 1 stock split effective June 6, 2005. The process for entering this transaction is; select Actions → Stock Split to start the assistant.

Figure 9.39. Activation Of The “Stock Split” Assistant

An image of the selection of the stock split assistant.

The first screen is an Introduction, select Forward to display the selection of the account and stock for the split. You will need to create an entry for each Account:Stock combination you hold.

Figure 9.40. Selection Of A Stock Account In The “Stock Split” Assistant

An image of the stock split assistant at step 2 - Selection of Account/Stock.

Select the Assets:Investments:DRIPs:NST and click on Forward.

The next screen presents 5 fields in the Stock Splits Details window:

Date

Enter the date of the split.
Investments

Shares

The number of shares increased (or decreased) in the transaction. In this example, it is a 2 for 1 split so the number of additional shares is the number of shares currently in the register.

Description

The Description should give a brief explanation of the transaction.

New Price

If desired the new price of the stock, after the split, may be entered.

Currency

The currency of the transaction is required. This should be the same as the stock purchase currency.

Click on the Forward button.

Figure 9.41. Split Details In The “Stock Split” Assistant

An image of the stock split assistant at step 3 - Split Details.

The next screen will be skipped in this example as there was no “Cash in Lieu”.
Figure 9.42. “Cash In Lieu” In The “Stock Split” Assistant

An image of the stock split assistant at step 4 - Cash in Lieu.

A final Finish screen will give a last option to; Cancel, Back to modify any data entered or Apply to complete the stock split with the data entered.

Figure 9.43. The NST Account After A Simple Stock Split

An image of the Assets:Investments:DRIPs:NST register after a simple stock split transaction.

**Moderately Complex Stock Merger**

As an example, assume you held AT&T stock during the Nov. 18, 2005 merger of SBC with AT&T. For this example you will have purchased AT&T on April 1, 2005, any dividends will have been paid in cash, therefore not entered into the AT&T stock register.

The conditions of the merger were 0.77942 share of SBC stock were exchanged for each share of AT&T stock. The merged company continued to use the symbol “T” from AT&T.

AT&T paid a “dividend” of $1.20/share on the transaction date, however this will not appear in the stock account as it was a cash distribution.
The process for entering this transaction is identical to the simple split until the “Details” screen. You will need to create an split entry in each Investment Account:Stock account combination that has shares splitting.

Figure 9.44. Selection Of A Stock Account In The “Stock Split” Assistant—Moderate

An image of the stock split assistant at step 2 - Selection of Account/Stock (Investment Account:T).


The next screen presents 5 fields in the Stock Splits Details window:

Date

Enter the date of the split. Here we’ll enter November 18, 2005.

Shares

The number of shares increased (or decreased) in the transaction. In this example it is a 0.77942 for 1 split so the number of shares will decrease from the number of shares currently in the register. You may use GnuCash’s ability to perform calculations on an entry form by entering data directly (0.77942*100 # 100) to calculate the decrease in shares from the split.

Description

The Description should give a brief explanation of the transaction.

New Price

If desired the new price of the stock, after the split, may be entered.

Currency

The currency of the transaction is required. This should be the same as the stock purchase currency.
Click on the Forward button.

**Figure 9.45. Split Details In The “Stock Split” Assistant—Moderate**

An image of the stock split assistant at step 3 - Split Details.

The next screen will be skipped in this example as there was no “Cash in Lieu”.

A final “Finish” screen will give a last option to Back to modify any data entered or Apply to complete the stock split with the data entered.

**Figure 9.46. The T Account After A Moderate Stock Split**

An image of the *Investment Account:T* register after a stock split transaction that decreases the shares.
Chapter 10. Reports

GnuCash is a powerful double entry accounting software package that allows users to enter and track their money in a reliable manner. However, putting this information into GnuCash is only a part of the process. To be truly helpful, you need to be able to extract this information in meaningful ways. GnuCash's reporting features allow you to just that.

GnuCash's reporting features allow you to display nearly any group of transactions in a wide variety of formats. This makes it easy to answer questions about your finances, such as “How much did I spend on groceries last month?” or “How much did I earn in the previous six months?”

GnuCash includes a number of common report types, which can be modified to meet your specific needs. If these common reports are insufficient, it is possible to modify or even write your own custom reports (although this is not recommended for beginners).

Overview

There are many standard reports pre-built in GnuCash, all available from the Reports pulldown menu in the main account window.

When you select a report from the list of reports, that report is first run with its default settings. Once you have opened the report, you can modify its parameters by clicking on the Options button on the toolbar. Under Options, you will see the different settings that you can change for each report. Note that for different reports, the options will be different.

Saved Reports Configurations Concepts

Once you have modified a report to meet your needs, you may wish to save that report for reuse at a later point. GnuCash allows custom reports to be saved, using the Save Report Configuration command.

Procedure 10.1. Save a report configuration

1. Go to the Reports Menu and choose the desired report.
2. Change the settings on the report until it includes what is needed.
3. Go to the General tab of the report’s options and change the Report Name to something meaningful (Do not confuse this with the Report Title.)
4. Apply the changes and close the dialog.
5. Click the Save Report Configuration or Save Report Configuration As... button.

This will store the report options in a file in your home directory.

The first time you save a report with a name that has not already been saved, you can use either the Save Report Configuration or the Save Report Configuration As... button. You can modify the report name before saving it.

Once a report has been saved with the current name, the Save Report Configuration button will immediately update the saved report configuration. Use the Save Report Configuration As... button to save the current report configuration with a new name.
Saved report configurations are available for use under the Reports → Saved Report Configurations entry. They will also be available for use on multicolumn reports.

Saved report configurations can be deleted in the Saved Report Configurations dialog by clicking the trashcan icon.

To edit saved report configurations, open the report via Reports → Saved Report Configurations, edit and apply the new options, and click Save Report Configuration.

**Standard Reports Overview**

The standard reports that are included in GnuCash are presented in this section. For each report, a short description is given, which explains what the report is intended to show and its primary purpose. We begin with a description of the Transaction Report, which is an all-purpose report with many features and settings that allow sophisticated examination of the data in a file.

**Transaction Report**

The Transaction Report is a fundamental report that allows users to retrieve a wide variety of useful information from the financial records. The report includes many features that allow powerful and flexible reporting from the single basic report.

- Debit and Credit subtotals can be displayed, and within a grouping section, if debit totals > credit totals, the group subtotal will be displayed in the debit column.

- Multiple data columns enable display of transaction amounts in report currency and original currency in separate columns.

- Additional sortkeys e.g. sort by reconcile status (unreconciled -> cleared -> reconciled), sort by weeks, allow additional views into the financial records.

- Full text filter enabled for description, notes and memo, and for account full names. This allows easier selection of source account names and tailored reporting. Filters can optionally use full POSIX regular expressions.

- Indenting of columns will indent the report columns for easier understanding of grouping and sorting. (This is now enabled by default for GnuCash 3.0 onwards)

- Subtotal table is useful to understand the relationship in the data. This feature compiles the primary and secondary subtotals into a table view, allowing additional insight into financial records, e.g. account subtotals in different time series.

For further ideas on how to use the Transaction Report to produce common reports, see Using the Transaction Report.

**Assets & Liabilities Group**

Reports in this group provide general information about assets and liabilities.

**Advanced Portfolio**

The Advanced Portfolio produces a report on commodity accounts (stock and mutual fund type accounts) using price information stored in the GnuCash price database and within the GnuCash transaction data. If
you do not have stock price information in your file, the report will indicate an error. This report includes extended information about commodity holdings, including information about the basis, gain, and return of individual commodities.

**Advanced Portfolio Capital Gains**

The Advanced Portfolio report doesn’t use the capital gain splits to calculate capital gains. It calculates the gains from the various buy and sell transactions in the account without regard to whether the gains and losses are recorded or not. Any realized gain splits are ignored. Realized gain splits are recognized as two splits, one in the stock’s account with a zero number of shares and a non-zero value, the other in an income or expense account with a value that is the negative of the split in the stock account. These two splits can be in a separate transaction (as created by scrubbing) or in the same transaction as the sale (this will cause incorrect future scrubbing). The income or expense split can be split into multiple splits, say for taxable/non-taxable or short/long term gains, without affecting this report.

**Asset Barchart**

The Asset Barchart presents the value of assets on a monthly basis in barchart form. By default, the report displays the eight largest accounts that have specific asset types assigned to them, and it displays bars for the current financial period.

Several settings on this report can greatly affect the information included.

- On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account totals. Change this value to see information at deeper levels of the account structure.

- On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing information for more accounts to display. Additionally, the "Show table" option enables the display of chart information in tabular form below the chart.

- On the General tab, the "Price Source" option can significantly affect the reported value of various commodities included in the report.

**Asset Piechart**

The Asset Piechart presents the value of assets on a monthly basis in piechart form. By default, the report shows the seven largest accounts, that have specific asset types assigned to them, arranged in descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

- On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account totals. Change this value to see information at deeper levels of the account structure.

- On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing information for more accounts to display.

- On the General tab, the "Price Source" option can significantly affect the reported value of various commodities included in the report.

**Average Balance**

The Average Balance report displays monthly averages for the current accounting period.
Balance Sheet

The Balance Sheet lists Asset, Liability, and Equity account balances for all such accounts, and provides totals as of a given date. Balance sheets are commonly run for the last day of each fiscal year to give an overall sense of the financial condition of the entity.

General Journal

The General Journal produces a register of all transactions (beginning to end) in order by date, showing the accounts and the amounts involved, and totals the Net Change by all currencies and assets.

This report is not customizable by date or account, though you can include more or fewer details about the individual transactions, and whether to include running balances and totals for the credits and debits. If you need a report restricted to particular accounts, consider the Transaction Report or open a particular account and choose the Account Transaction Report.

General Ledger

The General Ledger produces information about all transactions for a selected set of accounts. When first run, this report loads no data, and the report options must be changed to retrieve information from the file.
**Investment Lots, 03/07/20 to 24/11/22**

**Broker: RIO**

End price: **$180.00** on 08/10/22

<table>
<thead>
<tr>
<th>Lot Title</th>
<th>Opened</th>
<th>Closed</th>
<th>Bought Amount</th>
<th>Bought Value (Basis)</th>
<th>Bought Average Price</th>
<th>Sold Splits</th>
<th>Sold Amount</th>
<th>Sold Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot 1</td>
<td>01/02/22</td>
<td>04/02/22</td>
<td>10 RIO</td>
<td>$1,000.00</td>
<td>$100.00</td>
<td>2</td>
<td>10 RIO</td>
<td>9 RIO</td>
</tr>
<tr>
<td>Lot 0</td>
<td>02/02/22</td>
<td></td>
<td>12 RIO</td>
<td>$1,440.00</td>
<td>$120.00</td>
<td>1</td>
<td>6 RIO</td>
<td>6 RIO</td>
</tr>
</tbody>
</table>

**Account Lots Total**

22 RIO $2,440.00 $110.91 3 16 RIO $1,117.00 $68.69

**Warning:** 5 split(s) are not assigned to a lot. Do lots need to be scrubbed?

---

<table>
<thead>
<tr>
<th></th>
<th>Bought Value (Basis)</th>
<th>Sold Splits</th>
<th>Sold Amount</th>
<th>Sold Price</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Grand Total</strong></td>
<td>$2,440.00</td>
<td>3</td>
<td>$1,117.00</td>
<td>$68.69</td>
</tr>
</tbody>
</table>
The Investment Lots report shows details about lots in a selected set of accounts of type Stock or Mutual Fund (see the section called “Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots”). It includes an optional capital gains summary chart and a table with columns for dates, purchases, sales, end balances, capital gains (realized and unrealized, short term and long term), and return on investment (ROI). It also performs optional lot validation checks.

The report can help answer questions such as:

- Which lots are best candidates for tax loss/gain harvesting?
- What capital gains have been realized for a particular time period (i.e. this year, last year, etc)? Are they long term or short term gains?
- Which lots held longer than 1+ years have the largest unrealized gains, and would therefore be most advantageous (tax-wise) if donated to charity?
- Are the lots (and related accounts and splits) well-formed?

For more details, see the Investment Lots report documentation in the Manual.

**Investment Portfolio**

The Investment Portfolio produces a report of commodity accounts (that is, accounts with type "Stock" or "Mutual Fund"), giving holdings, price and value information about commodities in the file.

**Liability BarChart**

The Liability BarChart presents the value of liabilities on a monthly basis in barchart form. By default, the report displays the eight largest accounts that have specific asset types assigned to them, and it displays bars for the current financial period.

Several settings on this report can greatly affect the information included.

- On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account totals. Change this value to see information at deeper levels of the account structure.
- On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing information for more accounts to display. Additionally, the "Show table" option enables the display of chart information in tabular form below the chart.
- On the General tab, the "Price Source" option can significantly affect the reported value of various commodities included in the report.

**Liability PieChart**

The Liability PieChart presents the value of liabilities on a monthly basis in piechart form. By default, the report shows the seven largest accounts, that have specific asset types assigned to them, arranged in descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

- On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account totals. Change this value to see information at deeper levels of the account structure.
- On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing information for more accounts to display.
On the General tab, the "Price Source" option can significantly affect the reported value of various commodities included in the report.

**Net Worth Barchart**

The Net Worth Barchart summarizes Asset accounts, Liability accounts, and overall Net Worth as bars on a graph on a monthly basis for the current financial period. This report provides a graphic overview of the file over time.

**Net Worth Linechart**

The Net Worth Linechart summarizes Asset accounts, Liability accounts, and overall Net Worth as a line graph on a monthly basis for the current financial period. This report provides a graphic overview of the file over time.

**Price Scatterplot**

The Price Scatterplot displays the value of one commodity relative to another commodity, for example the value of a stock relative to a currency. When first run, this report loads no data, and the report options must be changed to retrieve information from the file. Specifically, the "Price of Commodity" setting on the Price options tab must be changed to a specific commodity.

**Budget Group**

Budget reports in GnuCash allow you to gather summary information related to budgets you may have created. In order for these reports to work, you must first create a budget. The reports in this group are specifically based on budget information. To use these reports, you need to have a budget saved in your file.

**Budget Balance Sheet**

**Budget Barchart**

**Budget Flow**

**Budget Income Statement**

**Budget Profit & Loss**

**Budget Report**

**Business Group**

Reports in this group provide general information about activities related to a business.

**Customer Report**
Customer Summary

Customer Summary is a customer profit report that can help with job analysis by comparing the income and expenses for a specific customer.

All invoices have an Owner in GnuCash, so invoices that are made will show a customer and show in the report. When creating a Bill, the Default Chargeback Customer is blank. To use the profit report, this field needs an entry, since this is the tag that decides the line to which to attach the expense. Left blank, the bill will be assigned to "No Customer." Similarly, when income is entered directly in a register rather than creating an invoice, it will also be assigned to "No Customer."

Thus, if this report includes an entry for "No Customer", this means that the report may be inaccurate, as the results are not all properly labeled.

Possible use scenarios include:

• Tracking retail sales from different cities
• Tracking rental properties
• Tracking types of business
• Tracking commission sales

Each of these scenarios assumes that the account structure includes breakdowns for individual tracked categories. Changing settings on the Income and Expense tabs under Options can hone the information displayed. By default all income and expense accounts are included; however, since GnuCash can't really predict the names and classification of income and expense accounts, it must group them all into the "No Customer" entry.

Note that inventory-based businesses won't benefit from this report because of its nature.

Useful options:

• The Expense Accounts tab allows the selection of one or more expense accounts.
• The Income Accounts tab allows the selection of one or more income accounts.
• The Display tab allows sorting by name, profit percentage, or amount of profit.

Easy Invoice

Employee Report

Fancy Invoice

Payable Aging

Printable Invoice
**Reports**

**Receivable Aging**

This report provides a listing of all customers, their current balance, and how much they have outstanding from invoices over different time periods—how much they owe from 0-30 days, from 31-60 days, from 61-90 days, and over 90 days. The report also contains links to each customer and to their current customer report.

**Vendor Report**

**Income and Expense Group**

Reports in this group provide information about Income and Expense

**Cash Flow**

This report shows the change in value for a set of accounts (the flow of cash) over a given period of time. By default, this report is based on accounts in Assets and Special Accounts, and covers the current financial period. The report enumerates all money coming in to and going out of the base accounts, broken down by the other account.

**Equity Statement**

This report can be seen as extension of the Balance Sheet report. The Balance Sheet states the balance of Assets, Liabilities and Equity at a specific point of time. The Equity Statement focuses on the Equity Accounts by showing the cash flow to and from them for a given period of time.

By balancing this cash flow with income, the report shows the available capital at the beginning and end of the selected time period.

**Expense Barchart**

The Expense Barchart presents the value of expenses on a monthly basis in barchart form. By default, the report displays the eight largest accounts that have specific expense types assigned to them, and it displays bars for the current financial period.

Several settings on this report can greatly affect the information included.

- On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account totals. Change this value to see information at deeper levels of the account structure.

- On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing information for more accounts to display. Additionally, the "Show table" option enables the display of chart information in tabular form below the chart.

- On the General tab, the "Price Source" option can significantly affect the reported value of various commodities included in the report.

**Expense Piechart**

The Expense Piechart presents the value of expenses on a monthly basis in piechart form. By default, the report shows the seven largest accounts, that have specific expense types assigned to them, arranged in descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.
• On the Accounts tab, the “Show Accounts until level” option changes how the report aggregates account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices” option will display more slices in the chart, allowing information for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various commodities included in the report.

Expenses vs. Day of Week

Expenses vs. Day of Week presents a pie chart showing the totals for selected expense accounts totaled by the day of the week of the transaction. The report options enable you to make some adjustments (such as accounts, display options, and the date range) but the account selector only allows expense accounts to be chosen. The report aggregates expense transactions by day of week, not by any other period or category. Due to these limitations, the report may be considered a demonstration or an example to someone wanting to examine the source code for composing a useful custom report.

Income Barchart

The Income Barchart presents the value of income on a monthly basis in barchart form. By default, the report displays the eight largest accounts that have specific income types assigned to them, and it displays bars for the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level” option changes how the report aggregates account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars” option will display more bars in the chart, allowing information for more accounts to display. Additionally, the "Show table“ option enables the display of chart information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various commodities included in the report.

Income & Expense Chart

Income Piechart

The Income Piechart presents the value of income on a monthly basis in piechart form. By default, the report shows the seven largest accounts, that have specific income types assigned to them, arranged in descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level” option changes how the report aggregates account totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices” option will display more slices in the chart, allowing information for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various commodities included in the report.
Income Statement

This report lists Income and Expense account totals for a set period. By default, it shows all Expense and Income accounts down to 3 levels of sub-accounts for the current financial period.

An Income Statement is also called a “Profit and Loss” report or "Revenue Statement."

In earlier versions of GnuCash, this report was called "Profit & Loss," but with version 2, the report was renamed "Income Statement" to use more common accounting terminology.

The Income Statement helps show where money is coming from and where it is going for a given time period.

Income vs. Day of Week

Income vs. Day of Week presents a piechart showing the totals for selected income accounts totaled by the day of the week of the transaction. The report options enable you to make some adjustments (such as accounts, display options, and the date range) but the account selector only allows income accounts to be chosen. The report aggregates income transactions by day of week, not by any other period or category. Due to these limitations, the report may be considered a demonstration or an example to someone wanting to examine the source code for composing a useful custom report.

Trial Balance

Trial Balance lists the ending balances in all accounts as of a particular date. It is typically run at the end of an accounting period and is primarily used to ensure that the total of all debits equals the total of all credits.

Income and GST Statement

The Income and GST Statement is a specialised Transaction Report designed to print Business-related Sales and Receipts, as well as their GST or VAT components. This report is designed for use in Australia, but is also usable in any jurisdictions implementing value-added taxes (or goods and services taxes) during regular business sales and receipts; and the business owner is expected to submit periodic reports of total sales, purchases, and taxes collected on sales from clients or paid to a supplier.

This report makes some assumptions upon the accounts used for sales, purchases, and taxes collected on sales, and paid on purchases.

• Net Sales must be an Income-type account
• Net Purchases must be an Expense-type account
• GST/VAT on Sales must be a Liability-type account
• GST/VAT on Purchases must be an Asset-type account
• There may be multiple GST accounts, e.g. reduced GST, standard GST etc. The GST accounts can be printed individually, or summarised for sales and purchases.
• There may be multiple sales and expenses accounts, e.g. Income:Sales, Income:Grants, Expenses:Suppliers, Expenses:Marketing, Expenses:Insurance. These amounts may be reported individually, or summarised for sales and purchases.
• The transactions may be entered manually as a multi-split transaction, or they may be entered via the Business Invoices and Bills tools.
As an example, consider a business has the following transactions: It incurs sales of $1,000 plus 5% GST, receiving $1,050. It also incurs GST-exempt sales of $600. It purchases goods/services worth $400 plus 5% = $420. The following transactions will record the business activities:

### Table 10.1. Sample Chart of Accounts for Income and GST Statement

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Account</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/2018</td>
<td>Sales $1,000 + 5% GST</td>
<td>Income:Sales</td>
<td>$1,000</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GST on Sales [Liability]</td>
<td></td>
<td>$50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Asset:Bank</td>
<td></td>
<td>$1,050</td>
</tr>
<tr>
<td>02/01/2018</td>
<td>GST-Free Sales $600</td>
<td>Income:Sales</td>
<td></td>
<td>$600</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Asset:Bank</td>
<td></td>
<td></td>
</tr>
<tr>
<td>03/01/2018</td>
<td>Purchase $400 + 5% GST</td>
<td>Expenses:Purchases</td>
<td>$400</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Asset:Bank</td>
<td>$420</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GST on Purchases [Asset]</td>
<td>$20</td>
<td></td>
</tr>
</tbody>
</table>

For the Income and GST Statement, the **Accounts** selected will be the Income and Expense Accounts, and the **Tax accounts** are used to select the GST accounts. The GST period is selected via the General tab. The resulting report is shown as follows:

### Table 10.2. Income and GST Statement

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Total Sales</th>
<th>Net Sales</th>
<th>Tax on Sales</th>
<th>Total Purchases</th>
<th>Net Purchases</th>
<th>Tax on Purchases</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/2018</td>
<td>Sales $1,000 + 5%</td>
<td>$1,050</td>
<td>$1,000</td>
<td>$50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>02/01/2018</td>
<td>GST-Free Sales $600</td>
<td>$600</td>
<td>$600</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03/01/2018</td>
<td>Purchase $400 + 5%</td>
<td></td>
<td></td>
<td>$420</td>
<td>$400</td>
<td>$400</td>
<td>$20</td>
</tr>
<tr>
<td>Totals</td>
<td></td>
<td>$1,650</td>
<td>$1,600</td>
<td>$50</td>
<td>$420</td>
<td>$400</td>
<td>$20</td>
</tr>
</tbody>
</table>

This report would indicate that there was a total of $50 GST collected, and $20 GST on purchases, therefore a $30 GST liability is payable to the authorities.

### Sample & Custom Group

The reports in this group offer examples on how reports can be customized or modified to suit personal need.

### Custom Multicolumn Report

This report provides a base that allows several standard and custom reports to be combined into one view. Note that this report opens with an empty window; you must open the options and designate which reports
to include for display. Once the reports have been selected, the settings for individual reports in the multicolou
n column display can be edited.

**Sample Report with Examples**

This is a sample report that users can examine to learn how to write their own reports.

**Welcome Sample Report**

This report demonstrates how the Multicolumn Report can be used to create custom dashboard-type reports.

**Other Reports**

Several reports are included on the main Reports menu. These are described below.

**Account Summary**

This lists the balances of all accounts and subaccounts as of a particular date. By default, this report shows accounts and totals down to third-level subaccounts.

This report gives effectively the same information as the Chart of Accounts. You can use this report to export and print the Chart of Accounts.

**Note**

To generate a report of account totals over a particular time period (especially if you do not close your books at regular intervals), you might consider using the Income Statement, or Cash Flow reports.

**Balance Forecast**

This creates a balance chart which aims to track asset (or any other account type) balances, including amounts from future scheduled transactions. The balances will include all regular booked amounts and future amounts from numeric scheduled transaction templates.

This report can also add additional data charts to forecast future minimum balances. Reserve line can be displayed to confirm if future minimum will dip below the reserve amount. A target line may also be displayed above the reserve line for financial planning.

**Future Scheduled Transactions Summary**

**Tax Report & TXF Export**

Generates a report and a downloadable .txf file of taxable income and deductible expenses for a particular accounting period. To download the report data, choose the Export button on the toolbar and choose between html and .txf downloadable versions.

To use this report, you must use Edit --> Tax Options to identify which form the taxing authority uses for each income or expense account. Note that you can see but not modify the “Tax related” checkbox in Edit --> Edit Account.
Saved Report Configurations

Selecting this will open a dialog with a list of available Saved Report Configurations. "Saved Report Configurations" means sets of customized settings for standard reports.

These sets must be saved by the user before they appear here. See Report Concepts above for instructions on how to save report configurations.

Account Report

The Account Report menu entry only appears when an account register is the active tab. This report produces a list of all transactions in the open register.

Note that if you conduct a search that retrieves several transactions, the results are displayed in a new search register, which can then be used to create a report for just those transactions.

Account Transaction Report

This report also only appears when an account register is the active tab. However, this report only lists transactions that have been selected (e.g. by mouse click) in the current register. If no transactions are selected, an empty report will be generated.

Using the Transaction Report

The Transaction Report can be heavily customised to produce most reports appropriate for personal finance and business bookkeeping purposes. It aims to retrieve and filter information from the database, and present transactions and totals, useful for the user and the accountant.

The following guide to the Transaction Report will assume the user has set up the chart of accounts according to conventional bookkeeping practice. For example, the following describes a typical household book with skeleton accounts. Further accounts will undoubtedly be necessary.

Table 10.3. Sample Chart of Accounts for the Transaction Report

<table>
<thead>
<tr>
<th>Account Name</th>
<th>Account Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>ASSET (placeholder)</td>
</tr>
<tr>
<td>Asset:Bank</td>
<td>BANK</td>
</tr>
<tr>
<td>Asset:Property</td>
<td>ASSET</td>
</tr>
<tr>
<td>Liability</td>
<td>LIABILITY (placeholder)</td>
</tr>
<tr>
<td>Liability:C信用 Card</td>
<td>CREDIT CARD</td>
</tr>
<tr>
<td>Liability:Home Loan</td>
<td>LIABILITY</td>
</tr>
<tr>
<td>Income</td>
<td>INCOME (placeholder)</td>
</tr>
<tr>
<td>Income:Salary</td>
<td>INCOME</td>
</tr>
<tr>
<td>Income:Interest</td>
<td>INCOME</td>
</tr>
<tr>
<td>Expense</td>
<td>EXPENSE (placeholder)</td>
</tr>
<tr>
<td>Expense:Groceries</td>
<td>EXPENSE</td>
</tr>
<tr>
<td>Expense:Auto</td>
<td>EXPENSE</td>
</tr>
<tr>
<td>Expense:Medical</td>
<td>EXPENSE</td>
</tr>
<tr>
<td>Equity</td>
<td>EQUITY (placeholder)</td>
</tr>
</tbody>
</table>
Conventionally, the oldest transaction would be equity transfers from Equity:Opening Balances to Asset and Liability Accounts. Most subsequent transactions would be transfers from Income/Expense accounts to Assets/Liability accounts (representing day-to-day activity e.g. receiving salary, paying utility bill), or transfers between assets and liability accounts (representing movements between loans and assets, e.g. paying credit card bill, receiving a loan).

The following use cases will be illustrated, and the options to be selected explained:

### Using the Transaction Report to show previous year expenses

The Transaction Report can show how much was spent on expense accounts last year. This will usually be the most useful basic transaction report format. To create this report:

1. Open the report options, from the Accounts tab, click the Expense placeholder account and Select Children.
2. From the General tab, Choose relative dates “Start of Previous Year” and “End of Previous Year”.
3. From the Sorting tab, set Primary Key to Accounts, and enable Primary Key Subtotal.
4. Set the Secondary Key to Date, and set the Secondary Key Subtotal to None.

### Secondary level grouping

The following will modify the above Transaction Report to use a secondary grouping strategy. The first grouping (i.e. Primary Key = Accounts, Subtotal = enabled) will group transactions from the same accounts, whereas the secondary grouping (i.e. Secondary Key = Date, Subtotal = Monthly) will also calculate monthly sums within each account.

1. Select options as above
2. From the Sorting tab, set Secondary Key Subtotal to Monthly

### Using secondary grouping for periodic comparison

The Display / Subtotal Table adds a subtotal summary table, which will ease comparison of accounts across date periods. This displays the same subtotal calculations as the main table, presented in a grid structure.

In addition, if there are multiple primary-key groups (e.g. Date grouping with monthly subtotals, across multiple months) the subtotal table will also compute and display the primary-key grouping Average. The average is computed as the total amount per row, divided by the number of columns. This may cause confusion when computing monthly spend averages, for instance, if a month has no transactions and is not displayed in the table, it will not create a corresponding column in the table, therefore the average amount will not reflect a true monthly average.

1. Select options as above
2. From the Display tab, enable the Subtotal Table.

### Use filtering to limit accounts and transactions

Accounts and transactions can be filtered for reporting according to account full name (e.g. ":Business:" will select account structure Income:Business:Sales, Income:Business:Grants, Expenses:Business:Rent,
Expenses: Business: Utilities) or transaction description/notes/memo (select transactions tagged #gift). The filtering text may be either a standard string, or a POSIX regular expression.

1. From the Filter tab, complete the Account Name Filter, or Transaction Filter. Optionally toggle the regular expression check boxes to toggle full POSIX regex matching. Regular expressions will allow more complex queries e.g. the transaction filter can be set to (#gift|#travel) which will filter transactions with either #gift or #travel. They can be complicated and are best learned from external guides.

**Using the Transaction Report to generate a reconciliation statement.**

This sortkey 'reconcile status' will separate reconciled, cleared and unreconciled transactions. This report may be useful in producing a printable reconciliation report.

Alternatively, the Reconciliation Report will preset these defaults and requires only the Accounts selection.

1. From the Accounts tab, select the relevant bank or credit card account

2. From the General tab, choose an appropriate date range e.g. past 3 months

3. From the Sorting tab, set the Primary Key to Reconcile Status, Primary Key Subtotal to enabled, and set the Secondary Key to Date. The Secondary Date Subtotal is left to None
Chapter 11. Capital Gains

This chapter will present some of the techniques used to keep track of the unrealized and realized gains and losses, better known as capital gains and losses.

Basic Concepts

This chapter will present some of the techniques used to keep track of the unrealized and realized gains and losses, better known as capital gains and losses.

Certain resellable assets can change value over time, such as stocks, bonds, houses, or cars. Some assets could increase in value, some could decrease in value. It is important to be able to track some of these time-dependent asset valuations, this chapter will show you how.

Probably everything you own will increase or decrease in value over time. So, the question is for which of these assets should you track this changing value? The simple answer is that you only need to track this for items which could be sold for cash in the future or which relate to taxation.

Consumable and disposable items (for example, food, gas for your car, or printer paper) are obviously not involved. Thus, even though the new clothes you recently bought will certainly depreciate, you would not want to track this depreciation since you have no intention of reselling the clothes and there is no tax implications to the depreciation on clothing. So, for this example, the purchase of new clothes should be recorded as a pure expense... you spent the money, and it is gone.

Asset appreciation occurs when something you own increases in value over time. When you own an asset which has increased in value, the difference between the original purchase price and the new value is known as unrealized gains. When you sell the asset, the profit you earn is known as realized gains or capital gains. An example of an asset from which you could have unrealized gains, and eventually capital gains, is stock in a publicly traded company.

Estimating Valuation

As mentioned in the introduction to this chapter, capital gains are the profits received from the sale of an asset. This section will describe how to record capital gains in GnuCash.

The accounting methods for handling asset appreciation differs somewhat from depreciation because typically you are only concerned with the moment you sell the asset and realize the capital gains. This is opposed to the continuous nature of tracking depreciation. Capital gains are an important subject in the world of taxation, because governments tend to be quite interested in taxing capital gains in one manner or another.

Note

As always, there are exceptions. If you hold a bond that pays all of its interest at maturity, tax authorities often require that you recognize interest each year, and refuse this to be treated as a capital gain. Consult the appropriate tax codes to determine the preferred treatment for each type of asset you have which may be affected by capital gains taxes.

Estimating the increasing value of assets is generally not simple, because often it is difficult to know its exact value until the moment it is sold.

Securities traded daily on open markets such as stock exchanges are possibly the easiest type of asset to predict the value of, and selling the asset at market prices may be as simple as calling a broker and
issuing a Market Order. On the other hand, estimating the value of a house is more difficult. Homes are sold less often than stocks, and the sales tend to involve expending considerable effort and negotiations, which means that estimates are likely to be less precise. Similarly, selling a used automobile involves a negotiation process that makes pricing a bit less predictable.

Values of collectible objects such as jewelry, works of art, baseball cards, and “Beanie Babies” are even harder to estimate. The markets for such objects are much less open than the securities markets and less open than the housing market. Worse still are one-of-a-kind assets. Factories often contain presses and dies customized to build a very specific product that cost tens or hundreds of thousands of dollars; this equipment may be worthless outside of that very specific context. In such cases, several conflicting values might be attached to the asset, none of them unambiguously correct.

The general rule of thumb in accounting for estimating unrealized gains (or loses) is that you should only revalue assets such as stocks which are readily sellable and for which there are very good estimates of the value. For all other assets, it is better to simply wait until you sell them, at which time you can exactly determine the capital gains. Of course, there is no hard rule on this, and in fact different accountants may prefer to do this differently.

**Account Setup**

**Important**

In the next few sections, unrealized gain accounts are created, and the estimated unrealized gain transactions are recorded there in order for users to understand unrealized gain easily. However, it is not necessary to record unrealized gains unless large corporations like which adopt IFRS in actual accounting. The small enterprise users, who are using GnuCash, should not record unrealized gains. Record into GnuCash only when realized gains are fixed.

As with most accounting practices, there are a number of different ways to setup capital gains accounts. We will present here a general method which should be flexible enough to handle most situations. The first account you will need is an asset Cost account (GnuCash account type Asset), which is simply a place where you record the original purchase of the asset. Usually this purchase is accomplished by a transaction from your bank account.

In order to keep track of the appreciation of the asset, you will need three accounts. The first is an Unrealized Gains asset account in which to collect the sum of all of the appreciation amounts. The Unrealized Gains asset account is balanced by a Unrealized Gains income account, in which all periodic appreciation income is recorded. Finally, another income account is necessary, called a Realized Gains in which you record the actual capital gains upon selling the asset.

Below is a generic account hierarchy for tracking the appreciation of 2 assets, ITEM1 and ITEM2. The Assets:Fixed Assets:ITEM1:Cost accounts are balanced by the Assets:Current Assets:Savings account, the Assets:Fixed Assets:ITEM1:Unrealized Gains accounts are balanced by the Income:Unrealized Gains account (similar for ITEM2).

```
-Assets
  -Current Assets
  -Savings
  -Fixed Assets
    -ITEM1
      -Cost
      -Unrealized Gains
    -ITEM2
```

188
Example

Let’s suppose you buy an asset expected to increase in value, say a Degas painting, and want to track this. (The insurance company will care about this, even if nobody else does.)

Start with an account hierarchy similar to that shown in the section called “Account Setup”, but replace ITEM1 with Degas and remove the ITEM2 accounts. We will assume that the Degas painting had an initial value of one hundred thousand dollars. Begin by giving yourself $100,000 in the bank and then transferring that from your bank account to your Assets:Fixed Assets:Degas:Cost account (the asset purchase transaction). You should now have a main account window which appears like this:

Figure 11.1. Asset Appreciation Main Window

The asset appreciation example main window
Unrealized Gains

A month later, you have reason to suspect that the value of your painting has increased by $10,000 (an unrealized gain). In order to record this you transfer $10,000 from your Income:Unrealized Gains account to your Assets:Fixed Assets:Degas:Unrealized Gains account. Your main window will resemble this:

Figure 11.2. Asset Appreciation Main Window

![Chart of Accounts after unrealized gain]

Selling

Let’s suppose another month later prices for Degas paintings have gone up some more, in this case about $20,000, you estimate. You duly record the $20,000 as an unrealized income like above, then decide to sell the painting.

Three possibilities arise. You may have accurately estimated the unrealized gain, overestimated the unrealized gain, or underestimated the unrealized gain.

1. Accurate estimation of unrealized gains.
Your optimistic estimate of the painting’s value was correct. First you must record that the profits made are now realized gains, not unrealized gains. Do this by transferring the income from the Income:Unrealized Gains to the Income:Realized Gains account.


These transactions should now appear as follows:

**Table 11.1. Turning an Unrealized Gain into a Realized Gain - Accurate Estimation**

<table>
<thead>
<tr>
<th>Account</th>
<th>Transfer to</th>
<th>Transaction Amount</th>
<th>Account Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Income:Unrealized Gains</td>
<td>Income:Realized Gains</td>
<td>$30,000</td>
<td>$0</td>
</tr>
<tr>
<td>Assets:Fixed Assets:Degas:Cost</td>
<td>Assets:Current</td>
<td>$100,000</td>
<td>$0</td>
</tr>
<tr>
<td>Assets:Fixed Assets:Degas:Unrealized Gains</td>
<td>Assets:Current Savings</td>
<td>$30,000</td>
<td>$0</td>
</tr>
</tbody>
</table>

This leaves the Assets:Current Assets:Savings account with a total of $130,000 and Income:Realized Gains with a total of $30,000.
Figure 11.3. Asset Appreciation Main Window

Chart of Accounts after realized gains

2. *Over estimation* of unrealized gains.

You were over-optimistic about the value of the painting. Instead of the $130,000 you thought the painting was worth you are only offered $120,000. But you still decide to sell, because you value $120,000 more than you value the painting. The numbers change a little bit, but not too dramatically.

The transactions should now appear as follows (observe the last transaction which balances the *Unrealized Gains* account):

**Table 11.2. Turning an Unrealized Gain into a Realized Gain - Over estimation**

<table>
<thead>
<tr>
<th>Account</th>
<th>Transfer to</th>
<th>Transaction Amount</th>
<th>Account Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Income:Unrealized Gains</td>
<td>Income:Realized Gains</td>
<td>$20,000</td>
<td>$10,000</td>
</tr>
<tr>
<td>Assets:Fixed Assets:Degas:Cost</td>
<td>Assets:Current</td>
<td>$100,000</td>
<td>$0</td>
</tr>
<tr>
<td>Assets:Fixed Assets:Degas:Unrealized Gains</td>
<td>Assets:Current</td>
<td>$20,000</td>
<td>$10,000</td>
</tr>
</tbody>
</table>
Capital Gains

<table>
<thead>
<tr>
<th>Assets:Fixed Assets:De-gas:Unrealized Gains</th>
<th>Income:Unrealized Gains</th>
<th>$10,000</th>
<th>$0</th>
</tr>
</thead>
</table>

This leaves the Assets:Current Assets:Savings account with a total of $120,000 and Income:Realized Gains with a total of $20,000.

3. **Under estimation** of unrealized gains.

You manage to sell your painting for more than you thought in your wildest dreams ($150,000). The extra value is, again, recorded as a gain, that is an income.

The transactions should now appear as follows (observe the last transaction which balances the Unrealized Gains accounts):

![Table 11.3. Turning an Unrealized Gain into a Realized Gain - Under estimation](image)

<table>
<thead>
<tr>
<th>Account</th>
<th>Transfer to</th>
<th>Transaction Amount</th>
<th>Account Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Income:Unrealized Gains</td>
<td>Income:Realized Gains</td>
<td>$50,000</td>
<td>$-20,000</td>
</tr>
<tr>
<td>Assets:Fixed Assets:De-gas:Cost</td>
<td>Assets:Current s:Savings</td>
<td>$100,000</td>
<td>$0</td>
</tr>
<tr>
<td>Assets:Fixed Assets:De-gas:Unrealized Gains</td>
<td>Assets:Current s:Savings</td>
<td>$50,000</td>
<td>$-20,000</td>
</tr>
<tr>
<td>Income:Unrealized Gains</td>
<td>Assets:Fixed Assets:De-gas:Unrealized Gains</td>
<td>$20,000</td>
<td>$0</td>
</tr>
</tbody>
</table>

This leaves the Assets:Current Assets:Savings account with a total of $150,000 and Income:Realized Gains with a total of $50,000.

**Taxation**

Taxation policies vary considerably between countries, so it is virtually impossible to say anything that will be universally useful. However, it is common for income generated by capital gains to not be subject to taxation until the date that the asset is actually sold, and sometimes not even then. North American home owners usually find that when they sell personal residences, capital gains that occur are exempt from taxation. It appears that other countries treat sale of homes differently, taxing people on such gains. German authorities, for example, tax those gains only if you owned the property for less than ten years.

Chris Browne has a story from his professional tax preparation days where a family sold a farm, and expected a considerable tax bill that turned out to be virtually nil due to having owned the property before 1971 (wherein lies a critical “Valuation Day” date in Canada) and due to it being a dairy farm, with some really peculiar resulting deductions. The point of this story is that while the presentation here is fairly simple, taxation often gets terribly complicated...
Chapter 12. Multiple Currencies

This chapter will show how to set up GnuCash accounts to use multiple currencies.

Basic Concepts

GnuCash supports over a hundred currencies, from the Andorran Franc to the Zimbabwe Dollar. For example, you can have a bank account set up in Euros, and another using Hong Kong Dollars.

Some of the issues which arise when using multiple currencies are as follows:

• How do you transfer funds between accounts with different currencies?

• How do you calculate the overall value when you have mixed currency accounts?

• How do reports deal with mixed currencies?

You can either deal with multiple currencies using manually entered transactions to record currency gains and losses as described in the section called “Manually Recording Currency Transaction” or you can utilize currency trading accounts introduced with GnuCash version 2.3.14 to automatically record the gains and losses on transactions between currencies as described in the subsequent section. Trading accounts are not enabled by default in GnuCash and must be explicitly enabled as described in the section called “Automatically Recording Currency Transactions using Trading Accounts”.

Manually Recording Currency Transaction

Account Setup

Your default account currency is set in the Account tab under Edit → Preferences (GnuCash → Preferences on macOS).

Similarly, GnuCash offers an option to set your preferred currency for displaying reports (like the balance sheet and income statement). The option is called Default Report Currency, and is in the Reports tab of the GnuCash Preferences screen. You’ll want to set both options when you start using GnuCash because if (for example) your accounts are all in Canadian Dollars but the generated reports are all in US Dollars, the reports will just say that there are “no data/transactions (or only zeroes) for the selected time period”.

When you create a new account, you have the option to define the commodity in which that account is denominated. For accounts denominated in a currency, you can specify any of the currencies supported by GnuCash by simply selecting it from the currency commodity list. You will notice that the default currency is the currency that is defined for the parent account of the new account.

As an example, let’s set up a bank account scenario where you mostly work in US Dollars, but do also have a European bank account using the Euro currency, as well as one bank account in Hong Kong using Hong Kong Dollars. So, set up 3 bank accounts, one denominated in US Dollars, one using Euros, and the third in Hong Kong Dollars. One possible account structure for this would be:

-Assets (USD)
- Current Assets (USD)
  - US Bank (USD)
  - European Bank (EUR)
  - HK Bank (HKD)
- Equity (USD)
  - Opening Balances (USD)
    - USD (USD)
    - EUR (EUR)
    - HKD (HKD)

**Note**

The currency of each account is shown in parenthesis.

Since in this example you mostly work in USD, all of the parent accounts are set to USD. Of course, if you mostly work in Euros, you could change the currency of these parent accounts to EUR. The totals shown in the account tree window will always be converted to the currency of each particular account. Notice, we also set up 3 Opening Balances equity accounts, used to initially populate the 3 banks.

**Note**

You could also set up just a single Opening Balance account and use a currency transfer to populate the “different currency” accounts. However, this is more advanced option, which is explained in a later section (the section called “Purchase of an Asset with Foreign Currency”).

Below you see the result of this example, in which you start with 10,000 USD, 10,000 EUR as well as 10,000 HKD in the three bank accounts. Notice that the total of the parent accounts only shows the value of the currency of sub-accounts with matching currencies. In other words, the Total Assets and Total Equity values only reflect USD amounts, because GnuCash has no way of evaluating the value of EUR or HKD yet. Once you set up exchange rates between the currencies, the parent accounts will calculate the converted value of all sub-accounts. See the later section (the section called “Recording and Updating Currency Exchange Rates”) on ways to do this.
Figure 12.1. Initial multi currency Account Bank Setup

Initial setup of 3 bank accounts with different currencies.

Notice that the Total (Report) column is being displayed. This is configured in the column header row, select Arrow down and select Total(USD).

User-Defined Currencies

Usually when we talk about currencies, we mean government-backed currencies (or more precisely, currencies defined in ISO 4217 [https://en.wikipedia.org/wiki/ISO_4217]). GnuCash does not allow you to create your own currencies. If you want to track non-ISO currencies, you can use either of two workarounds, depending on which fits your needs better.
User-Defined Currencies Workarounds

Let’s say for example that you want to track loyalty points you’ve earned by buying from a certain group of businesses. The account which tracks your loyalty points will be Assets:Other:LoyaltyPoints.

1. Treat these as if they were a security—that is, like a stock or mutual fund.

In this workaround, you define a new security, of type FUND, called LoyalityPoints. This is pretty straightforward—when you create the new LoyalityPoints account, just set the account type to Stock or Mutual Fund, click the Select... button next to the Security/currency: box, and click New to define a new security of type FUND.

This is not really what the stock and mutual fund account types are meant for, but GnuCash will allow it. The downside is that you’ll have to enter a “price” for every transaction involving this account, because GnuCash needs the prices to figure out the monetary value of the points and treat them as one of your assets.

2. Use one of the “dummy” currencies for them.

In this workaround, you use one of the dummy currencies to track the loyalty points. These currencies are “XTS (Code for testing purposes)” and “XXX (No currency)”. If you use one of these for your LoyalityPoints account, you can enter transactions into the account without having to enter share prices for every transaction. And, you can keep using the same two dummy currencies to track all sorts of amounts—vacation dollars earned and used so far this year, vacation hours earned and used, health insurance benefits allowance used and remaining, and so on.

The drawback with this workaround is that you cannot define exchange rates for the dummy currencies to convert them to ISO currencies. If you want to do that, you really should use the first workaround.

Recording and Updating Currency Exchange Rates

GnuCash allows you to update the Currency Exchange Rates both manually and automatically. This process is essentially the same as setting share prices for investments (see the section called “Setting Share Price”). In the following two sections we will work through both methods.

Before we start, let’s have a quick look at the Chart of Accounts.
Figure 12.2. Initial multi currency Account Bank Setup

![GnuCash interface showing bank accounts with different currencies](image)

Initial set up of 3 bank accounts with different currencies.

As you see, the overall balances do not yet reflect any value for EUR or HKD holdings. Adding currency exchange rates will fix this.

**Manually Updating Exchange Rates**

Open the Price Database by going to Tools → Price Database.
Figure 12.3. The Price Database Window—Still Empty

Click on the Add button to add a new currency exchange rate. A window will appear in which you can set up a new exchange rate. This window should appear like this:
Add Price Database Window

Set the Namespace to CURRENCY and the Security to EUR (Euro). Then set the exchange rate between the selected security and the selected currency. The Price box defines how many units of currency are required to purchase one unit of the security. In this case, how many dollars it will take to purchase one Euro. In this example, you will set the exchange rate to 1 EUR for 1 USD.
Multiple Currencies

Figure 12.5. The Price Database window after setting the exchange rate between Euros and US Dollars
Figure 12.6. Chart of Accounts After Setting The Exchange Rate Between Euro And US Dollar

Observe that since you have no exchange rate for HKD, GnuCash doesn’t convert the HKD accounts to USD. This will be added in the next section.

**Automatic Updating Exchange Rates (How-To)**

In the previous section you saw how to manually define a new currency exchange rate, but GnuCash includes an automatic price update feature, which will now be described.

Open the Price Database by going to Tools → Price Database.
Multiple Currencies

Figure 12.7. Price Database Before Obtaining Online Quotes

Click on the Get Quotes button to automatically load the various exchange rates you need.

**Note**

If the Get Quotes button is disabled, that means that the Perl module Finance::Quote is not installed. For information on how to install it, please see the section called “Configuring for Automatic Retrieval of Quotes”.
GnuCash downloads exchange rates for all currencies that are in use in your various accounts. This will happen every time you click on Get Quotes or request GnuCash to download quotes as per the section called “Configuring for Automatic Retrieval of Quotes”.

Now when you check the main Chart of Accounts you will see that GnuCash has automatically converted the HKD amount to USD amount on the parent accounts that are in USD, as well as on the Total (USD) column. Also the Euro accounts have been been updated with the latest exchange rate.
Disabling Exchange Rate Retrieval

Whenever you create an account that uses a non-default currency, exchange rate retrieval will be automatically enabled for that currency. However, if you later delete that account, GnuCash will not automatically disable exchange rate retrieval for that currency.

If you have deleted the last account for a particular currency, and you do not wish to retrieve exchange rates for that currency anymore, do the following:

1. Open the Securities window by selecting Tools → Security Editor .
2. Make sure the Show National Currencies box is selected.
3. Expand the CURRENCY row.
4. Double click on the currency for which you want to disable exchange rate retrieval.
5. Deselect the Get Online Quotes box and click OK.

**Recording Purchases in a Foreign Currency**

Purchases in a foreign currency can be managed in two different options.

A. Use GnuCash's built-in currency exchange functions when you do your transactions. This is mainly used for one-time transactions, and nothing which happens regularly.

B. Use separate accounts to track transactions, where all involved accounts use the same currency. This is the recommended method, since it allows much better tracking and follow up. In this way, you do one currency exchange transaction, and after that you do normal transactions in the native currency.

The rest of this section will explain more based upon option “B”.

**Purchase of an Asset with Foreign Currency**

You are using USD as your default currency. But, you decide to purchase a boat in Jamaica. To do this, you opened a bank account in Jamaica, moved some money from the US, and then purchased your boat.

To record this in GnuCash we use the following basic account structure:

-Assets (USD)
  -Current Assets (USD)
    -US Bank (USD)
    -Jamaican Bank (JMD)
  -Fixed Assets (USD)
    -Boat (JMD)
-Equity (USD)
  -Opening Balances (USD)
  -USD (USD)

**Note**

The currency of each account is shown in parenthesis.

First you need to transfer 10,000 USD to Jamaica, and you use your US bank account (with a balance of 100,000 USD) for that. The bank gives you an exchange rate of 1 USD = 64 JMD, but charges you 150 USD to transfer the money.

**Figure 12.10. Transaction “Currency Transfer To Jamaica”**
Select the Jamaica transaction line (9,850.00 USD), right click and select Edit Exchange Rate

**Figure 12.11. Edit Exchange Rate**

In this dialog the exchange rate of a currency transaction is specified.

As Exchange Rate, you enter 1 USD = 64 JMD, since this is the rate your bank gave. Press ok in the Transfer Funds (Edit Exchange Rate) window, and then save this split transaction. Below is how it now looks in the main Chart of Accounts.

**Figure 12.12. Chart of Accounts before purchasing the boat**
Multiple Currencies

You choose to buy a boat for 509,000 JMD. To record this transaction in GnuCash, you will need to enter a simple transaction in Assets:Current Assets:Jamaican Bank withdrawing 509,000 JMD and transferring it to Assets:Fixed Assets:Boat.

Figure 12.13. The Chart Of Accounts After Purchasing The Boat

The Chart of Accounts now reflects that your bank account has been reduced by 509,000 JMD, and that your Fixed Assets boat account has been increased by the same amount. If you also have turned on the Chart of Accounts (Column Choice) Total (USD) you will see the corresponding value in USD. The USD value will always reflect the latest currency exchange rate you have either automatically or manually retrieved.

Purchasing Foreign Stocks

This example will show how to purchase stocks that are priced in a currency other than your primary currency.

Assume that you live in New York and therefore you have set the default currency to USD. You decide to purchase a stock traded in Hong Kong that is priced in HKD. You would also like to be able to track the various income and expense amounts per stock and broker.

You decide to purchase stock in the Beijing Airport (Hong Kong). The ticker for this stock is 0694.HK on Yahoo! Since you wanted to track all various income and expense amounts, here is the necessary account structure:

- Assets:Investments:Brokerage Accounts:Boom:0694.HK (0694.HK)
- Assets:Investments:Brokerage Accounts:Boom:Bank (HKD)
- Equity:Opening Balances:HKD (HKD)
- Expenses:Commissions:Boom:0694.HK (HKD)
- Income:Investments:Dividend:Boom:0694.HK (HKD)
Multiple Currencies

The Chart of Accounts looks like this after creating all the needed accounts:

**Figure 12.14. The Chart of Accounts For International Stocks**

The stock definition can be seen in the Security Editor (Tools → Security Editor).

**Figure 12.15. International Securities**

If you have not moved money (50,000 HKD) into the brokerage cash account (Assets:Investments:Brokerage Accounts:Boom:Bank), do so now, either using the Equity (HKD) account, or an existing bank account (Currency Transfer).

There are two ways to enter the actual purchase transaction: you can enter it from the cash account (shown below), or you can enter it from the stock account.

**Note**

If entered from the stock account, the stock is assumed to be priced in the currency of the parent account.
Let’s assume that the stock price is 3 HKD per share. To record the purchase, open the brokerage’s HKD cash account (*Assets:Investments:Brokerage Accounts:Boom:Bank*), and enter the following:

<table>
<thead>
<tr>
<th>Account Description</th>
<th>Debit/Credit</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Investments:Brokerage Accounts:Boom:Bank</td>
<td>Withdrawal</td>
<td>50,000</td>
</tr>
<tr>
<td>Expenses:Commissions:Boom:0694.HK</td>
<td>Deposit</td>
<td>500</td>
</tr>
<tr>
<td>Assets:Investments:Brokerage Accounts:Boom:0694.HK</td>
<td>Deposit</td>
<td>49,500 (16,500 shares)</td>
</tr>
</tbody>
</table>

If the exchange rate dialog box does not appear automatically, right-click on the stock row, and select Edit Exchange Rate. Enter the number of shares (16,500) as the To Amount.

**Figure 12.16. Transfer Funds**

Setting the number of shares in the Transfer Funds dialog

When you return to the Chart of Accounts, you will see the purchased shares reflected in the stock account’s total.
Multiple Currencies

Figure 12.17. The Purchased international stocks

![Chart of Accounts](image)

Chart of Accounts is now containing the international stocks

However, as you can see, the USD totals may be zero if GnuCash doesn’t have an exchange rate between USD and HKD. To fix this, go to Tools → Price Database and click the Get Quotes button to automatically retrieve the exchange rates you need.

### Note

To reiterate, this example shows how stock can be purchased in any currency by entering the transaction in the register of the cash account used to make payment. It is also possible to enter the purchase in the stock account’s register, but be aware that the stock is assumed to be priced in the currency of the stock account’s parent.

In this example, the stock account’s parent (Assets:Investments:Brokerage Account:Boom) is denominated in HKD. Since this is same currency as the stock price, the purchase can be safely entered in the stock account’s register.

**Tracking Currency Investments**

Currency investment is when you decide to invest in a different country's currency, and hope that it will rise in value relative your own currency.

When you enter these transactions into GnuCash, you will have to decide on how much detail you would like to have.

If you are not interested in detail at all, a very simple account structure would suffice:

- Assets:Investments:Currency:Bank (USD)
- Assets:Investments:Currency:XXX (XXX)

You would simply enter transfers between the two accounts, noting exchange rates as you went.

But, if you do want to be able to track capital gains or losses, as well as any fees, you do need a more complex account structure, such as:
Multiple Currencies

- Assets:Investments:Currency:Bank (USD)
- Assets:Investments:Currency:Currency Bank:XXX (XXX)
- Expenses:Investments:Currency:Bank (USD)

**Purchasing Currency**

When purchasing another currency, you will buy a certain number of units of foreign currency with your own currency, at a particular rate. For example, you might buy 10,000 USD worth of Andorran Francs, 1 USD = 5 ADF, with a transaction fee of 150 USD.

<table>
<thead>
<tr>
<th>Account</th>
<th>Deposit/Expense</th>
<th>Withdrawal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Investments:Currency:Bank (USD)</td>
<td>Withdrawal</td>
<td>10,000</td>
</tr>
<tr>
<td>Expenses:Investments:Currency:Bank (USD)</td>
<td>Expense</td>
<td>150</td>
</tr>
<tr>
<td>Assets:Investments:Currency:Currency Bank:ADF (ADF)</td>
<td>Deposit</td>
<td>49,250</td>
</tr>
</tbody>
</table>

The Exchange Rate window should pop up when you leave the last row in the split above (Currency Transaction). If this window does not pop up, right click on the row or select Actions, and select Edit Exchange Rate. In the Exchange Rate window you specify the exchange rate you got from the bank.

**Selling a currency investment**

Entering a currency sale is done in the same way as a currency buy except that you are now transferring money from the Currency account to your native currency’s Bank account (very similar to the section called “Selling Shares”).

The proper recording of the currency sale **must** account for realized gains or losses. This can be done using a split transaction. In the split transaction, you must account for the profit (or loss) as coming from an Income:Investments:Currency:Currency Bank:Capital Gains:XXX account (or Expense:Investments:Currency:Currency Bank:Capital Loss:XXX). To balance this income, you will need to enter the Currency asset twice in the split—once to record the actual sale (using the correct amount and correct exchange rate), and once to balance the income profit (setting the amount to 0).

In short, a selling Currency transaction should look something like below, seen again from the Assets:Investments:Currency:Currency Bank:XXX.

**Table 12.1. Selling a currency with a Split Transaction Scheme**

<table>
<thead>
<tr>
<th>Account</th>
<th>Deposit/Expense</th>
<th>Withdrawal/Income</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Investments:Currency:Bank (USD)</td>
<td>Sold Amount - Exchange Fee</td>
<td></td>
</tr>
<tr>
<td>Expenses:Investments:Currency:Bank (USD)</td>
<td>Exchange Fee</td>
<td></td>
</tr>
<tr>
<td>Assets:Investments:Currency:Currency Bank:XXX (XXX)</td>
<td>Sold Amount (= Purchased Balance + PROFIT)</td>
<td></td>
</tr>
<tr>
<td>Income:Investments:Currency:Currency Bank:Capital Gains:XXX (XXX)</td>
<td>[LOSS]</td>
<td>PROFIT</td>
</tr>
<tr>
<td>Assets:Investments:Currency:Currency Bank:XXX (XXX)</td>
<td>PROFIT (with To Amount = 0)</td>
<td>[LOSS (with To Amount = 0)]</td>
</tr>
</tbody>
</table>
Reconciling Statements in a Foreign Currency

Reconciling foreign statement are done in the same manner as when you reconcile your local bank statement. If you have created a Chart of Accounts structure which allows you to have the same currency per account as your statement, it is actually exactly the same as reconciling your local bank statement.

If you have different currencies you might have to manually convert the amounts from one currency to another while you reconcile the accounts.

Automatically Recording Currency Transactions using Trading Accounts


Trading accounts are not enabled by default in GnuCash. To enable them go to File → Properties+Accounts tab and check the Use Trading Accounts checkbox.

Trading Account Concepts

In accounting terms, trading accounts are specialized equity accounts to record changes in income which result from transactions between two or more currencies. In GnuCash they are implemented as a top level account type of Trading. When trading accounts are enabled the required sub accounts of Trading are automatically created if they do not already exist when a transaction between one or more currencies is created.

In the extended Accounting Equation, Trading accounts would appear as follows:

\[ \text{Assets} = \text{Liabilities} + \text{Equity} (+ \text{Income} - \text{Expenses}) + \text{Trading} \quad (12.1) \]

Caution

The user is prevented from manually making entries directly to the registers for any of the accounts in the Trading top level account group. All entries to these accounts are automatically generated when transactions between currencies are created in other account registers within the GnuCash account hierarchy.

The Trading account group is structured below the top level account Trading with a sub-account CURRENCY which in turn has a sub-account for each currency between which transactions have been made. For the example previously used in the section called “Manually Recording Currency Transaction”, the additional accounts which will be created automatically when transactions are created between different currencies with trading accounts enabled are:

<table>
<thead>
<tr>
<th>Trading CURRENCY</th>
</tr>
</thead>
<tbody>
<tr>
<td>EUR</td>
</tr>
<tr>
<td>HKD</td>
</tr>
<tr>
<td>USD</td>
</tr>
</tbody>
</table>
Caution

The names of these accounts are again assigned automatically and cannot be changed by a user without disrupting the functionality of the trading accounts in GnuCash.

Recording Foreign Currency Transactions with Trading Accounts

Setup of Accounts for Trading Accounts

The same account structure used in the manual recording of currency transactions in the previous section is required. The initial account configuration for Assets and Equity accounts are as follows:

Figure 12.18. The Initial Multicurrency Bank Accounts Setup

Initial setup of bank accounts in multiple currencies.

The following prices were entered in the Price Database (Tools → Price Database) as at Jan. 1, 2020 to convert the account balances for the foreign currency accounts to USD:

Figure 12.19. The Initial Price Database Entries

Price Database window after setting initial exchange rates between USD, HKD and EUR.
With the currency prices set as shown, the Accounts tab will now display the values of the foreign accounts in USD in the Total(USD) column:

**Figure 12.20. The Initial Multicurrency Setup After Entering Exchange Rates Between USD, HKD and EUR**

![Accounts tab after setting exchange rates to USD.](image)

**Transfer of Funds to a Foreign Currency**

Let us assume we wish to purchase an item in Hong Kong using the Hong Kong bank account for 20,000 HKD on Feb. 1, 2020. The current funds in the Hong Kong account are insufficient and we will need to transfer another 10,200 HKD from the US bank account. The exchange rate at the time of the transfer is 1 USD = 7.7884 HKD and we will have to transfer 1,309.64 USD for which the bank charges a 40 USD transfer fee. The transaction to effect this is created with the Transfer Funds dialog as shown below:
Figure 12.21. The Transfer Dialog To Create Transaction For Transfer From USD To HKD

Transfer of 10,200 HKD from US Bank account to Hong Kong bank account.

The Debit Amount has been specified in HKD and the transaction Amount being transferred in USD. There is no provision to enter the transfer fee in the dialog. On closing the dialog the following transaction as viewed in the US Bank Account register has been created:

**Note**

Amount entered in the Transfer Funds are transferred from the selected Credit Account to the selected Debit Account. And if Debit Amount radio button is selected and the foreign currency amounts are entered, the transaction is recorded on the correct debit amounts. Whereas if Exchange Rate is selected and entered, the exact value is not often recorded due to the rounding errors.
Figure 12.22. The Transaction After Transfer Displayed in The US Bank Account Register

Transaction to transfer from US bank account to Hong Kong Bank account after closing transfer dialog.

The transaction can be opened in the US Bank Account register and may then be edited to add splits for the transfer fee as follows:

Figure 12.23. The Transaction After Adding The Splits For The Transfer Fee

Transaction to transfer from US bank account to Hong Kong Bank account after adding the splits for the transaction fee.

Returning to the Accounts tab we can see the result of the transfer transaction on the accounts:
Figure 12.24. The Account Tab Balances After Completion Of USD To HKD Transfer

Account balances in the Accounts tab after the transfer of funds from the US Bank account to the Hong Kong bank account.

The balances of the Asset and Equity accounts are presented with values set by the exchange rate entered in the transaction to transfer funds on Feb. 1, 2020.

The trading accounts have been automatically created and the amounts of the transfer have been entered into the accounts. There are no entries associated with the pre-existing opening balances of the accounts prior to the transfer. This reflects that the trading accounts only reflect gains and losses since the book was opened.

At this point there have been no trading gains or losses. The balances of the USD and HKD trading accounts are the same when converted to USD. The HKD trading account has a debit (negative balance) and the USD trading account has a credit balance (positive balance). The net balance of the CURRENCY sub account of Trading, and Trading itself, is 0 indicating that at this point no gains or losses have been recorded in the trading of currencies.

The hypothetical purchase in Hong Kong fails to take place and a month later on Mar. 1, 2020 the funds are required in the US account for another purpose. A transfer of 10,200.00 HKD is made from the Hong Kong bank account back to the US bank account. The exchange rate at the time of the transfer is 1 USD = 7.7933 HKD and a fee of 20.00 USD is charged for the transfer. The transaction to effect the transfer is as follows:
Figure 12.25. The Transaction To Transfer Funds From Hong Kong To US Bank Account

The transaction transfers 10,200.00 HKD from the Hong Kong Bank account to the US Bank account.

After transferring the funds back to the US Bank account, the prices database entries are as follows:

Figure 12.26. The Price database after transfer of funds back to US account

The price database showing prices for the transfer of funds to HKD and back to USD.

The Accounts tab balances after transferring the funds back are as follows:
Figure 12.27. The Accounts tab after transfer back

State of the accounts after the funds have been transferred back.

The Assets and Equity balances now reflect the values of the accounts at the exchange rate for the transfer of funds back to the US Bank account. The Trading and CURRENCY placeholder accounts now indicate a modest realized loss of 0.82 USD on the currency transactions. The associated transfer fees appear in the Expenses total. Not a profitable exercise but still illustrative.

**Note**

The gains or losses reported using trading accounts are realized gains and losses.

Finally we have the balance sheet after the above sequence of transactions reporting the Trading Loss incurred:
Balance Sheet after these transactions reflecting the trading loss incurred.
Part III. The Advanced Features
# Table of Contents

13. Business Features ................................................................. 225
   Introduction to Business Features ...................................... 225
   Business Setup ................................................................. 225
      Account Setup ............................................................... 225
      Setting up Sales Tax Tables .......................................... 226
      Enter Company Information .......................................... 228
      Setting Business Preferences ....................................... 230
      Setting Billing Terms .................................................. 230
   Accounts Receivable ....................................................... 231
      System Components ....................................................... 232
      Customers ................................................................. 232
      Invoices ................................................................. 234
      Customer Jobs .......................................................... 237
      Process Payment ....................................................... 238
      Changing the Invoice Appearance .................................. 239
   Accounts Payable ............................................................ 241
      System Components ....................................................... 241
      Vendors ................................................................. 242
      Bills ................................................................. 243
      Vendor Jobs ............................................................ 246
      Process Payment ....................................................... 246
   Payroll .......................................................................... 247
      Basic Concepts ............................................................ 247
      Account Setup ............................................................ 247
      Payroll Protocol Sample ............................................. 248
      Business Payroll Example ............................................ 250

14. Budgets ........................................................................... 254
   Basic Concepts .................................................................... 254
   Terminology ....................................................................... 254
   Creating a Budget ............................................................. 254
      Choose Which Accounts To Budget For ............................ 254
      Choosing a Budget Period ............................................. 255
      Getting Started ............................................................ 255
      Entering Budget Values ............................................... 255
   Budget Reporting ............................................................. 255
      Budgeted Income Statement ........................................ 256
      Budgeted Balance Sheet .............................................. 256

15. Other Assets ..................................................................... 257
   General Concepts ............................................................. 257
   Other Assets Described ..................................................... 257
      Current Assets ............................................................. 257
      Long-term (Fixed) Assets ............................................. 257
   Current Assets .................................................................... 257
      Short-term Receivables .................................................. 258
      Reimbursable Expenses ............................................... 258
      Travel Advances .......................................................... 259
      Prepaid Premiums or Prepaid Rent ................................. 259
      Suspense or Wash Accounts ........................................ 260
   Short or Long-term Assets .................................................. 261
   Long-term (Fixed) Assets ................................................... 261
   Land ................................................................................. 261
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Advanced Features</td>
<td>224</td>
</tr>
<tr>
<td>Buildings</td>
<td>261</td>
</tr>
<tr>
<td>Leasehold Improvements</td>
<td>262</td>
</tr>
<tr>
<td>Vehicles or Equipment</td>
<td>262</td>
</tr>
<tr>
<td>Intangibles</td>
<td>262</td>
</tr>
<tr>
<td>16. Depreciation</td>
<td>263</td>
</tr>
<tr>
<td>Basic Concepts</td>
<td>263</td>
</tr>
<tr>
<td>Personal Finances</td>
<td>263</td>
</tr>
<tr>
<td>Business</td>
<td>263</td>
</tr>
<tr>
<td>Estimating Valuation</td>
<td>264</td>
</tr>
<tr>
<td>Depreciation Schemes</td>
<td>264</td>
</tr>
<tr>
<td>Account Setup</td>
<td>266</td>
</tr>
<tr>
<td>Example</td>
<td>267</td>
</tr>
<tr>
<td>17. Python Bindings</td>
<td>271</td>
</tr>
<tr>
<td>18. Importing Business Data</td>
<td>272</td>
</tr>
<tr>
<td>Importing Bills and Invoices</td>
<td>272</td>
</tr>
<tr>
<td>General</td>
<td>272</td>
</tr>
<tr>
<td>The format of the import file</td>
<td>272</td>
</tr>
<tr>
<td>Import your data</td>
<td>274</td>
</tr>
<tr>
<td>Feedback and statistics</td>
<td>275</td>
</tr>
<tr>
<td>What could go wrong?</td>
<td>275</td>
</tr>
<tr>
<td>Not supported invoice functionality</td>
<td>276</td>
</tr>
<tr>
<td>Importing Customers and Vendors</td>
<td>277</td>
</tr>
<tr>
<td>General</td>
<td>277</td>
</tr>
<tr>
<td>The format of the import file</td>
<td>277</td>
</tr>
<tr>
<td>Import your data</td>
<td>277</td>
</tr>
<tr>
<td>Feedback and statistics</td>
<td>279</td>
</tr>
<tr>
<td>What could go wrong?</td>
<td>279</td>
</tr>
<tr>
<td>Not supported customer/vendor functionality</td>
<td>280</td>
</tr>
</tbody>
</table>
Chapter 13. Business Features

Introduction to Business Features

The accounting needs of a business are quite different from that of a person. Businesses have customers that owe money, vendors which are owed money, employee payroll, more complex tax laws, etc. GnuCash offers business oriented features to facilitate these needs.

Accounts Receivable (A/R) are used by businesses to record sales for which they are not immediately paid. This is represented on the balance sheet as an asset, because the expectation is that you will receive payment soon.

Accounts Payable (A/P) record bills that businesses have received, but may not pay until later. This is represented on the balance sheet as a liability because you will have to pay for them.

A/R and A/P accounts are used primarily when you have a lot of bills and receipts flowing in and out, and do not want to lose track of them just because you do not pay or get paid right away. For most home users, A/R and A/P are too complicated to be worthwhile.

Business Setup

To set up GnuCash to handle accounts receivable or accounts payable for a company, these preliminary steps must be done.

• Build an appropriate Account Hierarchy.
• Set up Sales Tax Tables.
• Enter the company information in GnuCash.
• Set Business Preferences.
• Set up Billing Terms.

Account Setup

There are many different ways to set up a business account hierarchy. You can start with the Business Accounts setup which is available from the New Account Hierarchy assistant, or you could build one manually. To access the prebuilt Business Accounts, start GnuCash and click on File → New File and proceed until you see the list of available accounts, select Business Accounts.

The prebuilt Business Account hierarchy will not meet your needs exactly. You will need make adjustments to the hierarchy so that it will meet your particular needs. It should be close enough, however, that it is recommended you begin with it.

To use GnuCash’s integrated accounts receivable system, you must first set up a special account (usually a sub-account under Assets) to hold transactions for receivables. This account must be defined with account type A/Receivable. GnuCash will use this account to place transactions related to the integrated accounts receivable system.

To use GnuCash’s integrated accounts payable system, you must first set up an account (usually a sub-account under Liabilities) to hold transactions for payables. This account must be defined with account
type A/Payable. GnuCash will use this account to place transactions related to the integrated accounts payable system.

**Basic A/R and A/P Account Hierarchy:**

- Assets
  - Accounts Receivable
  - Checking
- Expenses
  ...(as required)
- Income
- Sales
- Liabilities
  - Accounts Payable
  - Tax
    - Tax on Purchases
    - Tax on Sales

You need to add additional accounts to this hierarchy for it to be useful.

**Note**

You do not need to create an individual A/R account for each customer. GnuCash keeps track of customers internally and provides per-customer reports based on the internal tracking. The same applies to A/P and vendors.

**Note**

If you deal with customers in more than one currency you will need a separate Accounts Receivable account for each currency.

If you deal with vendors in more than one currency you will need a separate Accounts Payable account for each currency.

**Note**

Transactions involving an Accounts Receivable or Accounts Payable account should not be added, changed or deleted in any way other than by using Post/Unpost Bill/Invoice/Voucher or Process Payment!

**Setting up Sales Tax Tables**

Sales Tax Tables can be used to determine the tax for customer invoices (or vendor bills).

A tax table entry can be assigned to an invoice line or bill line.

Set up distinct tax tables for customers and vendors.

The default invoice tax table entry can be assigned to each customer and the default bill tax table entry can be assigned to each vendor.

The default tax table entry for new customers or new vendors can be specified in the Book Options window which can be accessed by File → Properties → Business tab.
Sales Tax Tables are maintained using the *Sales Tax Table* editor which is accessed via menu Business → Sales Tax Table.

**Figure 13.1. Sales Tax Tables Editor**

![Sales Tax Tables Editor](image1)

**Figure 13.2. New Sales Tax Table Entry**

![New Sales Tax Table Entry](image2)

- **Name** This is the tax table name.

- **Type** Either Percent % or Value $.

- **Value** This is the percentage or value depending on Type.

- **Account** This is the account to which tax will be posted. For tax collected from customers, this should probably be a Liability account as it must be payed to the government. For tax paid to vendors, if tax laws allow tax paid to vendors to offset tax collected from customers, this should probably also be a Liability account (even though it will usually have a debit balance) so that the net tax owed to the government can be easily observed.

If you set up Tax on Purchases and Tax on Sales as subaccounts of Liabilities:Tax then the net tax will be rolled up and can be seen in the GnuCash Accounts tab.
If unsure about tax law requirements, get professional advice.

The following charts illustrate sample tax tables and may be used as starting points to determine the setup appropriate for a particular jurisdiction.

**Table 13.1. Sample Tax Table Entries for EU country (e.g. 21% / 6% / 0% Belgium, 20% / 5% / 0% UK etc.) (2017)**

<table>
<thead>
<tr>
<th>Tax Table</th>
<th>Tax Table Entries [Asset/Liability]</th>
<th>Percentage or Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard VAT Sales</td>
<td>VAT:Sales:Standard [L]</td>
<td>21%</td>
</tr>
<tr>
<td>Reduced VAT Sales</td>
<td>VAT:Sales:Reduced [L]</td>
<td>6%</td>
</tr>
<tr>
<td>Zero-Rated VAT Sales</td>
<td>VAT:Sales:Zero [L]</td>
<td>0%</td>
</tr>
<tr>
<td>EC Sales</td>
<td>VAT:Sales:EC [L]</td>
<td>21%</td>
</tr>
<tr>
<td></td>
<td>VAT:Sales:Reverse EC [L]</td>
<td>-21%</td>
</tr>
<tr>
<td>Reduced VAT Purchases</td>
<td>VAT:Purchases:Reduced [A]</td>
<td>6%</td>
</tr>
<tr>
<td>Zero-Rated VAT Purchases</td>
<td>VAT:Purchases:Zero [A]</td>
<td>0%</td>
</tr>
</tbody>
</table>

**Table 13.2. Sample Tax Table Entries for Australia (2017)**

<table>
<thead>
<tr>
<th>Tax Table</th>
<th>Tax Table Entries [Asset/Liability]</th>
<th>Percentage or Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard GST Sales</td>
<td>GST:Sales:Standard [L]</td>
<td>10%</td>
</tr>
<tr>
<td>GST-free Sales</td>
<td>GST:Sales:Zero [L]</td>
<td>0%</td>
</tr>
<tr>
<td>Standard GST Purchases</td>
<td>GST:Purchases:Standard [A]</td>
<td>10%</td>
</tr>
<tr>
<td>GST-free Purchases</td>
<td>GST:Purchases:Zero [A]</td>
<td>0%</td>
</tr>
</tbody>
</table>

**Table 13.3. Sample Tax Table Entries for Cook County, Illinois (2017)**

<table>
<thead>
<tr>
<th>Tax Table</th>
<th>Tax Table Entries [Asset/Liability]</th>
<th>Percentage or Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chicago Sales Taxes</td>
<td>Taxes:Sales:State [L]</td>
<td>6.25%</td>
</tr>
<tr>
<td></td>
<td>Taxes:Sales:City [L]</td>
<td>1.25%</td>
</tr>
<tr>
<td></td>
<td>Taxes:Sales:County [L]</td>
<td>1.75%</td>
</tr>
<tr>
<td></td>
<td>Taxes:Sales:Region [L]</td>
<td>1%</td>
</tr>
</tbody>
</table>

**Enter Company Information**

After you have built the account structure and defined your tax tables, designate your company in the GnuCash file. To do this, select the Business tab in the Book Options window, which can be accessed from File → Properties.
Here you can:

- Enter the name of your company along with contact information such as your phone number, fax number, e-mail address and website URL.

- Enter your company’s tax payer id number in the Company ID field.
• Select default tax tables applicable to your most common customers and vendors.

**Setting Business Preferences**

Set options on the Business tab of the GnuCash preferences, which is accessed via Edit → Preferences (GnuCash → Preferences on macOS). See GnuCash Manual chapter 10.3.3 Business Book Options Tab.

**Setting Billing Terms**

Billing Terms can be used to determine the payment due date and be a guide for determining discount for early payment of invoices (or vendor bills).

**Note**

As of GnuCash 2.6.7, Billing Terms are only partially supported. Date due is calculated using the Billing Terms but discount amount is not.

Discount for early invoice payment is not implemented. There are 2 ways this may be done, although neither is recommended, and professional advice should be used to confirm that regulations are being complied with:

- After creating and posting a payment which pays the invoice in full, manually edit the payment transaction (usually strongly discouraged) and split the payment to reduce it by the amount of the discount and create a compensating split in an income (discount) account.

- Alternatively, after creating and posting a payment for the discounted amount, create a credit note for the discount using a specific negative sales income (discount) account for the transfer account.

You can specify the billing terms on each invoice/bill. Invoice billing terms will default from the customer billing terms. Bill billing terms will default from the vendor billing terms.

Billing Terms are maintained using the Billing Terms Editor which is accessed via menu Business → Billing Terms Editor.

**Figure 13.4. Billing Terms Editor**
Figure 13.5. New Billing Term

- Name The internal name of the billing term. For some examples of billing term names and descriptions see https://wiki.gnucash.org/wiki/Payment_Terms.
- Description The description of the billing term, printed on invoices
- There are 2 types of billing terms, with different information to be entered
  - Type Days
    - Due Days The invoice or bill is due to be paid within this number of days after the post date
    - Discount Days The number of days after the post date during which a discount will be applied for early payment
    - Discount % The percentage discount applied for early payment
  - Type Proximo
    - Due Day The day of the month bills are due
    - Discount Day The last day of the month for the early payment discount
    - Discount % The discount percentage applied if paid early
    - Cutoff Day The cutoff day for applying bills to the next month. After the cutoff, bills are applied to the following month. Negative values count backwards from the end of the month.

Accounts Receivable

Accounts Receivable (or A/R) refers to products or services provided by your company for which payment has not yet been received.
System Components

Transactions generated by the A/R system are recorded within the Accounts Receivable account. *You should not work directly with this account.* Instead, you will work with the four integrated GnuCash A/R application components available through the Business → Customer sub-menu. These four components are:

- **Customers** are people or companies to whom you sell products or services on credit.
- **Invoices** represent the physical invoice you send to a customer to request payment. This invoice contains an itemized list of things you sold.

In addition, GnuCash also has support for Credit Notes which represent the inverse of Invoices. A credit note is usually handed to a customer to correct items that were incorrectly invoiced or returned.

Both document types will be set up using the same menu items. Credit notes were introduced starting with GnuCash stable release 2.6.0.

- **Jobs** (optional) is where you register Customer Jobs. Jobs are a mechanism by which you can group multiple invoices to a particular customer.
- **Process Payments** is used to register payments you received from a customer.

Customers

Customers are people or companies to whom you sell goods or services. They must be registered within the A/R system.

New

To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer information, such as Company Name, Address, Phone, Fax, etc.
Find and Edit

To search for an existing customer, use the Business → Customer → Find Customer window. You select a customer to View/Edit from the results of the search. This window is also used to look up customers when creating invoices and processing payments.
Figure 13.7. Find Customer Window

If many customers match the search criteria you provide, the search can be refined by running an additional search within the current results. The current result set is searched when the Refine Current Search radio button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the customer you are searching for does not match the supplied search criteria, change the search criteria, click the New Search radio button and then the Find button. The relevant step is the New Search selection. If the customer is not in the result of the original search, and you only search within this set, the customer cannot be found, regardless of new search criteria.

**Note**

To return a list of all registered active customers, set the search criterion to matches regex, and place a single dot "." in the text field area. Make sure Search only active data is checked, then click Find. The regular expression "." means to match anything.

**Invoices**

An invoice is the paperwork you send to a customer to request payment for products or services rendered. GnuCash can generate and track invoices.

A credit note is the paperwork you send to a customer to correct products or services rendered that were incorrectly invoiced. GnuCash can generate and track credit notes via the same menu entries as invoices.

**Note**

This section applies to both invoices and credit notes. In order to avoid repeating everything twice and to keep the text easier to read it will refer only to invoices. You can apply it equally to credit notes. Only where the behavior of credit notes differs from invoices this will be explicitly mentioned.

**New**

To send an invoice to a customer you must first create the new document. To create an invoice use Business → Customer → New Invoice. The New Invoice window must be filled in appropriately.
Figure 13.8. Creating a New Invoice

When you click the OK button, the Edit Invoice window opens.

**Edit**

From the Edit Invoice window you can enter an itemized list of goods and services you sold on this invoice in a manner similar to how the account register works. For credit notes you enter an itemized list of goods and services you refunded instead.

Figure 13.9. Edit Invoice Window
When you have finished entering all the items, you can Post and print the invoice.

**Post**

When you finish editing an invoice and are ready to print, you must Post the invoice. The invoice does not have to be posted immediately. In fact, you should only post an invoice when you are ready to print it. Posting an invoice places the transactions in an accounts receivable account.

**Figure 13.10. Post Invoice Window**

![Post Invoice Window](image)

**Find**

To find an existing invoice, use the Business → Customer → Find Invoice menu item. From the results of the search, you can select an invoice to edit or view.

**Note**

Before you can edit a posted invoice, you will need to Unpost it.

One of the design goals in GnuCash’s Account Receivable system was to allow different processes to get to the same state, so you can reach an invoice from different directions based on the way you think about the problem:

- You can search for the customer first, then list their invoices.
- You can search for invoices by number or by company name.
- You can list invoices associated with a customer job.

**Print**

After you post an invoice, you should print it and send it to your customer. To print an invoice use File → Print Invoice menu item.
Business Features

Figure 13.11. Invoice Print Output

![Invoice Print Output](image)

Note

You can modify the appearance of the invoice, i.e., add a company logo, etc. To do so, see the section called “Changing the Invoice Appearance”.

Invoices can also be printed from the main window by selecting Reports → Business Reports → Printable Invoice from the main menu. The resulting report window states that no valid invoice is selected. To select the invoice to print:

1. Use the Options Toolbar button or select Edit → Report Options from the main menu.
2. Select the General tab of the report options dialog.
3. Click the Select button next to the Invoice Number field.
4. Search for the invoice as usual.

You can also print invoices from within the Process Payment dialog. See the section called “Process Payment” for instructions on how to do so.

Assign Starting Invoice Number

By default, GnuCash starts with invoice number 1 and increments from there. You can manually type an invoice number into the text box each time you create an invoice, but this gets tiring and sooner or later leads to duplicate numbers.

You can change the starting invoice number if it is important to you. Use File → Properties, access the Counters tab, change the Invoice number value to be one less than your desired starting invoice number and click the OK button or the Apply button.

Customer Jobs

Customer Jobs are used to group multiple invoices and credit notes to the same customer. Use of the Customer Jobs feature is optional. The feature is useful when you have multiple jobs for the same customer, and would like to view all the invoices and credit notes related to a single job.
To use customer jobs, you must create them using the Business → Customer → New Job menu item. You will see the New Job window.

To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the desired job in the search results, and click the View/Edit Job button.

To select from the invoices and credit notes associated with a given job, use Business → Customer → Find Job menu item. Select the desired job in the search results and click the View Invoices button. A window listing invoices and credit notes associated with this job appears. Select an invoice or credit note and click the View Invoice button to open an invoice editor in the main application window.

**Process Payment**

Eventually, you will receive payment from your customers for outstanding invoices. To register these payments, use the Process Payment application found in Business → Customer → Process Payment.
Figure 13.13. Process Payment From Customer

![Invoice Payment Window]

Changing the Invoice Appearance

The default Invoice style, as shown in the section called “Print”, is fairly barren. The default invoice style leaves the top part of the form blank, so you can print on company letterhead paper. There are some things you can do to change invoice appearance.

Use File → Properties to enter your Company information in the Business tab of the Book Options window. Some of the entered information is printed on the right side of invoices.

To add a customized background, heading banner or logo to invoices, modify the invoice style sheets. To do this, go to Edit → Style Sheets and select the New button in the Select HTML Style Sheet window that will appear. You will then see a window like this:

Figure 13.14. New Style Sheet Window

![New Style Sheet Window]

Give a Name to the new style sheet (e.g. Custom Invoice) and select the Fancy Template. When you click the OK button, the HTML Style Sheet Properties window is displayed. This window presents you five sections listed in the left pane: Colors, Fonts, General, Images, and Tables. The Colors section allows you to change the colors of various items of the invoice. The Fonts section lets you set fonts type and dimensions. The General section allows you to set the Preparer and Prepared for information, and to Enable Links. The Images section allows you to import graphics into the style sheet. The Tables section allows you to adjust the spacing around the tables which make up the invoice.

To include a company logo, banner heading and background image, use your favorite graphics application such as The Gimp or Apache OpenOffice/LibreOffice Draw to save the images in either GIF or PNG format. Then import them into the style sheet using the Images section described above.
Below is an example that imports all three types of images.

**Figure 13.15. HTML Style Sheet Example Window**

The HTML Style Sheets window with an example Background Tile, Heading Banner, and Logo.

**Note**

The images are placed in the invoice as follows. The Background Tile is tiled to become the background image, the Heading Banner goes to above the invoice text, and the Logo is placed in the upper left corner of the invoice to the left of the Heading Banner. You will probably have to try a few different sized images until you get the invoices to print nicely. Some sizing suggestions are that the Logo should be 1 square cm (~0.5 inch), and the Heading Banner should be 15 cm (~6 inches) wide and 1 cm (~0.5 inch) tall.

With the style sheet configured, when you print the invoice, you select the style sheet to use from the Options menu. Below is the resultant invoice after applying the style sheet demonstrated above.
Accounts Payable

Accounts Payable (or A/P) refers to the accounting of products or services which a company has bought and needs to pay for.

System Components

GnuCash has an integrated accounts payable system. The transactions generated by the A/P system are placed within the Accounts Payable account, as a record of what occurs. Generally you do not directly work with this account but use the four integrated GnuCash A/P application components. The A/P components are available from the Business → Vendor sub-menu. These A/P components are:

- Vendors are people or companies from which you buy products or services on credit.
- Bills represent the physical bills vendors send to request payment from you. A bill contains an itemized list of things you purchased.

In addition, GnuCash also has support for Credit Notes which represent the inverse of Bills. A credit note is usually received from a vendor to correct items that were erroneously billed or returned.

Both document types will be set up using the same menu items.

- Jobs (optional) is where you register Vendor Jobs. Jobs are mechanism by which you can group multiple bills from a particular vendor.
- Process Payments is where you register payments to a vendor to whom you owe money.

The following sections introduce the individual Accounts Payable application components.
**Vendors**

A vendor is a company or person from whom you purchase goods or services. Vendors must be registered within the A/P system.

**New**

To register a new vendor, select the Business → Vendor → New Vendor menu item. Fill in general information about the vendor, such as Company Name, Address, Phone, Fax, etc. Below is a list of the other options:

This is what the New Vendor registration window looks like:

**Figure 13.17. New Vendor Registration Window**

![New Vendor Registration Window](image)
### Find and Edit

To search for an existing vendor, use the Business → Vendor → Find Vendor window. You select a vendor to View/Edit from the results of the search. This window is also used to look up a vendor when entering bills and processing payments.

#### Figure 13.18. Find Vendor Window

If many vendors match the search criteria you provide, the search can be refined by running an additional search within the current results. The current result set is searched when the Refine Current Search radio button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the vendor you are searching for does not match the supplied search criteria, change the search criteria, click the New Search radio button and then the Find button. The relevant step is the New Search selection. If the vendor is not in the result of the original search, and you only search within this set, the vendor cannot be found, regardless of new search criteria.

#### Note

To return a list of all registered active vendors, set the search criterion to matches regex, and place a single dot “.” in the text field area. Make sure Search only active data is checked, then click Find. The regular expression “.” means to match anything.

### Bills

A bill is a request for payment you receive from a vendor. GnuCash can track bills.

A credit note is the document you receive from a vendor to correct products or services rendered that you were incorrectly charged for on a bill. GnuCash can generate and track credit notes via the same menu entries as bills.

#### Note

This section applies to both bills and credit notes. In order to avoid repeating everything twice and to keep the text easier to read it will refer only to bills. You can apply it equally to credit notes. Only where the behaviour of credit notes differs from bills this will be explicitly mentioned.

### New

When you receive a bill from a vendor and want to enter it into GnuCash, you must create a new bill. To create a new bill use the Business → Vendor → New Bill menu item, and fill in the resulting window appropriately.
Figure 13.19. New Bill Registration Window

When you click the OK button the Edit Bill window opens.

**Edit**

From the Edit Bill window you can enter an itemized list of goods and services you purchased, in a manner similar to how the account register works. For credit notes you enter an itemized list of goods and services the vendor refunded instead.
When you have finished entering all the items, Post the bill.

**Post**

When you finish editing a bill, you should Post the bill. You do not have to post the bill, you can close it and return to it later. You have to post the bill eventually. Posting a bill places its transactions into an accounts payable account. The Post Bill window appears and asks you to enter information:

**Figure 13.21. Post Bill Window**

To find an existing bill, use the Business → Vendor → Find Bill menu item. From the results of the search, you can select a bill to edit, or view.
**Note**

Before you can edit a posted bill, you will need to Unpost it.

**Note**

There are other ways to access an existing bill. These are similar to accessing invoices for your customers. See the section called “Find” for more information.

**Vendor Jobs**

Vendor Jobs are used to group multiple bills and credit notes from a single vendor. Use of the vendor jobs feature is optional. The feature is useful when you have multiple jobs for the same vendor, and would like to view all the bills and credit notes for a single job.

To use vendor jobs, you must create them using the Business → Vendor → New Job menu item. You will see the New Job window.

**Figure 13.22. New Vendor Job**

To edit an existing vendor job, use the Business → Vendor → Find Job menu item. Select the desired job in the search results, and click the View/Edit Job button.

To select from the bills associated with a given job, use Business → Vendor → Find Job menu item. Select the desired job in the search results and click the View Invoices button. A window listing bills and credit notes associated with this job appears. Select a bill or credit note and click the View Invoice button to open a bill editor in the main application window.

**Process Payment**

Eventually, you need to pay your bills. To do so, use the Process Payment application found in Business → Vendor → Process Payment.
Payroll

Payroll is a financial record of wages, net pay, paid vacations, and deductions for an employee. This section demonstrates how to track payroll using GnuCash.

Basic Concepts

Payroll is a financial record of wages, net pay, paid vacations, and deductions for an employee. Basically, anything that relates to giving money or benefits to an employee. Payroll is one of the more complex tasks in accounting, because there are many different accounts, people, and agencies involved in paying salaries.

Payroll is typically accounted for as an expense. Sometimes accountants “store” some payroll expenses in a short term liability account. This is useful for things such as payroll taxes, which may be paid at a different time than the employee. The employee might get paid biweekly, while taxes are paid quarterly. This chapter presents a methodology which expenses payroll immediately for salaries, but stores taxes in liability accounts.

Note

GnuCash does not have an integrated payroll system. While you can track payroll expenses in GnuCash, the calculation of taxes and deductions has to be done outside of GnuCash.

Account Setup

Local tax law must be considered when setting up accounts. Because there are many different ways payroll taxes are handled throughout the world, this section presents a very simple structure. From this, you should be able to adapt your particular payroll deductions setup.

Assume that you must pay 2 taxes, Tax1 and Tax2, and that each has an employee contribution and an employer contribution.

The employee’s salary and these two taxes are expense accounts. The tax components are liability accounts. The tax liability accounts are where you accumulate the taxes withheld for all of your employees. The taxes are later paid to the appropriate government agency.
Simple Payroll Account Layout:

- Assets
  -- Checking
- Liabilities
  -- Tax1  (short term “storage” account)
  -- Tax2  (short term “storage” account)
- Expenses
  -- Salaries
  -- Tax1
  -- Tax2

**Note**

Resist the temptation to create per-employee sub-accounts to track individual salaries. Creating a sub-account for each employee leads to unmanageably large lists of accounts. Imagine the account structure after a few years of employees coming and going. It is much simpler to keep all of your employees’ payroll records within a single account (Expenses:Salaries for example) and use reports to view per-employee information.

The Transaction report can be used to sort and total by description or memo (but not by part of them).

To report salary transactions for a specific employee where the employee name or code is entered in the transaction description or memo, use the Find Transaction assistant (Edit → Find) to select the transactions, and then report on them using Reports → Account Report. Further formatting or analysis may be done by copying and pasting the report into a spreadsheet. See Find Transaction [https://www.gnucash.org/docs/v5/C/gnucash-manual/tool-find.html?tool-find-txn] in the GnuCash Manual.

**Payroll Protocol Sample**

GnuCash does not have an integrated payroll system. GnuCash can track your payroll expenses, but you need to develop a payroll protocol and perform the calculations outside of GnuCash, in a spreadsheet for example. In this section, one such protocol is presented. You can use the sample protocol as a model.

**Step 1: Deductions list**

The first step to the payroll protocol is to create a list of all the possible taxes and deductions for each employee. Each entry should include definitions and formulas for calculating each value. Once the protocol is established it needs to be changed only when payroll laws or tax rates change.

In the proposed scenario, such a list would look like this:

- **E_GROSS_SALARY** - Employee gross salary
- **E_TAX1** - Employee contribution to tax1 (X% of E_GROSS_SALARY)
- **E_TAX2** - Employee contribution to tax2 (X% of E_GROSS_SALARY)
- **C_TAX1** - Company contribution to tax1 (X% of E_GROSS_SALARY)
- **C_TAX2** - Company contribution to tax2 (X% of E_GROSS_SALARY)

**Note**

The employee’s net salary (E_NET_SALARY) is defined as E_GROSS_SALARY - E_TAX1 - E_TAX2 and need not be placed in this list since it is composed of items that already exist.
Place the actual formulas for calculating each deduction in this list. Sometimes these formulas are quite complex, and sometimes they simply say "look it up in table XYZ of the tax codes".

Notice that you can calculate some interesting values using the above definitions. One such value is the total cost to the company: \( E_{GROSS\_SALARY} + C_{TAX1} + C_{TAX2} \).

### Step 2: Create the Transaction Map

When you record payroll in GnuCash, do so with a single split transaction. This split transaction populates the appropriate expense and liability accounts. If you need to look the payroll details at a later time, open the split transaction.

With the deductions list from above, an employee split transaction map can be generated. Each of the items in the list is mapped to a GnuCash account.

#### Table 13.4. Payroll Transaction Map

<table>
<thead>
<tr>
<th>Account</th>
<th>Increase</th>
<th>Decrease</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Checking</td>
<td>E_NET_SALARY</td>
<td></td>
</tr>
<tr>
<td>Expenses:Salaries</td>
<td>E_GROSS_SALARY</td>
<td>E_TAX1</td>
</tr>
<tr>
<td>Liabilities:Tax1</td>
<td></td>
<td>E_TAX1</td>
</tr>
<tr>
<td>Liabilities:Tax2</td>
<td></td>
<td>E_TAX2</td>
</tr>
<tr>
<td>Expenses:Tax1</td>
<td>C_TAX1</td>
<td></td>
</tr>
<tr>
<td>Liabilities:Tax1</td>
<td></td>
<td>C_TAX1</td>
</tr>
<tr>
<td>Expenses:Tax2</td>
<td>C_TAX2</td>
<td></td>
</tr>
<tr>
<td>Liabilities:Tax2</td>
<td></td>
<td>C_TAX2</td>
</tr>
</tbody>
</table>

Note that the \( C_{TAX1} \) and \( C_{TAX2} \) components have entries in both the liability and expense accounts. The company component of each tax is expensed at the time of payroll, but remains a liability until taxes are due.

### Step 3: Pay the Employee

Go to the account from which the employee will be paid, for example your Assets:Checking account. Open a split transaction and enter the real values using the Transaction Map above as a guide. Repeat this for all employees.

**Tip**

This manual process is tedious, especially if you have a large number of employees.

One GnuCash tool you certainly want to use when entering employee payroll is duplicate transaction (use the Duplicate Toolbar button). This saves you from having to enter all the transaction splits for each employee. You still need to change the amounts of money to match each employee’s real payroll values, but you will not have to build the split for each employee.

If payroll transactions do not change significantly every pay period, you can also use the duplicate transaction feature to duplicate each employee’s most recent payroll transaction for the current pay period. If you find you are doing so all the time, read about the Schedule Transactions feature and save even more time!
Step 4: Pay the Government

The final thing to do is to pay the taxes to the government. The liability accounts have been collecting the taxes for various government agencies, and periodically you need to send a check to the government to pay this charge. To do so, you simply enter a 2 account transaction in (for example) your checking account to pay off the tax liability. The transaction is between the checking account and the liability account, no expense account is involved. The expense accounts are charged at the time the tax liability is recorded.

Business Payroll Example

Using the account setup seen previously, let’s go through an example. Assume that there are 2 employees (E1 and E2) who each earn $1000 per month gross salary. The employee contribution to Tax1 and Tax2 are 10% and 5% respectively. The company contribution to Tax1 and Tax2 are 15% and 10% each on top of the employee’s gross salary.

Starting with $50k in the bank, and before doing any payroll, the account hierarchy looks like this:

Figure 13.24. Payroll Example: Initial Setup
The deductions list for employee 1 are:

- $E_{GROSS\_SALARY}$ - Employee gross salary - $1000
- $E_{TAX1}$ - Employee contribution to tax1 - $100 (10% of $E_{GROSS\_SALARY}$)
- $E_{TAX2}$ - Employee contribution to tax2 - $50 (5% of $E_{GROSS\_SALARY}$)
- $C_{TAX1}$ - Company contribution to tax1 - $150 (15% of $E_{GROSS\_SALARY}$)
- $C_{TAX2}$ - Company contribution to tax2 - $100 (10% of $E_{GROSS\_SALARY}$)

Table 13.5. Payroll Transaction Map for Employee 1

<table>
<thead>
<tr>
<th>Account</th>
<th>Increase</th>
<th>Decrease</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets:Checking</td>
<td>$850 (E_NET_SALARY)</td>
<td></td>
</tr>
<tr>
<td>Expenses:Salaries</td>
<td>$1000 (E_GROSS_SALARY)</td>
<td>$100 (E_TAX1)</td>
</tr>
<tr>
<td>Liabilities:Tax1</td>
<td>$150 (C_TAX1)</td>
<td>$150 (C_TAX1)</td>
</tr>
<tr>
<td>Liabilities:Tax2</td>
<td>$100 (C_TAX2)</td>
<td>$100 (C_TAX2)</td>
</tr>
</tbody>
</table>

From the checking account, enter the split transaction for employee 1. It should look like this:

Figure 13.25. Payroll Example: Employee Split Transaction

The Split Transaction for Employee 1

**Tip**

When paying employees, enter only the employee name in the Description area. If you decide to use GnuCash’s check printing capabilities, the check is automatically made out to the correct employee. If you want to record other information in the transaction besides the employee name, use the Notes area, available when viewing the Register in double-line mode.

Repeat this for the second employee, which leaves the account hierarchy looking like this:

251
Now, you will enter the company contributions. The Liabilities:Tax1 and Liabilities:Tax2 accounts track how much you must pay to the government for each tax type. When it is time to pay these agencies, you will make a transaction from the checking account to these liability accounts. No expense accounts are involved. The main account will then appear like this:
Figure 13.27. Payroll Example: Accounts After Paying Government

<table>
<thead>
<tr>
<th>Account Name</th>
<th>Type</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets</td>
<td>Asset</td>
<td>$47,500.00</td>
</tr>
<tr>
<td>Checking</td>
<td>Asset</td>
<td>$47,500.00</td>
</tr>
<tr>
<td>Equity</td>
<td>Equity</td>
<td>$50,000.00</td>
</tr>
<tr>
<td>Starting Balances</td>
<td>Equity</td>
<td>$50,000.00</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense</td>
<td>$2,500.00</td>
</tr>
<tr>
<td>Salaries</td>
<td>Expense</td>
<td>$2,000.00</td>
</tr>
<tr>
<td>Tax1</td>
<td>Expense</td>
<td>$300.00</td>
</tr>
<tr>
<td>Tax2</td>
<td>Expense</td>
<td>$200.00</td>
</tr>
<tr>
<td>Liabilities</td>
<td>Liability</td>
<td>$0.00</td>
</tr>
<tr>
<td>Tax1</td>
<td>Liability</td>
<td>$0.00</td>
</tr>
<tr>
<td>Tax2</td>
<td>Liability</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

$. grand total: Assets: $47,500.00  Profits: -$2,500.00
Chapter 14. Budgets

This chapter explains how to create and use budgets with GnuCash.

Basic Concepts

A budget is a tool for estimating expected income and expenses. You can use it to help you plan how you intend for your finances to change over a period of time, and to examine how your actual financial transactions for the period compare to your planned transactions.

The budgeting concept is quite general, so GnuCash offers a budgeting tool that is both simple and flexible. You, the user, have to decide how complex or simple you want to make your budget. This guide will help you make some of those decisions.

Terminology

There are a few helpful terms listed below that will be used to discuss budgeting.

- **Budget** - A financial plan describing the expected revenues and/or disbursements for a particular time period
- **Cash Budget** - A budget planning for expected cash receipts and cash disbursements. This type of budget tracks cash flow -- where your money comes from, where it goes, and, of course, how much.
- **Expense Budget** - A budget chiefly for planning what you spend your money on. This type of budget tracks your expenses. It is typically not concerned with things like appreciation or repayment of liabilities. However, it would account for interest charges. For example, if you buy $100 worth of groceries with your credit card, you incur an $100 expense for groceries, and a $100 liability to your credit card company. When you pay the credit card bill for $110, you are incurring an additional interest expense of $10. An expense budget plans for the transaction of buying the groceries and paying the interest, but not the transaction of repaying the credit card company.
- **Capital Budget** - A budget that describes a plan for paying for a large future expense, often through a combination of saving and borrowing money. Note: Capital budgets can sometimes get quite complex because they can try to answer the question “Can we afford to do such-and-such?” by exploring various hypothetical scenarios that can involve hypothetical accounts.
- **Budget Period** - The period of time during which the plan is expected to take place. The most common budget periods are annual and monthly. Sometimes, you may budget for several consecutive periods at once, for convenience or for finer-grained planning. For example, an annual budget may include 12 monthly budget periods.

Creating a Budget

Even before you begin to make a budget, it’s important to have given some thought to your account hierarchy. For example, if you want to budget a certain amount for your electric bill and a certain amount for your water bill, you can’t have only an Expenses:Utilities account. Your accounts must be at least as specific as your budget.

Choose Which Accounts To Budget For

The first step in creating a budget is to decide what it is you want to plan for. This decision will affect which accounts you include in your budget. For example, if you are only interested in tracking your expenses,
you may create an expense budget by only entering amounts for expense accounts. On the other hand, if you want to track all of your cash flow, you may create a cash flow budget by entering amounts for asset, liability, income and expense accounts.

Before you begin to create your budget, you need to make two decisions: What accounts do I want to budget for? and When do I want my budget to be for? You can always change your mind later, after you’ve created a budget, but you need to start with something.

Tip

As a rule of thumb, if you mostly care about what you spend your money on, you may want to make an expense report. If you’re also concerned about having enough money in the right places at the right times, you may want to use a cash-flow budget.

Choosing a Budget Period

Before creating a budget you must also decide what period of time you want to plan for. The most common budget periods are monthly and annual. If you want your budget to plan for changes in financial patterns over time, then you should include multiple budget periods in your budget. For example, if you want to plan on having higher utility expenses in the winter than in the summer, then you might break your annual budget into 4 quarters or even 12 months, and budget a higher value for the winter periods than for the summer periods.

Getting Started

To create your first budget click on Actions → Budget → New Budget. You will immediately see a new budget with the default settings and no entries. Then click on the Options button. The most important options are the budget period and the number of periods. For the budget period, choose the beginning date and the smallest period of time that you want to plan for. Then, for the number of periods, choose how many periods you want to plan for.

The budget page now shows a list of accounts with a column for each budget period. The date shown in the title of each column is the beginning of that budget period.

Entering Budget Values

Now, you must enter the budget values - the amounts that you expect the account balances to change during the budget period. There are two ways to enter budget values. The first way is to simply click on the cell and enter an amount.

If you have past transactions recorded in GnuCash, the second way is to let GnuCash estimate the budget values by looking at those transactions. First, select the accounts you want GnuCash to estimate. Then click on the Estimate Toolbar button. In the Estimate Budget Values dialog, select the date past which GnuCash should look for past transactions. GnuCash will start at that date and look forward for the duration of your budget. For example, if you are making an annual budget, and you select Jan. 1, 2005, GnuCash will look at all the transactions in that account from Jan. 1, 2005 through Dec. 31, 2005.

Budget Reporting

You’ve already done the hardest part - creating your budget. But now you want to know how your actual financial transactions compare to your plan. You need to run the Budget Report.
Click on Reports → Budget → Budget Report. For each account, the Budget Report will show the budgeted and the actual amounts in two adjacent columns for each period in the budget. If you have created multiple budgets, you can use the Budget Report Options to select which budget to use in the report.

Two other types of budget reports are commonly used in the small business setting. They are the *Budgeted Income Statement* and the *Budgeted Balance Sheet*. 

**Budgeted Income Statement**

The budgeted income statement is similar to the income statement. Both show the revenues and expenses for a given period as well as the profit, which is the difference revenue - expenses. The income statement is based on historical data, but the *budgeted* income statement is based on the predictions made in the budget.

**Budgeted Balance Sheet**

The budgeted balance sheet is similar to the balance sheet. Both show the assets, liabilities, and equity. The difference is that the balance sheet is based on historical data, and the *budgeted* balance sheet is based on the predictions made in the budget.
Chapter 15. Other Assets

General Concepts

This chapter presents many additional accounting treatments for frequently encountered business and less-frequently found personal activities that need recording in accounting books. The explanations below cover both the description and purpose of the activity, and they include also the usual accounting treatments (bookings or recordings) for these transactions.

These concepts have evolved over centuries of experience by those keeping accounting records and will help you maximize your record keeping’s utility and meaningfulness.

This section introduces categorization of assets in the balance sheet based on time or the asset’s useful life (current and long-term). Sometimes assets are also considered from the standpoint of their liquidity, which is regarded as how close or distant the asset is from being turned into cash. Near-cash assets are relatively quickly converted to cash (e.g., accounts receivable), while assets requiring rather a long time to convert to cash are considered to be relatively fixed in their non-cash state (e.g., heavy equipment, buildings, land). (Fixed does not mean they were repaired!)

You should find that current assets parallel those with more liquidity, while long-term and fixed assets are those with much less liquidity. Finally, below you will find a few assets that could be either current or long-term based on the nature of the facts constituting them.

Other Assets Described

Current Assets

Current Assets are those activities whose normal expected life would be one year or less. Such activities could be tracking reimbursable expenses, travel advances, short-term loans to a friend or family member, prepaid expenses, annual insurance premium amortization, and so on. The individual entity could have many other kinds of short term activities that reflect what it is doing. (These asset types are explained individually below.)

Long-term (Fixed) Assets

Long-term (Fixed) Assets are those activities whose normal expected life exceeds one or more years. This grouping covers both tangible and intangible assets. Examples of tangible assets are land, buildings, and vehicles (cars, trucks, construction equipment, factory presses, etc.) Intangible assets include such things as patents, copy rights, goodwill, etc. Because the lives of some of these assets show wear and tear and deterioration in value over time, businesses and individuals can allow for that diminution in value by calculating depreciation on such assets. For example, land normally does not depreciate, but buildings do, as do equipment and vehicles. (These asset types are explained individually below.)

Current Assets

This section explains short-term receivables, reimbursable expenses, travel advances, prepaid premiums, prepaid rent, suspense or wash accounts.
**Short-term Receivables**

This kind of account is useful to reflect an agreement made with someone you trust. Suppose you lent someone $500 and he agreed to repay you $50 a month. If he paid on time, the loan you made would be paid off within a year, which is why it is classified as a short-term receivable. So you could record that loan initially in this account tree: *Other Assets: Current Assets: LoanToJoe*. At the time you give him the money: your entry is debit (increase) LoanToJoe $500 and credit (decrease) Bank $500. Each time you receive Joe’s payment you record $50 debit (increase) to Bank and credit (decrease) LoanToJoe.

**Tip**

Don’t become confused by the use of the word “Loan”. “Loan-To” is the tipoff that you really have a receivable, that is, you will receive from Joe, the money you previously loaned. Until he actually pays the money owed you, you reflect his debt in your books by an account describing your expectation--you will receive the money owed you, hence the word “receivable”.

**Reimbursable Expenses**

This kind of activity is one in which you spend your own money on behalf of someone else (your employer, perhaps) and later you receive repayment of what you spent. The case might be a business trip. The employer has a policy of covering (paying for) all authorized expenses. After the trip is over, the employee submits a report listing dates and amounts spent with receipts for all the expenditures. The employer reviews the report and pays for all items that it considers as having a valid business reason. (Normally, employees know in advance what the employer will reimburse, so only those items are recorded as a reimbursable expense on the employee’s books.)

Because a business trip can involve different kinds of expenditures (air travel, lodging, transportation at the destination, etc.), different kinds of expenditures would be recorded in the one account as long as the expenditures all related to the same trip. In other words, if a second trip is made before the first is fully settled, a second account for a different event could be set up. It would make sense to do this, if it would help to keep separate all the details of one trip from those of another. It is up to the person making the trip to decide how much trouble it would be to put separate trips in separate accounts or to put them all in the same account. The trip taker should remember that the account must be reconciled in order to know with certainty that all expenses have been reimbursed.

Recording the expenditures on the trip would be much the same. That is, if you paid trip expenses by cash you would debit (increase) the reimbursable expense account for the money paid in cash, because it is a receivable to you until it has been reimbursed to you. The credit offsetting your expenditure would decrease the account that shows the cash in your pocket or the account from which you drew the cash for the payment made. If you paid by credit card, the debit side would be the same as just described, but the credit would be an increase to the credit card company account on your books.

When you received your reimbursement, then the journal entry (or transaction) to record receipt of the funds from the employer would be: debit (increase) Bank for the check amount and credit (decrease) the reimbursable expense account for the check amount.

If it turns out that the reimbursable expense account is not zero balance after processing the employer’s payment, then it means that there is a difference between you and the employer in handling the expense, which needs to be investigated. If the balance is a debit (a positive balance), your account has some money that was not reimbursed. If the balance is a credit (a negative balance), you were paid for more than what you recorded as due you. In both of those situations you should reconcile the difference between what you recorded and what was paid. That effort should disclose exactly what is causing the discrepancy. You will need to contact the employer’s bookkeeper to know what was paid, if the reimbursement check was not accompanied by a detailed list of the items being paid you.
In the event the employer refused to reimburse you for an expenditure, that effectively makes it your expense. In that case, you would make this entry: debit (increase) your own Expense (appropriately named) and credit (decrease) the Reimbursable Expense account. That entry should result in a zero balance in the Reimbursable Expense account. If not, reconcile until you identify the difference.

Tip

Sometimes there are small differences that don’t match an individual entry. In those cases divide the amount by 2 or by 9. If the unresolved amount is divisible by two, it suggests that both you and the employer entered the item in the same manner: both as debits or both as credits. If it is divisible by 9, then likely one of you transposed adjoining numbers; e.g., one entered 69 and the other entered 96. If the difference is divisible neither by 2 or by 9, then it could be that more than one error is present.

Travel Advances

These are very similar to Reimbursable Expenses. The difference is that someone gives you money first; you spend it, and then you give a report accounting for what you spent it on. The report is supported by invoices establishing who, what, where, when, and how much for each expenditure. In the Reimbursable Expense case, you spent your money first and later recovered it.

In the Travel Advance case when you receive the advance, you record on your books this entry: debit (increase) Bank for the travel advance amount received (say, $500); credit (increase) the short-term liability Travel Advance ($500). This is a liability, because you are not gifted with the money, but only loaned it for the purpose of having funds to spend when doing the employer’s business.

Frequently, the way these monetary arrangements work is that at the beginning of for example a salesperson’s employment, he or she receives the advance and monthly (or more frequently) turns in a report about who, what, where, when, and how much he spent. The money in the report is reimbursed if approved.

During the period after receiving the advance and before filing a request for reimbursement report, the salesperson can record his or her expenditures into the advance liability account. In that case, the balance in the account will show how much of the advance has not yet been spent (assuming the Travel Advance balance is a credit). If no mistakes have been made and all expenses are approved, then the sum of the unspent account balance and the reimbursing check amount will equal the original travel advance amount.

It makes sense for the salesperson to record the travel expenses to this advance account (and not to his or her own expense accounts), because the money is being spent on behalf of the employer, for the employer’s authorized expenses. It is not the employee’s own money, and therefore not his or her own expense.

When the salesperson receives the report reimbursement (say, $350), he or she debits (increases) Bank, and credits (increases) again the Travel Advance liability account, assuming that previously he or she had been recording expenditures to the travel advance account. Tracking activity in this manner causes the account to always show the amount that is owed the employer.

See the section called “Reimbursable Expenses” above for what to do if the employer does not accept an item the employee put on the travel advance reimbursement request report. The difference resolution effort is essentially the same for both types of accounts.

Prepaid Premiums or Prepaid Rent

Some types of expenses are usually billed as semi-annual or annual amounts. For example, the insurance industry will bill home insurance annually, while car insurance premiums can be annual or semi-annual. For those that pay an amount that covers several months or a full year, the proper accounting treatment is to reflect in each accounting period the amount that expresses the benefit applying to that period.
In the case of someone who pays a full-year’s insurance premium at the beginning of the insurance period, the entry to record this is debit (increase) Prepaid Insurance Premium for say, $1,200, and credit (decrease) Bank for $1,200.

Then a monthly recurring journal entry (scheduled transaction) is created that debits (increases) Insurance Expense $100 and credits (decreases) Prepaid Insurance Premium $100. This technique spreads the cost over the periods that receive the insurance coverage benefit. Businesses following generally accepted accounting practices would normally use this technique, especially if they had to present financial statements to banks or other lenders. Whether individuals do depends on the person and how concerned they are to match cost with benefit across time periods. Another factor influencing use of this technique would be the number of such situations the person encounters. It is relatively easy to remember one or two, but more difficult if having to manage 10 to 20. You would set up as many or as few as proved useful and important to you.

**Suspense or Wash Accounts**

The purpose of these accounts is to provide a device to track “change of mind” situations. The objective of these accounts is to provide a temporary location to record charges and credits that are not to be included permanently in your books of record. When the transactions reflected in these accounts have been fully completed, Wash/Suspense accounts will normally carry a zero balance.

For example, say in the grocery store you see canned vegetables on sale, so you buy 6 cans at $1 per can. Say that the total purchases were $50. When you come home and are putting things in the cupboard you discover you already had 12 cans. You decide to return the 6 you just bought. Some persons in this situation would charge (increase) the whole bill to Grocery Expense; and when they returned the cans, they would credit (decrease) Grocery Expense. That is one way of handling that. The effect of this method is to leave recorded on your books the cost of items that you really did not purchase from a permanent standpoint. It is only when the items have actually been returned and the vendor’s return receipt has also been recorded that the distortion this method generates will then be removed.

Actually, there are several treatments, depending on when and how the original transaction was booked/recorded and when you decided to return the items purchased. Basically, did you change your mind before you recorded the transaction or after doing so?

If you decided to return the items after recording the purchase transaction, you may originally have charged Grocery Expense for the full amount ($50) of all items. In that scenario, what you kept and the amount of the items to be returned were grouped into one account. You could edit the original transaction and restate the amount charged to the Grocery Expense account to be the difference ($44) between the total paid ($50) for groceries and the value of the items to be returned. That leaves the returned-item value as the amount ($6) you should record to the Suspense account.

Obviously, if you decided to return items before you recorded your purchase, then you would book the original entry as a charge to Grocery Expense for the amount kept ($44) and as a charge to Suspense for the amount returned ($6). The off-setting credit ($50) to cash or credit card is not affected by these treatments.

When there are several persons shopping and at different vendors, there can be a case where there are several returns happening at once and in overlapping time frames. In that case the Wash Account is charged (increased) at time of changing the mind, and either Bank or Credit Card is credited. When the return occurs, the reverse happens: Bank or Credit Card is debited for the cash value of the returned items and the Wash/Suspense Account is credited in the same amount.

If the wash account has a non-zero balance, scanning the debit and credit entries in the account will show the non-matched items. That is, debits not matched by offsetting credits indicate items intended to be returned but not actually returned yet. The reverse (credits not matched by offsetting debits) indicates that returns were made but the original charge was not recorded in the Wash Account.
These differences can be cleared up by returning unreturned items or recording charges (debits) for items already returned. The mechanics of doing that likely will be finding the original expense account the item was charged to and making an entry like: debit Wash Account, credit original expense. It also could be as described above where the original recording is adjusted by adding a charge to Wash/Suspense account and decreasing the amount charged to the original account.

**Short or Long-term Assets**

This section explains why some types of assets may be short or long-term and presents an example.

An example is deposits (e.g., utility, rental, security). If the deposit agreement contains a provision to recover the deposit at the end of a year, the treatment could be that of a short-term asset. However, when the agreement is that the deposit holder returns the funds only upon successful inspection at the end of the relationship, then at the start of the relationship or agreement, the person paying the deposit has to decide whether to write it off as a current expense or to track it for eventual recovery at the end of the agreement (not infrequently, moving to a new location).

Whichever decision is made, the accounting treatment is to debit (increase) expense (assuming the write-off decision) or debit (increase) Deposits Receivable (assuming the intent is to recover the deposit in the future) and credit (decrease) Bank for the amount of the deposit (if paid by cash) or credit (increase) credit card if paid using that payment method.

**Long-term (Fixed) Assets**

This section illustrates long-term assets (those whose useful lives exceed a year) and discusses these types: land, buildings, leasehold improvements, intangibles, vehicles and other equipment.

**Land**

Land is not a wasting asset. That is, it does not get used up over time and rarely suffers damage such that it loses value. For that reason, it usually is recorded at cost at the time of purchase. Appreciation in its value over decades is not recorded and is not recognized in any way on the books of the owner. It is only after land has been sold that sale price and purchase cost are compared to calculate gain or loss on sale.

Land is frequently sold/purchased in combination with structures upon it. That means that the cost has to become separated from the cost of structures on it. Land valuation is usually part of the transfer of ownership process and its value is shown on the purchase documents separately from that of any structures it supports.

Land values shown on purchase documents frequently arise from the process of value determination managed by assessors whose job it is to assign values to land for tax purposes. Local and regional areas of a state or province use the values determined by assessors in their tax formulas, which provide revenues for local and regional governing authorities to finance their required community services.

Should land be acquired in a situation not subject to a history of land valuation by a formal valuation system, then the purchaser can appeal to real estate agents and an examination of recent sale transactions for information that would allow calculating a reasonable amount to express the value of the land.

**Buildings**

Buildings are the man-made “caves” in which much of life’s human interaction occurs. These structures are wasting assets, because in their use they or their components gradually wear. Over time they begin to lose some of their function and they can suffer damage due to planetary elements or human action.
Accepted accounting practice is to record the cost of the building determined at time of ownership transfer (purchase) or at conclusion of all costs of construction. Because buildings are frequently used for decades, and due to the need to be able to calculate gain or loss on sale, accounting practice preserves the original cost by not recording declines in value in the account containing the original purchase or construction cost.

Instead, the depreciation technique is used to show (in the balance sheet) the structure’s net book value (original cost reduced by accumulated depreciation). Depreciation is a separate topic treated elsewhere in this Guide.

**Leasehold Improvements**

When a business does not own the building where it operates, and instead has a long-term lease, it is not uncommon for the business tenant to make improvements to the premises so that the structure obtains both function and appearance that enhances conducting its business activities.

In these cases, the expenditures that the business incurs are recorded in a Leasehold Improvements account: increase (debit) Leasehold Improvements, decrease (credit) Bank or increase (credit) a suitable liability account (which could be a liability to a contractor or a bank or a credit card, etc.).

**Vehicles or Equipment**

Vehicles or Equipment of all kinds usually last for several years, but their useful lives are much shorter than that of assets that have little movement in their functioning. Because they do wear out over time, common accounting practice in business is to record depreciation using life spans and depreciation methods appropriate to the nature and use of the asset. Frequently, the life and depreciation methods chosen are influenced by what is permitted per national tax regulations for the kind of asset being depreciated.

Usually, businesses depreciate their assets. Individuals can do so as well to the degree that taxing authorities permit. Very wealthy persons employ accountants and attorneys to track and manage their investments and assets holdings to take advantage of all tax benefits permitted by law.

**Intangibles**

The mechanics of accounting (debiting and crediting appropriate accounts) for these assets are relatively simple, much the same as for any of the above assets. Where the difficulty lies is in their valuation, which is an advanced topic and not something that individual persons and small businesses would likely encounter. For that reason further discussion of items such as patents, copyrights, goodwill, etc. are left out of this Guide.
Chapter 16. Depreciation

This chapter will introduce the concept of depreciation in accounting and give some real life examples for using it.

Basic Concepts

Depreciation is the accounting method for expensing capital purchases over time. There are two reasons that you may want to record depreciation; you are doing bookkeeping for your own personal finances and would like to keep track of your net worth, or you are doing bookkeeping for a small business and need to produce a financial statement from which you will prepare your tax return.

The method of recording depreciation is the same in either case, but the end goal is different. This section will discuss the differences between the two. But first, some terminology.

- **Accumulated depreciation** - the accumulated total of book depreciation taken over the life of the asset. This is accumulated in the depreciation account in the asset section.
- **Book depreciation** - this is the amount of depreciation that you record in your financial statements per accounting period.
- **Fair market value** - the amount for which an asset could be sold at a given time.
- **Net book value** - this is the difference between the original cost and the depreciation taken to date.
- **Original cost** - this is the amount that the asset cost you to purchase. It includes any cost to get the asset into a condition in which you can use it. For example - shipping, installation costs, special training.
- **Salvage value** - this is the value that you estimate the asset can be sold for at the end of it’s useful life (to you).
- **Tax depreciation** - this is the amount of depreciation that you take for income tax purposes.

Personal Finances

Depreciation is used in personal finances to periodically lower an asset’s value to give you an accurate estimation of your current net worth. For example, if you owned a car you could keep track of its current value by recording depreciation every year. To accomplish this, you record the original purchase as an asset, and then record a depreciation expense each year (See the section called “Example” for an example). This would result in the net book value being approximately equal to the fair market value of the asset at the end of the year.

Depreciation for personal finance has no tax implications, it is simply used to help you estimate your net worth. Because of this, there are no rules for how you estimate depreciation, use your best judgement.

For which assets should you estimate depreciation? Since the idea of depreciation for personal finances is to give you an estimate of your personal net worth, you need only track depreciation on assets of notable worth that you could potentially sell, such as a car or boat.

Business

As opposed to personal finance where the goal is tracking personal worth, business is concerned with matching the expense of purchasing capital assets with the revenue generated by them. This is done through
Depreciation

book depreciation. Businesses must also be concerned with local tax laws covering depreciation of assets. This is known as tax depreciation. The business is free to choose whatever scheme it wants to record book depreciation, but the scheme used for tax depreciation is fixed. More often than not this results in differences between book and tax depreciation, but steps can be taken to reduce these differences.

Now, what purchases should be capitalized? If you expect something that you purchase to help you earn income for more than just the current year, then it should be capitalized. This includes things like land, buildings, equipment, automobiles, and computers - as long as they are used for business purposes. It does not include items that would be considered inventory. So if you made a purchase with the intent to resell the item, it should not be capitalized.

In addition to the purchase of the asset itself, any costs associated with getting the asset into a condition so that you can use it should be capitalized. For example, if you buy a piece of equipment and it needs to be shipped from out of town, and then some electrical work needs to be done so you can plug the machine in, and some specialized training is needed so you know how to use the machine, all these costs would be included in the cost of the equipment.

You also need to know the estimated salvage value of the asset. Generally, this is assumed to be zero. The idea behind knowing the salvage value is that the asset will be depreciated until the net book value (cost less depreciation) equals the salvage value. Then, when the asset is written off, you will not have a gain or loss resulting from the disposal of the asset.

The last step is to determine the method of depreciation that you want to use. This will be discussed on the next few pages.

Warning

Be aware that different countries can have substantially different tax policies for depreciation; all that this document can really provide is some of the underlying ideas to help you apply your “favorite” tax/depreciation policies.

Estimating Valuation

A central issue with depreciation is to determine how you will estimate the future value of the asset. Compared to the often uncertain estimates one has to do where appreciation of assets is concerned, we are on somewhat firmer ground here. Using sources listed below should make it fairly straight forward to estimate the future value of your depreciating assets.

• **Tax Codes:** For businesses that want to use depreciation for tax purposes, governments tend to set up precise rules as to how you are required to calculate depreciation. Consult your local tax codes, which should explicitly state how to estimate depreciation.

• **Car Blue Book:** For automobiles, it is easy to look up in references such as “Blue Books” estimates of what an automobile should be worth after some period of time in the future. From this you will be able to develop a model of the depreciation.

Depreciation Schemes

A **depreciation scheme** is a mathematical model of how an asset will be expensed over time. For every asset which undergoes depreciation, you will need to decide on a depreciation scheme. An important point to keep in mind is that, for tax purposes, you will need to depreciate your assets at a certain rate. This is called tax depreciation. For financial statement purposes you are free to choose whatever method you want. This is book depreciation. Most small businesses use the same rate for tax and book depreciation. This way there is less of a difference between your net income on the financial statements and your taxable income.
Depreciation

This section will present 3 of the more popular depreciation schemes: linear, geometric, and sum of digits. To simplify the examples, we will assume the salvage value of the asset being depreciated is zero. If you choose to use a salvage value, you would stop depreciating the asset once the net book value equals the salvage value.

1. **Linear depreciation** diminishes the value of an asset by a fixed amount each period until the net value is zero. This is the simplest calculation, as you estimate a useful lifetime, and simply divide the cost equally across that lifetime.

Example: You have bought a computer for $1500 and wish to depreciate it over a period of 5 years. Each year the amount of depreciation is $300, leading to the following calculations:

<table>
<thead>
<tr>
<th>Year</th>
<th>Depreciation</th>
<th>Remaining Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-</td>
<td>1500</td>
</tr>
<tr>
<td>1</td>
<td>300</td>
<td>1200</td>
</tr>
<tr>
<td>2</td>
<td>300</td>
<td>900</td>
</tr>
<tr>
<td>3</td>
<td>300</td>
<td>600</td>
</tr>
<tr>
<td>4</td>
<td>300</td>
<td>300</td>
</tr>
<tr>
<td>5</td>
<td>300</td>
<td>0</td>
</tr>
</tbody>
</table>

2. **Geometric depreciation** is depreciated by a fixed percentage of the asset value in the previous period. This is a front-weighted depreciation scheme, more depreciation being applied early in the period. In this scheme the value of an asset decreases exponentially leaving a value at the end that is larger than zero (i.e.: a resale value).

Example: We take the same example as above, with an annual depreciation of 30%.

<table>
<thead>
<tr>
<th>Year</th>
<th>Depreciation</th>
<th>Remaining Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-</td>
<td>1500</td>
</tr>
<tr>
<td>1</td>
<td>450</td>
<td>1050</td>
</tr>
<tr>
<td>2</td>
<td>315</td>
<td>735</td>
</tr>
<tr>
<td>3</td>
<td>220.50</td>
<td>514.50</td>
</tr>
<tr>
<td>4</td>
<td>154.35</td>
<td>360.15</td>
</tr>
<tr>
<td>5</td>
<td>108.05</td>
<td>252.10</td>
</tr>
</tbody>
</table>

Note: Tax authorities may require (or allow) a larger percentage in the first period. On the other hand, in Canada, this is reversed, as they permit only a half share of “Capital Cost Allowance” in the first year. The result of this approach is that asset value decreases more rapidly at the beginning than at the end which is probably more realistic for most assets than a linear scheme. This is certainly true for automobiles.

3. **Sum of digits** is a front-weighted depreciation scheme similar to the geometric depreciation, except that the value of the asset reaches zero at the end of the period. This is a front-weighted depreciation
Depreciation scheme, more depreciation being applied early in the period. This method is most often employed in Anglo/Saxon countries. Here is an illustration:

Example: First you divide the asset value by the sum of the years of use, e.g. for our example from above with an asset worth $1500 that is used over a period of five years you get 1500/(1+2+3+4+5)=100. Depreciation and asset value are then calculated as follows:

**Table 16.3. Sum of Digits Depreciation Scheme Example**

<table>
<thead>
<tr>
<th>Year</th>
<th>Depreciation</th>
<th>Remaining Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-</td>
<td>1500</td>
</tr>
<tr>
<td>1</td>
<td>100*5=500</td>
<td>1000</td>
</tr>
<tr>
<td>2</td>
<td>100*4=400</td>
<td>600</td>
</tr>
<tr>
<td>3</td>
<td>100*3=300</td>
<td>300</td>
</tr>
<tr>
<td>4</td>
<td>100*2=200</td>
<td>100</td>
</tr>
<tr>
<td>5</td>
<td>100*1=100</td>
<td>0</td>
</tr>
</tbody>
</table>

**Account Setup**

As with most accounting practices, there are a number of different ways to setup depreciation accounts. We will present here a general method which should be flexible enough to handle most situations. The first account you will need is an **Asset Cost** account (GnuCash account type Asset), which is simply a place where you record the original purchase of the asset. Usually this purchase is accomplished by a transaction from your bank account.

In order to keep track of the depreciation of the asset, you will need two depreciation accounts. The first is an **Accumulated Depreciation** account in which to collect the sum of all of the depreciation amounts, and will contain negative values. In GnuCash, this is an account type **asset**. The **Accumulated Depreciation** account is balanced by a **Depreciation Expense** account, in which all periodic depreciation expenses are recorded. In GnuCash, this is an account type **expense**.

Below is a generic account hierarchy for tracking the depreciation of 2 assets, **ITEM1** and **ITEM2**. The **Asset Cost** accounts are balanced by the **Bank** account, the **Accumulated Depreciation** account is balanced by the **Expenses:Depreciation** account.

```
-Assets
  -Fixed Assets
    -ITEM1
      -Cost
      -Depreciation  (Asset Cost account)
    -ITEM2
      -Cost
      -Depreciation  (Asset Cost account)
  -Current Assets
    -Bank
    -Expense
      -Depreciation  (Depreciation Expense account)
```

One of the features of the account hierarchy shown above is that you can readily see some important summary values about your depreciating asset. The **Assets:Fixed Assets:ITEM1** account total shows you
Depreciation

the current estimated value for item1, the Assets:Fixed Assets:ITEM1:Cost shows you what you originally paid for item1, Assets:Fixed Assets:ITEM1:Depreciation shows you your accrued depreciation for item1, and finally, Expenses:Depreciation demonstrates the total accrued depreciation of all your assets.

It is certainly possible to use a different account hierarchy. One popular account setup is to combine the Asset Cost and Accrued Depreciation asset accounts. This has the advantage of having fewer accounts cluttering your account hierarchy, but with the disadvantage that to determine some of the summary details mentioned in the paragraph above you will have to open the account register windows. As with most things, there are many ways to do it, find a way that works best for you.

The actual input of the depreciation amounts is done by hand every accounting period. There is no way in GnuCash (as of yet) to perform the depreciation scheme calculations automatically, or to input the values automatically into the appropriate accounts. However, since an accounting period is typically one year, this really is not much work to do by hand.

Example

Let’s go ahead and step through an example. Imagine you are a photographer and you use a car and an expensive camera for your personal business. You will want to track the depreciation on these items, because you can probably deduct the depreciation from your business taxes.

The first step is to build the account hierarchy (as shown in the previous section, replace ITEM1 and ITEM2 with “car” and “camera”). Now, record the purchase of your assets by transferring the money from your bank account to the appropriate Asset Cost accounts for each item (eg: the Assets:Fixed Assets:Car:Cost account for the car). In this example, you start with $30k in the bank, the car cost $20k and the camera cost $10k and were both purchased on January 1, 2000.
Figure 16.1. Asset Accounts Before Depreciation

The asset accounts still only have the investments stored.

Looking at the tax codes, we realize that we must report depreciation on these items using the “sum of digits” scheme, over a 5 year period. So, the yearly depreciation amounts for the car come to $6667, $5333, $4000, $2667, $1333 for years 1 to 5 respectively, rounded to the nearest dollar. The yearly depreciation amounts for the camera are $3333, $2667, $2000, $1333, $667. Consult the previous section on Depreciation Schemes for the formula for calculating these values.

For each accounting period (IE: fiscal year) you record the depreciation as an expense in the appropriate Accrued Depreciation account (eg: the Assets:Fixed Assets:Car:Depreciation account for the car). The two windows below show your car’s accrued depreciation account and the main window after the third year (IE: three periods) of depreciation using this sum of digits scheme.
Figure 16.2. Asset Depreciation In The Register

This account shows a list of depreciation transactions.

Figure 16.3. Accounts Tab After Asset Depreciation

The asset accounts got decreased by the depreciation.
Note

A Word of Caution: Since depreciation and tax issues are closely related, you may not always be free in choosing your preferred method. Fixing wrong calculations will cost a whole lot more time and trouble than getting the calculations right the first time, so if you plan to depreciate assets, it is wise to make sure of the schemes you will be permitted or required to use.
Chapter 17. Python Bindings

GnuCash historically has always been a traditional application in the sense that you open it, use it to manipulate your financial data via the windows it presents, save your data and close the windows again. This has the inherent limitation that you can only do whatever the windows, menus and toolbars allow you to do.

Sometimes you might need a little more flexibility. For example, you need a report with just a little different information than what the built-in reports provide, or you want to automate a frequently recurring action. Such custom manipulations are ideal candidates to write in one or the other scripting language.

Starting with GnuCash version 2.4 you can write Python scripts to manipulate your financial data.

Important

The Python extensions are an optional feature which creates additional dependencies. To be able to use Python scripts, GnuCash must have been built with the `cmake -DWITH_PYTHON=ON` option enabled, otherwise all what follows won’t work. At present this option is not enabled by default, so if you need this, you may have to compile GnuCash from source yourself. But some distributions offer it also as a separate package with a name like `python[version]-GnuCash`

The Python extensions come with a couple of ready to use scripts. This chapter will show you how to use some of them.

Tip

This chapter is not about how to write your own Python scripts. Refer to the developer documentation [https://code.gnucash.org/docs/STABLE/python_bindings_page.html] for that instead.
Chapter 18. Importing Business Data

Importing Bills and Invoices

General

This functionality creates invoices or bills from a csv import file containing rows of invoice entry data. The import file may contain rows for new and/or existing invoices. If an invoice already exists, GnuCash adds the imported entries to the invoice (unless the invoice is already posted). If the import file contains posting data for an invoice, then GnuCash will also attempt to post the invoice. If any row of an invoice contains an error, GnuCash will ignore all rows of the same invoice.

The field separator in the csv file must be either a comma or a semicolon; field values may be enclosed in double quotes.

For the sake of readability, in this chapter the term “invoice” by itself is used to refer to both customer invoices and vendor bills.

The format of the import file

The import file should contain rows of invoice entry data. Any row contains both header and entry fields, but GnuCash takes the invoice header data from the first row of an invoice ID. For informational purposes, the header data may be repeated for each subsequent row of the same invoice.

There is no information in the file to indicate whether it concerns customer invoice or vendor bill data. Instead, a user option in the import dialog makes that distinction.

Each row should contain the fields listed below, in the same sequence, separated by a comma or a semicolon. The fields are listed here by their technical name, which GnuCash uses in the preview of the import data.

- id - The invoice ID. If the invoice ID is blank, GnuCash replaces it with the invoice ID from the previous row. If the invoice ID already exists, GnuCash will add the entries to the existing invoice (unless it is already posted).

- date_opened - Use the same date format as defined in Preferences. Defaulted to today's date if left blank, or if the date provided is not valid.

- owner_id - Customer or vendor number. Mandatory in the first data row of an invoice. If not provided, all rows of the same invoice will be ignored.

- billingid - Billing ID. Optional

- notes - Invoice notes. Optional.

- date - The date of the entry. Defaulted to date opened if left blank, or if the date provided is not valid.

- desc - Description. Optional

- action - Action. Optional

- account - Account for the entry. Mandatory in each row. If not provided or invalid, all rows of the same invoice will be ignored.
• **quantity** - Quantity. Defaulted to 1 if left blank.

• **price** - Price. Mandatory for each row. If not provided, all rows of the same invoice will be ignored.

• **disc_type** - Type of discount. Optional. Only relevant for invoices, not for bills. Use “%” or blank for percentage value, anything else for monetary value.

• **disc_how** - Discount how. Optional. Only relevant for invoices, not for bills. Use “>” for discount applied after tax, “=” for discount and tax applied before tax, and “<”, blank or anything else for discount applied before tax.

• **discount** - Amount or percentage of discount. Optional. Only relevant for invoices, not for bills

• **taxable** - Is this entry taxable? Optional. Use “Y” or “X” for yes, “N” or blank for no.

• **taxincluded** - Is tax included in the item price? Optional. Use “Y” or “X” for yes, “N” or blank for no.

• **tax_table** - Tax table. Optional. If the tax table provided does not exist, it will be blank in the invoice.

• **date_posted** - Date posted. Optional. Use the same date format as defined in Preferences. If you provide a date posted for the first row of an invoice, GnuCash will attempt to also post the invoice (as opposed to only saving or updating it).

• **due_date** - Due date. Optional. Use the same date format as defined in Preferences. Defaulted to date posted, if left blank. Only relevant in the first row of an invoice, if the invoice is posted.

• **account_posted** - Post to account, for vendor or customer posting. Only mandatory in the first row of an invoice, if the invoice is posted.

• **memo_posted** - Memo. Optional. Only relevant in the first row of an invoice, if the invoice is posted.

• **accu_splits** - Accumulate splits? Optional. Use “Y” or “X” for yes, “N” or blank for no. Only relevant in the first row of an invoice, if the invoice is posted. If you use a spreadsheet program to create the import file, it is advised not to use blank for no, because a final column with only blanks may not be recognized as relevant data when the spreadsheet program creates the csv file.

**Note on double quotes**

If you use the field separator character within a field, the field value should be enclosed in double quotes. Only for the fields description (desc) and notes, can you also include a double quote within a quoted field value, by doubling the double quote. E.g. "This field value uses the separator, and a ""quoted"" word", would be imported as This field value uses the separator, and a "quoted" word.

Example content for two bills; one of 2 entries, and one of 3 entries. The first is saved and posted, the second only saved. Using comma field separator, decimal point and dd/mm/yyyy date format.

```
1204;15/12/2018;2001;PO 210220;Special delivery;16/12/2018;Pride and Prejudice;pc;Expenses:Books;1;30.00;;;;;;;;;;X;;A1;17/12/2018;17/1/2019;Liabilities:Accounts Payable;;X
1204;15/12/2018;2001;PO 210220;Special delivery;16/12/2018;Electronic principles;pc;Expenses:Books;1;50.00;;;;;;;;;;;
1205;15/12/2018;2044;PO 21099;;16/12/2018;Ultimate Guide;pc;Expenses:Books;1;10.01;;;;;;;;;;;
1205;15/12/2018;2044;PO 21099;;16/12/2018;Dinner & drinks;pc;Expenses:Dining;1;10.01;;;;;;;;;;;
1205;15/12/2018;2044;PO 21099;;16/12/2018;UG course;pc;Expenses:Education;1;10.01;
```
Example content for one customer invoice, with one entry, including tax and discount. Using comma field separator, decimal point and dd/mm/yyyy date format. The the value of the description field contains the separator character.

20221;16/12/2018;1001;Order 3378;Discount as agreed;4/12/2018;"Accounting part 1,

Import your data

To import your invoice data, navigate to File → Import → Import Bills & Invoices… to open a new import dialog, and provide the necessary information.

• 1. Choose the file to import - Select your import file, or manually type the path and file name.

• 2. Select import type - Select the import type, either Bill or Invoice.

• 3. Select import options - Select your csv format. Use the with quotes options if your file contains fields enclosed in double quotes. These options also match fields not enclosed in quotes; except for the fields for description and notes, fields should not contain the quote character itself. See Note on double quotes above. Use one of the other options if your file does not have fields enclosed in quotes; any quote characters in the file will be imported as is.

• 4. Preview - Once you have selected your import file and csv format, GnuCash shows you a preview of the data. You can verify if your data is listed in the correct columns. If you do not see any rows in the preview, then GnuCash was not able to match your import data rows to the selected csv format. See the section called “What could go wrong?” below.

• 5. Afterwards - You can choose if GnuCash should open tabs for the invoices after the import. Either for all invoices, or for the invoices that are saved but not posted, or for none of the invoices. Opening tabs slows down the import process considerably.

• Start the import - If you are satisfied with your selections, hit the OK button to start the import.

If your data file contains invoice IDs that already exist, then GnuCash will ask you (once per import session) to confirm that you want to update existing invoices. If not confirmed, all rows for existing invoices will be ignored.

Note

Internally, GnuCash uses so called regular expressions to match the import rows to the data fields. The import option Custom regular expression offers the option to use your own regular expression for this matching process. Obviously, this option requires that you are well versed in regular expressions. When you choose the option Custom regular expression, GnuCash opens a window in which you can edit the GnuCash regular expression, or replace it with your own. Your regular expression should contain a named subpattern for each of the fields of the csv file (using the technical names). A custom regular expression could be useful if the rows of your source data file contain all required fields, but in a different order or format. E.g. if the format of your source data file starts with customer number, followed by invoice ID, followed by the due date, and uses | as separator, your regular expression would start with something like this:

`^(?<owner_id>[^|]*)\|(?<id>[^|]*)\|(?<due_date>[^|]*)`
With a custom regular expression, GnuCash could import your source data files, without the need to convert them to the GnuCash import format.

Feedback and statistics

GnuCash executes the import process in three steps:

- **Import** - Imports the data file and attempts to match each row to the data fields.
- **Validation and adjustment** - Validates the data fields and replaces data with defaults if applicable.
- **Processing** - Handles the currency related validations, and creates, updates and posts the invoices.

After all steps have finished, GnuCash issues information about the result of the process. The initial dialog shows the informational or error messages from the validation and processing steps. The second dialog shows the statistics of the process:

- Import - rows ignored: the number of rows that could not be matched to the data fields.
- Import - rows imported: the number of rows that were successfully matched to the data fields.
- Processing and validation - rows fixed: the number of rows for which a default value was used for a field.
- Processing and validation - rows ignored: the number of rows for that were not processed because of a validation error.
- Processing and validation - invoices created: the number of invoices created.
- Processing and validation - invoices updated: the number of invoices that were updated.

If there were unmatched rows in the import step, a final dialog shows the actual rows that could not be matched.

What could go wrong?

Errors in the import step

If the statistics show unmatched rows under “Import - rows ignored”, then there is some issue with the format of your import file. Verify that you use and select the correct separator. Verify that your data rows have exactly 21 separator characters (1 for each field, except for the last). Verify whether you use the separator character within a data field; if so, enclose the field in double quotes.

If you use one of the with quotes import options, verify if you use the double quote character in any of the data field values; if within the description or notes fields, make sure that the field value is quoted, and precede each double quote within the field with an extra double quote; if within any other field, remove the double quote character.

Errors in the validation step

The following errors can occur in the validation step. Any error in a data row will cause all rows of the same invoice to be ignored.

Note

In versions 3.4 and earlier, an error in a data row would cause just that row to be ignored, as opposed all rows of the same invoice.
• The field **ID** is blank. GnuCash replaces a blank invoice ID with the invoice ID from the previous row. But the first row of the import file should always have an invoice ID.

• The field **owner_id** is blank. Every first row of an invoice should have an owner_id.

• The customer or vendor number in field **owner_id** does not exist. The owner_id in the first row of an invoice should be an existing customer (for invoices) or vendor (for bills).

• The date in field **date_posted** is not a valid date. If you provide a value for **date_posted** in the first row of an invoice, it should be a valid date. Did you use the date format as set in Preferences?

• The account in the field **account_posted** does not exist. If you provide a value for the field **date_posted** in the first row of an invoice, the field **account_posted** should be an existing account.

• The account in the field **account_posted** is not of type Accounts Receivable (for invoices) or Accounts Payable (for bills). If you provide a value for the field **date_posted** in the first row of an invoice, the field **account_posted** should be an account of the correct type.

• The field **price** is blank. Every row should have a value for the field **price**.

• The account in the field **account** does not exist. Every row should have an existing account in the field **account**.

Any error in the validation step is listed after the overall import process completes. Correct your data file accordingly.

**Errors in the processing step**

The following errors can occur in the processing step.

• The invoice cannot be updated because it is already posted. All rows of the same invoice will be ignored. If you want to update the existing invoice, unpost it first in GnuCash.

• The currency of the invoice differs from the currency of the account posted (“Invoice x NOT posted because currencies don't match”). GnuCash determines the currency of the invoice either from the customer or vendor master data (for a new invoice) or from the invoice itself (for an existing invoice). The currency of the invoice must agree with the currency of the post to account in the field **account_posted**. GnuCash creates the invoice but cannot post it. Manually correct the invoice in GnuCash.

• The invoice requires currency conversion. (“Invoice x NOT posted because it requires currency conversion”). The invoice contains entries on accounts with different currencies, or the currency of the entries differs from the currency of the post to account. For such an invoice, GnuCash needs exchange rates to translate the currency amounts. GnuCash creates the invoice but cannot post it. Post the invoice manually in GnuCash, and provide the requested exchange rates.

**Not supported invoice functionality**

Currently the invoice import function does not support (at least) the following:

• Import of billing terms and job.

• Import of customer and job in default chargeback project for bills.

• Application of billing terms from customer or vendor master data.
Importing Business Data

- Automatic numbering of invoices.
- Credit notes.

Importing Customers and Vendors

General

This functionality creates and updates customers and vendors from a csv import file containing rows of vendor/customer master data. The import file may contain rows for new and/or existing customers/vendors. If a customer/vendor already exists, GnuCash updates the existing customer/vendor.

The format of the import file

The import file should contain rows of customer/vendor data, one row for each customer/vendor. The customer/vendor is identified by the customer/vendor number in the field `id` of the data rows. If the field is blank, GnuCash will use the next number from the relevant counter (set in the Counters tab under File → Properties).

There is no data in the file to indicate whether it concerns customer or vendor master data. Instead, a user option in the import dialog makes that distinction.

Each row should contain the fields listed below, in the same sequence, separated by a comma or a semi-colon. The fields are listed here by their technical name, which GnuCash uses in the preview of the import data.

- `id` - The customer/vendor number. If it is for an existing customer/vendor, GnuCash will update the customer/vendor. Note that in GnuCash e.g. '000010' is a different customer number than '10'. If the id field is empty, GnuCash will use the next number from the relevant counter.

- `company` - The company name. If it is left blank, it is defaulted to the value of field `name`. If that is also blank, then the row is ignored.

- `name` - Billing address - Name. Optional.

- `addr1` - Billing address - Address line 1. At least one of the four address lines of the billing address must be filled. If not, then the row is ignored.

- `addr2` - Billing address - Address line 2.

- `addr3` - Billing address - Address line 3.

- `addr4` - Billing address - Address line 4.

- `phone` - Billing address - Phone. Optional

- `fax` - Billing address - Fax. Optional

- `email` - Billing address - Email. Optional

- `notes` - Notes. Optional

- `shipname` - Shipping information - Name. Optional. Not relevant for vendors.

Importing Business Data

- **shipaddr2** - Shipping information - Address line 2. Optional. Not relevant for vendors.
- **shipaddr3** - Shipping information - Address line 3. Optional. Not relevant for vendors.
- **shipphone** - Shipping information - Phone. Optional. Not relevant for vendors.
- **shipmail** - Shipping information - Email. Optional. Not relevant for vendors.

Example content for a customer with a separate shipping address. Using a semicolon for separator.

```
2201;All Star Company;All Star Company;Union Avenue
776;San Juan;CA;;0482938838;;contact@allstar.com;Last contacted on
4/4/2018.;All Star Company; John Alderman, Office 456;Union Avenue
777;San Juan;CA;78998766;;alderman@allstar.com
```

Example content for a vendor; no ID given, so GnuCash will take the next number from the counter. Using a comma for separator.

```
,,Johnson Supplies,Johnson Supplies,Electric Park 56,Plain-
s,VA,,0482986538,,jack@johnson.com,Discount negotiated,,,,,,
```

All fields by technical name in the required sequence.

```
id, company, name, addr1, addr2, addr3, addr4, phone, fax, email, notes,
shipname, shipaddr1, shipaddr2, shipaddr3, shipaddr4, shipphone, shipfax, 
shipmail
```

**Import your data**

To import your customer or vendor data, navigate to File → Import → Import Customers & Vendors... to open a new import dialog, and provide the necessary information.

- 1. Choose the file to import - Select your import file, or manually type the path and file name.
- 2. Select import type - Select the import type, either Customer or Vendor.
- 3. Select import options - Select your csv format. Use the with quotes options if your file contains fields enclosed in double quotes. These options also match fields not enclosed in double quotes, but fields should not contain the double quote character itself. Use one of the other options if your file does not have fields enclosed in quotes; any double quote characters in the file will then be imported as is.
- 4. Preview - Once you have selected your import file and csv format, GnuCash shows you a preview of the data. You can verify if your data is listed in the correct columns. If you do not see any rows in the preview, then GnuCash was not able to match your import data rows to the selected csv format. See the section called “What could go wrong?” below.

- **Start the import** - If you are satisfied with your selections, hit the OK button to start the import.

**Note**

Internally, GnuCash uses so called regular expressions to match the import rows to the data fields. The import option Custom regular expression offers the option to use your own regular expression for this matching process. Obviously, this option requires that you are well versed in regular
Importing Business Data

expressions. When you choose the option Custom regular expression, GnuCash opens a window in which you can edit the GnuCash regular expression, or replace it with your own. Your regular expression should contain a named subpattern for each of the fields of the csv file (using the technical names). A custom regular expression could be useful if the rows of your source data file contain all necessary fields, but in a different order or format. E.g. if the format of your source data file starts with customer number, followed by company name, name, and one address field, and that is all you want to import, then your custom regular expression would be something like this (using comma as a separator):

```
^(?<company>[^,]*),(?<id>[^,]*),(?<name>[^,]*),(?<addr1>[^,]*),(?<addr2>[^,]*)$
```

With a custom regular expression, GnuCash could import your source data files, without the need to convert them to the GnuCash import format.

Feedback and statistics

GnuCash executes the import process in three steps:

- **Import** - Imports the data file and attempts to match each row to the data fields.
- **Validation and adjustment** - Validates the data fields and replaces data with defaults if applicable.
- **Processing** - Creates or updates the vendor or customer master data.

After all steps have finished, GnuCash issues information about the result of the process. The initial dialog shows the statistics of the process:

- Import results - lines ignored: the number of rows that could not be matched to the data fields.
- Import results - lines imported: the number of rows that were successfully matched to the data fields.
- Import results - customers/vendors fixed: the number of rows for which a default value was used for a field.
- Import results - customers/vendors ignored: the number of rows for that were not processed because of a validation error.
- Import results - customers/vendors created: the number of customers/vendors created.
- Import results - customers/vendors updated: the number of customers/vendors that were updated.

If there were unmatched rows in the import step, a final dialog shows the actual rows that could not be matched.

What could go wrong?

Errors in the import step

If the statistics show unmatched rows under “Import results - lines ignored”, then there is some issue with the format of your import file. Verify that you use and select the correct separator. Verify that your data rows have exactly 18 separator characters (1 for each field, except for the last). Verify whether you use the separator character within a data field; if so, enclose the field in double quotes.
If you use one of the with quotes import options, verify if you use the double quote character in any of the data field values. If so, remove them; importing double quotes as is, is not supported when using the with quotes import options.

**Errors in the validation step**

If the statistics show rows under “Import results - customers/vendors ignored”, then data rows were ignored because of one of the errors below:

- The field `company` and the field `name` are both blank. The field `company` is mandatory; if it is blank, then it is defaulted to the value of the field `name`, but if both are blank, then the data row cannot be processed.

- The fields `addr1`, `addr2`, `addr3` and `addr4` are all blank. At least one of these fields must have a value, otherwise the data row cannot be processed.

**Not supported customer/vendor functionality**

Currently the customer/vendor import function does not support (at least) the following:

- Import of any of the fields in the customer tab for billing information: currency, terms, discount, credit limit, tax included and tax table.

- Import of any of the fields in the vendor tab for payment information: currency, terms, tax included and tax table.
Part IV. Appendices
# Table of Contents

GnuCash Glossary ........................................................................................................... 283
A. Migration Guide ....................................................................................................... 287
   Using Accounts vs. Categories ................................................................................. 287
   Importing Data ........................................................................................................ 287
      Import of Financial Data by QIF Files ................................................................. 287
      Import of Business Data by CSV Files ............................................................... 287
      Converting XML GnuCash File ........................................................................... 287
B. Auxiliary File Formats ............................................................................................. 290
   Check Format Files (*.chk) ..................................................................................... 290
      Overview .............................................................................................................. 290
      Example file ......................................................................................................... 290
      Field Descriptions .............................................................................................. 291
      Creating Check Format Files ............................................................................ 300
C. GNU Free Documentation License .......................................................................... 301
   0. PREAMBLE .......................................................................................................... 301
   1. APPLICABILITY AND DEFINITIONS .................................................................. 301
   2. VERBATIM COPYING ........................................................................................ 302
   3. COPYING IN QUANTITY ...................................................................................... 302
   4. MODIFICATIONS .................................................................................................. 303
   5. COMBINING DOCUMENTS .................................................................................. 304
   6. COLLECTIONS OF DOCUMENTS ...................................................................... 304
   7. AGGREGATION WITH INDEPENDENT WORKS .............................................. 304
   8. TRANSLATION ...................................................................................................... 305
   9. TERMINATION ...................................................................................................... 305
  10. FUTURE REVISIONS OF THIS LICENSE ............................................................. 305
Addendum ...................................................................................................................... 305
# GnuCash Glossary

This is a glossary of common terms used in GnuCash. Some entries here are taken from Wikipedia [https://en.wikipedia.org/wiki/Main_Page].

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>An account keeps track of what you own, owe, spend or receive.</td>
</tr>
<tr>
<td>Accounting Period</td>
<td>An accounting period is the period with reference to which accounting books of an entity are prepared. Common accounting periods include month, quarter, and year.</td>
</tr>
<tr>
<td>AqBanking</td>
<td>A library which implements the German Home Banking Computer Interface (HBCI) and Electronic Banking Internet Communication Standard (EBICS), OFX Direct Connect and Paypal. It is the successor of openHBCI.</td>
</tr>
<tr>
<td>Asset</td>
<td>An asset is something you own. Anything tangible or intangible that can be owned or controlled to produce value and that is held to have positive economic value is considered an asset.</td>
</tr>
<tr>
<td>Balance Sheet</td>
<td>A Balance Sheet is a summary of the financial balances of an individual or organization. It summarizes a company's assets, liabilities and ownership equity at a specific point in time.</td>
</tr>
<tr>
<td>Book</td>
<td>A book is a record of all transactions for an individual or organization. In GnuCash, each file contains a book.</td>
</tr>
<tr>
<td>Capital Gain/Loss</td>
<td>The difference between the purchase and selling prices of an investment at the time the investment is sold. Also known as Realized Gain/Loss. Before an investment is sold, the difference in value is referred to as Unrealized Gain/Loss. See Also Realized Gain/Loss, Unrealized Gain/Loss.</td>
</tr>
<tr>
<td>Capital stock</td>
<td>See Stock.</td>
</tr>
<tr>
<td>Chart of Accounts</td>
<td>A listing of all the accounts available in the data file. The chart of accounts consists of balance sheet accounts (assets, liabilities, stockholders’ equity) and income statement accounts (revenues, expenses, gains, losses).</td>
</tr>
<tr>
<td>Commission</td>
<td>The fee paid to a broker to buy or sell securities.</td>
</tr>
<tr>
<td>Commodity</td>
<td>A commodity is something of value that is easily tradeable or sellable; for example, currencies, stocks, bonds, grain, copper, and oil are all commodities.</td>
</tr>
<tr>
<td>Common stock</td>
<td>See Stock.</td>
</tr>
<tr>
<td>Compounding</td>
<td>The concept that the reinvested interest can later earn interest of its own (interest on interest). This is often referred to as compound interest.</td>
</tr>
<tr>
<td>Cost Basis</td>
<td>Cost basis is the original cost of property, adjusted for various factors. Its primary use is for tax purposes. Factors that affect the cost basis include: stock splits, dividends, depreciation and return of capital distributions. Cost basis is used to determine the capital gain.</td>
</tr>
<tr>
<td>CSV</td>
<td>Stands for Comma Separated Values. CSV files are used to store data in plain text. Each line of the file is a record and each record can be comprised of multiple fields separated by commas. CSV is one import format that GnuCash supports.</td>
</tr>
</tbody>
</table>
Dividends Dividends are cash payments a company makes to shareholders. The amount of this payment is usually determined as some amount of the profits of the company. Not all common stocks give dividends.

Equities Equities are investments in which the investor becomes part (or whole) owner in something.

Financial Transaction Services (FinTS) A banking protocol used by German banks. Developed by the German Central Banking Committee ZKA (Zentraler Kredit-Ausschuss). The standard is used only by German banks. Prior 2002, it was called Home Banking Computer Interface (HBCI). FinTS is one import format that GnuCash supports. See Also Home Computer Banking Interface (HBCI).

GSettings Since version 2.5 the tool that stores user configuration data. It uses the native data store of the operating system:

- **Linux**
  - DConf since Gnome 3.0 dropped GConf

- **macOS**
  - Defaults. Use the command-line defaults(1) to modify prefs when GnuCash isn't running.

- **Windows**
  - Registry.

Home Computer Banking Interface (HBCI) A bank-independent online banking protocol used by German banks. Home Banking Computer Interface (HBCI) was developed by the German Central Banking Committee ZKA (Zentraler Kredit-Ausschuss). Since 2002, it has been called Financial Transaction Services (FinTS). HBCI is one import format that GnuCash supports. See Also Financial Transaction Services (FinTS).

Interest What a borrower pays a lender for the use of their money. Normally, this is expressed in terms of a percentage of the principal per year. For example, a savings account with 1% interest will pay you $1 for every $100 you keep deposited per year.

Liability A liability is a debt or obligation that an individual or organization owes.

LibOFX An open source library for OFX. It was created by one of the GnuCash developers, originally to be the OFX interface for GnuCash. See Also OFX.

Liquidity A measure of how easily convertible an investment is to cash. Money in a savings account is very liquid, while money invested in a house has low liquidity because it takes time to sell a house.

Lot A lot is a means of grouping a commodity so that you later identify that the item bought in one transaction is the same as one sold in a different transaction. Lots are often implemented with stocks, where capital gain can depend on which item is being sold at a given time.

MT940 A financial information standard defined by SWIFT and used by several European banks. It is also used internally in HBCI. Unfortunately, you can't download the
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>MT940 standard</td>
<td>The MT940 standard, but some banks publish it on their websites. MT940 is one import format that GnuCash supports.</td>
</tr>
<tr>
<td>OFX</td>
<td>The Open Financial eXchange format. This is a financial information exchange standard used by many institutions. OFX is one import format that GnuCash supports.</td>
</tr>
<tr>
<td>Price Database</td>
<td>The price database contains a store of price quotes for stocks, mutual funds, and currencies.</td>
</tr>
<tr>
<td>Principal</td>
<td>The original amount of money invested or borrowed.</td>
</tr>
<tr>
<td>QFX</td>
<td>The Quicken Financial eXchange format is a proprietary financial information exchange standard promoted by Quicken and used by many institutions. QFX is one import format that GnuCash supports.</td>
</tr>
<tr>
<td>QIF</td>
<td>The Quicken Interchange Format (QIF) is an open specification for reading and writing financial data to files. This is an older format that is still used by many institutions. QIF is one import format that GnuCash supports.</td>
</tr>
<tr>
<td>Realized Gain/Loss</td>
<td>The difference between the purchase and selling prices of an investment at the time the investment is sold. Also known as Capital Gain/Loss. Before an investment is sold, the difference in value is referred to as Unrealized Gain/Loss. See Also Capital Gain/Loss, Unrealized Gain/Loss.</td>
</tr>
<tr>
<td>Reconciliation</td>
<td>Reconciliation is a verification process in which the user compares their records with those of the financial institution to ensure that the records in each system agree at some particular point in time. During reconciliation, the user checks individual transactions in their file against the institution's statement; upon completion, the reported balances of the institution and the reconciled account will match at that point in the register.</td>
</tr>
<tr>
<td>Return</td>
<td>The total income plus capital gains or losses of an investment. See Also Yield.</td>
</tr>
<tr>
<td>Reversing Transaction</td>
<td>In formal accounting, a transaction is never deleted. Therefore, when a mistake is made, the original transaction remains in the ledger, and a transaction is added to the ledger that reverses the original. This reversing transaction duplicates the original transaction, but with debit and credit amounts reversed. This removes the effect of the erroneous transaction from the books. After entering the reversing transaction, a corrected transaction can then be entered. Reversing transactions are not commonly used in personal accounting.</td>
</tr>
<tr>
<td>Risk</td>
<td>The probability that the return on investment is different from what was expected. Investments are often grouped on a scale from low risk (e.g., savings accounts or government bonds) to high risk (e.g., common stocks or junk bonds). As a general rule of thumb, the higher the risk, the higher the possible return.</td>
</tr>
<tr>
<td>Scheduled Transaction</td>
<td>Scheduled transactions provide a framework for remembering information about transactions that are set to occur in the future, either once or periodically. See Also Yield.</td>
</tr>
<tr>
<td>Scheme</td>
<td>Scheme is a functional programming language based on a dialect of LISP. Reports in GnuCash use the Scheme programming language; thus, users wishing to customize reports must write Scheme.</td>
</tr>
<tr>
<td>Shareholder</td>
<td>A shareholder is a person who holds common stock in a company.</td>
</tr>
</tbody>
</table>
### Split
A split, or Ledger Entry, is the fundamental accounting unit. Each split consists of an amount, the value of that amount expressed in a (possibly) different currency, a Memo, a pointer to the parent Transaction, a pointer to the debited Account, a reconciled flag and timestamp, an action field, and a key-value frame which can store arbitrary data.

### Stock
A security that represents a certain fractional ownership of a company. This is what you buy when you “buy stock” in a company on the open market. This is also sometimes known as *capital stock*, or *common stock*.

### Stock split
Occurs when a company offers to issue some additional multiple of shares for each existing stock. For example, a “2 for 1” stock split means that if you own 100 shares of a stock, you will receive an additional 100 shares at no cost to you. The unit price of the shares will usually be adjusted so there is no net change in the value, so in this example the price per share will be halved. Note that such transactions affect the cost basis per share owned.

### Transaction
A transaction consists of a date, a description, an ID number, a list of two or more splits, and a key-value frame. Transactions embody the notion of "double entry" accounting.

### Unrealized Gain/Loss
Unrealized gain or loss is the difference in value between a purchase price and the current value of a given asset. These gains remain unrealized until the asset is sold, at which point they become *Realized gains or losses*. See Also Capital Gain/Loss, Realized Gain/Loss.

### Valuation
The process of determining the market value or the price the investment would sell at in a “reasonable time frame”.

### XML
The eXtensible Markup Language is an international markup standard. GnuCash stores its data by default in an XML data structure.

### Yield
A measure of the amount of money you earn from an investment (i.e., how much income you receive from the investment). Typically, this is reported as a percentage of the principal amount. Yield does not include capital gains or losses (see Return). For example, a stock that sells for $100 and gives $2 in dividends per year has a yield of 2%.
Appendix A. Migration Guide

This appendix is to help current users of other financial software packages in their migration to GnuCash. We address the conceptual differences between the layout of GnuCash accounts versus other software packages.

Using Accounts vs. Categories

If you are familiar with other personal finance programs, you are already accustomed to tracking your income and expenses as categories. Since GnuCash is a double-entry system (see the section called “Accounting Concepts”), income and expenses are tracked in accounts. The basic concept is the same, but the account structure allows more consistency with accepted business practices. So, if you are a business user as well as a home user, GnuCash makes it easy to keep track of your business as well as your personal accounts.

Income and expense accounts give you the same information you would get with categories, but they also give you more flexibility in entering your transactions. In GnuCash, you have the option to enter transactions directly into income and expense accounts through their account registers. Other programs that use categories do not offer this option, because there is no “account register” for a category.

You also have the option in GnuCash to treat income and expense accounts exactly as you would treat categories, if you are more comfortable with that method. In Quicken® and similar programs, transactions require an account and a category. Substitute an income or expense account name in GnuCash where you would normally enter a category name in the other programs, and the result should be the same. We will discuss transaction entry in the section called “Transactions” in greater detail.

Importing Data

If you want to import data from your previous application, you should distinguish between financial data and other data. Probably the best way to import financial data is the “Quicken Interchange Format” QIF. It is a specific format for financial data, which most financial applications for the private sector know and can use for export.

For other data we suggest the use of the “Comma Separated Value” CSV format.

Import of Financial Data by QIF Files


Some GnuCash users collected their knowledge about the best use in our https://wiki.gnucash.org/wiki/Quicken_Migration.

For other formats and more details see Chapter 3, Importing Data into GnuCash.

Import of Business Data by CSV Files

If you want to import customers and vendors or bills and invoices see Chapter 18, Importing Business Data.

Converting XML GnuCash File

The GnuCash XML data file can be transformed to almost any other data format (e.g., QIF, CSV...) quite easily if one is familiar with the “Extensible Stylesheet Language Transformations” XSLT [https://
The GnuCash data file is well-formed XML, and it can therefore be run through an XSLT parser with an associated stylesheet. This allows one to transform the file to just about any format that can be designed, given a properly written stylesheet.

A few steps need to be followed. The writing of a stylesheet is a task for a different time, but if you can get one written, here’s what you need to do:

1. Copy the GnuCash XML data file to a working file.

   **Important**

   If the file was last modified by a version of GnuCash older than 2.0, then before you continue to the next step you will need to modify the working file’s `<gnc-v2>` tag to read something like this:

   ```xml
           xmlns:gnc="http://www.gnucash.org/XML/gnc"
           xmlns:cmdty="http://www.gnucash.org/XML/cmdty"
           xmlns:trn="http://www.gnucash.org/XML/trn"
           xmlns:split="http://www.gnucash.org/XML/split"
           xmlns:price="http://www.gnucash.org/XML/price"
           xmlns:lot="http://www.gnucash.org/XML/lot"
           xmlns:cust="http://www.gnucash.org/XML/cust"
           xmlns:entry="http://www.gnucash.org/XML/entry"
           xmlns:invoice="http://www.gnucash.org/XML/invoice"
           xmlns:owner="http://www.gnucash.org/XML/owner"
           xmlns:job="http://www.gnucash.org/XML/job"
           xmlns:billterm="http://www.gnucash.org/XML/billterm"
           xmlns:bt-days="http://www.gnucash.org/XML/bt-days"
           xmlns:sx="http://www.gnucash.org/XML/sx"
           xmlns:fs="http://www.gnucash.org/XML/fs"
           xmlns:addr="http://www.gnucash.org/XML/custaddr">
   ```

   **Note**

   You can put pretty much anything you want behind the equal signs, but a unique URL is what is typically used.

2. Create an XSLT stylesheet containing the transformation your desire, or obtain one that’s already written.

   **User Contributed XSLT Stylesheets**

   - in our repository: https://github.com/Gnucash/gnucash/tree/stable/ contrib/xslt
   - in our wiki: https://wiki.gnucash.org/wiki/De/export_to_excel_xls_transform

4. Run the work file and the stylesheet through the processor according to the processor’s instructions.

5. You will now have a file in the desired output format. An enterprising individual could go so far as to write a stylesheet to transform the GnuCash data file to an Apache OpenOffice/LibreOffice Calc (or vice-versa, for that matter). Such things as QIF ought to be a little less work.

Benefits are that you don’t need to write a Scheme module or a new C routine to do this transformation. Anyone who knows or can learn XML and XSLT can perform this task. Not much harder, really, than writing a Web page....

Anyhow, I just wanted this tidbit to be captured somewhere permanently. The process works on 5.8 datafiles, and ought to work on earlier versions, too.
Appendix B. Auxiliary File Formats

These are the formats of some auxiliary files used by GnuCash.

Check Format Files (*.chk)

Overview

The check format file is used to tell GnuCash how to print a check or checks onto a page of paper. This file first describes the overall layout of a page (number of checks, orientation, etc) and then describes the layout of the specific items on a single check. The file is organized as a typical Key/Value file used by many Linux applications. Keys/values pairs are grouped into sections that begin with the group name enclosed in square brackets.

GnuCash looks for check format files in two different locations when you bring up the check printing dialog. The first location is typically /usr/share/gnucash/checks, where check files distributed with the application can be found. The second location is the user private ~/.local/share/gnu-cash/checks1 directory. Users may add check formats at any time (even while GnuCash is running) simply by dropping a new *.chk file in this directory. The next time the check printing dialog is opened the new check format will appear in the list of available check formats.

Note

Printing functions differently depending on the version of GTK that is installed on your system. When GnuCash is using a version of GTK prior to 2.10 all offsets are measured from the lower left corner of the page or check. When using GTK 2.10 or later, all offsets are measured from the upper left corner of the page or check.

Example file

A typical GnuCash check file is presented below. The contents of this file will be described in the next sections.

```
[Top]
Guid = 67b144d1-96a5-48d5-9337-0e1083bbf229
Title = Quicken/QuickBooks (tm) US-Letter
Rotation = 0.0
Translation = 0.0;4.0
Show_Grid = false
Show_Boxes = false

[Check Positions]
Height = 252.0
Names = Top;Middle;Bottom

[Check Items]
Type_1 = PAYEE
Coords_1 = 90.0;102.0;400.0;20.0

Type_2 = AMOUNT_WORDS
Coords_2 = 90.0;132.0
```

1Up to GnuCash 2.6.21 it was ~/.gnucash/checks
Field Descriptions

Top Group

This section of the check file describes the overall layout of a page of checks (or check) that goes into the printer.

Table B.1. Overall Page Description Fields

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guid</td>
<td>string</td>
<td>mandatory</td>
<td>The guid is used to uniquely identify a check format to GnuCash. It must be unique across the entire set of application supplied and user supplied check formats. If you copy an application check file as the basis of your own check format, you must change this value. The uuidgen program may be used to generate these identifiers.</td>
</tr>
<tr>
<td>Title</td>
<td>string</td>
<td>mandatory</td>
<td>The title is used to uniquely identify a check format to the user. This value is presented verbatim in the check format list of the check printing dialog. If you copy an application check file as the basis of your own check format, you should change this value. The title may be any utf-8 string.</td>
</tr>
<tr>
<td>Font</td>
<td>string</td>
<td>optional</td>
<td>If supplied, this is the default font used to print all text items on this check. This field can contain any string that is accept-</td>
</tr>
<tr>
<td>Name</td>
<td>Type</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BlockingChars</td>
<td>boolean</td>
<td>optional</td>
<td>If supplied, this is the default used when printing all <em>TEXT</em> items on this check. When set to true, will print *** before and after each text field on the check. Blocking characters are printed to protect check fields from alteration. For example, the amount field may be printed as <em><strong>100.00</strong></em>.</td>
</tr>
<tr>
<td>DateFormat</td>
<td>boolean</td>
<td>optional</td>
<td>If supplied, this is the default used when printing all <em>DATE</em> items on this check. When set to true, will print the format of the DATE in 8 point type, centered and below the actual DATE. For example, DDMMYYYY.</td>
</tr>
<tr>
<td>Rotation</td>
<td>double</td>
<td>optional</td>
<td>This value specified the rotation of the entire page (in degrees) around the origin point. For gtk versions prior to 2.10, the origin point is in the lower left corner of the page and rotation values increase in the counterclockwise direction. For gtk version 2.10 and later, the origin point is in the upper left corner of the page and rotation values increase in the clockwise direction. Rotation of the page is applied before translation.</td>
</tr>
<tr>
<td>Translation</td>
<td>list of 2 doubles</td>
<td>optional</td>
<td>These values specify the x and y translation of the entire page (in points) relative to the origin point. For gtk versions...</td>
</tr>
</tbody>
</table>
Auxiliary File Formats

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>prior to 2.10, the origin point is in the lower left corner of the page and translation values increase moving up and to the right. For gtk version 2.10 and later, the origin point is in the upper left corner of the page and translation values increase moving down and to the right. Rotation of the page is applied before translation.</td>
</tr>
<tr>
<td>Show_Grid</td>
<td>boolean</td>
<td>optional</td>
<td>If this value is set to true then GnuCash will draw a grid on the page, starting at the origin with the lines spaced every 50 points. This can be helpful when creating a check format file.</td>
</tr>
<tr>
<td>Show_Boxes</td>
<td>boolean</td>
<td>optional</td>
<td>If this value is set to true then for each item where the width and height have been specified, GnuCash will draw a box showing location and maximum size of that item. This can be helpful when creating a check format file.</td>
</tr>
</tbody>
</table>

**Note**

The Blocking_Chars and DateFormat options are defined for all check formats in Edit->Preferences->Printing. It is recommended that these global options be set to false (the default), and that the options be set for individual Check Items as described below.

**Check Positions Group**

This group of items specifies how multiple checks are laid out on the same sheet of paper, and gives names to each of these check locations so that a user can specify which check location that GnuCash should print. This entire group of key/value pairs is optional, and should be omitted if the format file only specifies a single check per page of paper.

**Table B.2. Multiple Checks Per Page Fields**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>double</td>
<td>mandatory</td>
<td>This field specifies the height of a single check</td>
</tr>
</tbody>
</table>
### Auxiliary File Formats

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names</td>
<td>list of strings</td>
<td>mandatory</td>
<td>This field specifies the names of the check locations that can be printed on each page. These names represent the check positions starting from the top of the page and moving downward. The names are presented verbatim in the check position list of the check printing dialog. A typical value for this field is &quot;Top;Middle;Bottom&quot;, but it could also be &quot;First;Second;Third&quot; or any other set of strings that clearly identify the check locations. If there are multiple checks per page then this item is mandatory. If there is only a single check per page, this entire section should be omitted.</td>
</tr>
</tbody>
</table>

### Check Items Group

This section specifies the individual items that are printed on the check. There is no limit to the number of items that may be present in this section, and any given type of item can be repeated multiple times. This allows for the printing of checks that have a side stub, or for the one-per-page business checks that have both the check and multiple check stubs on the same page. For example, to print the payee name on a business check and on both stubs, simply specify three payee items with differing print coordinates.

Each key names in this section explicitly includes the item number to which it applies. E.G. The key named Type_1 applies to the first item to be printed, and the key Coords_3 applies to the third item to be printed. Item numbers start at one and increase sequentially. Any gap in the numbering sequence is interpreted by GnuCash as the end of the item list. Items are printed in the order of their item numbers, not in the order in which they appear in the file.

Each item specified must include a type declaration. The rest of the parameters for that item depend upon the particular type of that item. See Table B.4, “Individual Check Item Types” for a list of valid item types and their required parameters.
### Table B.3. Individual Check Item Fields

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typeₙ</td>
<td>string</td>
<td>mandatory</td>
<td>This field specifies the type of a single item to be printed on a check. See Table B.4, “Individual Check Item Types” for a list of valid item types.</td>
</tr>
<tr>
<td>Coordsₙ</td>
<td>list of 2 or 4 doubles</td>
<td>mandatory</td>
<td>This field specifies the coordinates where the item should be placed on a check, and optionally also specifies the width and height of the item. The numbers in order are the X and Y offset of the lower left corner of the item, and optionally the width and height of the item. If the width is supplied then the height must also be supplied, so this field will always contain two or four numbers. For gtk versions prior to 2.10, the origin point is in the lower left corner of the page and translation values increase moving up and to the right. For gtk version 2.10 and later, the origin point is in the upper left corner of the page and translation values increase moving down and to the right.</td>
</tr>
</tbody>
</table>

**Note**

Regardless of whether the origin is at the top or the bottom of the page, the coordinates always specify the lower left point of the item.
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font_n</td>
<td>string</td>
<td>optional</td>
<td>If supplied, this is the font used to print this specific text item. This field can contain any string that is acceptable by gtk as a font specifier. If this field is omitted, the default font is the font specified in the Top section of the check description file, or if that was omitted the font specified in the GnuCash preferences dialog. This field is only recognized when using gtk version 2.10 or later.</td>
</tr>
<tr>
<td>Align_n</td>
<td>string</td>
<td>optional</td>
<td>If supplied, this is the alignment used to print this specific text item. This field must contain one of the strings “left”, “center” or “right”. If this field is omitted, the text will be left aligned. This field is only recognized when using gtk version 2.10 or later.</td>
</tr>
<tr>
<td>Text_n</td>
<td>string</td>
<td>optional</td>
<td>This field is only used when the item type is TEXT. It specifies the utf-8 text that should be printed on the check.</td>
</tr>
<tr>
<td>Filename_n</td>
<td>string</td>
<td>optional</td>
<td>This field is only used when the item type is PICTURE. It specifies the filename of the image that should be printed on the check. The string may specify either an absolute path name or as a relative path name. If a relative path name is specified, GnuCash first looks in the application check format folder (typically /usr/share/gnucash/checks) for the image file, and if it is not found there then it looks in the</td>
</tr>
</tbody>
</table>
### Auxiliary File Formats

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user private</td>
<td></td>
<td></td>
<td>~/local/share/gnuCash/checks(^1) directory for the image. This field is only recognized when using gtk version 2.10 or later.</td>
</tr>
<tr>
<td>Blocking_Chars_n</td>
<td>boolean</td>
<td>optional</td>
<td>If supplied, this will set the print Blocking_Chars option for this item.</td>
</tr>
<tr>
<td>DateFormat_n</td>
<td>boolean</td>
<td>optional</td>
<td>If supplied, this will set the print DateFormat option for this item.</td>
</tr>
</tbody>
</table>

These are the individual items that can be printed on a check. All items require the coordinates on the page where the item should be printed. The majority of these items result in text being printed on the page, and these items may have individual font and alignments specified. For example, the numerical amount of a check could be printed right justified while everything else is printed left justified. Other types may have unique parameters.

### Table B.4. Individual Check Item Types

<table>
<thead>
<tr>
<th>Name</th>
<th>Required Fields</th>
<th>Optional Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAYEE</td>
<td>Coords</td>
<td>Font Align</td>
<td>This type value tells GnuCash to print the check payee name at the specified coordinates.</td>
</tr>
<tr>
<td>DATE</td>
<td>Coords</td>
<td>Font Align</td>
<td>This type value tells GnuCash to print the check date at the specified coordinates.</td>
</tr>
<tr>
<td>NOTES</td>
<td>Coords</td>
<td>Font Align</td>
<td>This type value tells GnuCash to print the transaction notes field at the specified coordinates.</td>
</tr>
<tr>
<td>CHECK_NUMBER</td>
<td>Coords</td>
<td>Font Align</td>
<td>This type value tells GnuCash to print the check number at the specified coordinates.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Required Fields</th>
<th>Optional Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MEMO</td>
<td>Coords</td>
<td>Font</td>
<td>This type value tells GnuCash to print the split memo field at the specified coordinates.</td>
</tr>
<tr>
<td>ACTION</td>
<td>Coords</td>
<td>Font</td>
<td>This type value tells GnuCash to print the split action field at the specified coordinates. However, the printed field reflects the book option selection under File → Properties for number source (transaction number or anchor-split action - see Use Split Action Field for Number [<a href="https://www.gnucash.org/docs/v5/C/gnucash-manual/book-options.html#num-action-book-option">https://www.gnucash.org/docs/v5/C/gnucash-manual/book-options.html#num-action-book-option</a>] in the Book Options section of the GnuCash Manual). If number source for the book is specified as anchor-split action, this field will instead print the transaction number field.</td>
</tr>
<tr>
<td>AMOUNT_WORDS</td>
<td>Coords</td>
<td>Font</td>
<td>This type value tells GnuCash to print the check amount in words at the specified coordinates. The amount will appear similar to the string &quot;One thousand, two hundred thirty four and 56/100&quot;.</td>
</tr>
<tr>
<td>AMOUNT_NUMBER</td>
<td>Coords</td>
<td>Font</td>
<td>This type value tells GnuCash to print the check amount in numbers at the specified coordinates. The amount will appear similar to the number &quot;$1,234.56&quot;.</td>
</tr>
<tr>
<td>ADDRESS</td>
<td>Coords</td>
<td>Font</td>
<td>This type value tells GnuCash to print the address.</td>
</tr>
</tbody>
</table>
## Auxiliary File Formats

<table>
<thead>
<tr>
<th>Name</th>
<th>Required Fields</th>
<th>Optional Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPLITS_ACCOUNT</td>
<td>Coords</td>
<td>Font, Align, Blocking_Chars</td>
<td>This type value tells GnuCash to print the account names for each split entry stating at the specified coordinates. See the note on splits printing.</td>
</tr>
<tr>
<td>SPLITS_AMOUNT</td>
<td>Coords</td>
<td>Font, Align, Blocking_Chars</td>
<td>This type value tells GnuCash to print the amount for each split entry stating at the specified coordinates. Amounts are printed with currency symbols. See the note on splits printing.</td>
</tr>
<tr>
<td>SPLITS_MEMO</td>
<td>Coords</td>
<td>Font, Align, Blocking_Chars</td>
<td>This type value tells GnuCash to print the memo text for each split entry stating at the specified coordinates. See the note on splits printing.</td>
</tr>
<tr>
<td>TEXT</td>
<td>Coords, Text</td>
<td>Font, Align, Blocking_Chars</td>
<td>This type value tells GnuCash to print an arbitrary string at the specified coordinates. The string to be printed is specified with the Text_n key.</td>
</tr>
<tr>
<td>PICTURE</td>
<td>Coords, Filename</td>
<td>(none)</td>
<td>This type value tells GnuCash to print an image at the specified coordinates. The image to be printed is specified with the Filename_n key. This type is only recognized when using gtk version 2.10 or later.</td>
</tr>
</tbody>
</table>

### Note

SPLIT items include all split entries for the transaction except for the split that applies to the current account register (referred to as the anchor-split). This is usually the last split listed when splits are displayed in the register. The coordinate location defines the lower left location for the split information.
Creating Check Format Files

Creating your own check format file is a fairly simple task. The easiest way to start is to copy an existing check format file from the application directory (typically `/usr/share/gnucash/checks`) to the directory `~/.local/share/gnucash/checks`. Make sure to change the guid so the new file will be accepted by gnucash, and change the title to something descriptive. Then change or add individual item fields as necessary. You can also create a new check file by clicking the Save Format button on the Custom format page of the check printing dialog.

Note

Key names are case sensitive. If you are having problems with a check format file, ensure that all key names have capital letters as documented above.
Appendix C. GNU Free Documentation License

Version 1.1, March 2000
Copyright © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place,
   Suite 330, Boston, MA
   02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other written document “free” in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work that contains a notice placed by the copyright holder saying it can be distributed under the terms of this License. The “Document”, below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as “you”.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the Document is released under this License.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document is released under this License.
A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specification is available to the general public, whose contents can be viewed and edited directly and straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent modification by readers is not Transparent. A copy that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires to appear in the title page. For works in formats which do not have any title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies of the Document numbering more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a publicly-accessible computer-network location containing a complete Transparent copy of the Document, free of added material, which the general network-using public has access to download anonymously at no charge using public-standard network protocols. If you use the latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a chance to provide you with an updated version of the Document.
4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

- **A.** Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version gives permission.

- **B.** List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it has less than five).

- **C.** State on the Title Page the name of the publisher of the Modified Version, as the publisher.

- **D.** Preserve all the copyright notices of the Document.

- **E.** Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

- **F.** Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this License, in the form shown in the Addendum below.

- **G.** Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document’s license notice.

- **H.** Include an unaltered copy of this License.

- **I.** Preserve the section entitled “History”, and its title, and add to it an item stating at least the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no section entitled “History” in the Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

- **J.** Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network locations given in the Document for previous versions it was based on. These may be placed in the “History” section. You may omit a network location for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

- **K.** In any section entitled “Acknowledgements” or “Dedications”, preserve the section’s title, and preserve in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

- **L.** Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered part of the section titles.

- **M.** Delete any section entitled “Endorsements”. Such a section may not be included in the Modified Version.

- **N.** Do not retitle any existing section as “Endorsements” or to conflict in title with any Invariant Section.
If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice. These titles must be distinct from any other section titles.

You may add a section entitled “Endorsements”, provided it contains nothing but endorsements of your Modified Version by various parties—for example, statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents, make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections entitled “History” in the various original documents, forming one section entitled “History”; likewise combine any sections entitled “Acknowledgements”, and any sections entitled “Dedications”. You must delete all sections entitled “Endorsements.”

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License, and replace the individual copies of this License in the various documents with a single copy that is included in the collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all other respects.

You may extract a single document from such a collection, and dispbibute it individually under this License, provided you insert a copy of this License into the extracted document, and follow this License in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of a storage or distribution medium, does not as a whole count as a Modified Version
of the Document, provided no compilation copyright is claimed for the compilation. Such a compilation is called an “aggregate”, and this License does not apply to the other self-contained works thus compiled with the Document, on account of their being thus compiled, if they are not themselves derivative works of the Document. If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one quarter of the entire aggregate, the Document’s Cover Texts may be placed on covers that surround only the Document within the aggregate. Otherwise they must appear on covers around the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections. You may include a translation of this License provided that you also include the original English version of this License. In case of a disagreement between the translation and the original English version of this License, the original English version will prevail.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation [http://www.gnu.org/fsf/fsf.html] may publish new, revised versions of the GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/ [http://www.gnu.org/copyleft].

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered version of this License “or any later version” applies to it, you have the option of following the terms and conditions either of that specified version or of any later version that has been published (not as a draft) by the Free Software Foundation. If the Document does not specify a version number of this License, you may choose any version ever published (not as a draft) by the Free Software Foundation.

Addendum

To use this License in a document you have written, include a copy of the License in the document and put the following copyright and license notices just after the title page:

Copyright YEAR YOUR NAME.

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License, Version 1.1 or any later version published by the Free Software Foundation; with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST. A copy of the license is included in the section entitled “GNU Free Documentation License”.
GNU Free Documentation License

If you have no Invariant Sections, write “with no Invariant Sections” instead of saying which ones are invariant. If you have no Front-Cover Texts, write “no Front-Cover Texts” instead of “Front-Cover Texts being LIST”; likewise for Back-Cover Texts.

If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel under your choice of free software license, such as the GNU General Public License [https://www.gnu.org/copyleft/gpl.html], to permit their use in free software.